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CHAPTER

ONE

DASHBOARDS

The Dashboards area displays the output from any report template which has been configured in the report template
library and marked as a Dashboard.

When a user logs in NEXUS IC the first time, he/she will be presented with the Dashboards Page. On subsequent
logins, NEXUS IC will open to screen that was active when the user logged out.

To choose which dashboard template is shown, click the Dashboard drop-down button on the toolbar, and choose the
desired template.

Tables have a blue ellipsis at the top right. You can view or edit the contents of a table row by clicking the row
then clicking the blue ellipsis, or by double-clicking the row.

Pivot tables have a ellipsis on each cell that contains a number. Clicking that ellipsis will show either a grid with a
list of all the rows that make up the number in that cell, or a form showing the single row represented by that cell. If
you have edit permission on the relevant table, you can make changes here and click OK to save them.

Note: If you make changes to data, the dashboard will not automatically be refreshed to show those changes. You’ll
need to click the Refresh button.

For charts (including risk charts) you can click on a data point, and you will similarly get a list of rows that make up
that point, or a form showing the single row represented by that cell.

To choose which report templates are available as Dashboards, navigate to the Configuration → Reports and Dash-
boards → Templates dialog. Edit the required report template and tick Dashboard Report. (You can use Multi-Edit
to edit several templates at once.)

Refer to the section Report Templates for detailed information on configuring report templates.

Tip: For the Dashboards Screen, choose report templates which summarise data in the database, or that show statistics
on Anomalies or Risk.
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CHAPTER

TWO

ASSETS

2.1 Assets Toolbar

2.1.1 Assets Import

The ASSETS → Import functionality gives the user the ability to bulk update data stored in the Asset Information
Groups.

The format of the Excel workbook needs to be very specific. It is recommended you generate an Excel export using
the Assets Export functionality, to generate the workbook in the correct format for importing data.

Caution: It is important to note that as the Asset Importer is importing rows, the SQL server creates Row and
Table Locks. This may mean that to other users accessing NEXUS IC, the application may appear unresponsive.
When the import has finished and the data committed, then the Row and Table locks are released and the other
users will be able to continue using NEXUS IC as normal.

The Asset Import Wizard

1. Import Filename - Navigate to the Excel or Text file which has been prepared for import. If you uncheck
the “Automatically commit transaction on successful import”, the wizard will present you with a summary of
the Import actions, and will prompt you to commit changes. Please note that the database will still be in a
Transaction state until you Commit or Cancel the import.

2. Configure Import - If you are using the Excel output from the Example template or the Asset Export wizard,
then the destination Fields will be pre-populated. If you would like to make changes to the Destination fields or
elect to ignore some fields, then click on the column heading titled Field: and choose from the options presented
in the pop up menu. Finally, ensure that the correct Asset View is selected from the Required Fields selection
box and that the number of Header Rows and worksheet are correct (by default this will be 2 rows).

3. Import Complete - This page summarises the import, advising the user how many rows have been added to the
AIG forms and whether or not any new assets have been created as part of the import. It is important that the
summary is scrutinised to ensure that the import has performed the actions that you expected. What is important
to take note of is the total rows for a specific item; i.e. add together the number added and updated and make
sure that is equal to the number you expect.

Note: If the importer encounters a completely blank row in an Excel file, it will stop importing at that point, even if
there are non-blank rows further down. This can provide an easy way to test an import sheet: set it up, and then after
just one or two rows of data, insert a blank. Run the import to see if it’s doing what you expect, and if so, delete the
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blank and run again. Similarly, if the importer encounters a blank column in an Excel file, columns to the right of this
will not be imported.

Tip: When importing inspection event data, anomaly triggers are checked during the import and findings created
automatically from data which falls outside the data bounds.

Note: If you are importing a sheet designed for use with NEXUS IC 5, it may have one or more columns titled
‘Component.Location’. In the Configure Import page, you should select ‘Asset Location.Full Location’ for these
columns.

Note: You can have one ‘Asset Location.Full Location’ column, with levels in the asset hierarchy separated by space
slash space, like ‘My Field / My Plaform / My Member’, or many ‘Asset Location.Full Location’ columns, with one
asset hierarchy level in each. (But you can’t mix the two, with one containing ‘My Field / My Platform’ and a second
containing ‘My Member’.)

Tip: You can also import from .csv files. For very large imports, saving your Excel file as a .csv and then importing
from the .csv may be faster.

Sub-rows

Sometimes a single “master” row will have several “detail” rows. For example, an asset information row might have
several sub-AIG rows; or an event might have several findings or several multimedia images or both. When this occurs,
you should repeat the row, with different “detail” values in each.

For example, if you have several multimedia images to import against a single event, your Excel sheet should have
several rows that are identical except for the Multimedia.Name and Multimedia.Image columns. If you have specified
an event number, and you use the same event number on each row, NEXUS will only create the event once, but will
create several multimedia items. (If you do not specify an event number, NEXUS will instead create several different
events with one multimedia item each.)

It is also acceptable to leave event fields blank for all except the last row — under the hood, NEXUS is importing each
Excel row into the event, and only the last Excel row imported will “stick”. Note that if your event has a finding, you
should not repeat the finding data on each event row — if you do, NEXUS will create one finding for each Excel row
that has finding data filled in.

In some cases you do want multiple findings on one event, and in that case you should fill in several rows as appropriate.
Similarly for sub-event data or sub-AIG data: if you want several different sub-events or sub-AIG rows imported, you
should repeat the event row or AIG row with different sub-event or sub-AIG data in each case. If you are repeating
an Excel row for another reason and you do not want several sub-event or sub-AIG rows imported, you should fill in
sub-event or sub-AIG data in only one of the Excel rows.

Tip: You can find the next available event number for a given event type by creating an event of that type using Add
Event, noting the event number, then deleting that event. If you want next available event numbers for several event
types, create a report template with a Simple Source on table Event and a Pivot Table with a pivot row on Event Type
and a value field on Event Number with aggregate Max. Then add 1.
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Excel

During an import, we communicate with Excel “behind the scenes”: we command Excel to open the file you want to
import, and ask Excel what’s in each cell. An upshot of this is that if you use Excel to modify the file while we’re
importing it, even if you don’t hit Save, you may confuse the import process. Similarly if you take a variety of other
actions: using Save As, closing Excel, etc. If you see error text “Call was rejected by callee”, this is what’s happened:
Excel has stopped answering our calls.

2.1.2 Assets Export

The ASSETS → Custom Export functionality gives the user the ability to choose a subset of assets and associated AIG
forms to export to Excel.

The format in which the data is exported to Excel is the same format in which the data can be reimported, see Assets
Import for more detail on importing data from Excel.

Hint: Use the “Custom Export” wizard to export the operating properties of a Process Stream. Update the operating
temperature and pressure in the Excel sheet, then reimport the data using the Assets Import functionality

The Asset Export Wizard

1. Export Filename - Either use the default folder and filename that NEXUS IC proposes, or use the ellipsis button
to navigate to an alternate Windows folder and edit the default filename.

2. Export Options - Select options here.

• If you set Columns to User Selected, you will be shown a page later in the wizard to select those columns.
If you set it to All Visible Columns, columns that have Visible Grid or Visible Form ticked will be exported.
Workflow rules affecting field visibility will not be run.

• Asset Location can be shown in a Single Column, like “Field / Asset / Elevation / Member / Anode”, or
as Multiple Columns, with one tree level per column.

• You can choose to export or not export Calculated fields and Sub Asset Information.

• Extra sheets are exported for each Lookup List used in the forms. You can choose to hide these.

• You can control Formatting for Date and Time. You can also control Cell formatting — if you select
this, cells with invalid values will be shown in red, cells not relevant to this asset information group or
event form will be greyed out, etc.

3. Asset Selection - Choose the Asset View and check which subset of assets to include in the export. Note use
the Select Children and Unselect Children toolbar buttons to include and exclude the visible and non-visible
child assets. Simply checking an asset at the top level will not automatically check all the child assets beneath
it.

4. Asset Information Groups - Check which Asset Information Groups to include in the exported document.

Hint: Column order within the exported sheet is determined by the grid column order set within each form in
Configuration → Assets → Asset Information.

Hint: The exported Excel sheet will contain a Legend tab, which shows the meaning of various cell and row colours.
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2.1.3 Asset Views

The Asset Views functionality can be used to isolate asset hierarchies from one another, or to view only a filtered list
of assets, or to arrange assets differently.

Tip: Create an asset view titled “Subsea” which contains all subsea assets and a second view titled “SPE” which
contains all topside Static Pressure Equipment assets.

Tip: Create an asset view titled “Pressure Relief Devices” which contains only the PRD assets in the “SPE” view. In
this example, the PRDs are Linked from the SPE asset view

The Asset Views toolbar button first lists all Asset Views configured in the database, as well as providing ability to
add, edit and delete Asset Views.

• Asset Views → Add Add a new asset view. Enter the name of the asset view and a descriptive comment (for
informational and reporting purposes only).

• Asset Views → Edit Edit the properties of the currently selected asset view.

• Asset Views → Delete Delete the currently selected asset view.

Note: Deleting an asset view will delete all the assets contained within that view, regardless of whether
those assets exist in other asset views.

2.1.4 Traffic Lighting

The Traffic Lighting functionality displays pre-defined colours against each asset (where configured). The legend is
shown at the bottom of the asset hierarchy and will display the name of the Traffic Lighting rule and what each of the
colours signify. Hovering over the traffic lighting with the mouse displays a popup hint of the value of the traffic light.
This is shown in the following screenshot:
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Traffic lighting can also be displayed on Drawings Links. For example, where an asset has a region defined on a
drawing, and there is a traffic light colour assigned to that asset, then the region will be displayed in that colour. The
display of traffic lighting on drawings is switched on and off from the Drawing Toolbar.

See Traffic Lights for details on configuring new Traffic Lighting rules.

The Traffic Lighting toolbar button shows a list of configured traffic lighting rules. By default there are three Traffic
Lighting rules, None, Anomalies and Risk.

• Traffic Lighting → None This menu item item clears all existing traffic lighting rules from the asset hierarchy.

Elements of the Assets toolbar are available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. INSPECTION

The Assets toolbar button allows the user to add, edit, delete and move Assets to and from the hierarchy. Additional
navigation and filtering capabilities are also provided from this toolbar.

• Back The Back menu item allows you to return to assets that you had previously selected in the Assets tree.

• Forward The Forward menu item allows you to return to assets that you had previously selected in the Assets
tree, after you’ve used the Back button.

• Assets → Add → Asset Adds a new (child) asset to the asset currently selected in the hierarchy.

• Assets → Add → Root Asset Adds a new root level asset into the active Asset View. A root level asset is an
asset which does not have a parent asset.

• Assets → Add → Linked Asset (With Children) Add a link to an existing asset including all its children. An
asset tree will be displayed to allow selection of the asset to link as a child to the currently selected asset.

• Assets → Add → Linked Asset (Without Children) Add a link to an existing asset, without any of its children.
An asset tree will be display to allow selection of the asset to link as a child to the currently selected asset.
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• Assets → Edit → Asset Properties Change the name or Asset Type of the currently selected asset or
add/remove the Primary Asset flag.

• Assets → Edit → Asset Type Properties Edit the Asset Type of the currently selected asset: change its name,
and change what Asset Information groups, Event types and Survey types it is associated with.

• Assets → Delete Deletes or unlinks the selected asset. If the asset exists in multiple places just this location
can be removed, instead of deleting all locations the asset exists. Click on the Connections button to view
dependant records of the current asset.

• Assets → Show Asset Type Toggles the display of the asset type in the hierarchy.

• Assets → Expand Children All children, grandchildren, etc. of the selected asset will be expanded. (You can
also press the * key on the numeric keypad.)

• Assets → Collapse Children All children, grandchildren, etc. of the selected asset will be collapsed.

• Assets → Undo Move Reverses the last asset move action. Note that ONLY the last asset move can be undone.

• Assets → Copy to Clipboard Copies either the asset name or full hierarchy location of the selected asset to the
clipboard.

• Assets → Reparent to Root Repositions the selected asset in the asset tree so that it becomes a root asset.

• Assets → Show on Drawing Shows a list of drawings that have this asset as a layer. Click on a menu item to
go to that drawing. If the drawing name has “(Different Asset)” after it, the drawing you will be taken to
is not available on the current asset; thus, when you select the menu option, you will not only be taken to
that layer on that drawing, you will also be navigated to the new asset. You can get back by using the Back
toolbar button.

• Assets → Other Locations Shows a list of other locations that this asset exists in on the asset tree (including
in other Asset Views). Click on a menu item to navigate there. If this asset does not appear in any other
locations, you will not see any items in this list.

• Assets → Connections See Connections for information about the Connections toolbar option.

• Assets → Anomaly Triggers Asset-specific anomaly triggers are found here. Triggers for a field independent
of asset are found in Asset Information and Event Types. If you have both an asset-specific and a generic
anomaly trigger on the same field, for assets with the asset-specific trigger, only the asset-specific trigger
will apply. For assets with only a generic trigger, only the generic trigger will apply. Note that asset-
specific anomaly triggers are specific to their asset — they do not automatically apply to an asset’s children.

• Assets → Coordinates This is the equivalent of the version 5 ‘Pipeline’ and ‘Map’ tabs.

• Assets → Rotate Equipment

The Rotate Equipment menu item is used to swap the location of the selected asset with another
asset of the same type. Swapping assets will exchange their location in the asset tree and create
records in the asset history tab for both assets, to record details of the exchange.

The Rotate Equipment menu item will only be enabled if the selected asset has an asset type.
When you click on the Rotate Equipment menu item, an asset selection dialog will be displayed.
Assets that are not of the same type will be greyed out in the tree. To swap the location of the
selected asset, select another asset of the same type and click the OK button on the dialog. The
asset tree will refresh and the swapped asset will be selected in the tree.

You cannot rotate an asset with one of its children.

The Rotate Equipment menu item is a Shortcut. As such, if necessary, it can be debugged us-
ing the Shortcut debugger. When you select the menu item, hold down the Control key on the
keyboard. The Select Asset dialog will be displayed, but will be followed by the Debug Shortcut
dialog. You can step through shortcut items one at a time, which may help to narrow down any
problems.
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This functionality is most commonly used for PRDs where they are “rotated” out for valves that have been
tested and prepared for service.

• Assets → Retire Equipment The Retire Equipment menu item is used to change the location of the selected
asset in the asset tree. Changing the asset location in the asset tree creates records in the asset history tab
for the asset itself as well as the source parent, to record details of the relocation.

When you click on the Retire Equipment menu item, an asset selection dialog will be displayed. To
change the location of the selected asset, select another asset as the destination parent and click the Ok
button on the dialog. The asset tree will refresh and the asset will be selected in the tree in the new location.

The Retire Equipment menu item is a Shortcut. As such, if necessary, it can be debugged using the Shortcut
debugger. When you select the menu item, hold down the Control key on the keyboard. The Select Asset
dialog will be displayed, but will be followed by the Debug Shortcut dialog. You can step through shortcut
items one at a time, which may help to narrow down any problems.

• Asset Views See Asset Views for detailed information on the Asset Views toolbar option.

• Traffic Lighting See Traffic Lighting for detailed description of the Traffic Lighting toolbar option.

• Import See Assets Import for detailed information on the Import Wizard. The MS Excel Import Template
details the required format for importing Library Items.

• Custom Export See Assets Export for information about exporting Assets and Asset Information data.

• Reports See Reports for information about the Reports toolbar option.

Tip: The asset selection is persistent between ASSETS and INSPECTION screens, that means if you choose an asset
in ASSETS screen and change the screen to INSPECTION, the same asset has been selected and vice versa.

Tip: If you exit out of NEXUS and open the application, it will reopen the application on the same location that you
exited last time.

2.2 Asset Information

Asset Information forms retains asset specific information for the currently selected asset. The Asset Information
screen is available in two locations in NEXUS IC, from the ASSETS screen and the INSPECTION screen. Functionality
in both areas is the same.

An example asset information form is shown here:
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Not all Asset Information forms are relevant to all Asset Types. You can configure the relationship between Asset
Information forms and Asset Types from Configuration → Assets → Asset Information or Configuration → Assets →
Asset Types.

To select a different Asset Information form, click the Group menu button. If you have many Asset Information forms
available on this asset type, you’ll see a menu with submenus for each Category of form; if you have only a few, you’ll
see a single menu listing all your forms. Select a form. (Some forms may take a moment to display, depending upon
the amount of calculation that must be done.)

Tip: If you are navigating through the Asset register and not concerned with the Asset Information, you can select a
different tab, such as Library. This will prevent asset information from being loaded, which can be useful if the Asset
Information is performing many calculations.

2.2.1 Toolbar

Use the button to toggle the Asset Information tab between two different locations:

• Amongst the other Asset tabs (Dashboard, Drawings, etc.)

• At the bottom of the window, below the other tabs.

This lets you easily view asset information at the same time as viewing other data; or lets you fill the available window
space with the data you’re interested in.

Once you have made changes, Save and Revert will become enabled, and you can use these to save or discard
your changes. (If you select a different asset without clicking Save or Revert, your changes will be saved.)

Use the History button to show a dialog with the History for this asset information form on this asset.
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2.2.2 Ordering forms

To change the order of the Asset Information forms, go to Configuration → Assets → Asset Types. Edit the asset type
in question, then select the Asset Information Groups tab. Use the up and down buttons to set order for forms.

The following sections detail functionality available to the user from an Asset Information Group form.

2.2.3 Unit Aware Numeric Field

When Numeric field are configured in an Asset Information Group, you have an option to define a base unit type
for that field. By default, the base unit type is displayed to all users, however, each user has the option to view the
numerical value in that field in a different unit type.

Unit aware numerical fields are identified by the label after the field name which states the unit type in blue text.

To view a different unit type in the Asset Information form, click on the unit label, choose an alternate unit type from
the popup menu. Please note that NEXUS IC will “remember” your preferred unit type and display that next time you
login to NEXUS IC.

2.2.4 Calculated Field

Calculated fields are those where the value displayed is derived by a function which has been configured in the
database.

Calculated fields are identified by the icon.

To view the function for the calculated field, click on the icon to launch the View Function Calculation dialog.
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Please note that the function can not be edited from this dialog. You can, however, right-click on any element and
select View to view its internal details.

Hint: When focus is on a calculated field (by clicking in it with the mouse or tabbing into it), any other fields on the
same form which are inputs into the function, are highlighted a darker grey colour. You can also see a function’s inputs

by clicking on the icon — an input parameter will be labelled “Source - Constant” if it is being given a constant
value rather than a value from a field; or “Source - Field” followed by the table name and the field name.

In the example shown below, the ‘Adjusted Safety Consequence’ calculated field has inputs from ‘Asset Area Location’
and ‘Safety Consequence’.

12 Chapter 2. ASSETS



NEXUS Documentation, Release 6.6.xxxxx.0

2.2.5 Passthru Field

Passthru fields show data from another field on the same asset. A passthru field will have a icon at its right-hand
side. Clicking this button will show a dialog telling you what form and field the passthru is pulling information from.

2.2.6 Global Lookup Field

Global Lookup fields are fields whose value is returned from a Global Tables matrix table. Lookup values are passed
into the comparison function and the first value which meets the specified criteria is returned as the value for that field.
(see section Global Tables for further information on configuring Global Tables.)

Global Lookup fields are identified by the icon.

Click on the icon to launch the View Global Table Lookup dialog. This dialog highlights which row matched
the Global lookup criteria and is being displayed in the field. Click the Inspect button to see the Compare function
evaluation for the focused row.

2.2.7 Sub-Asset Information Forms

Often you will have a list or table of information to place against a single asset. For example, you might have a list of
different kinds of threats that apply to this asset, and their severity, etc.

To represent this, we use a sub-form within the form.
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You can use in-grid editing to make changes to a row, and use Add and Delete to add or remove rows. If you click on

a cell that is a function or global lookup field, you will see the or button.

The left-most column within the grid is Modified. Any row you make changes to will receive a check mark.

Once you have made changes, Commit and Cancel will become enabled, and you can use these to save
or discard your changes. (If you select a different asset without clicking Commit or Cancel, your changes will be
committed.)

2.2.8 Changes by other users

If a change is made in another copy of NEXUS IC or IC-Inspection to data on a form you are viewing, you will see a
message saying that this item has been modified by another user.

Click Refresh to load their changes into your copy of the application. (This will discard any changes you have made.)
Or click the Save button to save your changes. (This will overwrite the changes the other user has made, meaning
that they in turn will see this message, and have the opportunity to refresh or save.)

This feature applies generally throughout NEXUS IC and IC-Inspection, but asset information is perhaps the most
common place to see it.

2.3 Dashboards

The Assets screen’s Dashboards tab shows you the output of any of the pre-configured report templates in the database
that has been marked as a Dashboard. The only difference is that the Dashboard report recognises what asset is
currently selected in the asset hierarchy and will update the contents of the dashboard report base on the selected asset.

To choose which report templates are available as Dashboards, navigate to the Configuration → Reports and Dash-
boards → Templates dialog. Right-click the required report template and tick Asset Dashboard.

Note that this is distinct from the overall DASHBOARDS screen.

Refer to the section Report Templates for detailed information on configuring report templates.
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Note: For the Dashboard report, chose a report template which requires an asset as a report parameter.

2.4 Drawings

Drawings displayed in the ASSETS screen are essentially Library records where the Library Type has the “Show as
Drawings” flag checked.

“Layers” can be added to drawings for the purposes of:

1. Navigation

2. Data overlay

3. Reporting

“Layers” are marked up regions on the drawing which can be linked to assets in the asset hierarchy.

2.4.1 Properties of a Drawing

1. Library Type - By default, this will be “Drawings”.

2. Name - A 50 character field which is the name for the drawing, it is most common to use either the drawing title
or the drawing number here.

3. Description - A 100 character field which provides more descriptive information of the Drawing.

4. Document No. - A 50 character field which stores the Drawing Number or Reference.

5. Revision - Revision of the drawing (eg. “A” or “C”).

6. Reference Date - Reference date of the drawing.

7. Physical Location - If this Library Item is a reference to hard copy document, then enter the physical location
of the document here.

8. Hyperlink - When linking this document to a UNC or URL, then the full hyperlink is stored in this field.

9. Attachment - When loading a drawing into the NEXUS IC database, or replacing an existing drawing then click
on the Import sub menu item. Other menu items available from this dropdown are:

• Link - Link to a file on a mapped drive. A copy of the file will be stored in the NEXUS database and
updated when the file changes.

• Export - Saves the drawing to a folder location of your choice.

• Launch - Launches the drawing in the default Windows viewer.

• Copy - Copies the drawing to your clipboard.

• Clear - Removes the drawing from the library item.

10. Show Grey Scale - A flag which will display DWG or DXF drawing layers in black and white in lieu of designed
colours.

11. Show Captions - A flag which will show or hide caption layers of a DWG or DXF drawing.

12. Show Dimensions - A flag which will show or hide dimension layers of a DWG or DXF drawing.

13. Use in Reports - Can be used to filter what drawings are output to reports.
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14. Force 2D - If you have DWG or DXF drawings which NEXUS is detecting as 3D, and you’d prefer NEXUS to
treat them as 2D, tick this box for those drawings.

15. Background Colour - Allows you to define the background colour of a Drawing. Please note that this func-
tionality will only work on drawing types which support transparency (eg. DXF, DWG, GIF etc.).

2.4.2 The Drawings Toolbar

• Add The Add menu item allows you to add a new Drawing. When you click Add, the Add Library dialog will
appear. (This is because Drawings are Library Items in NEXUS IC 6.) Enter the Name of the Drawing
and any other relevant document information. Then click on the Attachment button.

Note: You can also add drawings by dragging image files from Windows Explorer onto the Drawings
pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will cancel
the add. If you drag/drop multiple files, they will simply be added.

Note: NEXUS IC supports the following image formats:

– GIF, JPG, JPEG, TIF, BMP, PNG, PDF, DWG, CGM, DXF, SVG, WMF and EMF.

• Edit Edit the properties of the current drawing. From this dialog you can also Add and Edit connections to the
drawing.

• Delete Delete or Unlink the drawing from the asset. Delete will delete the library item from NEXUS. Unlink
will remove the link to the asset, but keep the library item.

• Drawing Type You can select which library types appear here. (To control what appears on this list, go to
LIBRARY , edit the library types in question, and tick or untick Show As Drawings).

• Include Parents If you check Include Parents, drawings on this asset’s parents will be shown in the thumbnail
list for you to select.

• Copy to Clipboard Copies the drawing to your clipboard at the current scale and offset shown. The drawing
thumbnail and layers will also be included.

Layers Menu

• Layers → Edit Layers Click this to add, edit delete layers on drawings. A ‘layer’ is a region, or a button, or a
caption, drawn on the drawing.

• Layers → Save Save add/edit/deletions that you’ve done to layers on this drawing and exit Edit Layers mode.
This option is only available if you’ve made changes.

• Layers → Cancel Cancel add/edit/deletions that you’ve done to layers on this drawing.

• Layers → Layer properties Properties of the currently selected layer(s). Different types of layer have different
properties. Pick a different item from the Layer Type drop-down to change this layer to another type. You
can set a Colour, which will be shown in the shape’s border, and shown translucent in the shape’s area.
Opacity sets how translucent — 0 is completely transparent; 100 is completely opaque.

• Layers → Delete Layer Deletes the layer off the drawing.

• Layers → Create Layer If you’re partway through creating, say, a Polygon layer (see below), you can right-
click and choose Create Layer (or press Enter) to complete the shape. This will take you to the Layer
Properties dialog for your new layer.
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• Layers → Cancel Point Don’t like the point you’ve just left-clicked to create? Right-click and choose Cancel
Point (or press Shift-Ctrl-P).

• Layers → Cancel Layer Don’t like the layer you’re partway through creating? Right-click and choose Cancel
Layer (or press Escape).

• Layers → Copy Select a layer using the Selection Tool (see below), and right-click and choose Copy (or press
Ctrl-C). This will copy the region to NEXUS IC’s internal clipboard. Then. . .

• Layers → Paste . . . paste that layer by right-clicking and choosing Paste (or Ctrl-V). NEXUS will paste the
layer in, offset a little from the original. Then click inside the layer with the left mouse button and drag the
layer to its desired location.

• Layers → Select All Select all the layers on the drawing.

Tip: Using ‘Select All’ is useful way to reposition or delete multiple layers. You can also select multiple
layers by holding down the Ctrl key and clicking each layer.

• Layers → Clear Selection Unselects all the layers. This is useful, for example, if you want to unselect the
selected layer so you can see the colours of all layers at once. (The selected layer is shown in pale blue;
Clear Selection means no layer is so shown.)

Layer Tools

• Selection Tool Click this, and when you click on a layer in the drawing you’ll be selecting it. Ctrl-click to select
additional layers. You can click inside a layer and drag to move layers. (Click-dragging a point will move
just that point.)

• Rectangle Click this then click-drag to create a rectangular region on the drawing. Once complete, you can
drag the four corners of the rectangle separately so that it’s not a rectangle anymore.

• Polygon Click this to start drawing a polygon region. Each click in the drawing will add a point to your polygon.
Press Enter or right-click and choose Create Layer to complete the polygon.

• Ellipse Click this then click-drag to create a ellipse region on the drawing. Once complete, this is turned into a
50-sided polygon.

• Line Region This tool is useful for putting regions on P&IDs etc., where you have a thin, possibly branching
line and you want to put a narrow region over it. Click the Line Region button, then left-click on an end of
the line you want to trace, left-click at the next point that it turns a corner, etc. As with Rectangle, when
you complete (by pressing Enter or right-clicking and choosing Complete Layer), the layer is a region
and you can adjust all its corners independently.

• Caption Click this then click in the drawing at the top left of where you would like your caption to appear. In
the Layer Properties dialog, type some Caption text. Optionally choose a Caption Colour and a Caption
Angle — blank or 0 gives ordinary horizontal text.

• Button Click this then click in the drawing at the top left of where you would like your caption to appear. In the
Layer Properties dialog, type some Caption text — if you type no text, you will get a very small button,
because the button sizes to fit the text.

View Menu

• View → Fit Width Changes the pan and zoom on the drawing so that it fits within the width available in the
Drawings pane.
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• View → Fit Height Changes the pan and zoom on the drawing so that it fits within the height available in the
Drawings pane.

• View → Default Size Sets zoom to 100%. This may or may not fit in your Drawings pane, depending on how
big the drawing is.

• View → Zoom In Zoom In.

• View → Zoom Out Zoom Out.

• View → Zoom Selection Click this, then in the drawing click and drag a rectangle. NEXUS IC will then zoom
to the area you’ve selected.

• View → Increase Caption Size Increases the size of all captions on the drawing: on captions, buttons, and
regions.

• View → Decrease Caption Size Decreases similarly.

• View → Caption → . . . If you select Default, captions will display the text you have set in Layer Properties.
If you select Asset Information or Event, NEXUS IC will display a picker. You pick a field, and NEXUS
IC will use values from that field to fill captions. This only works for layers that have an asset set in Layer
Properties.

Layer Colour Menu

• Layer Colour → Default Shows layers on drawings in the colours that you have selected in the Properties of
each layer.

• Layer Colour → Traffic Lighting Shows layers on drawings in the colours specified by the currently selected
Traffic Light.

• Layer Colour → Transparent Shows layers on drawings as just an outline, in the colours that you have selected
in the Properties of each layer.

• Layer Colour → Unknown Asset Shows layers that have an asset in the Known Asset Colour, and layers
that don’t have an asset assigned in the Missing Asset Colour. You can configure these in Database →
Properties.

2.4.3 3D Drawings Toolbar

3D Drawing Setup Example

There is some configuration required to be able to link assets in the NEXUS IC hierarchy to objects in a 3D drawing.
Once configured successfully, you will be able to:

1. Hover over the object in the 3D Drawing to view the NEXUS IC asset name.

2. Click on an object in the 3D drawing to auto navigate to that asset in the NEXUS IC asset hierarchy.

3. Display traffic lighting on the 3D drawing objects.

Caution: For optimal performance, an OpenGL graphics card is required on the client machine for this function-
ality. 3D drawings can take a considerable time to load. We recommend that 3D drawings are simplified as much
as possible to reduce file size and load times.
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Step 1

The first step is to ensure that the 3D Drawing is configured with an Asset Serial Number attribute.

Using Autocad, create a block which represents a single asset in the NEXUS IC asset hierarchy. For each block, define
an attribute (using the ATTDEF command) and populate the attribute with the “Asset Serial Number”.

In this example, the attribute in the 3D drawing is titled EXTERNAL.REFERENCE.3D.DRAWING.TAG. The fol-
lowing images illustrate the attributes in Autocad and in NEXUS IC.
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For detailed instructions on how to prepare an Autocad drawing, refer to 3D Drawing Preparation in Autocad.

Step 2

Go to Database → Properties → 3D Drawings. Type in the 3D Drawing Attribute name which contains
the Asset Serial Number information. In this example, the attribute in the 3D drawing is titled EXTER-
NAL.REFERENCE.3D.DRAWING.TAG.
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Step 3

Go to Database → Properties → 3D Drawings. Select a colour to be displayed for any block where the attribute is
defined, but there is no corresponding match in the asset hierarchy in NEXUS.

Step 4

Go to Configuration → Assets → Information → Configure Asset Features and specify the AIG and AIG field as the
Asset - Serial Number. In this example, the corresponding field in NEXUS is in the AIG titled External Reference
and the field is titled 3D Drawing TAG.
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Step 5

Ensure that the Asset Serial Number data is populated in the specified AIG field and that the data matches that in the
Asset Serial Attribute in the 3D drawing.
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3D Drawing Preparation in Autocad

In order to prepare a 3D drawing follow the steps below:

1. Create the required attributes in Autocad

a) In Autocad type ATTDEF, the following form will open

b) Check the Invisible mode and uncheck the Lock position mode

c) Uncheck the Specify on-screen and leave the coordinates X:0, Y:0, Z:0

d) In the Tag textbox, type the name of the attribute (e.g. EXTER-
NAL.REFERENCE.3D.DRAWING.TAG)

e) Press OK button

f) Repeat steps a – e for each attribute to be created

2. Create blocks with attributes

a) In Autocad type BLOCK, the following form will open
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b) Type the block name (preferred to be the object component unique ID)

c) Click on Select objects

d) Select the attributes created in step 1

e) Select the object required

f) Press OK button

3. Fill out the attributes values. The value will be filled with the unique identifier that will be used by NEXUS IC

4. Repeat steps 1 – 3 for each object in the Autocad drawing

The above steps could be time consuming, therefore an AUTOLISP (one of the Autocad scripting languages) has been
developed to automate the attribute and block creation as well as the attributes value population. You will need to
download the AUTOLISP file from here.

This file can be used to automatically do the steps for creating a 3D drawing using Autocad. The steps to use the
AUTOLISP are as follow:

1. Open the drawing in Autocad

2. Go to the Manage tab and click on Load Application

3. Select the “NEXUS_REF.lsp” file

4. Press the Load button

5. Press the Close button
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6. In the command line type the following command: (NEXUS_REF)

In order to use this AUTOLISP, it is required that each object in the drawing to be on a separate layer. These layers
should be named as the external reference name (e.g. Leg_B1). The script will do the following:

1. Create attribute with the name “EXTERNAL.REFERENCE.3D.DRAWING.TAG”

2. Create a block for one object, setting the block name to be the same as the object’s layer name

3. Populate the attribute value with the object’s layer name

4. Loop on all the objects and repeat steps 1 - 3

You can download a sample 3D Drawing from the following link.

This sample Autocad drawing can be used in conjunction with the Autoslip file for further clarification.

3D drawings get different items on their toolbar. Add, Edit, Delete and Colour are as described above.

• Rotate When selected, dragging on the 3D drawing will change the “camera” angle. When unselected, dragging
on the drawing will pan.

• Wireframe / Hidden Lines / Smooth Shading / Flat Shading Select between these to control rendering of the
drawing. Some are faster; some are prettier. For some drawings, Wireframe may not show anything.

• Information Toggle a panel at the bottom of the Drawings pane showing information for the selected region of
the drawing.

• Coordinates Toggle the display of coordinates at the bottom right of the drawing, showing the mouse location.
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View Menu

For 3D drawings, the View menu contains extra items:

• View → Rotate Same as the Rotate button.

• View → View Direction Select one of 10 viewing directions. You can get to any of these viewing directions via
the Rotate button, but this is faster.

• View → Viewports For a 3D drawing, available viewports will be displayed on this menu.

• View → 3D Styles Same as the Wireframe / Hidden Lines / Smooth Shading / Flat Shading buttons.

• View → Hint → . . . Similar to View → Caption → . . . , but information will be displayed as a mouse-over hint
on the region you’re currently on, rather than as captions.

• View → Show → . . .

Information and Coordinates are the same as their respective buttons. Grid may or may not show a
grid, depending on the drawing. Axis will show/hide the axis orientation arrows at the bottom left
of the Drawing panel. North Arrow may or may not show an arrow illustrating the North direction,
depending on the drawing.

Refer to 3D Drawing Setup Example and 3D Drawing Preparation in Autocad on how to configure 3D drawing objects
to link to assets in the asset hierarchy.

2.4.4 Asset Information

You can right-click on an Asset Information field name and select “Display on drawing” to show values from that
Asset Information field on drawing layers.

2.4.5 Drag and Drop

When you are editing layers, you can drag an asset from the asset tree at the left of the window onto the drawing. You
will then be given a dialog asking you what type of layer you would like to add to represent this asset on this drawing.

You can also drag from the asset tree onto an existing region. The existing region will be given this new asset as its
Caption and Asset, and you will be shown the Edit Layer dialog.

You can also drag an Asset Information field from a form onto the drawing. This makes the selected layer display text
from that Asset information field.

2.4.6 Properties of a Layer

1. Layer Type - Specifies the way the layer will be rendered on the drawing. Only Region and Button with
Region let you create complex outlines.

2. Colour - Colour of the layer. This colour is used for both the outline and the fill.

3. Opacity - Opacity of the filled part of the layer. 0 is transparent; 100 is solid.

4. Show Caption - Tick this to set the Caption (below) visible.

5. Caption - Text string to show for this layer. This caption text grows/shrinks as you zoom in/out. It can be
moved using the “grab point” at its top left. The text can be replaced with other text when the drawing is used
in a report template or the drag AIG feature is used.

6. Caption Colour - Colour of the Caption.
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7. Caption Angle - 0° is horizontal, right way up. Positive angles rotate the text anticlockwise.

8. Associated Field - You can show text from an Asset Information field on this layer. The text wll be appended
after the fixed text specified in Caption.

9. Asset - A layer can link to an asset. Specify that asset here.

10. Relative Asset - Instead of specifying a particular asset, you can enter text here. NEXUS will search for children
that match that name. If multiple children match, when the user clicks this layer and chooses Navigate to, there
will be one entry for each in the pop-up menu.

11. Associated Drawing - When the user clicks this layer and chooses Navigate to, you can choose here which
drawing will be selected once the navigation is complete. That drawing must be available on that asset.

2.5 Library

This functionality is also available via the Library screen. Here on the Assets screen, you can view all the library items
for a particular asset.

Library Items are electronic documents which can be linked (via Connections) to data and data types in NEXUS IC.

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced via URL or
UNC paths.

Here are some examples of valid URL and UNC paths:

1. https://www.youtube.com/watch?v=oHg5SJYRHA0

2. \\example.com\groups\eng\this_doc.docx

Caution: Mapped drives - If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped for every other
potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use UNC paths for network drive
locations.

The Library functionality is available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. LIBRARY

3. INSPECTION

4. ANOMALIES

5. Configuration → General → Functions → Edit Function Definition

6. Configuration → Assets → Types

7. Configuration → Events → Event Types → Edit Table Information
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Note: Example - Upload company Piping specifications to the NEXUS IC Library and assign to the Asset Type
“Pipework”. This will make the Piping Specifications available from the ASSETS | Library screen whenever the
active asset is of type “Pipework”.

2.5.1 Library Items Toolbar

The Library toolbar button allows the user to add, edit and delete Library Items.

• Add The Add menu item allows you to add a new Library item. Depending on what screen is active, the
Add drop down menu will provide connection type options. Enter the Name of the Library item and any
other relevant document information (Revision, Date, Document Reference etc). If the document is to be
uploaded into NEXUS IC, then click on the Attachment button, else enter a Hyperlink location.

When adding an item, you can either Import or Link it. If you Import, the item will be brought into the
database. If you subsequently change the original on disk, the item in the database will not change to
match. If you Link the item, then when you change the original on disk, the next time you view the item
within NEXUS IC, you will see the updated item.

Note: NEXUS IC will still load a copy of a Linked item into the NEXUS database — this is so that if the
original is unavailable (for example, because you are away from your network), NEXUS IC can display
the cached copy. When you view the item, if the original has been updated, we also update the database
cached copy. You can’t Link items that are on your local hard disk — only items on network drives can
be Linked. The Link feature is designed to keep you up to date with items that may have been changed by
others, and that can’t happen on your local drive.

Hint: You can also add multimedia by dragging image files from Windows Explorer onto the Library
Items pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will
cancel the add. If you drag/drop multiple files, they will be added, and then multi-selected in the grid. You
can then click Edit to multi-edit them. Drag-drop will Import items, not Link them.

• Edit The Edit menu item allows you to edit the properties of the currently selected Library Item (not the
document itself).

• Delete Deletes the currently selected Library Item.

Note: Deleting a Library Item will delete all the connections of that Library Item.
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• Launch Launches the Library item on the local machine. Note that by default NEXUS will only launch files
with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

Hint: Use the Space Bar on your keyboard to launch the currently selected Library item.

Note: If the local machine does not have an associated viewer for the document type (eg. AutoCad viewer
for DWG type), then the document can not be launched.

• Email Attachment This option will launch a new email message and attach the associated Library Item to it.
Note that Email account properties need to be set up for this option to function.

• Import

See Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing Library Items.

You can also import the Connections in the same import as the Library items, so in addition to the
Library Import columns, you can additionally define the Connection information using the following
column headings:

– Library Connection.Connect To

– Library Connection.Workpack

– Library Connection.Asset Type

– Library Connection.Asset

– Library Connection.Event Type

– Library Connection.Event

– Library Connection.Anomaly

– Library Connection.Risk Model

– Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

– Anomaly

– Asset

– Asset Type

– Event

– Event Type

– Function

– Risk Model

– Workpack

• Export See Export for information about exporting Library Items. Please note that this option will only export
the contents of the grid, not the Library Items themselves.

• Customise See Customise for information about the Customise toolbar option.

• Connections See Connections for information about the Connections toolbar option.
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Double-click

The first time you double-click on a library item, NEXUS will ask you what action to take: you can either Launch the
Library item in an external editor, or Edit the Library item. If you would like your choice to become permanent, tick
the “Always do this” box. Note that if you hold down the Alt key while double-clicking, you will be asked again.

2.6 Asset History

The Asset History functionality provides the user with a tool to record key events of an asset (or a group of as-
sets) throughout it’s (or their) life cycle. These asset history items represent information that should be captured for
posterity. Asset history records can be retrieved in report templates or accessed via the UI.

The Asset History dialog allows for the user to enter a date for the Asset History item. If however the Asset history
item is related to a Workpack or a Schedule, then the Date of the Asset History item will be populated from the Date
of the Workpack or Schedule. Additionally, you can reassign (or change) the asset which this Asset History item is
related from this dialog.

Hint: To bulk update (or delete) Asset History items, use the Multi-Edit functionality.

2.6.1 Asset History Toolbar

The Asset History toolbar allows the user to add, edit and delete Asset History Items.

• Asset History → Add The Asset History → Add menu item allows you to manually create a new Asset History
item. Enter the Title and Description of the Asset History item. If the Asset History item is not related
to a specific Workpack or Schedule, then enter a date for the record (usually the date which represents the
event).

• Asset History → Edit Choose Asset History → Edit to edit the properties of the currently selected Asset History
record. Changes are saved when you click on the OK button.

• Asset History → Import Refer to section Import for detailed information on the Import Wizard. The MS Excel
Import Template details the required format for importing Asset History records.

• Asset History → Export Refer to section Export for information about exporting Asset History Items.

• Asset History → Customise Refer to section Customise for information about the Customise toolbar option.

2.6.2 Reporting on Asset History

To retrieve Asset History data in a report template, use the System Table titled Asset History.

2.7 Anomalies

Anomalies are records which identify discrete items or areas of concern. An anomaly record may have been originated
from an inspection item (which means that it will have a finding linked to it) or it may be a stand alone record created
outwith the integrity and inspection cycle (ad-hoc).

Anomalies can be accessed from the ANOMALIES screen, or from here in the Anomalies tab on the Assets screen.
From here you will see only anomalies which pertain to the asset you have selected in the asset tree; or, if you click
the Child Assets button, to this asset and all its descendants.
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Anomalies can be bulk imported from MS Excel or manually created from the Add Anomaly dialog.

2.7.1 Properties of an Anomaly

1. Asset - The name of the asset that the anomaly is attached to. This is a required field.

2. Name - A short (50 character limit) name for the Anomaly.

3. Description - A 100 character field which provides more descriptive information of the anomaly.

4. Code - Code which identifies the type of anomaly. Some typical codes may include “CD”, “PD” or “VIB” (Coat-
ing Damage, Physical Damage or Vibration) however, anomaly codes are user-definable and can be configured
from Configuration → Anomalies.

5. Severity - Choose from a list of pre-defined Severity Levels. Typical severity levels may include “Level 1 -
Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level 5 - Extreme Dan-
ger” however, severity levels are user-definable and can be configured from the Configuration → Anomalies
area. Anomaly severities can also be assigned to Anomaly Triggers and will be pre-populated from the initial
automatically generated Finding, through to the anomaly that the finding is linked to.

6. Priority - Choose from a list of pre-defined Priorities. Typical priority levels may include “Very High”, “High”,
“Medium”, “Low” or “Very Low” however, the list of anomaly priorities are user-definable and can be config-
ured from the Configuration → Anomalies area.

7. Anomaly Number - A numerical property which can be used to store a number against the anomaly. This
number is not auto-populated.
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8. Anomaly Set - Is an alternative option for grouping anomalies. A common grouping may include “Topside” and
“Subsea” however, Anomaly Sets are user-definable and can be configured from Configuration → Anomalies.

9. Reference Number - A 200 character limit field which can be used to reference (or cross reference) anomalies.

10. Date Created - The date the anomaly was first created. This will default to todays date, but is editable thereafter.

11. Created By - Name of the person creating the anomaly record. This will default to the currently logged in user,
but is editable thereafter.

12. Comments - A large free text field to retain additional information about the anomaly which may not be captured
in the properties of the anomaly.

13. Status - Status of the anomaly. Anomaly statuses are user-definable and can be configured from Configuration
→ Anomalies.

14. Closed Out - A check box which identifies whether of not the anomaly is Open or Closed. Closed anomalies
are normally excluded from anomaly statistical reporting.

15. Risk Score - This is a calculated field, the function assigned to this field is named “System - Anomaly - Risk
Score” and must be configured through the Functions. Different fields such as the “Severity” and “Priority” of
the anomaly can be used as the input parameters for the function.

2.7.2 Report Table Sources

To extract anomaly data into a report template, use the System Table titled Anomaly as the primary Table Source. For
more information on Report Templates see Report Templates.

2.7.3 The Grid

The anomalies grid lists all anomalies based on the currently applied filters. Primary filtering options are:

• Workpack; and

• Asset.

Filters are set and cleared using the Filter menu on the Anomalies toolbar.

Tip: Use the grid Grouping functionality to group and filter anomaly records. It is a quick and easy way to drill down
to the anomalies that you are particularly interested in reviewing.

2.7.4 The Anomalies Toolbar

Add, Edit, Delete: Add / Edit / Delete anomaly(s).

Tip: To bulk update (or delete) anomalies, use the Multi-Edit functionality available from the anomalies grid.

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.
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• Anomaly → Close Anomaly Click this to close out the anomaly. You will be shown an Anomaly Action dialog.
This dialog lets you create an anomaly action saying why the anomaly was closed out, and by whom.

• Filter → No Filter Clears any currently applied anomaly filters.

• Filter → Workpack Allows you to filter the anomaly listing by one or more workpacks. Workpacks are linked
to anomalies via the linked findings and events.

• Filter → Asset Allows you to filter the anomaly listing by a user-selected sub-set of assets. Assets are linked to
anomalies by the Asset chosen in the Anomaly record itself AND by the linked findings and events.

• Reports See Reports for information about the Reports toolbar option.

2.7.5 Matrix

You can show anomalies on a risk matrix. This (when configured) is visible at the right or bottom right of the screen.

Each anomaly’s Risk Score is used to place it on the diagram. Note that anomalies do not have a Likelihood or
Consequence to give them an X/Y position on the diagram — they only have a Risk Score. So if your diagram has
several squares with the same Risk Score (as is usually the case), your anomalies will be placed in the left-most such
square. That is, risk-assessed assets are placed in a particular square, but anomalies are merely placed in a particular
band.

To make this matrix work, you will need to configure Database → Properties → Database → Anomaly Risk Chart.
You will also need to configure the “System - Anomaly - Risk Score” function.

2.8 Risk

The Risk functionality displays the risk assessment results for the currently selected asset and all children. Results are
graphically represented in the pre-configured Risk Matrix and in the data grid.

Where there are several risks at the same location in the chart, the dot will be shown larger.

Clicking on a row in the Grid will highlight that item in the Matrix. Similarly, clicking on a result indicator in the
Matrix will highlight the relevant row (or rows) in the Grid.
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If you are using scenarios, each scenario will be shown in its own colour. Scenario dots may be offset within the risk
square; if so, this does not indicate a difference in risk — it is merely for legibility.

If you click on a scenario dot within the Matrix, the relevant row(s) in the grid will be highlighted, and the relevant
dots for those assets’ other scenarios will be highlighted in the Matrix.

2.8.1 Risk Toolbar

• Assign → Risk Model Choose from the list of pre-configured Risk Models in the Drop Down menu to assign
to the currently selected asset. (See Copy Assessment below to bulk-assign a model to many assets.)

• Edit Launches the Risk Assessment dialog. Any Values in the Risk Assessment can be edited and saved from
this dialog by clicking in the Value column of any Value type row (white rows). Please note that Pass
Thru and Calculation values can not be edited. Clicking on a Factor or Model row however, we allow you
to view the function and the function results that has been assigned to that row. From here you can also
assign Scenarios to this Risk Assessment. Click on OK to save changes, or Cancel to exit without saving
changes.

• Delete Deletes the currently selected Risk Assessment from the asset to which it is assigned. Please note that
the Asset and all information linked to that asset will remain unchanged.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Child Assets Select to include risk assessments on all this asset’s children.

• Navigate to Asset Will change the active asset in the hierarchy to the currently selected risk assessed asset.
Note that this will filter the Risk grid so that only assessments for the active asset will be shown.

Hint: Use the Back toolbar button on the Assets toolbar to return to the previously selected asset.

• Copy Assessment This menu item will launch the Copy risk assessment to selected assets dialog. From here,
select the assets which you want to assign the currently selected risk model to. Values assigned to Factors
and Categories in the Risk Model will be copied also. Please note that you will only be able to select valid
assets from this dialog (e.g. assets which already have the same risk model assigned cannot be selected).
Click on OK to copy the Risk Assessments.

• Copy To Clipboard This menu item will copy the risk chart to the clipboard as an image.

• Show Count When in the “Down” state, the matrix will overlay the total number (count) of risk assessments at
that location in the Matrix, as shown in the following image:
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2.9 Sensors

Sensor data is periodically logged (for example, once per hour). Here you can see a summary of sensor data, including
a “sparkline” chart showing the last 30 days of data. The dots on each chart show the minimum and maximum (within
the 30-day range). The two lines show the minimum and maximum values for that particular range — if the chart
is 90 pixels wide, each pixel represents a third of a day, so a considerable range of values may occur within a single
horizontal pixel.

2.9.1 Sensors Toolbar

• Child Assets Will display all children of the currently selected asset (multiple levels of the hierarchy) if it is
selected. Note that if the selected asset has many children that are sensors with large quantities of data,
this may be slow.

• Navigate to asset Will change the active asset in the Asset hierarchy to the currently selected asset in the data
grid. By navigating to a different asset in the hierarchy, this will also update the contents of data grid.
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• View Data Will display the View Sensor Data dialog showing you the row-by-row data for this sensor. Note
that this dialog has a Shortcuts button which shows any Sensor-specific On Focussed Item shortcuts.

• Import This is shared functionality. Refer to Import for a full feature description.

• Export This is shared functionality. Refer to Export for a full feature description.

• Customise See Toolbar → Customise for information about the Customise toolbar option.

The Sensors feature is separately licensed. Contact support@nexusic.com for details.

2.10 Planning Templates

2.10.1 Summary

The Planning Template is made up of three sections:

1. Summary Toolbar (shown in 1. below)

2. Visual Summary (shown in 2. below)

3. Planning Template Task listing (shown in 3. below)

Summary Toolbar

• Show Asset Type Toggles off/on the Asset Type column in the Visual summary.

• Tasks Toggles off/on the Planning Template Task Listing at the bottom of screen.

Visual Summary

The asset hierarchy is filtered from the Base Asset (defined on the Planning Template). If no Base Asset is defined
then the entire hierarchy for the default Asset View is displayed.
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The number of Occurrence columns displayed on on the right of the asset hierarchy is equal to the number of Occur-
rences defined on the Planning Template). Each Occurrence will be represented by a Workpack (after the Planning
Template has been Applied)

Planning Tasks are represented by coloured circles in the Visual Summary. They are defined by the Planning Template
Tasks.

Planning Template Task Listing

Properties of a Planning Task

Location fields are in the first section:

• Asset - Choose an asset from the hierarchy.

• Start KP/EL - Enter the Start KP (Kilometre Point) or the Elevation location where the task is to be performed.
A non-required field, can be left blank if not relevant.

• End KP/EL - Enter the End KP or ELevation where the task is to be performed. A non-required field, can be
left blank if not relevant.

• Asset Type - If this task is not relevant to a single asset, but rather a group of assets of a particular type, then
choose the Asset Type by clicking on the ellipsis button.

Then the Task Details:

• Event Type - Choose the type of task to be scheduled.

• Schedule Type - A non-required field, used for grouping, categorising.

• Category - A non-required field, used for grouping, categorising.

• Requires Shutdown - [TODO]

• Order Number - Used to identify the order in which this task should be carried out. Can be left blank if not
applicable.

• Approximate Timing - Used to calculate the Task Time (min) and Duration (Estimated) (days) for the
workpack.

• Instructions (Manual) - Enter any specific task instructions here. Can be output to a Workpack report to provide
guidance to the inspection engineer.

• Instructions (Lookup) - Choose the AIG field (if any) which contains the instructions for this task.

Then the Rules

• Start (Manual) - Enter a value which defines the first occurrence (or workpack) to create this task. This can
either be a number type field which specifies the first occurrence, or a date type field (such as “last inspected
date”) and the Update/Apply process will work out the occurrence based on the date.

• Repeat (Manual) - Enter a value which defines the frequency that the task is to be created. This can be either a
number type field (which will be considered a frequency), or a date type field (such as “next inspection date”)
and the Update/Apply process will figure out the occurrence based on the date.

• Start (Lookup) - Choose the AIG field which defines the first occurrence (or workpack) to create this task. This
can either be a number type field which specifies the first occurrence, or a date type field (such as “last inspected
date”) and the Update/Apply process will work out the occurrence based on the date.

• Repeat (Lookup) - Choose the AIG field which defines the frequency that the task is to be created. This can be
either a number type field (which will be considered a frequency), or a date type field (such as “next inspection
date”) and the Update/Apply process will figure out the occurrence based on the date.
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• Create Action - Two self explanatory options here, “Always create task when Start Occurrence is valid, re-
gardless of Repeat Occurrence value.”; or “Only create task when Start Occurrence and Repeat Occurrence are
valid.”.

Then the Origin fields

• Anomaly Action - If this Planning Template Task is related to a specific Anomaly Action, then click on the
ellipsis button and choose the relevant Anomaly Action from the list.

• Details - A field which identifies a reference or source for the Planning Template Task, an example would be
“Risk Based Assessment” or a company Procedure number.

2.10.2 Applied To

When a Planning Template is “Applied”, the tasks in that Planning Template are created and assigned to a workpack.

This screen provides the user with the name of each of the workpacks that has been created from, or linked to this
Planning Template, as well as the Planning Template occurrence number relevant to that workpack.

Note that it is possible for a workpack to contain tasks from multiple Planning Templates.

The Applied To Toolbar

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

2.10.3 Worked Examples

Asset Tasks (Static Repeats)

In the following example we will create a UT inspection Planning Template for a subset of CML assets.

Step 1 - Create a Planning Template

Go to ASSETS → Planning Templates and click on the Add toolbar button. Alternatively, go to PLANNING →
Planning Templates and click on the Add toolbar button.
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Input requirements for the Planning Template are the Name, Base Asset, Frequency, Occurrences and Format fields.
Choose a name which best describes your planning template and a parent asset which will behave as a filter in later
screens. In our worked example we have chosen a Yearly Frequency. The Occurrences field is arbitrary, we will
be able to view 10 columns in the Summary page (see next step). Entering a Format of YYYY SPE UT means that
when the workpacks are automatically generated, they will be named 2019 SPE UT, 2020 SPE UT, 2021 SPE UT
and so on.

Step 2 - Create the Planning Template Tasks

Edit the Planning Template create in Step 1, click on the Summary tabbed page, then click on the Add toolbar button
to create a Planning Template Task.

Input requirements for an Asset based planning template task are the Asset, Event Type, Start and Repeat fields.

• Asset - Identifies which asset the task belongs to.

• Event Type - Identifies the inspection method to be scheduled and carried out.

• Start - Identifies the first occurrence that this task should occur, or a lookup to an AIG field.

• Repeat - Identifies the frequency at which this task should be scheduled and can either be a manually entered
number or a lookup to an AIG field.

Additional fields such Start KP, End KP, Approximate Timing, Instructions etc. whilst not required fields, can be
populated to provide more information on the individual tasks.

As tasks are added, the Summary screen shows where the tasks will be created once the Planning Template is Applied.
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Step 3 - Apply the Planning Template

Applying the Planning Template will create the Workpack and Task records.

Go to ASSETS → Planning Templates (alternatively go to PLANNING → Planning Templates), select the Planning
Template from the grid, and click on the Apply toolbar button to launch the Apply Planning Template wizard.

1. Occurrences - Allows you to choose how far into the future to create workpacks. Entering a date in the Specific
Date field will automatically calculate the Number of Occurrences to apply, or entering a Number of Occur-
rences will automatically calculate the future Date. In this example we have entered 10, meaning that 10 years
of future workpacks will be created. Click Next.

2. Specify Workpacks - For each occurrence, either choose an existing workpack or elect to create a new workpack
for the tasks to be created in. In this example we are electing to create new workpacks, one in each occurrence
(year) for 10 occurrences (years). Click “Apply”.

Step 4 - Check Workpacks

Select the newly created workpack/s in the WORKPACKS screen and view the tasks in that workpack/s. In this
example, tasks have been created in 2017 SPE UT and 2020 SPE UT and 2023 SPE UT and 2026 SPE UT workpacks
(the 3rd occurrence, then every 3rd occurrence after that).

Step 5 - Edit Planning Template Task

In our example, we want to increase the frequency of the UT inspection campaigns to every second year. To do this,
we edit the Planning Template task by editing the Repeat field from 3 to 2, as shown here:
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Step 6 - Update Planning Template

We then need to ensure that previously generated workpacks and tasks are updated with the revised frequency. So new
tasks are created in 2019, 2020 tasks moved to 2021, and 2026 tasks moved to 2025 to reflect the new requirement for
UT inspection every second year. 2023 tasks are unchanged, and so are not shown.

Go to ASSETS → Planning Templates (alternatively go to PLANNING → Planning Templates), select the Planning
Template from the grid, and click on the Update toolbar button.

This launches the Update “Asset Based Example” Planning Template dialog which details all changes that will be
applied once you click on the Update button.

Note: When you click the Update button at the bottom of the Update Planning Template dialog, the changes are made
inside a database transaction. This means that changes can be rolled back in the event of a problem (such as loss of
database connection partway through the process). But since SQL Server can handle at most one open transaction at a
time, any other copy of NEXUS IC that attempts to carry out updates (or potentially other planning template changes)
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will be blocked until the update process completes.

Asset Tasks (Lookup Repeats)

Most commonly, inspection frequencies are a moving target, in that frequencies tend to increase or reduce depending
on inspection results. Where corrosion rates are low, then inspection can be less often; when high, then inspection
needs to occur more often. To this end, NEXUS IC allows for the frequency (Repeat) field to be an input from a field
in an AIG. Using the above example, we will change the Repeat from static 3 to use a field from the Remaining life
AIG. Note that frequency will only be calculated calculated if the CML is identified as an Active Monitoring Location.

Step 1 - Edit the Planning Task

Edit the Planning Task as shown here:

42 Chapter 2. ASSETS



NEXUS Documentation, Release 6.6.xxxxx.0

For each of the CMLs, the Frequency has been calculated as follows:

• E1 - 2 (Active Monitoring location is checked)

• T1 - NULL (Active Monitoring location is unchecked)

• E2 - 20 (Active Monitoring location is checked)

• P1 - 5 (Active Monitoring location is checked)

• R1 - 5 (Active Monitoring location is checked)

Step 2 - Update the Planning Template

When the Planning Template is updated the previously created Tasks will be deleted and/or moved or new tasks created
based on the revised frequency. Performing an Update allows you to view the proposed changes to existing tasks and
view new tasks. Our Update is shown here:
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Asset Type Tasks (Lookup Repeats)

Planning Tasks can be configured by Asset Type, so that instead of defining the particular asset, you define the asset
type, and tasks will be created for all assets of the specified type using the frequency.

Step 1 - Create the Planning Task

Here we are creating a single Planning Task, and setting its Asset Type to CML. Thus, every CML under our planning
template’s Base Asset (PP-PG-CL01) will have a UT Inspection task created in the first occurrence, and frequency set
according to the function. That’s the same function shown in the previous example, Asset Tasks (Lookup Repeats),
and so relies on the same Remaining life AIG fields already filled in for that example. In this way, a single asset type
planning task can potentially configure tasks for thousands of individual assets, based on the data in each one of those
assets.

Deleting a Planning Task

Deletion of a planning task works slightly differently to deletion of other entities within NEXUS. For all other types
of thing in NEXUS, clicking the Delete button deletes that thing. But for a Planning Task, if you have applied that
Planning Task to create one or more Tasks, we want NEXUS to still know that those Tasks were created from this
Planning Task. So instead, we simply set an under-the-hood Is_Deleted flag on the Planning Task. Once all the Tasks
that were created from that Planning Task are deleted, the Planning Task will also be removed from the underlying
database table.

Consider the case where you want to delete an event definition. First, you must delete everything that depends on that
event definition. This includes Planning Tasks which use this event definition, but the way to remove those Planning
Tasks is to remove the Tasks that in turn relied on that Planning Task. Once this is done you should be able to delete
the event definition (which will delete all events of that type, etc).
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Planning templates functionality exist in NEXUS IC 6.1 (and higher).

Planning Templates provides the user the ability to automatically set up future workpacks (groups of inspection or
testing tasks).

• A Planning Template is a group of Planning Template Tasks.

• A Planning Task (once Applied) becomes a Task in a Workpack.

See Worked Examples for step-by-step guide on how to configure and maintain Planning Templates.

Planning Templates are records on which workpacks and tasks are generated.

2.10.4 Properties of a Planning Template

1. Name - A short (50 character limit) name for the Planning Template.

2. Base Asset - This field is non-required. However, if an asset is chosen, then the Planning Template tasks will be
limited to the assets for the Base Asset and all child assets of the Base Asset.

3. Frequency - Determines the frequency assigned to the Planning Template. Options are Yearly, Half Yearly,
Quarterly or Monthly. As an example, a Planning Template set up for Annual Subsea ROV Inspections would
be set to Yearly, however a Planning Template set up for quarterly oil change on a gear box would be set to
Quarterly.

4. Occurrences - The number of occurrences defines how many columns will be displayed in the Planning Tem-
plate.Summary

5. Format - When “Applied”, each Workpack created from a Planning Template will take the naming convention
described here. Using [yyyy] will insert the year into the Workpack name, or [yy] the abbreviated year, and
using [mm] will insert the Month in the Workpack name. For example Workpacks generated where the format
is defined as “[yyyy]-Annual UT”, will be titled “2018-Annual UT”, “2019-Annual UT” etc. [oc] represents the
Occurrence Number and will increment as the workpack is generated.

6. Workpack Group - When Workpacks are created from this Planning Template, they will be created in the
specified Workpack Group.

7. Revision - When Workpacks are created from this Planning Template, they will be created with the specified
Revision.

8. Read Only - When Workpacks are created from this Planning Template, if this box is ticked, they will be created
as Read Only.

9. Respect Task Move - This flag determines whether or not when tasks (which are generated from a Planning
Template) are re-scheduled, the subsequent (or following) tasks are moved based on their frequency relative to
the date of the moved task. If the checkbox is unchecked, then Tasks are simply created in the pre-determined
occurrences.

Note: The Respect Task Move option will be checked by default for all new Planning Templates. For databases
converted from v5, the Respect Task Move option will be unchecked by default.

2.10.5 Report Table Sources

To extract Planning Template data into a report template, use the System Table titled Planning Template as the
primary Table Source. For more information on Report Templates see Report Templates.
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2.10.6 Planning Templates Toolbar

• Add, Edit, Delete: Add / Edit / Delete Planning Template(s).

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

• Apply Creates tasks in new (or existing workpacks) based on the currently selected Planning Templates. If you
have selected multiple templates, they must all have the same Frequency, and you won’t be able to select
Workpacks to Apply to — fresh Workpacks will be created.

• Update Click on Update to view any changes that need to be made to Tasks that have already been created.
Multi-select, Update is also available here. Updates to each Planning Template are represented on separate
tabbed pages in the Update Planning Template dialog.

2.11 Children

The Children pane allows the user to display asset information data in a flat table for multiple assets. You can select
one or more rows and edit them, but there are caveats: you must have exactly one asset information group selected
under Groups, and the assets you select must all be of types that have that asset information group available on them.

You can also export the grid to Excel, Text or CSV.

Caution: If you elect to view complicated AIG forms which contain complex calculations and references, then
the data grid may take several minutes to load. This will depend on the complexity of AIG forms and the number
of assets to view.

Note: In some circumstances (particularly if your database used to be a version 5 database) you may have AIG
records against assets whose type does not have that AIG assigned. This is because AIG records are not deleted when
you unassociate an asset type from an AIG. Any such “secret” records will show in the Children tab with a purple
border, to visually indicate to you that you won’t see this data as an AIG form when you navigate to the asset.

• Children → Edit This button can be used to edit asset information. This Edit button is only enabled if you have
exactly one Group selected under the Groups menu button, and you have one or more assets selected in the
list, that have that Group assigned to them. This Edit button is useful for editing Asset Information data
on many assets at once. When you have multiple assets selected in the Children grid, it follows the usual
rules of Multi-Edit. You can edit asset information on single assets either via here or via Asset Information
at the bottom right of the Assets screen.

• Children → Export This is shared functionality. Refer to Export for a full feature description.

• Children → Groups This menu lists all Asset Information Groups which are assigned to the Asset Types of the
visible assets in the grid. Check and uncheck which AIG groups to view in the data grid.

• Children → Filters This menu item has a drop down list with two options to select.either in the “up” state
or “down” state. When “down”, the children grid displays only the direct descendants of the currently
selected asset (one level of the hierarchy only). When in the “up” state, the grid will display all children of
the currently selected asset (multiple levels of the hierarchy).
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• Children → Filters → Show All Children This menu item will display all children of the currently selected
asset (multiple levels of the hierarchy) if it is selected.

• Children → Filters → Show Selected Asset This menu item will display the selected asset and its direct de-
scendants if it is selected, if it is not selected, the grid will only show the direct descendants without the
selected asset in the hierarchy.

• Children → Navigate This menu item will change the active asset in the Asset hierarchy to the currently se-
lected asset in the data grid. By navigating to a different asset in the hierarchy, this will also update the
contents of data grid.

• Children → Customise See Toolbar → Customise for information about the Customise toolbar option.

• Children → Connections See Toolbar → Connections for information about the Connections toolbar option.

• Children → Shortcuts If your database has Shortcuts on Assets (which by default, databases do) they will
appear here, in addition to appearing at the bottom of the Assets screen’s main Assets menu.

2.12 Charts

This tab shows Chart Templates that are suitable to the selected asset’s type. If you don’t see any charts listed, try
selecting an asset of a different type.

To expand/collapse each chart, click the button at the top right of that chart, or click the chart’s grey header row.

If a chart is misconfigured, you will see a message explaining this in place of the chart. Go to Chart Templates to
resolve the described problem.

Charts are generated from Chart Templates. For details on setting these up, see Chart Templates.

Available charts will be listed alphabetically. The first chart will be automatically expanded.

Events with Findings will be shown on the chart in red.

For some Chart Templates, at the right or the bottom of the chart is the chart legend. If you hover the mouse over an
item on the legend, other series on the chart will fade out temporarily. If you click an item on the legend, that series
will be toggled on/off. If you export the chart (see below), only series currently visible will be exported.

2.12.1 Chart Width

When the Charts pane is 1000 pixels wide or less, all charts are shown at the full width of the chart pane. When the
Charts pane is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit
more charts side-by-side onto your screen.

Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full
width. Of course, you can adjust the width of all charts by adjusting the width of the whole application window,
adjusting other elements such as the asset tree wider/narrower, etc.

2.12.2 Zooming

At the bottom of most Chart Templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.

2.12. Charts 47



NEXUS Documentation, Release 6.6.xxxxx.0

You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all
charts support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

2.12.3 Charts Toolbar

There is no toolbar for the whole Charts panel. Instead, each chart has its own toolbar.

• Zoom In Zoom in.

• Zoom Out Zoom out.

• Reset Zoom Resets to default zoom level.

• Export the chart to image(s) Click this button to open the Export dialog. Ensure the range you want is set
correctly using the Zoom Bar. Ensure the series you want to export are visible. If you would like to export
the chart as a series of images, each covering a smaller horizontal range, enter the range you would like
each chart to cover in the Range of X Axis per image field. For example, if you have a 300km pipeline
and you enter “10” as the range per image, it will be broken into 30 images, each covering 10km.

• Copy the chart to the clipboard Copies the chart, as you see it displayed, without the “zoom” section at the
bottom, to the clipboard.

• Toggle chart Expand/collapse display of this chart.

2.12.4 Report Table Sources

To extract chart template data into a report template, use a Chart Template element in the report, and use the appropriate
Event table as a source. For more information see Report Templates.

Central to the NEXUS IC application is the Asset register. Most all information retained in NEXUS IC is linked back
to an asset in the asset hierarchy, including (but not limited to) risk assessments, anomalies, drawings, library items,
inspection data and inspection schedules.

Assets are presented to the end-user in a hierarchical tree view (each asset may have a single parent, and multiple
children or siblings). Each asset is also assigned an Asset Type. There is no limit to the number of levels that can
be configured in the Asset Hierarchy, however from a usability perspective Wood recommend keeping the hierarchy
levels to less than 10 (this is for guidance purposes only).

Tip

Ctrl+C copies the name of the currently selected asset to the clipboard. Ctrl+Shift+C copies the full asset path of
the currently selected asset to the clipboard.

Example Asset register:
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The asset tree appears on several screens within NEXUS IC: ASSETS, PLANNING, and INSPECTION. If you click
on an asset to select it in one of those screens, it will be selected in all of those screens.

2.13 Asset Types

The Asset Type determines what Asset Information Groups are visible for that asset and also what Event Definitions
are allowable for that asset.

2.14 Moving Assets

Tip
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Ctrl-R is available as a shortcut key to initiate the move. Cursor up and down move between assets in the picker
dialog. Cursor left and right close and open sub-trees. Enter or Escape complete or cancel the dialog.

To move an asset, right-click it and choose Move → To. . . , then select a destination from the resulting “picker”. Or
choose Move → To Root to make this asset a new root-level asset.

If the asset that you have chosen to move has children, then the child assets will be moved along with the selected
asset.

50 Chapter 2. ASSETS



CHAPTER

THREE

LIBRARY

3.1 Library Items

Library Items are displayed in the data grid and are filtered by the currently selected Library Type. See LIBRARY for
detailed information on editing Library Types.

1. Library Type - Select the type of the library from the drop down list.

2. Name - A 100 character field which is the name for the library. It is most common to use either the document
title or the document number here. This field is mandatory.

3. Description - A 100 character field which provides more descriptive information of the document.

4. Document No. - A 50 character field which stores the Document Number or Reference.

5. Revision - Revision of the document (eg. “A” or “C”).

6. Reference Date - Reference date of the document.

7. Physical Location - If this Library Item is a reference to hard copy document, then enter the physical location
of the document here.

8. Hyperlink - When linking this document to a UNC or URL, then the full hyperlink is stored in this field.

9. Attachment - When loading a document into the NEXUS IC database, or replacing an existing document then
click on the Import sub menu item. Other menu items available from this dropdown are:

• Link - Link to a file on a mapped drive. A copy of the file will be stored in the NEXUS database and
updated when the file changes.

• Export - Saves the document to a folder location of your choice.

• Launch - Launches the document in the default Windows viewer.

• Copy - Copies the document to your clipboard.

• Clear - Removes the document from the library item.

10. Show Grey Scale - A flag which will display drawing layers in black and white in lieu of designed colours.
This item is only applicable to documents which are selected to be shown as drawing.

11. Show Captions - A flag which will show or hide caption layers of a document. This item is only applicable to
documents which are selected to be shown as drawing.

12. Show Dimensions - A flag which will show or hide dimension layers of a document. This item is only applicable
to documents which are selected to be shown as drawing.

13. Use in Reports - Can be used to filter what documents are output to reports.

14. Force 2D - If you have DWG or DXF drawings which NXUS is detecting as 3D, and you’d prefer NEXUS to
treat them as 2D, tick this box on those drawings.
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15. Background Colour - Allows you to define the background colour of a document. Please note that this func-
tionality will only work on drawing types which support transparency (eg. DXF, DWG, GIF etc.).

Caution: Mapped drives If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped
for every other potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use
UNC paths for network drive locations.

Library Items are electronic documents which can be linked (via Connections) to data and data types in NEXUS IC.

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced via URL or
UNC paths.

Here are some examples of valid URL and UNC paths:

1. https://www.youtube.com/watch?v=oHg5SJYRHA0

2. \\example.com\groups\eng\this_doc.docx

Caution: Mapped drives - If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped for every other
potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use UNC paths for network drive
locations.

The Library functionality is available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. LIBRARY

3. INSPECTION

4. ANOMALIES

5. Configuration → General → Functions → Edit Function Definition

6. Configuration → Assets → Types

7. Configuration → Events → Event Types → Edit Table Information

Note: Example - Upload company Piping specifications to the NEXUS IC Library and assign to the Asset Type
“Pipework”. This will make the Piping Specifications available from the ASSETS | Library screen whenever the
active asset is of type “Pipework”.

3.1.1 Library Items Toolbar

The Library toolbar button allows the user to add, edit and delete Library Items.
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• Add The Add menu item allows you to add a new Library item. Depending on what screen is active, the
Add drop down menu will provide connection type options. Enter the Name of the Library item and any
other relevant document information (Revision, Date, Document Reference etc). If the document is to be
uploaded into NEXUS IC, then click on the Attachment button, else enter a Hyperlink location.

When adding an item, you can either Import or Link it. If you Import, the item will be brought into the
database. If you subsequently change the original on disk, the item in the database will not change to
match. If you Link the item, then when you change the original on disk, the next time you view the item
within NEXUS IC, you will see the updated item.

Note: NEXUS IC will still load a copy of a Linked item into the NEXUS database — this is so that if the
original is unavailable (for example, because you are away from your network), NEXUS IC can display
the cached copy. When you view the item, if the original has been updated, we also update the database
cached copy. You can’t Link items that are on your local hard disk — only items on network drives can
be Linked. The Link feature is designed to keep you up to date with items that may have been changed by
others, and that can’t happen on your local drive.

Hint: You can also add multimedia by dragging image files from Windows Explorer onto the Library
Items pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will
cancel the add. If you drag/drop multiple files, they will be added, and then multi-selected in the grid. You
can then click Edit to multi-edit them. Drag-drop will Import items, not Link them.

• Edit The Edit menu item allows you to edit the properties of the currently selected Library Item (not the
document itself).

• Delete Deletes the currently selected Library Item.

Note: Deleting a Library Item will delete all the connections of that Library Item.

• Launch Launches the Library item on the local machine. Note that by default NEXUS will only launch files
with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

Hint: Use the Space Bar on your keyboard to launch the currently selected Library item.

Note: If the local machine does not have an associated viewer for the document type (eg. AutoCad viewer
for DWG type), then the document can not be launched.
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• Email Attachment This option will launch a new email message and attach the associated Library Item to it.
Note that Email account properties need to be set up for this option to function.

• Import

See Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing Library Items.

You can also import the Connections in the same import as the Library items, so in addition to the
Library Import columns, you can additionally define the Connection information using the following
column headings:

– Library Connection.Connect To

– Library Connection.Workpack

– Library Connection.Asset Type

– Library Connection.Asset

– Library Connection.Event Type

– Library Connection.Event

– Library Connection.Anomaly

– Library Connection.Risk Model

– Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

– Anomaly

– Asset

– Asset Type

– Event

– Event Type

– Function

– Risk Model

– Workpack

• Export See Export for information about exporting Library Items. Please note that this option will only export
the contents of the grid, not the Library Items themselves.

• Customise See Customise for information about the Customise toolbar option.

• Connections See Connections for information about the Connections toolbar option.

Double-click

The first time you double-click on a library item, NEXUS will ask you what action to take: you can either Launch the
Library item in an external editor, or Edit the Library item. If you would like your choice to become permanent, tick
the “Always do this” box. Note that if you hold down the Alt key while double-clicking, you will be asked again.

The Details pane at the bottom of the Library screen displays the properties of the currently selected Library Item.

See section Library Connections for full explanation of the Connections functionality.
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3.2 Library Connections

Each Library Item may have one or more ‘connections’ associated with it. A Library Connection is a ‘link’ between
a Library Item and a data record. Connection Types include:

1. Asset (where a library item is linked to a specific asset or assets)

2. Asset Type (where a library item is linked to an asset type)

3. Event (where a library item is linked to a discrete event)

4. Event Type (where a library item is linked to an event definition)

5. Workpack (where a library item is linked to a specific workpack or workpacks)

6. Anomaly (where a library item is linked to an anomaly)

7. Risk Model (where a library item is linked to an Risk Model)

8. Function (where a library item is linked to a function)

The Library Connections toolbar button allows the user to add, edit and delete Library Connections of the currently
selected library item.

• Connections → Add The Library → Add menu item allows you to add a new Connection to the currently
selected Library item. When clicked, you will be presented with the Add Library Connection dialog
which will prompt you to select the type of Connection to add. When you have chosen the Connection
Type, then you will be presented with further options to finalise the Connection options.

• Connections → Edit The Connections → Edit menu item allows you to edit the properties of the currently
selected Library Connection (not the Library Item properties or the document itself).

• Connections → Delete Deletes the currently selected Library Connection. Note: This will not delete the Li-
brary Item itself just the currently selected Library Connection.

• Connections → Import See Import for detailed information on the Import Wizard. The MS Excel Import
Template details the required format for importing Library Connections.

• Connections → Export See Export for information about exporting Library Connections.

• Connections → Customise See Customise for information about customising the Connections grid.

Library Types are categories which are assigned to Library Items. A Library Type is defined by its name as well as a
flag which determines whether or not the Library Item is to be displayed in the Drawings pane.
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Note that there are two toolbars on this screen. The first applies to the Library Types list, and the second applies to the
library items list. If you select a Library Type, you will see all the library items of that type in the Library Items list.
If you select multiple Library Types, you will see all the library items of all those types in the Library Items list.

3.3 The Library Toolbar

The Library toolbar button allows the user to add, edit and delete Library Types.

• Library → Add The Library → Add menu item allows you to add a new Library item type.

• Library → Edit The Library → Edit menu item allows you to edit the properties of the currently selected
Library Type (not the Library Item properties or the document itself).

• Library → Delete Deletes the currently selected Library Type.

Note: If there are library items which have been assigned the library type that you are attempting to
delete, then you will be unable to delete the Library Type until all Library Items have been reassigned.

• Library → Import See Import for detailed information on the Import Wizard. The MS Excel Import Template
details the required format for importing Library Types.

• Library → Export See Export for information about exporting Library Types.

• Library → Connections See Connections for information about the Connections toolbar option.

• Library → Reports See Reports for information about the Reports toolbar option.
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3.4 Library Items

Library Items are electronic documents which can be linked (via Connections) to data and data types in NEXUS IC.

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced via URL or
UNC paths.

Here are some examples of valid URL and UNC paths:

1. https://www.youtube.com/watch?v=oHg5SJYRHA0

2. \\example.com\groups\eng\this_doc.docx

Caution: Mapped drives - If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped for every other
potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use UNC paths for network drive
locations.

The Library functionality is available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. LIBRARY

3. INSPECTION

4. ANOMALIES

5. Configuration → General → Functions → Edit Function Definition

6. Configuration → Assets → Types

7. Configuration → Events → Event Types → Edit Table Information

Note: Example - Upload company Piping specifications to the NEXUS IC Library and assign to the Asset Type
“Pipework”. This will make the Piping Specifications available from the ASSETS | Library screen whenever the
active asset is of type “Pipework”.

3.5 Library Items Toolbar

The Library toolbar button allows the user to add, edit and delete Library Items.

• Add The Add menu item allows you to add a new Library item. Depending on what screen is active, the
Add drop down menu will provide connection type options. Enter the Name of the Library item and any
other relevant document information (Revision, Date, Document Reference etc). If the document is to be
uploaded into NEXUS IC, then click on the Attachment button, else enter a Hyperlink location.
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When adding an item, you can either Import or Link it. If you Import, the item will be brought into the
database. If you subsequently change the original on disk, the item in the database will not change to
match. If you Link the item, then when you change the original on disk, the next time you view the item
within NEXUS IC, you will see the updated item.

Note: NEXUS IC will still load a copy of a Linked item into the NEXUS database — this is so that if the
original is unavailable (for example, because you are away from your network), NEXUS IC can display
the cached copy. When you view the item, if the original has been updated, we also update the database
cached copy. You can’t Link items that are on your local hard disk — only items on network drives can
be Linked. The Link feature is designed to keep you up to date with items that may have been changed by
others, and that can’t happen on your local drive.

Hint: You can also add multimedia by dragging image files from Windows Explorer onto the Library
Items pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will
cancel the add. If you drag/drop multiple files, they will be added, and then multi-selected in the grid. You
can then click Edit to multi-edit them. Drag-drop will Import items, not Link them.

• Edit The Edit menu item allows you to edit the properties of the currently selected Library Item (not the
document itself).

• Delete Deletes the currently selected Library Item.

Note: Deleting a Library Item will delete all the connections of that Library Item.

• Launch Launches the Library item on the local machine. Note that by default NEXUS will only launch files
with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

Hint: Use the Space Bar on your keyboard to launch the currently selected Library item.

Note: If the local machine does not have an associated viewer for the document type (eg. AutoCad viewer
for DWG type), then the document can not be launched.

• Email Attachment This option will launch a new email message and attach the associated Library Item to it.
Note that Email account properties need to be set up for this option to function.

• Import
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See Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing Library Items.

You can also import the Connections in the same import as the Library items, so in addition to the
Library Import columns, you can additionally define the Connection information using the following
column headings:

– Library Connection.Connect To

– Library Connection.Workpack

– Library Connection.Asset Type

– Library Connection.Asset

– Library Connection.Event Type

– Library Connection.Event

– Library Connection.Anomaly

– Library Connection.Risk Model

– Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

– Anomaly

– Asset

– Asset Type

– Event

– Event Type

– Function

– Risk Model

– Workpack

• Export See Export for information about exporting Library Items. Please note that this option will only export
the contents of the grid, not the Library Items themselves.

• Customise See Customise for information about the Customise toolbar option.

• Connections See Connections for information about the Connections toolbar option.

3.5.1 Double-click

The first time you double-click on a library item, NEXUS will ask you what action to take: you can either Launch the
Library item in an external editor, or Edit the Library item. If you would like your choice to become permanent, tick
the “Always do this” box. Note that if you hold down the Alt key while double-clicking, you will be asked again.
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CHAPTER

FOUR

PLANNING

4.1 Tasks

Tasks are work to be done. Often (but not always) this is inspection work. Typically you will specify an asset that the
task is to be done on, and an event type specifying the type of work to be done. For example if the task is to carry out
a GVI of the asset, you would specify event type ‘GVI’. Tasks are grouped into workpacks.

Tasks can be created by using the Add button, or by importing, or can be raised as a result of an anomaly action: in
a previous inspection you might have noted some fault by logging an event and logging a finding on that event, or
NEXUS might have noticed that a data value was outside acceptable bounds and log a finding for you. You might
then create an anomaly to track that problem, then create an anomaly action as your intended solution to the problem,
and then create a task and link it to that anomaly action, so that the remediation gets carried out as part of a particular
workpack.

Tasks can also created as a continuation of an existing task: if you get partway through a task and are then forced to
stop (by end of day, by weather, etc.), you may log a continuation task for the remainder of the work.

4.1.1 Properties of a Task

1. Asset - where the task is to be completed.

2. Start KP/EL / End KP/EL - defines the starting and ending kilometre point or elevation of a task (if required).

3. Workpack - You must specify a workpack to contain your task.

4. Event Type - the type of Event which is to occur to complete this task (can be null).

5. Schedule Type - A non-required field, used for grouping, categorising.

6. Category - You may optionally create task categories to further group your tasks (tasks that require rope access,
tasks that should only be undertaken on days ending in a ‘y’, etc).

7. Assigned To - you may optionally assign particular tasks to particular personnel.

8. Requires Shutdown - In plant inspection, some work requires the asset to be shut down — for example, in-
specting the interior of a vessel. Check this box for such tasks.

9. Order - Order in which the task is to be completed (for information purposes only). For example, if an asset
should be cleaned and then GVI’ed, give the Cleaning task a lower order number than the GVI task. Repeated
numbers are OK.

10. Approx Timing - This will be used to estimate the overall duration (and optionally, cost) of workpacks.

11. Due Date - optionally set a due date by which you want this task to be completed.
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12. Instructions - any descriptive text relating to this task which may assist the inspector. If you find you are using
the same instruction for every event of this type, you should instead put those instructions on the Event Type.
(It is similarly possible to put instructions on a planning template.)

13. Task Origin - 150 characters.

14. Anomaly Action - If this task was created from an anomaly action, it is shown here.

15. Planning Template - If this task was created from a planning template, it is shown here.

16. Event - If an event has been used to complete this task, it is shown here.

17. Task Status - You may optionally create task statuses to classify your tasks.

18. Is Completed - True if an event has been used to complete this task.

19. Retasked - True if another task references this task (i.e. is linked to this task).

20. Is Deferred - True if Is Completed is true and Is Retasked is true.

If the task has instructions (from any of event type instructions, planning template instructions or instructions on the
specific task), those instructions will be shown in a pane on the right.

4.1.2 Tasks Toolbar

• Add, Edit, Delete: Add / Edit / Delete task(s).

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

• Instructions Shows/hides the Task Instructions pane. Task instructions can come from the task’s Event Type,
and/or from its planning template, and/or from the task itself.

• Reschedule Reschedule allows for Planning Template tasks to be moved from one Workpack to another. Once
PT Task/s has/have been moved, then an “Update” should be performed on the Planning Template. The
Reschedule option is not available for tasks which have been imported or manually created.

• Child Assets The Child Assets toolbar button is only shown in the Tasks pane from PLANNING screen where
the asset hierarchy is visible. When down, tasks are shown for the currently selected asset and all child
assets.

4.2 Risk

The Risk functionality displays the risk assessment results for the currently selected workpack’s asset and all that
asset’s children. Results are graphically represented in the pre-configured Risk Matrix and in the data grid.
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Where there are several risks at the same location in the chart, the dot will be shown larger.

Clicking on a row in the Grid will highlight that item in the Matrix. Similarly, clicking on a result indicator in the
Matrix will highlight the relevant row (or rows) in the Grid.

If you are using scenarios, each scenario will be shown in its own colour. Scenario dots may be offset within the risk
square; if so, this does not indicate a difference in risk — it is merely for legibility.

If you click on a scenario dot within the Matrix, the relevant row(s) in the grid will be highlighted, and the relevant
dots for those assets’ other scenarios will be highlighted in the Matrix.

4.2.1 Risk Toolbar

• Assign → Risk Model Choose from the list of pre-configured Risk Models in the Drop Down menu to assign
to the currently selected asset. (See Copy Assessment below to bulk-assign a model to many assets.)

• Edit Launches the Risk Assessment dialog. Any Values in the Risk Assessment can be edited and saved from
this dialog by clicking in the Value column of any Value type row (white rows). Please note that Pass
Thru and Calculation values can not be edited. Clicking on a Factor or Model row however, we allow you
to view the function and the function results that has been assigned to that row. From here you can also
assign Scenarios to this Risk Assessment. Click on OK to save changes, or Cancel to exit without saving
changes.

• Delete Deletes the currently selected Risk Assessment from the asset to which it is assigned. Please note that
the Asset and all information linked to that asset will remain unchanged.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Child Assets Select to include risk assessments on all this asset’s children.

• Navigate to Asset Will change the active asset in the hierarchy to the currently selected risk assessed asset.
Note that this will filter the Risk grid so that only assessments for the active asset will be shown.

Hint: Use the Back toolbar button on the Assets toolbar to return to the previously selected asset.
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• Copy Assessment This menu item will launch the Copy risk assessment to selected assets dialog. From here,
select the assets which you want to assign the currently selected risk model to. Values assigned to Factors
and Categories in the Risk Model will be copied also. Please note that you will only be able to select valid
assets from this dialog (e.g. assets which already have the same risk model assigned cannot be selected).
Click on OK to copy the Risk Assessments.

• Copy To Clipboard This menu item will copy the risk chart to the clipboard as an image.

• Show Count When in the “Down” state, the matrix will overlay the total number (count) of risk assessments at
that location in the Matrix, as shown in the following image:

4.3 Task Instructions

You can specify instructions for each event type on each asset type. So you might specify one set of instructions for a
GVI on a pressure vessel, and different instructions for a GVI on a piece of piping.

Here you will see listed each event type that is associated with the asset type selected in the top pane. So if in the top
half of the screen you’ve selected an asset of type Corrosion Loop, here you’ll see one row for each event type that is
associated with the Corrosion Loop asset type.

If you see nothing in the list in the Task Instructions panel, that likely means that there are no event types associated
with the asset type of the selected asset. You can change the associations between asset types and event types from
Asset Types or Event Types.

To change the instructions for a particular event type on a particular asset type, select an asset of that type, and edit
the appropriate row. Enter your desired instructions. There is no limit to the amount of text you can enter. Optionally
enter an estimated time for this task. (This will be used to estimate the total duration of workpacks.)
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4.3.1 The Task Instructions Toolbar

• Edit Edit the selected task instruction(s).

• Export → Export See Export for information about exporting Library Connections.

• Customise → Customise See Customise for information about customising the Connections grid.

4.4 Shutdowns

4.4.1 Properties of a Shutdown

1. Name - A short (50 character limit) name for the shutdown.

2. Asset - The asset that will be shut down. You should choose as specific an asset as you can.

3. Start Date - This is the date the shutdown is scheduled to begin.

4. End Date - This is the date the shutdown is scheduled to end.

4.4.2 The Shutdowns Toolbar

• Add, Edit, Delete: Add / Edit / Delete Shutdown(s).

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

The Planning area shows tasks against their asset, in calendar form. Each task is a dot with two colours: an outer ring
showing whether the task is complete, and an inner dot, showing the event type of the task. (You can set the colour for
each event in Event Types.) If you hover the mouse over a task dot, you will get a hint, detailing the task’s description,
workpack, event type, completion status, and any associated anomaly action.

4.5 Report Table Sources

To extract task data into a report template, use the System Table titled Task as the primary Table Source. For more
information see Report Templates.

4.6 The Planning Toolbar

• Asset Views See Asset Views for detailed information on the Asset Views toolbar option.

• Assets Filter → Show Task Completion When checked, each task in the calendar will be outlined with a green
(complete) or red (incomplete) circle identifying the completion status of that task.

• Assets Filter → Schedule Type. . . .

• Monthly, Quarterly, Half Yearly, Yearly Use these buttons to choose the ‘resolution’ of the grid — if you select
Monthly, there will be one column for each calendar month, etc.

• Reports See Reports for information about the Reports toolbar option.
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FIVE

WORKPACKS

5.1 Tasks

Tasks are work to be done. Often (but not always) this is inspection work. Typically you will specify an asset that the
task is to be done on, and an event type specifying the type of work to be done. For example if the task is to carry out
a GVI of the asset, you would specify event type ‘GVI’. Tasks are grouped into workpacks.

Tasks can be created by using the Add button, or by importing, or can be raised as a result of an anomaly action: in
a previous inspection you might have noted some fault by logging an event and logging a finding on that event, or
NEXUS might have noticed that a data value was outside acceptable bounds and log a finding for you. You might
then create an anomaly to track that problem, then create an anomaly action as your intended solution to the problem,
and then create a task and link it to that anomaly action, so that the remediation gets carried out as part of a particular
workpack.

Tasks can also created as a continuation of an existing task: if you get partway through a task and are then forced to
stop (by end of day, by weather, etc.), you may log a continuation task for the remainder of the work.

5.1.1 Properties of a Task

1. Asset - where the task is to be completed.

2. Start KP/EL / End KP/EL - defines the starting and ending kilometre point or elevation of a task (if required).

3. Workpack - You must specify a workpack to contain your task.

4. Event Type - the type of Event which is to occur to complete this task (can be null).

5. Schedule Type - A non-required field, used for grouping, categorising.

6. Category - You may optionally create task categories to further group your tasks (tasks that require rope access,
tasks that should only be undertaken on days ending in a ‘y’, etc).

7. Assigned To - you may optionally assign particular tasks to particular personnel.

8. Requires Shutdown - In plant inspection, some work requires the asset to be shut down — for example, in-
specting the interior of a vessel. Check this box for such tasks.

9. Order - Order in which the task is to be completed (for information purposes only). For example, if an asset
should be cleaned and then GVI’ed, give the Cleaning task a lower order number than the GVI task. Repeated
numbers are OK.

10. Approx Timing - This will be used to estimate the overall duration (and optionally, cost) of workpacks.

11. Due Date - optionally set a due date by which you want this task to be completed.
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12. Instructions - any descriptive text relating to this task which may assist the inspector. If you find you are using
the same instruction for every event of this type, you should instead put those instructions on the Event Type.
(It is similarly possible to put instructions on a planning template.)

13. Task Origin - 150 characters.

14. Anomaly Action - If this task was created from an anomaly action, it is shown here.

15. Planning Template - If this task was created from a planning template, it is shown here.

16. Event - If an event has been used to complete this task, it is shown here.

17. Task Status - You may optionally create task statuses to classify your tasks.

18. Is Completed - True if an event has been used to complete this task.

19. Retasked - True if another task references this task (i.e. is linked to this task).

20. Is Deferred - True if Is Completed is true and Is Retasked is true.

If the task has instructions (from any of event type instructions, planning template instructions or instructions on the
specific task), those instructions will be shown in a pane on the right.

5.1.2 Tasks Toolbar

• Add, Edit, Delete: Add / Edit / Delete task(s).

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

• Instructions Shows/hides the Task Instructions pane. Task instructions can come from the task’s Event Type,
and/or from its planning template, and/or from the task itself.

• Reschedule Reschedule allows for Planning Template tasks to be moved from one Workpack to another. Once
PT Task/s has/have been moved, then an “Update” should be performed on the Planning Template. The
Reschedule option is not available for tasks which have been imported or manually created.

• Child Assets The Child Assets toolbar button is only shown in the Tasks pane from PLANNING screen where
the asset hierarchy is visible. When down, tasks are shown for the currently selected asset and all child
assets.

5.2 Risk

The Risk functionality displays the risk assessment results for the currently selected workpack’s asset and all that
asset’s children. Results are graphically represented in the pre-configured Risk Matrix and in the data grid.
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Where there are several risks at the same location in the chart, the dot will be shown larger.

Clicking on a row in the Grid will highlight that item in the Matrix. Similarly, clicking on a result indicator in the
Matrix will highlight the relevant row (or rows) in the Grid.

If you are using scenarios, each scenario will be shown in its own colour. Scenario dots may be offset within the risk
square; if so, this does not indicate a difference in risk — it is merely for legibility.

If you click on a scenario dot within the Matrix, the relevant row(s) in the grid will be highlighted, and the relevant
dots for those assets’ other scenarios will be highlighted in the Matrix.

5.2.1 Risk Toolbar

• Assign → Risk Model Choose from the list of pre-configured Risk Models in the Drop Down menu to assign
to the currently selected asset. (See Copy Assessment below to bulk-assign a model to many assets.)

• Edit Launches the Risk Assessment dialog. Any Values in the Risk Assessment can be edited and saved from
this dialog by clicking in the Value column of any Value type row (white rows). Please note that Pass
Thru and Calculation values can not be edited. Clicking on a Factor or Model row however, we allow you
to view the function and the function results that has been assigned to that row. From here you can also
assign Scenarios to this Risk Assessment. Click on OK to save changes, or Cancel to exit without saving
changes.

• Delete Deletes the currently selected Risk Assessment from the asset to which it is assigned. Please note that
the Asset and all information linked to that asset will remain unchanged.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Child Assets Select to include risk assessments on all this asset’s children.

• Navigate to Asset Will change the active asset in the hierarchy to the currently selected risk assessed asset.
Note that this will filter the Risk grid so that only assessments for the active asset will be shown.

Hint: Use the Back toolbar button on the Assets toolbar to return to the previously selected asset.
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• Copy Assessment This menu item will launch the Copy risk assessment to selected assets dialog. From here,
select the assets which you want to assign the currently selected risk model to. Values assigned to Factors
and Categories in the Risk Model will be copied also. Please note that you will only be able to select valid
assets from this dialog (e.g. assets which already have the same risk model assigned cannot be selected).
Click on OK to copy the Risk Assessments.

• Copy To Clipboard This menu item will copy the risk chart to the clipboard as an image.

• Show Count When in the “Down” state, the matrix will overlay the total number (count) of risk assessments at
that location in the Matrix, as shown in the following image:

A workpack is a collection of Tasks.

Workpacks can be created in the following ways:

• automatically by means of Planning Templates

• manually created from the Add Workpack dialog

• bulk imported from MS Excel

• automatically via connection with a corporate ERP / CMMS.

5.3 Properties of a Workpack

1. Name - A short (50 character limit) name for the Workpack.

2. Workpack Group - Workpack groups are optional and user-definable and can be used to group work however
you like: you could have different groups for different geographical areas, different groups for different kinds of
inspections (GVI, non-destructive measurement, destructive measurement, etc.) or whatever is useful for you.

3. Abbreviation - A short (15 character limit) name for the workpack that may be useful in reports, etc.

4. Description - A 100 character field which provides more descriptive information of the workpack.
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5. Asset - The asset that the workpack is attached to. You should choose as specific an asset as you can, while still
including all the assets that tasks in this workpack will be on. So if all the tasks in this workpack were within
MyCompany / MyField / Gas Plant, you could specify that as your asset for the workpack.

6. Revision - This field is used for quickly managing the status of workpacks: for example, when a workpack is
complete, you can change its revision to Completed. Workpack Revisions are user-definable.

7. Read Only - The check box is only present for historical purposes. It has no effect in NEXUS IC 6.

8. Actual Start - This is the date the workpack is scheduled to commence.

9. Task Time - A sum of how long all the tasks in this workpack will take. For this to be meaningful, you must
have given each task an Approx Timing.

10. Work Hours (per day) - Used to estimate duration, based on Task Time.

11. Duration (Estimated) - Task Time divided by Work Hours (per day) gives Duration (Estimated).

12. Duration (Contingency) - You can optionally add a value onto the estimated duration here, to allow for down-
time.

13. Duration (Override) - You can optionally enter a value here instead of relying on the calculated process above.
This would be useful if, for example, you have another management system that estimates duration for you.

14. Actual End - Actual Start plus Duration gives Actual End.

15. Day Rate - If you would like NEXUS IC to estimate cost, enter a day rate here. This should be the full cost of
one inspector, if inspectors will be working on different tasks in parallel, or the full cost of the team if they are
not.

16. Cost based on Day Rate - Day Rate x Duration = Cost based on Day Rate

17. Costs (Fixed) - Optionally enter any fixed costs here (for example, cost of mobilisation/demobilisation).

18. Cost (Total) - Cost based on Day Rate + Costs (Fixed) = Cost (Total)

19. Cost (Override) - You can optionally enter a value here instead of relying on the calculated process above. This
would be useful if, for example, you have another management system that estimates cost for you.

20. Final Estimate - If you have entered an override, Final Estimate will be the override value. Otherwise, it will
be the Cost (Total) value.

21. Cost Code - Cost Codes are optional and user-definable and can be used to group workpacks however you like.

5.4 Report Table Sources

To extract workpack data into a report template, use the System Table titled Workpack as the primary Table Source.
For more information see Report Templates.

5.5 The Grid

The workpacks grid lists all workpacks.

Tip: Use the grid Grouping functionality to group and filter workpacks. It is a quick and easy way to drill down to
the anomalies that you are particularly interested in reviewing. By default, this grid is grouped by Revision.
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5.6 The Workpacks Toolbar

Add, Edit, Delete: Add / Edit / Delete Workpack(s).

Tip: To bulk update (or delete) workpacks, use the Multi-Edit functionality available from the workpacks grid.

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

• Monthly, Quarterly, Half Yearly, Yearly Use these buttons to choose the ‘resolution’ of the grid — if you select
Monthly, there will be one column for each calendar month, etc.

• Today Click this button to horizontally scroll the calendar to today’s date. Note that if the calendar does not
cover today’s date (because all your workpacks are in the past, or all your workpacks are in the future, or
no workpacks have start/end dates) then the Today button will not work.

• Goto Item Click this button to horizontally scroll the calendar to the selected workpack’ start date. If you have
selected multiple workpacks, the calendar will scroll to the last one you selected.

• Reports See Reports for information about the Reports toolbar option.
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SIX

INSPECTION

This is an overview of the INSPECTION screen.

Inspection event data can be uploaded, analysed, charted and reviewed from this screen.

Tip: The asset hierarchy is pivotal to the INSPECTION screen as all data will be filtered by the currently selected
asset.

Select the asset from the asset hierarchy that contains the events you are interested in. Use the Event Listing pane to
see those events. Use the Event Listing’s Filter menu to control which events you see in the list, including whether you
want to see just events directly on this asset, or events on this asset and all its descendants. The rest of the Inspections
screen will then show data relevant to the events in the Event Listing, or relevant to the selected event(s) in the Event
Listing.

6.1 Inspections Toolbar

6.1.1 Events Export

The INSPECTION → Custom Export functionality gives the user the ability to choose a subset of event data to export
to Excel.

The format in which the data is exported to Excel is the same format in which the data can be reimported (with some
exceptions). See Import for more detail on importing data from Excel.

The Events Export Wizard

1. Export Filename - Either use the default folder and filename that NEXUS IC proposes, or use the ellipsis button
to navigate to an alternate Windows folder and edit the default filename.

2. Export Options - Select options here.

• If you set Columns to User Selected, you will be shown a page later in the wizard to select those columns.
If you set it to All Visible Columns, columns that have Visible Grid or Visible Form ticked will be exported.
Workflow rules affecting field visibility will not be run.

• Asset Location can be shown in a Single Column, like “Field / Asset / Elevation / Member / Anode”, or
as Multiple Columns, with one tree level per column.

• Findings: You can Include findings in the export, in which case they will get their own worksheet, or
Exclude them, or Only export Findings.
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• Images: You can Embed thumbnails at various resolutions, Embed full size images, Hyperlink to
external images, or Do not export images. If an event has several images, you will get several sets of
Multimedia columns, with images for an event shown horizontally within the event’s row.

• You can choose to export or not export Calculated fields and Sub events. If you export subevents, the
event data will be repeated in several rows, one for each subevent.

• Under Worksheets if you untick One per event type, you will get one Excel worksheet with (potentially)
many different event types mixed together.

• Extra sheets are exported for each Lookup List used in the forms. You can choose to hide these.

• You can control Formatting for Date and Time. You can also control Cell formatting — if you select
this, cells with invalid values will be shown in red, cells not relevant to this asset information group or
event form will be greyed out, etc.

3. Asset Selection - Choose the Asset View and check which subset of assets to include in the export. Note: use
the Select Children and Unselect Children toolbar buttons to include and exclude the visible and non-visible
child assets. Simply checking an asset at the top level will not automatically check all the child assets beneath
it.

4. Workpacks - Choose which Workpacks to include in the exported document.

5. Events - Choose which Event types to include in the exported document.

Hint: Column order within the exported sheet is determined by the grid column order set within each form in
Configuration → Assets → Asset Information.

Hint: The exported Excel sheet will contain a Legend tab, which shows the meaning of various cell and row colours.

The Inspections toolbar allows the user to control the INSPECTION screen as a whole. Functionality specific to
individual panes may be found on those panes.

• Back The Back menu item allows you to return to assets that you had previously selected in the Assets tree.

• Forward The Forward menu item allows you to return to assets that you had previously selected in the Assets
tree, after you’ve used the Back button.

• Assets → Asset Views See Asset Views for detailed information on the Asset Views toolbar option.

• Assets → Traffic Lighting See Traffic Lighting for detailed description of the Traffic Lighting toolbar option.

• Assets → Add → Asset Adds a new (child) asset to the asset currently selected in the hierarchy.

• Assets → Add → Root Asset Adds a new root level asset into the active Asset View. A root level asset is an
asset which does not have a parent asset.

• Assets → Add → Linked Asset (With Children) Add a link to an existing asset including all its children. An
asset tree will be displayed to allow selection of the asset to link as a child to the currently selected asset.

• Assets → Add → Linked Asset (Without Children) Add a link to an existing asset, without any of its children.
An asset tree will be display to allow selection of the asset to link as a child to the currently selected asset.

• Assets → Edit → Asset Properties Change the name or Asset Type of the currently selected asset or
add/remove the Primary Asset flag.

• Assets → Edit → Asset Type Properties Edit the Asset Type of the currently selected asset: change its name,
and change what Asset Information groups, Event types and Survey types it is associated with.
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• Assets → Delete Deletes or unlinks the selected asset. If the asset exists in multiple places just this location
can be removed, instead of deleting all locations the asset exists. Click on the Connections button to view
dependant records of the current asset.

• Assets → Show Asset Type Toggles the display of the asset type in the hierarchy.

• Assets → Expand Children All children, grandchildren, etc. of the selected asset will be expanded. (You can
also press the * key on the numeric keypad.)

• Assets → Collapse Children All children, grandchildren, etc. of the selected asset will be collapsed.

• Assets → Undo Move Reverses the last asset move action. Note that ONLY the last asset move can be undone.

• Assets → Copy to Clipboard Copies either the asset name or full hierarchy location of the selected asset to the
clipboard.

• Assets → Reparent to Root Repositions the selected asset in the asset tree so that it becomes a root asset.

• Assets → Show on Drawing Shows a list of drawings that have this asset as a layer. Click on a menu item to
go to that drawing. If the drawing name has “(Different Asset)” after it, the drawing you will be taken to
is not available on the current asset; thus, when you select the menu option, you will not only be taken to
that layer on that drawing, you will also be navigated to the new asset. You can get back by using the Back
toolbar button.

• Assets → Other Locations Shows a list of other locations that this asset exists in on the asset tree (including
in other Asset Views). Click on a menu item to navigate there. If this asset does not appear in any other
locations, you will not see any items in this list.

• Assets → Connections See Connections for information about the Connections toolbar option.

• Assets → Anomaly Triggers Asset-specific anomaly triggers are found here. Triggers for a field independent
of asset are found in Asset Information and Event Types. If you have both an asset-specific and a generic
anomaly trigger on the same field, for assets with the asset-specific trigger, only the asset-specific trigger
will apply. For assets with only a generic trigger, only the generic trigger will apply. Note that asset-
specific anomaly triggers are specific to their asset — they do not automatically apply to an asset’s children.

• Assets → Coordinates This is the equivalent of the version 5 ‘Pipeline’ and ‘Map’ tabs.

• Assets → Rotate Equipment See Assets Toolbar for details.

• Assets → Retire Equipment See Assets Toolbar for details.

• Import See Event Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing events.

• Custom Export Gives the user the ability to choose which subset of assets and associated event data to export
to Excel. Clicking this launches the Event Export wizard. The format in which the data is exported to
Excel is similar to but not the as same format in which the data can be reimported. See Events Export for
more information about exporting event data.

• Reports See Reports for information about the Reports toolbar option.

• View → Toggle Event/Findings Flips between showing the Event Listing and the Finding Listing. Equivalent
to clicking on the Event Listing tab or the Finding Listing tab. Having the menu item there lets us attach a
shortcut key to it: F10.

• View The remainder of the View menu lists the various panes available in the Inspection screen. Click a menu
item to check/uncheck it. Checked items are visible; unchecked items are not.

• Time Source If set to System Time, the date and time box visible just to the right of this button will show the
current time according to this PC’s clock. If set to Video Time, it will show time from the video player
— as you move backwards and forwards through the video, you will see this time move backwards and
forwards in unison.
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• Time Source → Synchronise KP If selected, then as video plays, KP on appropriate charts will be updated from
Video Time: as video plays, we see what time the video is up to, then we check what KP is associated with
that time, and we update charts that have a KP axis to that KP. This only works if there is suitable survey
data in the database, allowing us to get KP from the current time. Updated charts include Event type -v-
KP, CP -v- KP, and Pipeline View, as these all have a KP axis. It does not include the Cross-Profile chart,
as this does not have a KP.

• Desktops If you have several saved desktop configurations for this screen, select which one is active here.

• Save Desktop If you have made changes to the currently selected desktop, click this to save them. Otherwise,
when you restart the application, your changes will be lost.

• Add Desktop You can add a new desktop layout here.

• Delete Desktop Delete the currently selected desktop from the list by clicking this.

6.2 Alignment

The Alignment pane lets you align events in one workpack with events in another. If you have carried out multiple
inspections on an asset with KP (such as a pipeline), survey may have been calibrated differently in different years.
Thus, the same physical object may be logged at slightly different KPs in different inspections. This tool lets you bring
all those subtly different KP measurements into alignment with each other.

Ensure that the events that you want to align on are visible in the Event Listing, by setting filters as required. Choose
a baseline workpack and an alignment workpack using the toolbar buttons.

You will see a chart showing events from both workpacks, with the ‘Provide Suggested Control Points’ pane at the
right. This pane lists the event types that NEXUS IC believes might be suitable for matching on — essentially, events
that have KP. Each event type has a checkbox and a slider. If you check the box next to a given event type, NEXUS IC
will suggest control points, in that event type’s colour. The slider at the right of each event type controls sensitivity: if
the slider is all the way to the left, it will only suggest pairs of events that have identical KP. As you move the slider
to the right, it will suggest points that have more and more KP difference, up to a maximum of 25 metres. The default
slider position is 5 metres.

Check one or more event types. Good choices are event types that represent static objects: pipeline features, anodes,
field joints, etc. Bad choices are event types that represent thing that might change location over time: freespans,
burials, etc. Adjust sliders as required: if the survey variation from one workpack to the other is more than 5 metres,
you will need to adjust sliders upwards.

NEXUS IC should now display some suggestions. These are only suggestions — as yet, no links have been made. To
convert a suggestion into a link, zoom in on the chart (put the mouse over the KP axis and spin the mouse wheel, or
adjust the zoom bar at the bottom of the pane) far enough that you can select that individual point, click on the point
to select it, and click Link.

You can also make a link that is not based on a suggestion — for example, suppose that a particular object has been
logged one year as a Feature and the next year as a Survey Note. NEXUS IC will not automatically suggest a link if
the event types are different, but you can still manually click those two events and click Link.

If you change your mind, you can click Unlink to unlink a single pair of events, or Unlink All to start again from
scratch.

Once you are happy with the links you have made, click Align. NEXUS IC will then align events between the lowest
and highest KPs you have created links for. Adjustments will be made to the KPs of events in the Alignment Workpack.
This may take some time, depending on the number of events involved. (If you are carrying out a test, you may wish
to do so on a small KP range.)

Events will be adjusted based on the Linked points nearest them: for example, if you have a point at KP 0 linked to
a point at KP 0.004, and another point at KP 1 linked to a point at KP 1.004, all points in the Alignment Workpack
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between KP 0.004 and KP 1.004 will have their KP decreased by 0.004 km. If your low points were at KP 0 and KP
0.004 and your high points were at KP 1 and KP 1.008, then weighted scaling would occur: a point halfway between
at KP 0.506 would have a scaling halfway between 0.004 and 0.008 (i.e. 0.006) applied; a point at KP 0.252 would
have a scaling of 0.005 applied, and so on.

6.3 Anomaly Triggers Tool

The Anomaly Trigger utility only checks against the filtered list of events in the Event Listing grid. It only need
be run if Anomaly Trigger limits have changed. The Anomaly Triggers utility checks the event data for each event
currently shown in the Event Listing grid against pre-configured Anomaly Triggers. The Anomaly Triggers tool will
automatically create findings on those events where the event data exceeds specified criteria. Where findings exist and
event data no longer exceeds the criteria, then findings will be deleted.

After you click the Shortcuts → Anomaly Triggers button, you will be shown an “Are you sure” message.

During the check:

1. If it fails (meaning data is outside of defined triggers), then it will create a new finding. We first match on the
following to see if the finding already exists. It matches on:

1. Anomaly Trigger rule (Bound_ID)

2. Is Auto Generated = true

In other words, if there is no finding already created from this trigger for this event, NEXUS will create a finding.

2. If it passes (meaning data is within the defined limits), then we check to see if we need to delete an existing
finding. We match the finding based on:

1. Anomaly Code (Code_ID)

2. Anomaly Severity (Severity_ID)

3. Reason (if there is an Error Message provided in the anomaly trigger)

4. Anomaly Trigger rule (Bound_ID)

5. Is Auto Generated = true

6. that it has not been linked to an anomaly (Anomaly_ID is null)

7. Anomaly Required is null

In other words, if a finding was automatically generated from a particular Anomaly Trigger rule, and the event
data no longer exceeds that rule (because the event data has been changed or because the rule has been changed),
and the Error Message in that rule still matches the Reason in this finding, and the finding has not been linked
to an anomaly and the user has not marked whether it needs to be linked to an anomaly, NEXUS will delete it.

If you delete an Anomaly Trigger, findings created from it won’t be deleted. If you want to delete all findings
created from an Anomaly Trigger, don’t delete the Anomaly Trigger — instead, modify it so that no data will
be marked as anomalous (e.g. set it to only flag data between -2 and -1 on a field with no negative values, etc.),
then run the Anomaly Triggers tool. Then as a second step you can delete the Anomaly Trigger.

When an anomaly trigger is violated, a yellow exclamation mark ( ) will appear next to the field. You can set
lower/upper bounds to be constant values (so a field might trigger if it was outside, say, 1 to 9) or to pull from a field,
on this form or on another form. So for example if this field is Measured Wall Thickness, it might trigger if its value
is less than Minimum Allowable Wall Thickness.

For Lookup List fields, the comparison is done of the lookup list item’s Value, not its Comment. So if you have a
lookup list titled “Anode Depletion”, and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS
will use the “25” for purposes of determining whether an anomaly trigger should be fired.

6.3. Anomaly Triggers Tool 77



NEXUS Documentation, Release 6.6.xxxxx.0

For Yes/No fields you can set the trigger to fire on any combination of Yes, No or blank; but you can’t compare to
another field.

The Include Boundary tickbox controls whether exact matches cause the trigger to fire: if you have set a trigger
to “Fail when inside Upper/Lower bounds”, your lower bound is 1 and your upper bound is 9, this is the difference
between “1 < x < 9” and “1 <= x <= 9”.

You can optionally give an anomaly trigger a date range. If you set just a Date From, the trigger will apply only to
event data from that date forward. If you set just a Date To, the trigger will apply only to event data from that date or
earlier. If you set both, the trigger will apply only to event data within the specified range. In this way, you can change
triggers to reflect new conditions, without causing spurious warnings on historical data. For example, if you decrease
the operating pressure of an asset, this might decrease the minimum allowable wall thickness. Rather than editing the
existing anomaly trigger, you can set a “To” date on that old trigger, and add a new trigger with a “From” date.

Caution: In most cases, Findings are generated at the time events are added or imported. There are however some
scenarios in which the Anomaly Triggers utility should be run manually. These are 1) whenever anomaly triggers
are edited; 2) when anomaly triggers exist on a calculation field; 3) before any Finding review sessions; or 4) after
a bulk import of event data (particularly when anomaly triggers rely on events other than itself).

Triggers for a field independent of asset are found in NEXUS IC in Asset Information and Event Types. Anomaly
triggers for specific assets can be configured in NEXUS IC by right-clicking on an asset and choosing Anomaly
Triggers. . . . If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply. Note that asset-specific anomaly triggers are specific to their asset — they do not automatically
apply to an asset’s children.
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A trigger can have an anomaly Code and a Severity, and you can have several different triggers on a single field, with
different codes and/or severities. The dialog may also show a preview chart, showing which triggers apply at which
KPs or depths.

See also the Anomaly Triggers section under Event Types.

6.4 Asset History

See Asset History.

6.5 Asset Information

See Asset Information.

6.6 Charts

The Charts tab will list all of the Chart Templates that are appropriate for the event data shown in the Event Listing
pane. If you don’t see any charts listed, try different types of events, by changing asset or by changing your filters.
Charts will only show event data included in your filters (workpacks, event types, column-specific filters, etc). If your
Chart Template is on Continuous Event data (such as cross-profiles), ensure that you select that Continuous Event in
your event type filter.

To expand/collapse each chart, click the button at the top right of that chart, or click the chart’s grey header row.

If a chart is misconfigured, you will see a message explaining this in place of the chart. Go to Chart Templates to
resolve the described problem.

Charts are generated from Chart Templates. For details on setting these up, see Chart Templates.

Available charts will be listed alphabetically. The first chart will be automatically expanded.

Events with Findings will be shown on the chart in red.

For some Chart Templates, at the right or the bottom of the chart is the chart legend. If you hover the mouse over an
item on the legend, other series on the chart will fade out temporarily. If you click an item on the legend, that series
will be toggled on/off. If you export the chart (see below), only series currently visible will be exported.

Every client database includes:

• Baseline Chart, which shows events’ Easting and Northing, and optionally also shows a pipeline baseline track
(if you’ve set one up);

• Cross-Profile chart, which shows seabed profile for a single KP (if you have any PL - Cross Profile data im-
ported);

• Event Type -v- KP chart, which will show what events are logged at what KP of a pipeline (if you have any
KP-based assets such as pipelines);

• Events by Type, a pie chart showing how many events you have of each type;

• Longitudinal Profile, which shows top of pipe, bottom of pie, and left and right seabed versus KP (if you have
any PL - Profile data imported); and

• Pipeline View, which shows events along your pipeline in a 3D view. This view can also show seabed profile
(if you have any PL - Cross Profile data imported), and animates motion along the pipeline as you select events.
See Charts Toolbar below for details of buttons that are used by the Pipeline View.
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6.6.1 Chart Width

When the Charts pane is 1000 pixels wide or less, all charts are shown at the full width of the chart pane. When the
Charts pane is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit
more charts side-by-side onto your screen.

Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full
width. Of course, you can adjust the width of all charts by adjusting the width of the whole application window,
adjusting other elements such as the asset tree wider/narrower, etc.

6.6.2 Zooming

At the bottom of most Chart Templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.
You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all
charts support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

6.6.3 Charts Toolbar

There is no toolbar for the whole Charts panel. Instead, each chart has its own toolbar.

• Zoom In Zoom in.

• Zoom Out Zoom out.

• Reset Zoom Resets to default zoom level.

• Export the chart to image(s) Click this button to open the Export dialog. Ensure the range you want is set
correctly using the Zoom Bar. Ensure the series you want to export are visible. If you would like to export
the chart as a series of images, each covering a smaller horizontal range, enter the range you would like
each chart to cover in the Range of X Axis per image field. For example, if you have a 300km pipeline
and you enter “10” as the range per image, it will be broken into 30 images, each covering 10km.

• Copy the chart to the clipboard Copies the chart, as you see it displayed, without the “zoom” section at the
bottom, to the clipboard.

• Toggle chart Expand/collapse display of this chart.

There are also several buttons specific to the Pipeline View chart:

• Track the current KP This button is only available in IC-Inspection. When selected, the pipeline view will
move in time with the KP value coming in from survey. For NEXUS IC, see Time Source → Synchronise
KP on the Inspections Toolbar.

• Exaggerate the scale to show more of the pipeline When selected, will distort the scale of the pipeline to make
a greater KP range visible.

• Toggle stacked series mode When selected, will move events above the pipeline to make them more obvious.
Different events will be moved up different distances so that all are easily distinguishable.

• Toggle 3D perspective mode When unselected, you will see the pipeline viewed from the side. When selected,
you will see the pipeline viewed from above and slightly off to one side.
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Tip: Click on the chart area and then, with the mouse cursor still inside the chart area, use your mouse wheel to
increase/decrease the chart scale for export.

6.6.4 Report Table Sources

To extract chart template data into a report template, use a Chart Template element in the report, and use the appropriate
Asset table or Event table as a source. For more information see Report Templates.

6.7 Drawings

See Drawings and Charts and Drawings.

Here in INSPECTION, if you left-click on a drawing layer, you can create a new event on that layer’s asset.

An additional option is available from the Layer Colour button menu: Finding Status. This shows the following
colours:

• Green - No Findings, but Events exist.

• Grey - No Events exist.

• Yellow - Findings exist, but no severity.

• Other - Finding Severity Colour.

6.8 Event Details

The Event Details pane displays the Event data for the currently selected event.
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An event represents a discrete inspection or survey item. Each event record has (as a minimum) the following data
linked to it:

1. Asset

2. Workpack

3. Start Date/Time

4. End Date/Time

5. Survey Set

6.8.1 Report Table Sources

To extract event data (common to all events) into a report template, use the System Table titled Event as the primary
Table Source. To extract additional data from specific events, add fields from the relevant Events which exist in the
Event category.

For more information see Report Templates.

6.8.2 The Event Form

Fields on event forms and sub-event forms follow the same rules and have the same features as fields on Asset Infor-
mation forms.
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Event Details is broken into two tabs: the Details tab, containing Event and Commentary, and the Survey tab, contain-
ing key data and survey values.

Data fields specific to this event are displayed in the upper section of the Details tab. The fields displayed here are
user-definable and can be configured from Event Types. Event specific data can be edited and saved using the controls
in this section of the form.

The lower part of the Details tab titled Commentary has the Notes field, where free text relating to this event can be
entered and saved.

At the top of the Survey tab is Event, containing the key data associated with this event. The Workpack, Asset, Survey
Set, Start Clock and End Clock can all be edited from this section. Click on the ellipses buttons to edit Workpack,
Asset or Survey Set. Type in or choose from the calendar and clock control to edit the Start and/or End Clock values.

Below this is the Survey section. This shows data for each survey field assigned for this asset type. The data shown
is related to the Start Clock and End Clock: if another event has the same Start or End Clock, it will have the same
survey data.

6.8.3 Event Details Toolbar

• Save Saves any changes made to the current event.

• Revert Ignores changes and reverts data in the event back to the last saved state.

• History Shows a History dialog for this event.
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6.8.4 Editing Graphical Markup On Images In Events

If one or more event types are configured to show graphical markup, you will see a region on the event form showing
any multimedia attached to this event. (If there are no multimedia attached to this event, this region will show as
white. If there are several multimedia, you will see them all overlaid translucently, and you should use Multimedia
toolbar option to untick the ones you don’t want.) You can pan the photo by using the left mouse button to drag it.
You can zoom with the Zoom In / Zoom Out buttons, or by using the mouse wheel. (You may need to click in the
image region before the mouse wheel will zoom for you — this is a focus issue related to Windows.) You can then do
graphical markup on the photo: click the Redraw Layer button, then click in the drawing region to mark up. (If your
markup type is Point, click just once; otherwise click several times.) Then click Save Layer to complete the shape.

6.9 Event Listing

The Event Listing grid lists all events based on the currently applied filters. Primary filters are:

• Asset;
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• Workpack; and

• Event Type

The number of events in the grid (based on the current filters) is displayed in the Event Listing tab title.

Tip: The asset hierarchy is pivotal to the Inspections screen as all data will be filtered by the currently selected asset.
If the Child Assets toolbar button is not in the “Down” state, then only events recorded on the selected asset will be
shown (eg. events on child assets will not be listed).

Finding Column

There is significance to the colours in the Finding column.

• Yellow - the finding needs to be reviewed;

• Green - the finding has been deemed insignificant and is not linked to an anomaly.

• Grey - the finding is linked to a closed anomaly;

• Red - The finding is linked to an open anomaly;

• White - there are no findings on this event.

6.9.1 The Grid

By default, the Event Listing grid displays columns which are common to all event types. The first six columns in the
Event Listings grid represent:

1. F = The presence or absence of a Finding for this event.

2. B = The presence or absence of a Bookmark for this event

3. L = The presence or absence of a Library Item for this event

4. V = The presence or absence of Video for the event recorded at this date/time.

5. M = The presence or absence of Multimedia for this event

6. C = The presence or absence of Reviewer comments for this event

Tip: All columns listed above can be filtered and sorted. Each column has a filter icon which appears by hovering
over the column header, for example the F column, by clicking on the filter, a drop down with a list of relevant items
will appear that can be used to filter the events by that item in that column. By pressing on the column header, for
example F, the events will be sorted in ascending order based on the findings, i.e all the events with findings will be
listed at the bottom of the list, by clicking on the header for another time, the events will be sorted in descending order
based on the findings, i.e all the events with findings will be listed at the top of the list. A small arrow (either up or
down) on the column header shows this functionality.

Right clicking on any of the events in the Event Listing grid will pop up the Events menu.

Hint:

To bulk update (or delete) events, use the Multi-Edit functionality. If you’re deleting only a few events, simply multi-select them and hit the Delete toolbar button. Otherwise:
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• Go to the WORKPACKS screen and create a workpack called DeleteMe.

• Return to the INSPECTION screen, multi-select the events you wish to delete, and in the Event Details

pane, click Survey, click the ellipsis button on Workpack, and set it to DeleteMe.

• Go to the Workpacks screen again.

• Database → Close, then Database → Reopen or Database → Connect. . . to clear those events from
NEXUS IC’s cache.

• Now delete the DeleteMe workpack.

Tip: The Event Listing grid performs a check whenever the filtered data set is updated, when it detects there are only
events of a single event type, the properties of that event (the event data) will be displayed as additional columns in
the Event Listing grid.

6.9.2 Event Listing Toolbar

• Add Event. . . The submenu here lists all event types in the database, grouped by Event Category. Disabled
Event Types are those which are not “allowed” to be recorded on the currently selected asset. “Allowable”
event definitions are dependant on the asset type of the currently selected asset. (This is configured in
Asset Types.) The Workpack, Asset and Survey Set for your new event will be filled in to match the event
you had selected in the grid before you clicked Add. You can enter survey data for your new event. If you
specify a Start Clock or End Clock for which data already exists in the selected Survey Set, you will be
shown that data; otherwise, you will be able to type in survey data.

At the top of the Add Event menu you’ll see Hide Unavailable. If you select this, event types not relevant
to the asset type of the currently selected asset will be hidden. If you unselect it, those irrelevant event
types will be shown, but disabled. If you have too many event types to fit on your monitor, select Hide
Unavailable.

• Delete Deletes the currently selected event. Where multiple events are selected, the Delete menu item will
delete all selected events.

• Filter → By Workpack . . . From the Select Workpacks dialog, check which Workpacks to include in the filter.

• Filter → By Event Type . . . From the Select Table Definitions dialog, check which Event Types to include in
the filter. If you have no Event Types selected, then all Events will be shown, and no Continuous events
will be shown. To view Continuous events, you must explicitly select those event type(s) in the filter.

• Child Assets When in the Down state, events for the currently selected asset and all sub-assets will be included
in the Event Listing. When in the Up state, only events that have been recorded on the currently selected
asset will appear in the Event Listing.

• Events → Event Reviewed → Mark Event as reviewed Flags the currently selected event as Reviewed. The
font colour of a reviewed event is blue, events which have not been reviewed are shown in the default
colour font (black).

• Events → Event Reviewed → Mark Event as reviewed (move next) Flags the currently selected event as re-
viewed and changes focus to the next event in the Event Listing.

• Events → Event Reviewed → Mark Event as reviewed (with comment) Flags the currently selected event as
reviewed and prompts the user to enter descriptive text into the Add Signoff dialog. Reviewed events with
comment are identified with a blue callout symbol in Column 6 of the Event Listing grid.

• Events → Event Reviewed → Mark Event as not reviewed This option will only be enabled on an event that
has already been Reviewed. Choosing this option will unflag the event as being reviewed.
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• Events → Navigate to the event asset Will change focus in the Asset Hierarchy to the asset on which this event
has been recorded. To change back, click on the back arrow in the Assets toolbar (see Assets Toolbar).

• Events → Update Start Will change the start time of the currently selected event to the time displayed in the
Time Source control in the Assets toolbar.

• Events → Update End Will change the end time of the currently selected event to the time displayed in the
Time Source control in the Assets toolbar.

• Events → Toggle Bookmark Bookmarks are simply flags on an event. Bookmarked events are identified by a
green star symbol in column 3 of the Event Listing grid. The use of bookmarks and the workflow around
setting and removing bookmarks will differ for each client.

• Events → Match Task When clicked, the Shortcut will loop through all selected events in the Event Listing.
If it finds a matching Task, then the Event is linked to the Task and the Task is deemed completed. The
following four criteria must be true for a Task to be matched to an event:

1. Task.Event does not already have an Event assigned to it

2. Task.Asset = Event.Asset

3. Task.Workpack = Event.Workpack

4. Task.Event Type = Event.Event Type

• Shortcuts → Anomaly Triggers See Anomaly Triggers Tool for full description of the Anomaly Triggers utility.

• Connections See Connections for information about the Connections toolbar option.

• Export See Export for full description of the Summary Export menu item.

• Customise See Customise for full description of the Customise menu item.

6.10 Finding

6.10.1 Findings Toolbar

• Add Creates a new finding on the currently selected event.

• Edit Launches the Edit Finding dialog. Properties of the finding can be updated and saved. Additionally, By
checking the Anomaly Required checkbox, you can select an Anomaly to link the finding to by clicking
on the Ellipsis button.

• Delete Delete will delete the currently selected finding record/s. If multiple findings have been selected, then
the Question dialog will give notice of how many Findings will be deleted and prompt you to confirm by
clicking on the Delete button.

• Anomaly → Link Anomaly Launches the Select Anomaly dialog. Select from the existing list of anomalies,
or create a new anomaly, then click on OK to Link the Anomaly. Note also that you may select multiple
findings in this grid and bulk assign an anomaly if required.

• Anomaly → Unlink Anomaly Will unlink the anomaly from the currently selected Finding. Please note that
the Anomaly record itself will not be deleted, it will just be disassociated from the Finding.

• Anomaly → Launch Anomaly Launches the Edit Anomaly dialog. The Anomaly may be edited and saved by
clicking on OK.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for full description of the Connections menu item.
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Link Anomaly, Unlink Anomaly and Close Anomaly are Shortcuts. As such, if necessary, they can be debugged
using the Shortcut debugger. When you select the menu item, hold down the Control key on the keyboard. After
you have given any necessary input (such as selecting an anomaly for Link Anomaly) the Debug Shortcut dialog will
appear. You can step through shortcut items one at a time, which may help to narrow down any problems.

The Finding pane is only visible when the Finding Listing tab is active. The Finding pane displays the properties for
the currently selected Finding (multi-select edit is also supported here).

When then Event Listing tab is active, then the Finding pane is hidden and the Findings pane is shown.

A finding record has a Number, a Code, a Severity ranking, Reason (descriptive text) and Remedial Action (descriptive
text). Upon review, if you deem that the Finding should be escalated to an Anomaly, then you should tick the Anomaly
Required field, and choose an Anomaly from the list and linked to the Finding. If you click the Add button on the
Select Anomaly dialog, the new anomaly will have the asset, code, and various other fields pre-populated for you.

6.10.2 Properties of a Finding

1. Number - Optional. For use by users to label Findings.

2. Event - The Event which this Finding is connected to.

3. Code - Code which identifies the type of Finding. These are the same codes that are used to classify Anomalies.
Some typical codes may include “CD”, “PD” or “VIB” (Coating Damage, Physical Damage or Vibration);
however, anomaly codes are user-definable and can be configured from Configuration → Anomalies.

4. Severity - Choose from a list of pre-defined Severity Levels. Typical severity levels may include “Level 1 -
Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level 5 - Extreme Danger”;
however, severity levels are user-definable and can be configured from the Configuration → Anomalies area.
These are the same severities that are used to classify Anomalies. Anomaly severities can also be assigned to
Anomaly Triggers.

5. Reason - Text field. Size unlimited.
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6. Remedial Action - Text field. Size unlimited.

7. Anomaly Required - Check this box if this Finding should be linked to an Anomaly.

8. Anomaly - Anomaly that this Finding is linked to. This field only appears if Anomaly Required is checked.

9. Anomaly Trigger - If this Finding was automatically generated by an Anomaly Trigger, that trigger is shown
here.

10. Is Auto Generated - True if this Finding was automatically generated by an Anomaly Trigger.

6.10.3 Report Table Sources

To extract Finding data into a report template, use the System Table titled Finding as the primary Table Source, or
use the System Tables titled Event or Anomaly and then add fields from the Finding table. For more information see
Report Templates.

6.11 Findings

The Findings pane displays the finding/s for the currently selected event.

When the Finding Listing tab is active, then the Findings pane is hidden and the Finding pane is shown.

A Finding is the link between an Anomaly and an inspection or survey event. Findings are either escalated and linked
to an Anomaly or deemed “insignificant” and remain simply as an observation on the source event.

Findings are automatically created on events when event data meets or exceeds the pre-configured anomaly criteria.

Example: An Anomaly trigger is defined on a CP event, where the CP reading value is outside -800mv and -1200mv,
NEXUS IC will automatically create a Finding on that event when the event is created.

Findings will be created automatically when event data is imported from Excel.
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A finding record has a Number, a Code, a Severity ranking, Reason (descriptive text) and Remedial Action (descriptive
text). Upon review, if you deem that the Finding should be escalated to an Anomaly, then you should tick the Anomaly
Required field, and choose an Anomaly from the list and linked to the Finding. If you click the Add button on the
Select Anomaly dialog, the new anomaly will have the asset, code, and various other fields pre-populated for you.

6.11.1 Properties of a Finding

1. Number - Optional. For use by users to label Findings.

2. Event - The Event which this Finding is connected to.

3. Code - Code which identifies the type of Finding. These are the same codes that are used to classify Anomalies.
Some typical codes may include “CD”, “PD” or “VIB” (Coating Damage, Physical Damage or Vibration);
however, anomaly codes are user-definable and can be configured from Configuration → Anomalies.

4. Severity - Choose from a list of pre-defined Severity Levels. Typical severity levels may include “Level 1 -
Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level 5 - Extreme Danger”;
however, severity levels are user-definable and can be configured from the Configuration → Anomalies area.
These are the same severities that are used to classify Anomalies. Anomaly severities can also be assigned to
Anomaly Triggers.

5. Reason - Text field. Size unlimited.

6. Remedial Action - Text field. Size unlimited.

7. Anomaly Required - Check this box if this Finding should be linked to an Anomaly.

8. Anomaly - Anomaly that this Finding is linked to. This field only appears if Anomaly Required is checked.

9. Anomaly Trigger - If this Finding was automatically generated by an Anomaly Trigger, that trigger is shown
here.

10. Is Auto Generated - True if this Finding was automatically generated by an Anomaly Trigger.

6.11.2 Report Table Sources

To extract Finding data into a report template, use the System Table titled Finding as the primary Table Source, or
use the System Tables titled Event or Anomaly and then add fields from the Finding table. For more information see
Report Templates.

6.11.3 The Findings Toolbar

Refer to section Findings Toolbar for full description of the this Toolbar.

6.12 Findings Listing

As with the Event Listing, the Findings Listing grid lists all Findings associated with the events based on the currently
applied filters. Primary filters are:

• Asset;

• Workpack; and

• Event Type
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The number of events in the grid (based on the current filters) is displayed in the Findings Listing tab title.

Tip: The asset hierarchy is pivotal to the Inspections screen as all data will be filtered by the currently selected asset.
If the Child Assets toolbar button is not in the “Down” state, then only events recorded on the selected asset will be
shown (e.g. events on child assets will not be listed).

A finding record has a Number, a Code, a Severity ranking, Reason (descriptive text) and Remedial Action (descriptive
text). Upon review, if you deem that the Finding should be escalated to an Anomaly, then you should tick the Anomaly
Required field, and choose an Anomaly from the list and linked to the Finding. If you click the Add button on the
Select Anomaly dialog, the new anomaly will have the asset, code, and various other fields pre-populated for you.

6.12.1 Properties of a Finding

1. Number - Optional. For use by users to label Findings.

2. Event - The Event which this Finding is connected to.

3. Code - Code which identifies the type of Finding. These are the same codes that are used to classify Anomalies.
Some typical codes may include “CD”, “PD” or “VIB” (Coating Damage, Physical Damage or Vibration);
however, anomaly codes are user-definable and can be configured from Configuration → Anomalies.

4. Severity - Choose from a list of pre-defined Severity Levels. Typical severity levels may include “Level 1 -
Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level 5 - Extreme Danger”;
however, severity levels are user-definable and can be configured from the Configuration → Anomalies area.
These are the same severities that are used to classify Anomalies. Anomaly severities can also be assigned to
Anomaly Triggers.

5. Reason - Text field. Size unlimited.

6. Remedial Action - Text field. Size unlimited.

7. Anomaly Required - Check this box if this Finding should be linked to an Anomaly.

8. Anomaly - Anomaly that this Finding is linked to. This field only appears if Anomaly Required is checked.

9. Anomaly Trigger - If this Finding was automatically generated by an Anomaly Trigger, that trigger is shown
here.

10. Is Auto Generated - True if this Finding was automatically generated by an Anomaly Trigger.

6.12.2 Report Table Sources

To extract Finding data into a report template, use the System Table titled Finding as the primary Table Source, or
use the System Tables titled Event or Anomaly and then add fields from the Finding table. For more information see
Report Templates.

6.12.3 The Grid

By default, the Findings Listing grid displays columns which are common to all Findings. The first three columns in
the Findings Listings grid represent:

1. F = The status of this finding.

2. V = The presence or absence of Video for the event recorded at this date/time.

3. M = The presence or absence of Multimedia for this event
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4. Reviewed = Ticked if this Finding has been reviewed (and therefore has entries on the Review Status panel).

5. C = The presence or absence of Reviewer comments for this event

Right clicking on any of the events in the Findings Listing grid will pop up the Findings menu.

Hint: To bulk update (or delete) findings, use the Multi-Edit functionality.

Tip: The Findings Listing grid performs a check whenever the filtered data set is updated, when it detects there are
only events of a single event type, the properties of that event (the event data) will be displayed as additional columns
in the Findings Listing grid.

6.12.4 Findings Listing Toolbar

• Finding → Mark finding as reviewed Flags the currently selected finding as Reviewed. The font colour of a
reviewed finding is orange, findings which have not been reviewed are shown in the default colour font
(black), or blue, which indicates that the underlying event has been reviewed.

• Finding → Mark finding as reviewed (with comment) Flags the currently selected finding as reviewed and
prompts the user to enter descriptive text into the Add Signoff dialog. Reviewed findings with comment
are identified with a blue callout symbol in Column 3 of the Findings Listing grid.

• Finding → Mark Finding as not reviewed This option will only be enabled on an finding that has already been
Reviewed. Choosing this option will unflag the finding as being reviewed.

• Finding → Link Anomaly Launches the Select Anomaly dialog. Choose the required Anomaly record from
list and click on OK to close the dialog and link the anomaly to the Finding.

• Finding → Unlink Anomaly Will disassociate the linked anomaly from the currently selected finding. Please
note that the previously linked Anomaly will not be deleted, and the Finding will remain unchanged (other
than not having a linked Anomaly).

• Finding → Launch Anomaly Where a Finding has been linked to an Anomaly, then the Launch Anomaly
menu item will launch the Anomaly dialog, displaying the properties of the Anomaly that the Finding is
linked to.

• Delete Delete will delete the currently selected finding record/s. If multiple findings have been selected, then
the Question dialog will give notice of how many Findings will be deleted and prompt you to confirm by
clicking on the Delete button.

• Filter → By Workpack . . . From the Select Workpacks dialog, check which Workpacks to include in the filter.

• Filter → By Event Type . . . From the Select Table Definitions dialog, check which Event types to include in
the filter.

• Child Assets When in the Down state, findings for the currently selected asset and all sub-assets will be included
in the Findings Listing. When in the Up state, only findings that have been recorded on the currently
selected asset will appear in the Findings Listing.

• Events → Event Reviewed → Mark Event as reviewed Flags the currently selected event as Reviewed. The
font colour of a reviewed event is blue, events which have not been reviewed are shown in the default
colour font (black).

• Events → Event Reviewed → Mark Event as reviewed (move next) Flags the currently selected event as re-
viewed and changes focus to the next event in the Event Listing.
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• Events → Event Reviewed → Mark Event as reviewed (with comment) Flags the currently selected event as
reviewed and prompts the user to enter descriptive text into the Add Signoff dialog. Reviewed events with
comment are identified with a blue callout symbol in Column 6 of the Event Listing grid.

• Events → Event Reviewed → Mark Event as not reviewed This option will only be enabled on an event that
has already been Reviewed. Choosing this option will unflag the event as being reviewed.

• Events → Navigate to the event asset Will change focus in the Asset Hierarchy to the asset on which this event
has been recorded. To change back, click on the back arrow in the Assets toolbar (see Assets Toolbar).

• Events → Toggle Bookmark Bookmarks are simply flags on an event. Bookmarked events are identified by a
green star symbol in column 3 of the Event Listing grid. The use of bookmarks and the workflow around
setting and removing bookmarks will differ for each client.

• Connections See Connections for information about the Connections toolbar option.

• Export See Export for full description of the Summary Export menu item.

• Customise See Customise for full description of the Customise menu item.

6.13 Incomplete Tasks

The Incomplete Tasks pane lists all tasks for the currently selected asset which have not been flagged as completed.

A Task will be marked as completed under the following circumstances:

1. When an event is created directly from the Task in the data acquisition software IC Inspection.

2. When the task is launched from the Incomplete Tasks pane in the INSPECTIONS area.

3. When the Incomplete Task is manually Linked to an existing event from the Incomplete Tasks pane in the
INSPECTIONS area.
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6.13.1 Report Table Sources

To extract task data into a report template, use the System Table titled Task as the primary Table Source. For more
information see Report Templates.

6.13.2 Incomplete Tasks Toolbar

• Link This menu option will link the currently selected event in the Event Listings pane to the currently se-
lected Task in the Incomplete Tasks pane. When clicked, the task will be linked to the event, flagged as
completed and no longer shown in the Incomplete Tasks window. Please note that the event type of the
event and the event type of the task need not necessarily match for them to be linked together.

• Launch Launches the event form for the currently selected task. Once the details in the event form have been
completed and saved, the task will be linked to the event, flagged as completed and no longer shown in the
Incomplete Tasks window.

• Add, Edit, Delete: Add / Edit / Delete task(s).

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

6.14 Library

Library items are shown in this panel based on the Event selected in the Event Listing.

If you have events in the event listing, and you select one, then library items associated with the

• Event

• Event Type of the selected event

• Workpack of the selected event

• Asset of the selected event

will be shown in the list of library items.

6.14.1 Library Items

Library Items are electronic documents which can be linked (via Connections) to data and data types in NEXUS IC.

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced via URL or
UNC paths.

Here are some examples of valid URL and UNC paths:

1. https://www.youtube.com/watch?v=oHg5SJYRHA0
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2. \\example.com\groups\eng\this_doc.docx

Caution: Mapped drives - If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped for every other
potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use UNC paths for network drive
locations.

The Library functionality is available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. LIBRARY

3. INSPECTION

4. ANOMALIES

5. Configuration → General → Functions → Edit Function Definition

6. Configuration → Assets → Types

7. Configuration → Events → Event Types → Edit Table Information

Note: Example - Upload company Piping specifications to the NEXUS IC Library and assign to the Asset Type
“Pipework”. This will make the Piping Specifications available from the ASSETS | Library screen whenever the
active asset is of type “Pipework”.

6.14.2 Library Items Toolbar

The Library toolbar button allows the user to add, edit and delete Library Items.

• Add The Add menu item allows you to add a new Library item. Depending on what screen is active, the
Add drop down menu will provide connection type options. Enter the Name of the Library item and any
other relevant document information (Revision, Date, Document Reference etc). If the document is to be
uploaded into NEXUS IC, then click on the Attachment button, else enter a Hyperlink location.

When adding an item, you can either Import or Link it. If you Import, the item will be brought into the
database. If you subsequently change the original on disk, the item in the database will not change to
match. If you Link the item, then when you change the original on disk, the next time you view the item
within NEXUS IC, you will see the updated item.

Note: NEXUS IC will still load a copy of a Linked item into the NEXUS database — this is so that if the
original is unavailable (for example, because you are away from your network), NEXUS IC can display
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the cached copy. When you view the item, if the original has been updated, we also update the database
cached copy. You can’t Link items that are on your local hard disk — only items on network drives can
be Linked. The Link feature is designed to keep you up to date with items that may have been changed by
others, and that can’t happen on your local drive.

Hint: You can also add multimedia by dragging image files from Windows Explorer onto the Library
Items pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will
cancel the add. If you drag/drop multiple files, they will be added, and then multi-selected in the grid. You
can then click Edit to multi-edit them. Drag-drop will Import items, not Link them.

• Edit The Edit menu item allows you to edit the properties of the currently selected Library Item (not the
document itself).

• Delete Deletes the currently selected Library Item.

Note: Deleting a Library Item will delete all the connections of that Library Item.

• Launch Launches the Library item on the local machine. Note that by default NEXUS will only launch files
with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

Hint: Use the Space Bar on your keyboard to launch the currently selected Library item.

Note: If the local machine does not have an associated viewer for the document type (eg. AutoCad viewer
for DWG type), then the document can not be launched.

• Email Attachment This option will launch a new email message and attach the associated Library Item to it.
Note that Email account properties need to be set up for this option to function.

• Import

See Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing Library Items.

You can also import the Connections in the same import as the Library items, so in addition to the
Library Import columns, you can additionally define the Connection information using the following
column headings:

– Library Connection.Connect To

– Library Connection.Workpack

– Library Connection.Asset Type

– Library Connection.Asset

– Library Connection.Event Type

– Library Connection.Event

– Library Connection.Anomaly

– Library Connection.Risk Model

– Library Connection.Function
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Note that the Connect To column should only contain one of the following text items:

– Anomaly

– Asset

– Asset Type

– Event

– Event Type

– Function

– Risk Model

– Workpack

• Export See Export for information about exporting Library Items. Please note that this option will only export
the contents of the grid, not the Library Items themselves.

• Customise See Customise for information about the Customise toolbar option.

• Connections See Connections for information about the Connections toolbar option.

Double-click

The first time you double-click on a library item, NEXUS will ask you what action to take: you can either Launch the
Library item in an external editor, or Edit the Library item. If you would like your choice to become permanent, tick
the “Always do this” box. Note that if you hold down the Alt key while double-clicking, you will be asked again.

6.15 Map

The Map pane shows you the events in the Event Listing on a two-dimensional map, based on their Easting and
Northing. Each event is a dot, coloured with the Event Type’s colour. (You can set the colour for each event in Event
Types.)

The Map pane will only show event data included in your filters (workpacks, event types, column-specific filters,
etc). If the events you are interested in are Continuous Event data (such as cross-profiles), ensure that you select that
Continuous Event in your event type filter.

At the bottom or right of the map is the legend. If you hover the mouse over an item on the legend, other series on the
Map will fade out temporarily. If you click an item on the legend, that series will be toggled on/off. If you export the
Map (see below), only series currently visible will be exported.

6.15.1 Zooming

You can zoom in or out by clicking in the map area and (with the mouse cursor still inside the map area) spinning the
mouse wheel. You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

6.15.2 Maps Toolbar

• Zoom In Zoom in.

• Zoom Out Zoom out.

• Reset Zoom Resets the zoom so that all data points are visible.
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• Copy Use this button to copy the Map, as currently displayed, to the clipboard.

• Legend Use this button to show the legend of the events on the map, the legend includes the Event Types that
are selected and the Layers which their opacity has been set to anything above 0%. Layers and Event
Types can be switched off by clicking on the layer or event on the legend.

• Layers OpenStreetMap, ESRI World Imagery, ESRI World Hillshade, ESRI World Topographic, ESRI Ocean
Base Map and ESRI Street Map are free to use on the web. Each of these layers has an opacity drop down
list to be selected from 0% to 100%. If 0% is selected for any of the layers, it will not be included in the
map legend.

• Event Types Use this button to select what event types are displayed. This is more persistent than click-
ing/unclicking series on the map legend.

• Inspection Track Selecting a workpack from this menu will result in a line on the map connecting events in
the order they were logged. If the events were logged by a single ROV (or a single human inspector), this
track will show the path that the ROV (or inspector) took.

• Configure Specify the sources of the various fields used by the Map tab to display pipeline baseline data and
map data. “As Built - Easting”, “As Built - Northing” and “As Built - Order” should all point to the same
table — this is the table used to supply the pipeline baseline track. Typically you would point these three
fields at a sub-AIG. If you don’t configure these, no as-built track will be displayed. If your pipeline has
many events on it, not showing an as-built may be OK — users may be able to get a sense of the pipeline
track from the events on it. “Coordinates - Datum” and “Coordinates - UTM Zone” should point to fields
that provide these values. Typically they will be in an AIG — only one datum and one UTM Zone are
necessary for an entire asset. Ask your surveyors for the values that you should fill in to these fields.

• Export Image Click this button to save the Map to an image file.

6.16 Multimedia

Multimedia are electronic images which have been uploaded against an event.

Multimedia items are displayed as thumbnails for the currently selected event(s).
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Note: You can add multimedia by dragging image files from Windows Explorer onto the Multimedia pane.

6.16.1 Multimedia Toolbar

Multimedia File Formats

GIF, JPG, JPEG, TIF, BMP, PNG, PDF, DWG, CGM, DXF, SVG, WMF or EMF are all allowed Multimedia file
types.

• Add Launches the Add Multimedia dialog to allow you to attach an image to the currently selected event.
Please note that if multiple events are selected, then the image being added will be attached to all events.

Note: You can also add multimedia by dragging image files from Windows Explorer onto the Multimedia pane.

Note: The Can Report property of the Multimedia item can be used to filter which images are output to the report.
(This column is invisible by default, but is available under Customise → Columns.)

• Edit Launches the Edit Multimedia dialog. Properties of the Multimedia can be updated and saved.
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• Delete Delete will delete the currently selected multimedia record/s. If multiple Multimedia items have been
selected, then the Question dialog will give notice of how many Multimedia items will be deleted and
prompt you to confirm by clicking on the Delete button.

• Launch Launches the currently selected Multimedia file into the default Windows viewer for the selected file
type. (Note that if your image viewer supplies “Next” and “Previous” buttons, these will show you the
next and previous files in the temp folder, which may not be the next and previous images in NEXUS.)

• Preview Toggle display of preview. If this button is selected, then whichever image is focused in the grid will
be shown in a “preview” window. If EXIF data is available for the image, it will be displayed.

• Crop Crop the selected image. Within the Crop dialog, click the Crop button or Ctrl-X, then click and drag a
rectangle on the image. To complete the crop, click the button, or Crop To Selection, or Ctrl-Shift-X.

If you want to replace the existing image with the new cropped version, ensure Keep Original is not
selected. If you want the new cropped image to be added to the event’s collection of images without
overwriting the existing image, ensure Keep Original is selected.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

6.17 Related Events

Related Events shows you events that are of the same Event Type, are from a different Workpack, and have a start/end
KP that overlaps with the start/end KP of the event currently selected in the Event Listing.

If you click the Navigate Event button, the event selected here in Related Events will be selected in the Event Listing.

6.18 Review Status

When an event or finding has been reviewed (e.g. via the Event Listing Toolbar), the review details are shown in the
Review Status pane.

For an event that has been marked as reviewed via Events → Event Reviewed → Mark Event as reviewed, this will
be the name(s) of users who have marked the event as reviewed. For an event that has been marked as reviewed via
Events → Event Reviewed → Mark Event as reviewed (with comment), this will be the name(s) of users who have
marked the event as reviewed, and the comment they gave.

If you have selected multiple events in the Event Listing pane, reviews for all of them will be shown here.

Similarly for findings in the Findings Listing: the list shows reviewer(s) and their comments; and if you select multiple
findings, all relevant reviews will be shown here.

You can add, edit or delete reviews from here. If you Add, and multiple events are selected in Event Listing, a review
will be added to each. This is useful for marking numerous events as reviewed at once.

6.18.1 Report Table Sources

To extract review data into a report template, use the System tables titled Event Review and Finding Review as the
primary Table Source. For more information see Report Templates.
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6.19 Event Import

The INSPECTION → Import functionality gives the user the ability to bulk import events.

The format of the Excel workbook needs to be very specific. It is recommended you use the Example button on the
first page of the Import wizard to generate the workbook in the correct format for importing data.

1. Import File - Navigate to the Excel or Text file which has been prepared for import. If you uncheck the
“Automatically commit transaction on successful import”, the wizard will present you with a summary of the
Import actions, and prompt you to commit the changes. Please note that the database Transaction will remain
open until you Commit or Cancel the import. This may impact other users.

2. Configure Import - If you are using an Excel sheet generated via the Example button, then the destination
Fields will be pre-populated. If you would like to make changes to the Destination fields or elect to ignore
some fields, then click on the column heading titled Field: and choose from the options presented in the pop up
menu. Finally, ensure that the correct Asset View is selected from the Required Fields selection box and that
the number of Header Rows and Worksheet are correct (by default this will be 1 row).

3. Import Complete - This page summarises the import, advising the user how many rows have been added to the
AIG forms and whether or not any new assets have been created as part of the import. It is important that the
summary is scrutinised to ensure that the import has performed the actions that you expected.

Finding trigger checks are run on each event during the import process, or whenever an event is edited, or the Anomaly
Triggers Tool is run from the Event Listing. Please note that the Anomaly Trigger tool is only run on the filtered list
of events in the grid and should only be run if Anomaly Trigger limits have changed. During the check:

If it fails (meaning data is outside of defined triggers), then it will create a new finding. We first match on the following
to see if the finding already exists. It matches on:

1. Anomaly Trigger rule (Bound_ID)

2. Is Auto Generated = true

In other words, if there is no finding already created from this trigger for this event, NEXUS will create a finding.

Note: If you do not specify a Survey Set for event survey data to be imported into, it will be imported into Raw Survey
Data, which is the default set. If two different events have the same date/time, the second one imported will overwrite
the survey values of the first. To avoid this, don’t have two different events in the same survey set at the same time
with different survey data.

Note: If the importer encounters a completely blank row in an Excel file, it will stop importing at that point, even if
there are non-blank rows further down. This can provide an easy way to test an import sheet: set it up, and then after
just one or two rows of data, insert a blank. Run the import to see if it’s doing what you expect, and if so, delete the
blank and run again. Similarly, if the importer encounters a blank column in an Excel file, columns to the right of this
will not be imported.

Tip: When importing inspection event data, anomaly triggers are checked during the import and findings created
automatically from data which falls outside the data bounds.

Note: If you are importing a sheet designed for use with NEXUS IC 5, it may have one or more columns titled
‘Component.Location’. In the Configure Import page, you should select ‘Asset Location.Full Location’ for these
columns.
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Note: You can have one ‘Asset Location.Full Location’ column, with levels in the asset hierarchy separated by space
slash space, like ‘My Field / My Plaform / My Member’, or many ‘Asset Location.Full Location’ columns, with one
asset hierarchy level in each. (But you can’t mix the two, with one containing ‘My Field / My Platform’ and a second
containing ‘My Member’.)

Tip: You can also import from .csv files. For very large imports, saving your Excel file as a .csv and then importing
from the .csv may be faster.

6.19.1 Sub-rows

Sometimes a single “master” row will have several “detail” rows. For example, an asset information row might have
several sub-AIG rows; or an event might have several findings or several multimedia images or both. When this occurs,
you should repeat the row, with different “detail” values in each.

For example, if you have several multimedia images to import against a single event, your Excel sheet should have
several rows that are identical except for the Multimedia.Name and Multimedia.Image columns. If you have specified
an event number, and you use the same event number on each row, NEXUS will only create the event once, but will
create several multimedia items. (If you do not specify an event number, NEXUS will instead create several different
events with one multimedia item each.)

It is also acceptable to leave event fields blank for all except the last row — under the hood, NEXUS is importing each
Excel row into the event, and only the last Excel row imported will “stick”. Note that if your event has a finding, you
should not repeat the finding data on each event row — if you do, NEXUS will create one finding for each Excel row
that has finding data filled in.

In some cases you do want multiple findings on one event, and in that case you should fill in several rows as appropriate.
Similarly for sub-event data or sub-AIG data: if you want several different sub-events or sub-AIG rows imported, you
should repeat the event row or AIG row with different sub-event or sub-AIG data in each case. If you are repeating
an Excel row for another reason and you do not want several sub-event or sub-AIG rows imported, you should fill in
sub-event or sub-AIG data in only one of the Excel rows.

Tip: You can find the next available event number for a given event type by creating an event of that type using Add
Event, noting the event number, then deleting that event. If you want next available event numbers for several event
types, create a report template with a Simple Source on table Event and a Pivot Table with a pivot row on Event Type
and a value field on Event Number with aggregate Max. Then add 1.

6.19.2 Excel

During an import, we communicate with Excel “behind the scenes”: we command Excel to open the file you want to
import, and ask Excel what’s in each cell. An upshot of this is that if you use Excel to modify the file while we’re
importing it, even if you don’t hit Save, you may confuse the import process. Similarly if you take a variety of other
actions: using Save As, closing Excel, etc. If you see error text “Call was rejected by callee”, this is what’s happened:
Excel has stopped answering our calls.

6.20 Task

When an event has been linked to a Task, the details of the originating task are shown in the Task pane.
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There are no editing capabilities on this pane.

6.20.1 Report Table Sources

To extract task data into a report template, use the System Table titled Task as the primary Table Source. For more
information see Report Templates.

6.21 Video

6.21.1 How does video playback work?

The electronic video files (wmv, mp4 etc.) are stored in one or more sub-folders under a network share location called
the Global Video Path. Video files are NOT stored in the NEXUS database.

If you are working in a subscriber database or are otherwise working with video that has not yet been uploaded to the
Global Video Path, you can configure the Temporary Inspection Video Path to point to these video files.

When new files are added under the Global Video Path or Temporary Inspection Video Path (usually after a subsea
or drone inspection has taken place), these need to be re-parsed by NEXUS. You can do this by clicking on Tools →
Parse Video. (Already-parsed video will not be reparsed.)

When video is parsed, NEXUS incrementally searches all folders under the Global Video Path and/or Temporary
Inspection Video Path (if configured), searching for valid video files. As each file is found, NEXUS extracts the key
information from each video file and stores that key information in the database. Key information includes:

• Date-time – This is then compared with Events to determine which Events contain video.

• ROV name – This is extracted from the video file name (eg. “Tiger”), allowing video to be sorted by ROV .

• Channel name – This is extracted from the video file name (eg. “Centre”, “Port”, “Starboard”), allowing video
to be sorted.

• Video attributes – size, duration, and other data about the video file.
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For example, a video file with the name:

2019-01-01 123456 - Port - [MINI ROV].wmv

will set the date and time to 12:34AM (and 56 seconds) on the 1st of January 2019, the channel to ‘Port’ and the ROV
to ‘MINI ROV’. If the ROV name does not exist in the database, the ROV will be left empty when the video is parsed.

Now that NEXUS “knows” about the video files, it can determine which inspection events have associated video and
allows the user to play the Video from the INSPECTION screen.

When you select an event with video, NEXUS will automatically play the relevant part of the inspection video based
on the Event start and end times and the ROV name. If the video files and the event both have no ROV set, video will
play. If either the video files or the event has a ROV set, both must have the same ROV to be considered a match.

Troubleshooting

When I play video for an event, multiple copies of a single video channel appear

This is likely because you have multiple copies of that file in one or the other or both video paths. For example if your
Global Video Path contained Folder1\Video1.wmv and Folder2\Video1.wmv (i.e. two copies of the same file), or there
is one copy of Video1.wmv in the Global Video Path and another in the Temporary Inspection Video Path, NEXUS
will identify “both” files as being appropriate for the time range covered by that event, and will therefore display both.

Remedy: Find and remove duplicates. The Windows Explorer search feature might help.

The Video icon does not show against events that I know have video

Remember that you need to wait for video to be copied from your recorders to your network (where required) and then
Parse Video.
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Remedy: Tools → Parse Video. And Tools → Video. . . may be a useful place to look to check NEXUS’ opinion of
what video files it knows about, and whether or not they parsed successfully.

A video does not play on my machine, but does on another machine

This is likely a codec issue. NEXUS asks Windows Media to play the video within NEXUS’ video frame. Windows
Media will only play video it understands. Note that many video file extensions are envelopes that can contain videos
of a variety of formats: just because your PC can play one .avi file does not necessarily mean it can play another.

Remedy: install appropriate codec. Use GSpot, which despite its name is a long-standing reliable tool for checking
codec details for a particular file. Run it on both a machine where the video file does play and a machine where the
video file doesn’t play, if possible. Drag the video file into GSpot in each case. Click the ‘1’ and ‘2’ buttons near
the bottom and compare output. (There are more than one set of ‘1’ and ‘2’ buttons — they’re all worth trying and
comparing.) This may help you figure out which codec is required. If not, the Shark Codec pack is worth a try.

What’s with the audio?

NEXUS lets you choose which channels to play audio for. This is handy if multiple channels have identical audio
recorded, but are played back slightly out of sync. (If the filename specifies start time only down to the nearest second,
two files could easily play 0.9 seconds out of sync.) But it also gives you the power to disable audio from all channels,
or disable audio from all channels that have audio recorded on them.

Remedy: If you have too many channels playing audio, turn off audio for all but one using the Video pane’s Channels
menu button, or by clicking the speaker icon on each channel to mute/unmute. If you have no audio, ensure that audio
is turned on in the Video pane. Try unplugging and replugging your headset or external speakers if appropriate, as
sometimes this persuades Windows to route audio more correctly. Check volume controls under the Windows system
tray at bottom right of your screen. Play audio from some other piece of software (Windows Media Player, youtube,
etc.) to verify whether the problem is with the PC or with NEXUS.

Filename formats

Here are filename formats that NEXUS IC will parse:

• yyyy-mm-dd hhmmss - Channel Name.extension

• yyyy-mm-dd hhmmss - Channel Name - Ignored Text.extension

• yyyy-mm-dd hhmmss - Channel Name - [ROV Name].extension

• yyyy-mm-dd hhmmss - Channel Name - Optional Ignored Text[ROV Name]Optional Ignored Text.extension

• dd-mm-yyyy hhmmss - Channel Name.extension

• dd-mm-yyyy hhmmss - Channel Name - Ignored Text.extension

• dd-mm-yyyy hhmmss - Channel Name - [ROV Name].extension

• dd-mm-yyyy hhmmss - Channel Name - Optional Ignored Text[ROV Name]Optional Ignored Text.extension

VisualSoft style:

• yyyymmddhhmmss.extension

• yyyymmddhhmmss@Channel Name.extension

• Ignored Text_yyyymmddhhmmss.extension

• Ignored Text_yyyymmddhhmmss@Channel Name.extension
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The above formats may contain additional text or digits after the ‘ss’, which will be ignored.

• Recorded on yyyy-mm-dd at hhmmss with Channel Name.extension

PKT style:

• Ignored Text_yy-mm-dd_hh-mm-ss_z.extension

• Ignored Text_Channel Name~Ignored Text_yy-mm-dd_hh-mm-ss_z.extension

• Ignored Text~Ignored Text_Channel Name~Ignored Text_yy-mm-dd_hh-mm-ss_z.extension

In the above three formats, the ‘_z’ must be present, but ‘z’ represents a single character which will be ignored.

• Ignored Textyyyy-mm-dd hhmmssIgnored Text.extension

• Ignored Textyyyy-mm-dd_hhmmssIgnored Text.extension

• Ignored Textyyyy-mm-ddThhmmssIgnored Text.extension

• Ignored Textyyyy-mm-dd hhmmIgnored Text.extension

• Ignored Textyyyy-mm-dd_hhmmIgnored Text.extension

• Ignored Textyyyy-mm-ddThhmmIgnored Text.extension

ROV-first style:

• ROV Name_Optional Ignored Textdd-mm-yyyy hh-mm-ss.extension

• ROV Name_Optional Ignored Textyyyymmdd-hhmmss.extension

File name formats that do not include a channel name are assigned to the channel “Digital Video”.

The ROV Name, if present, must be enclosed in square brackets. Any “Ignored Text” above may contain such a ROV
Name.

The Video window allows playback of centrally stored video which is linked via datetime stamp from the currently
selected event.

Events with associated video are identified with a small play icon in the Event Listing window as shown here:
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Tip: If you are experiencing degradation of video quality due to frame dropouts caused by insufficient bandwidth,
then disable one or more channels.

6.21.2 Video Toolbar

• Play/Pause Starts playback at the current point in time. The video can be paused by pressing this button again.

• Play from Event Start time Plays video for the event selected in the Event Listing.

• Play from Event End time Plays video for the event selected in the Event Listing, starting at that event’s End
Clock.

• Auto Play The Auto Play toolbar button has two states, Up and Down. When Up, you will be required to click
on the Play Event or Play toolbar buttons to start video playback. When Down, then video playback will
automatically start when an event becomes active in the Event Listing.

• Leap Backwards Steps back in the video by the selected timeframe. Choose the timeframe from 1 second, 5
seconds, 10 seconds, 30 seconds, 1 minute or 5 minutes from the sub menu.

• Rewind Rewinds the video with preview using the selected speed. Choose the speed from -1 x, -1.5 x, -2 x,
-2.5 x, -3 x, -4 x and -8 x from the sub menu. Depending on how the video has been encoded, some speeds
may not be available. When the desired position is reached, the video can be played by pressing the Play
button. (You can also set fast forward/rewind speed by putting the mouse cursor over the video window
and using the mouse wheel.)
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• Fast Forward Fast forwards the video with preview using the selected speed. Choose the speed from 1.5 x, 2
x, 2.5 x, 3 x, 3.5 x, 4 x and 8 x from the sub menu. Depending on how the video has been encoded, some
speeds may not be available. When the desired position is reached, the video can be played by pressing
the Play button. (You can also set fast forward/rewind speed by putting the mouse cursor over the video
window and using the mouse wheel.)

• Leap Forward Steps forward in the video by the selected timeframe. Choose the timeframe from 1 second, 5
seconds, 10 seconds, 30 seconds, 1 minute or 5 minutes from the sub menu.

• Step Backward Steps backward in the video by one frame. Depending on how the video has been encoded, this
button may step the video back to the previous key frame, which might be several seconds back.

• Step Forward Steps forward in the video by one frame.

• Capture Image Captures an image from each of the playing video channels and attaches it/them to the currently
selected event as a multimedia item. Multimedia can be viewed from the Multimedia pane. Within the
Capture Image dialog, you can select/unselect and crop images. To crop, click the Crop button or Ctrl-X,
then click and drag a rectangle on the image. To complete the crop, click the button, or Crop To
Selection, or Ctrl-Shift-X.

• Channels Where multiple channels of video exist for a selected event, they will be listed in this sub menu. For
each channel you may enable/disable the Video and/or Audio. To disable the audio or video, uncheck the
video or audio from the sub menu. You can also enable/disable audio each channel’s audio by clicking the
speaker icon next to the audio level meter.

• Layout → Automatic This option will automatically size and position the channels (minimising unused space)
based on the size and proportions of the video pane.

Tip: Note that the Video pane can be undocked, resized and placed outside of the NEXUS application, on another
monitor for example.

• Layout → Horizontal The channels will be displayed horizontally by checking this option.

• Layout → Vertical The channels will be displayed vertically by checking this option.

• Layout → Square The channels will be displayed in square shape by checking this option.

• Configure → Show Thumbnails When Show Thumbnails is checked, hovering over the video trackbar will
show a Thumbnail grab of the video at that position.

• Configure → Show Statistics The statistics for each video will be displayed on the top left side of the video by
checking the Show Statistics.

• Configure → Use Time Videos This option affects what is shown on the Thumbnail when hovering over the
trackbar. When checked, the actual date and time of the video will be shown, when unchecked, the current
video position will be shown (in minutes).

Note: You can tell NEXUS IC where to look for video by setting Global Video Path and/or Temporary Video Path on
the Database Properties dialog. See also How does video playback work?
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CHAPTER

SEVEN

ANOMALIES

7.1 Anomaly Actions

An anomaly may have one or more anomaly actions associated with it. Anomaly actions can be assigned to individuals
or teams or departments and may have a “due by” date.

Anomaly actions are not necessarily inspection type actions (e.g. Confirm WT reading). The Anomaly actions func-
tionality can be used as a reminder to initiate a study with a vendor, or to have a discussion with an OIE about access.

7.1.1 Properties of an Anomaly Action

1. Anomaly - Is the name of the anomaly that this action belongs to. To change the anomaly that the action is

assigned to, click on the button to the right.

2. Name - A short (50 character limit) name for the anomaly action.
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3. Status - Optionally select a status for the anomaly action. This list is user-definable and you can add/edit/delete

statuses by clicking on the button on the right hand side of the Status input control.

4. Reference No. - Used to reference (or cross reference) number. The number may relate to a Work Order number
in your Planned Maintenance System.

5. Action Type - Choose from a list of pre-defined action types. Typical action types may include “[EVENT] -
UT Reading”, “[ENGINEERING ASSESSMENT]”, or “[TEMPORARY REPAIR]”, however this list is user-

definable and you can add/edit/delete action types by clicking on the button on the right hand side of the
Action Type input control.

6. Created At - Enter the date that the anomaly action is created. This will default to today’s date, but is editable
thereafter.

7. Created By - Select the name of the person creating the anomaly action. This will default to the currently
logged in user, but is changeable thereafter.

8. Action Before - Enter a date that the anomaly action should be completed by.

9. Assigned To - Select the name of an individual or department that is responsible for progressing or completing
the Anomaly Action.

10. Completed At - Enter the date that the anomaly action was completed. Please note that an anomaly action is
not deemed “completed” until there is a valid date entered in this field.

11. Percent Complete - Enter a value between 0 and 100. This is for reporting and information purposes only.

12. Comments - A large free text field to retain additional information about the Anomaly Action which may not
already be captured in the properties of the anomaly action.

13. Is Tasked? - This field shows whether this action has had a task assigned to it.

When you edit an anomaly action, you will also see Tasks and Planning Tasks associated with it. To link a task to an
an anomaly action, go to the Tasks tab on the WORKPACKS screen. Add or edit a task, and set its Anomaly Action to
match the desired anomaly action. Note that the task’s asset and the anomaly action’s asset must match.

7.1.2 Report Table Sources

To extract anomaly action data into a report template, use the System Table titled Action as the primary Table Source.
For more information see Report Templates.

7.1.3 The Grid

The Actions grid lists all anomaly actions for the currently selected anomaly (or anomalies).

7.1.4 The Actions Toolbar

Add, Edit, Delete: Add / Edit / Delete Anomaly Action(s).

Tip: To bulk update (or delete) Anomaly Actions, use the Multi-Edit functionality available from the Actions grid.

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.
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• Connections See Connections for information about the Connections toolbar option.

• Assign Task You can assign one or more tasks to an action of an anomaly. By clicking on this button the Select
Task dialog will be displayed, you can select the task from the existing tasks or you can add a new task.
(If you add a new task, it will have its Asset automatically populated from the anomaly.) The action must
have Action Type to be able to assign tasks.

7.2 Findings

The Findings pane displays the finding(s) linked to the selected anomaly (or anomalies).

A Finding is the link between an Anomaly and an inspection or survey event. Findings are either escalated and linked
to an Anomaly or deemed “insignificant” and remain simply as an observation on the source event.

Findings displayed in this screen have been “escalated” during the during the finding review process and linked to an
anomaly.

A finding record has a Number, a Code, a Severity ranking, Reason (descriptive text) and Remedial Action (descriptive
text). Upon review, if you deem that the Finding should be escalated to an Anomaly, then you should tick the Anomaly
Required field, and choose an Anomaly from the list and linked to the Finding. If you click the Add button on the
Select Anomaly dialog, the new anomaly will have the asset, code, and various other fields pre-populated for you.

7.2.1 Properties of a Finding

1. Number - Optional. For use by users to label Findings.

2. Event - The Event which this Finding is connected to.
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3. Code - Code which identifies the type of Finding. These are the same codes that are used to classify Anomalies.
Some typical codes may include “CD”, “PD” or “VIB” (Coating Damage, Physical Damage or Vibration);
however, anomaly codes are user-definable and can be configured from Configuration → Anomalies.

4. Severity - Choose from a list of pre-defined Severity Levels. Typical severity levels may include “Level 1 -
Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level 5 - Extreme Danger”;
however, severity levels are user-definable and can be configured from the Configuration → Anomalies area.
These are the same severities that are used to classify Anomalies. Anomaly severities can also be assigned to
Anomaly Triggers.

5. Reason - Text field. Size unlimited.

6. Remedial Action - Text field. Size unlimited.

7. Anomaly Required - Check this box if this Finding should be linked to an Anomaly.

8. Anomaly - Anomaly that this Finding is linked to. This field only appears if Anomaly Required is checked.

9. Anomaly Trigger - If this Finding was automatically generated by an Anomaly Trigger, that trigger is shown
here.

10. Is Auto Generated - True if this Finding was automatically generated by an Anomaly Trigger.

7.2.2 Report Table Sources

To extract Finding data into a report template, use the System Table titled Finding as the primary Table Source, or
use the System Tables titled Event or Anomaly and then add fields from the Finding table. For more information see
Report Templates.

7.2.3 The Grid

The Findings grid lists all findings based on the currently applied filters. Primary filtering options are:

• Workpack; and

• Event Type.

Filters are set and cleared using the Filter menu on the Findings toolbar.

Tip: Use the grid Grouping functionality to group and filter Finding records.

7.2.4 The Findings Toolbar

Refer to section Findings Toolbar for full description of the Findings Toolbar.

7.3 Library

This functionality is also available via the LIBRARY screen. Here on the Anomalies screen, you can view all the library
items attached to a particular anomaly.

Library Items are electronic documents which can be linked (via Connections) to data and data types in NEXUS IC.
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The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced via URL or
UNC paths.

Here are some examples of valid URL and UNC paths:

1. https://www.youtube.com/watch?v=oHg5SJYRHA0

2. \\example.com\groups\eng\this_doc.docx

Caution: Mapped drives - If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped for every other
potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use UNC paths for network drive
locations.

The Library functionality is available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. LIBRARY

3. INSPECTION

4. ANOMALIES

5. Configuration → General → Functions → Edit Function Definition

6. Configuration → Assets → Types

7. Configuration → Events → Event Types → Edit Table Information

Note: Example - Upload company Piping specifications to the NEXUS IC Library and assign to the Asset Type
“Pipework”. This will make the Piping Specifications available from the ASSETS | Library screen whenever the
active asset is of type “Pipework”.

7.3.1 Library Items Toolbar

The Library toolbar button allows the user to add, edit and delete Library Items.

• Add The Add menu item allows you to add a new Library item. Depending on what screen is active, the
Add drop down menu will provide connection type options. Enter the Name of the Library item and any
other relevant document information (Revision, Date, Document Reference etc). If the document is to be
uploaded into NEXUS IC, then click on the Attachment button, else enter a Hyperlink location.
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When adding an item, you can either Import or Link it. If you Import, the item will be brought into the
database. If you subsequently change the original on disk, the item in the database will not change to
match. If you Link the item, then when you change the original on disk, the next time you view the item
within NEXUS IC, you will see the updated item.

Note: NEXUS IC will still load a copy of a Linked item into the NEXUS database — this is so that if the
original is unavailable (for example, because you are away from your network), NEXUS IC can display
the cached copy. When you view the item, if the original has been updated, we also update the database
cached copy. You can’t Link items that are on your local hard disk — only items on network drives can
be Linked. The Link feature is designed to keep you up to date with items that may have been changed by
others, and that can’t happen on your local drive.

Hint: You can also add multimedia by dragging image files from Windows Explorer onto the Library
Items pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will
cancel the add. If you drag/drop multiple files, they will be added, and then multi-selected in the grid. You
can then click Edit to multi-edit them. Drag-drop will Import items, not Link them.

• Edit The Edit menu item allows you to edit the properties of the currently selected Library Item (not the
document itself).

• Delete Deletes the currently selected Library Item.

Note: Deleting a Library Item will delete all the connections of that Library Item.

• Launch Launches the Library item on the local machine. Note that by default NEXUS will only launch files
with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

Hint: Use the Space Bar on your keyboard to launch the currently selected Library item.

Note: If the local machine does not have an associated viewer for the document type (eg. AutoCad viewer
for DWG type), then the document can not be launched.

• Email Attachment This option will launch a new email message and attach the associated Library Item to it.
Note that Email account properties need to be set up for this option to function.

• Import
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See Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing Library Items.

You can also import the Connections in the same import as the Library items, so in addition to the
Library Import columns, you can additionally define the Connection information using the following
column headings:

– Library Connection.Connect To

– Library Connection.Workpack

– Library Connection.Asset Type

– Library Connection.Asset

– Library Connection.Event Type

– Library Connection.Event

– Library Connection.Anomaly

– Library Connection.Risk Model

– Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

– Anomaly

– Asset

– Asset Type

– Event

– Event Type

– Function

– Risk Model

– Workpack

• Export See Export for information about exporting Library Items. Please note that this option will only export
the contents of the grid, not the Library Items themselves.

• Customise See Customise for information about the Customise toolbar option.

• Connections See Connections for information about the Connections toolbar option.

Double-click

The first time you double-click on a library item, NEXUS will ask you what action to take: you can either Launch the
Library item in an external editor, or Edit the Library item. If you would like your choice to become permanent, tick
the “Always do this” box. Note that if you hold down the Alt key while double-clicking, you will be asked again.

7.4 Multimedia

Multimedia are electronic images which have been uploaded against any of the events which are linked to the currently
selected anomalies.

Multimedia items are displayed as thumbnails for the currently selected anomaly(s).
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Multimedia items are displayed as thumbnails for the currently selected anomaly or anomalies.

7.4.1 Multimedia Toolbar

Multimedia File Formats

GIF, JPG, JPEG, TIF, BMP, PNG, PDF, DWG, CGM, DXF, SVG, WMF or EMF are all allowed Multimedia file
types.

• Add Launches the Add Multimedia dialog to allow you to attach an image to the currently selected event.
Please note that if multiple events are selected, then the image being added will be attached to all events.

Note: You can also add multimedia by dragging image files from Windows Explorer onto the Multimedia pane.

Note: The Can Report property of the Multimedia item can be used to filter which images are output to the report.
(This column is invisible by default, but is available under Customise → Columns.)

• Edit Launches the Edit Multimedia dialog. Properties of the Multimedia can be updated and saved.

• Delete Delete will delete the currently selected multimedia record/s. If multiple Multimedia items have been
selected, then the Question dialog will give notice of how many Multimedia items will be deleted and
prompt you to confirm by clicking on the Delete button.

• Launch Launches the currently selected Multimedia file into the default Windows viewer for the selected file
type. (Note that if your image viewer supplies “Next” and “Previous” buttons, these will show you the
next and previous files in the temp folder, which may not be the next and previous images in NEXUS.)

118 Chapter 7. ANOMALIES



NEXUS Documentation, Release 6.6.xxxxx.0

• Preview Toggle display of preview. If this button is selected, then whichever image is focused in the grid will
be shown in a “preview” window. If EXIF data is available for the image, it will be displayed.

• Crop Crop the selected image. Within the Crop dialog, click the Crop button or Ctrl-X, then click and drag a
rectangle on the image. To complete the crop, click the button, or Crop To Selection, or Ctrl-Shift-X.

If you want to replace the existing image with the new cropped version, ensure Keep Original is not
selected. If you want the new cropped image to be added to the event’s collection of images without
overwriting the existing image, ensure Keep Original is selected.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

Anomalies are records which identify discrete items or areas of concern. An anomaly record may have been originated
from an inspection item (which means that it will have a finding linked to it) or it may be a stand alone record created
outwith the integrity and inspection cycle (ad-hoc).

Anomalies can be bulk imported from MS Excel or manually created from the Add Anomaly dialog.

7.5 Properties of an Anomaly

1. Asset - The name of the asset that the anomaly is attached to. This is a required field.

2. Name - A short (50 character limit) name for the Anomaly.
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3. Description - A 100 character field which provides more descriptive information of the anomaly.

4. Code - Code which identifies the type of anomaly. Some typical codes may include “CD”, “PD” or “VIB” (Coat-
ing Damage, Physical Damage or Vibration) however, anomaly codes are user-definable and can be configured
from Configuration → Anomalies.

5. Severity - Choose from a list of pre-defined Severity Levels. Typical severity levels may include “Level 1 -
Contributor”, “Level 2 - Degraded”, “Level 3 - Damaged”, “Level 4 - Danger” and “Level 5 - Extreme Dan-
ger” however, severity levels are user-definable and can be configured from the Configuration → Anomalies
area. Anomaly severities can also be assigned to Anomaly Triggers and will be pre-populated from the initial
automatically generated Finding, through to the anomaly that the finding is linked to.

6. Priority - Choose from a list of pre-defined Priorities. Typical priority levels may include “Very High”, “High”,
“Medium”, “Low” or “Very Low” however, the list of anomaly priorities are user-definable and can be config-
ured from the Configuration → Anomalies area.

7. Anomaly Number - A numerical property which can be used to store a number against the anomaly. This
number is not auto-populated.

8. Anomaly Set - Is an alternative option for grouping anomalies. A common grouping may include “Topside” and
“Subsea” however, Anomaly Sets are user-definable and can be configured from Configuration → Anomalies.

9. Reference Number - A 200 character limit field which can be used to reference (or cross reference) anomalies.

10. Date Created - The date the anomaly was first created. This will default to todays date, but is editable thereafter.

11. Created By - Name of the person creating the anomaly record. This will default to the currently logged in user,
but is editable thereafter.

12. Comments - A large free text field to retain additional information about the anomaly which may not be captured
in the properties of the anomaly.

13. Status - Status of the anomaly. Anomaly statuses are user-definable and can be configured from Configuration
→ Anomalies.

14. Closed Out - A check box which identifies whether of not the anomaly is Open or Closed. Closed anomalies
are normally excluded from anomaly statistical reporting.

15. Risk Score - This is a calculated field, the function assigned to this field is named “System - Anomaly - Risk
Score” and must be configured through the Functions. Different fields such as the “Severity” and “Priority” of
the anomaly can be used as the input parameters for the function.

7.6 Report Table Sources

To extract anomaly data into a report template, use the System Table titled Anomaly as the primary Table Source. For
more information on Report Templates see Report Templates.

7.7 The Grid

The anomalies grid lists all anomalies based on the currently applied filters. Primary filtering options are:

• Workpack; and

• Asset.

Filters are set and cleared using the Filter menu on the Anomalies toolbar.
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Tip: Use the grid Grouping functionality to group and filter anomaly records. It is a quick and easy way to drill down
to the anomalies that you are particularly interested in reviewing.

7.8 The Anomalies Toolbar

Add, Edit, Delete: Add / Edit / Delete anomaly(s).

Tip: To bulk update (or delete) anomalies, use the Multi-Edit functionality available from the anomalies grid.

• Import See Import for full description of the Import menu item.

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

• Anomaly → Close Anomaly Click this to close out the anomaly. You will be shown an Anomaly Action dialog.
This dialog lets you create an anomaly action saying why the anomaly was closed out, and by whom.

• Filter → No Filter Clears any currently applied anomaly filters.

• Filter → Workpack Allows you to filter the anomaly listing by one or more workpacks. Workpacks are linked
to anomalies via the linked findings and events.

• Filter → Asset Allows you to filter the anomaly listing by a user-selected sub-set of assets. Assets are linked to
anomalies by the Asset chosen in the Anomaly record itself AND by the linked findings and events.

• Reports See Reports for information about the Reports toolbar option.

7.9 Matrix

You can show anomalies on a risk matrix. This (when configured) is visible at the right or bottom right of the screen.

Each anomaly’s Risk Score is used to place it on the diagram. Note that anomalies do not have a Likelihood or
Consequence to give them an X/Y position on the diagram — they only have a Risk Score. So if your diagram has
several squares with the same Risk Score (as is usually the case), your anomalies will be placed in the left-most such
square. That is, risk-assessed assets are placed in a particular square, but anomalies are merely placed in a particular
band.

To make this matrix work, you will need to configure Database → Properties → Database → Anomaly Risk Chart.
You will also need to configure the “System - Anomaly - Risk Score” function.
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CHAPTER

EIGHT

IC-INSPECTION

8.1 Desktops

The IC-Inspection 6 “desktop” works in the same way as NEXUS IC’s Inspection screen: you can use the View button
to drop down a menu which lets you control what panels are visible, and you can drag panels around and “dock” them.

When you are dragging a window over an existing window, you will see a pale blue highlight and/or a set of icons:

If you drag the window over one of the icons, the pale blue highlight shows where the window will drop, and the new
size and shape it will take on. If you drop the window onto one of the icons, the window will dock appropriately:
dropping it onto the centre square icon will make this window part of the tab group; dropping it on the left, right, top
or bottom icons will split the current window and drop this window to the left, right, top or bottom of it.

If you drop a window outside the IC-Inspection main window, they will become “floating” windows.

As far as the “desktop manager” that lets you drag/drop these windows is concerned, the IC-Inspection main window
area starts as one large void. If you drop a window into the centre of that void, the dropped window fills the void, and
subsequent drops can split that window into parts. If you drop a window into the left, right, top or bottom of the void,
then the void is split, but the right, left, bottom or top will still contain the void.

You can resize windows with the “splitter” at each edge between two docked windows — when you move the mouse

over a splitter the mouse cursor will change to a or split arrow. Drag the splitter to resize the windows.

(The difference between floating and docked windows is that docked windows will resize together: when you drag
a splitter, one window will get bigger while another gets smaller. Thus, docked windows never overlap each other.
Typically most or all of your windows will be docked.)

You can close panels with the at their top right corner, or click on to “unpin” panels so that they collapse to
an edge of the IC-Inspection window. To recover an unpinned panel, click on the panel’s name at the edge of the
IC-Inspection window, then click on the icon.
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Three desktop layouts are automatically created for you: Structures, Pipelines, and Setup.

You can save and switch desktops: click the Add a new desktop with the current layout button to create an entry in
the list of desktops and save your current arrangement of panels into it; or click Save the active desktop to save your
current settings. Settings are not automatically saved when you close IC-Inspection — this is so that if you get into
a state you don’t know how to get out of, you can simply close and re-open. You can also choose a different desktop
from the Desktops menu to switch to it, and Delete the currently active desktop to delete it.

If you have two monitors, it may be useful to spread IC-Inspection across both, either by clicking the “Restore Down”
button at the top right of the window if necessary and then dragging the main application window larger, or by floating
windows such as Drawings and then dragging the floating windows onto the second monitor.

8.2 Inspections Toolbar

The Inspections toolbar allows the user to control IC-Inspection as a whole. Functionality specific to individual panes
may be found on those panes.

• Back The Back menu item allows you to return to assets that you had previously selected in the Assets tree.

• Forward The Forward menu item allows you to return to assets that you had previously selected in the Assets
tree, after you’ve used the Back button.

• Assets → Show Asset Type Toggles the display of the asset type in the hierarchy.

• Assets → Expand Children All children, grandchildren, etc. of the selected asset will be expanded. (You can
also press the * key on the numeric keypad.)

• Assets → Collapse Children All children, grandchildren, etc. of the selected asset will be collapsed.

• Assets → Copy to Clipboard Copies either the asset name or full hierarchy location of the selected asset to the
clipboard.

• Assets → Show on Drawing Shows a list of drawings that have this asset as a layer. Click on a menu item to
go to that drawing. If the drawing name has “(Different Asset)” after it, the drawing you will be taken to
is not available on the current asset; thus, when you select the menu option, you will not only be taken to
that layer on that drawing, you will also be navigated to the new asset. You can get back by using the Back
toolbar button.

• Assets → Other Locations Shows a list of other locations that this asset exists in on the asset tree (including
in other Asset Views). Click on a menu item to navigate there. If this asset does not appear in any other
locations, you will not see any items in this list.

• Assets → Connections See Connections for information about the Connections toolbar option.

• Asset Views See Asset Views for detailed information on the Asset Views toolbar option.

• Traffic Lighting See Traffic Lighting for detailed description of the Traffic Lighting toolbar option.

• View The remainder of the View menu lists the various panes available in IC-Inspection. Click a menu item to
check/uncheck it. Checked items are visible; unchecked items are not.

• Desktops If you have several saved desktop configurations for this screen, select which one is active here.

• Save Desktop If you have made changes to the currently selected desktop, click this to save them. Otherwise,
when you restart the application, your changes will be lost.

• Add Desktop You can add a new desktop layout here.

• Delete Desktop Delete the currently selected desktop from the list by clicking this.

• Restore Desktops Restores desktops to the factory defaults.
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8.3 Active Events

The Active Events panel displays all the events that have been launched but not recorded, called the “active” events,
and the data entry tabs for the currently selected active event. If more than one event is active (i.e. launched but not as
yet recorded), then you will see tabs on the left-hand side of the panel, with one one for each active event. Each tab has
the name of the event type it contains, but no event number — unsaved events do not yet have an event number. The
panel has tabs for event Details (with an area for a descriptive comment for the event), Survey information, Multimedia
and a manually created Finding (if present).

(The event shown above will generate a finding when the user clicks Save, because “Depletion (Numeric)” is anoma-
lous.)

8.3.1 Events Toolbar

• Save Commits the active event and associated data to the database. Once the event has been recorded (or saved),
then it will no longer appear in the Active Events panel.

• Save & New Saves the active event and associated data to the database and creates a new event of the same
event type. Note that they are two distinct events.

• Save & Hold Saves the active event and associated data to the database and creates a new task to represent the
outstanding work. Use this button when you have completed some but not all of the work represented by
a single task; e.g. you have inspected part of an asset but have stopped because of bad visibility, etc. Save
and Hold is only available on events that were launched from tasks, not on events that were launched ad
hoc from the Event Launcher.

• Cancel Cancels the active event without saving to the database.

• Navigate to Asset This menu item will change the active asset in the Asset hierarchy to the asset of the current
event. By navigating to a different asset in the hierarchy, this will also update the tasks shown in the task
list, the asset shown on the overlay, etc.

• Raise a Finding Launches the Findings tab in the Active Events panel.

• Capture Image Captures a snapshot from the incoming video signal and references it to the active event. Within
the Capture Image dialog, you can select/unselect and crop images. To crop, click the Crop button or Ctrl-
X, then click and drag a rectangle on the image. To complete the crop, click the button, or Crop To
Selection, or Ctrl-Shift-X.
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• Bookmark Creates a bookmark on the current event as a reference for the data reviewer.

• Update Start Updates the start survey information of the active event with the survey data gathered at the time
of the button click.

• Pause End Pauses the end survey information of the active event. By default, the end survey information is
updated whilst the event is visible in the Active Events panel and is updated by incoming serial survey
information whilst the event is active.

8.3.2 Adding an Event

There are several ways to add an Event for editing in the Active Events panel:

• Event Launcher - Click on the required event type to launch in the Active Events panel.

• Event Launcher - Click a pre-defined Event Template to launch it.

• Click on the Save and New toolbar button in the Active Events panel. This will save the active event to the
database and launch a new event of the same type.

• Drawings panel - Using a Task button on the Drawings panel.

• Tasks panel - Double-click the task in the Task grid or click the Launch toolbar button to launch the selected
task.

• Tasks panel - Click the Launch Template drop-down and choose the event template you want to launch this
event with.

8.3.3 Creating a Finding

To create a Finding for the active event, click Raise a Finding in the Active Events panel. This will activate the
Findings tabbed page in the Active Events panel. Enter the Description and Remedial Action/s and choose an anomaly
code from the Code dropdown list.

Only one finding can be manually created for an event. Multiple findings can be created automatically by Anomaly

Triggers. If you see a yellow exclamation mark ( ) next to one or more fields in your event form, this is because one
or more anomaly triggers have been violated, and a finding will be automatically created for each.

8.3.4 Completing a Task

If this event is launched from a task it will have a “Task” section at the top of the event form with a Complete Task
checkbox. If this checkbox is left ticked, then when you save the event, the task will be completed. If this event is not
launched from a task, but matches an existing task, you will again see the “Task” section. Tick the checkbox if you
would like to use this event to complete the task. If there are multiple tasks that this event could complete, you will
instead see a Select Tasks button which will let you pick which task(s) to complete.

8.4 Active Inspection

The Active Inspection panel displays the active (currently selected) IC-Inspection entities. Once set up, the selections
are remembered from session to session, via the logged-in user ID. (If you log out and log in a s a different user, that
user may have different settings.) When you view data from any area of IC-Inspection, the data typically relates to the
active entities displayed in the Active Inspection panel.
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When you enter new data, the data is typically recorded against the active entities displayed in the Active Inspection
panel, as appropriate for the particular entity. For example, if you launch an event, the event’s Workpack will be the
one selected here, and the event’s Survey Set will be the one selected here (if any).

8.4.1 Functionality

• Asset - displays the currently selected asset.

• Workpack – click the Workpack ellipsis and select a workpack from the list.

• Survey Set - click the Survey Set ellipsis and select a survey set from the list. If you attempt to start inspections
from two different copies of IC-Inspection on the same Survey Set simultaneously, you will receive an error:
“Another session is open with the same survey set selected.” Doing this is forbidden because both IC-Inspections
would be writing to the same survey set simultaneously, meaning that it would be impossible after the fact to
associate events with correct survey data.

• ROV - clicking the ellipsis on this field will take you to the same picker as the Survey Set ellipsis. ROV is shown
here to make it clear to inspectors what ROV their video is being recorded against.

• Event Template Group - click the Event Template Group ellipsis and select an Event Template Group from the
list.

8.4.2 Warning

If you have two copies of IC-Inspection open, and both have the same survey set selected, you will see a warning
dialog. The risk here is that if two ROVs are simultaneously writing to the same survey set, but those ROVs are at
different points in space, the survey set will contain a hard-to-untangle mess of both locations interleaved. In this
instance, you need to move (at least) one of the IC-Inspection instances to log to a different survey set. This means
that after the fact, in track reposition etc., even two events logged at the exact same time can be given correct survey
data, because each is given data from the appropriate survey set. To keep things maximally clear, fill out the ROV
value in each survey set you’re using concurrently, so that reviewers can clearly understand what is intended to connect
to what.

8.5 Anomaly Triggers

The Anomaly Triggers panel shows anomaly triggers assigned to the current asset. It may also show a preview chart,
showing which triggers apply at which KPs or depths.
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This panel only shows asset-specific anomaly triggers — it does not show triggers which may apply to event fields
independent of asset. For example, if your Anode event is set to always raise a finding when its Depletion is greater
than 75%, that would not be shown in this panel.

Anomaly triggers are pre-defined upper and lower bounds which are applied to event information. When the bounds
are exceeded, IC-Inspection automatically creates a Finding on the event.

When an anomaly trigger is violated, a yellow exclamation mark ( ) will appear next to the field. You can set
lower/upper bounds to be constant values (so a field might trigger if it was outside, say, 1 to 9) or to pull from a field,
on this form or on another form. So for example if this field is Measured Wall Thickness, it might trigger if its value
is less than Minimum Allowable Wall Thickness.

For Lookup List fields, the comparison is done of the lookup list item’s Value, not its Comment. So if you have a
lookup list titled “Anode Depletion”, and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS
will use the “25” for purposes of determining whether an anomaly trigger should be fired.

For Yes/No fields you can set the trigger to fire on any combination of Yes, No or blank; but you can’t compare to
another field.

The Include Boundary tickbox controls whether exact matches cause the trigger to fire: if you have set a trigger
to “Fail when inside Upper/Lower bounds”, your lower bound is 1 and your upper bound is 9, this is the difference
between “1 < x < 9” and “1 <= x <= 9”.

You can optionally give an anomaly trigger a date range. If you set just a Date From, the trigger will apply only to
event data from that date forward. If you set just a Date To, the trigger will apply only to event data from that date or
earlier. If you set both, the trigger will apply only to event data within the specified range. In this way, you can change
triggers to reflect new conditions, without causing spurious warnings on historical data. For example, if you decrease
the operating pressure of an asset, this might decrease the minimum allowable wall thickness. Rather than editing the
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existing anomaly trigger, you can set a “To” date on that old trigger, and add a new trigger with a “From” date.

Caution: In most cases, Findings are generated at the time events are added or imported. There are however some
scenarios in which the Anomaly Triggers utility should be run manually. These are 1) whenever anomaly triggers
are edited; 2) when anomaly triggers exist on a calculation field; 3) before any Finding review sessions; or 4) after
a bulk import of event data (particularly when anomaly triggers rely on events other than itself).

Triggers for a field independent of asset are found in NEXUS IC in Asset Information and Event Types. Anomaly
triggers for specific assets can be configured in NEXUS IC by right-clicking on an asset and choosing Anomaly
Triggers. . . . If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply. Note that asset-specific anomaly triggers are specific to their asset — they do not automatically
apply to an asset’s children.

A trigger can have an anomaly Code and a Severity, and you can have several different triggers on a single field, with
different codes and/or severities. The dialog may also show a preview chart, showing which triggers apply at which
KPs or depths.

8.6 Assets

Central to both IC-Inspection and NEXUS IC application is the Asset register. Most all information retained in NEXUS
IC is linked back to an asset in the asset hierarchy, including inspection data.

In the Asset Tree panel, you can see assets in a hierarchical tree view. Each asset is also assigned an Asset Type.

The Asset Type determines what Asset Information Groups are visible for that asset and also what Event Definitions
are allowable for that asset (see Asset Types for more detail on configuring Asset Types).

When you select an asset in the asset tree, it affects other panels. For example, it controls what buttons are enabled in
the Event Launcher, what tasks are shown in the Tasks panel, what drawings are shown in the Drawings panel, etc.

The toolbar at the top of the IC-Inspection window has several items relevant to the Asset Tree panel: the Previous
Asset button returns you to the asset that was selected before your currently selected asset, and the Previous Asset and
Next Asset buttons and menus in general work the same way as back/forward buttons and menus in a web browser.
The Assets menu lets you select Asset Views and Traffic Lighting. It also lets you control whether the Asset Type
column is visible.

8.7 Asset Information

The Asset Information panel shows asset-specific information for the currently selected asset.

Different Asset Information forms are relevant to different Asset Types. (You can configure the relationship between
Asset Information forms and Asset Types in NEXUS IC under Tools → Configuration.)

At the left are “sideways” tabs: one for each asset information Category relevant to this asset type. When you click
on one of these Category tabs, you will be shown tabs across the top of the form, one for each Asset Information
form in this Category that are relevant to this Asset Type. When you click on an Asset Information form tab, you will
be shown that Asset Information form. (Some forms may take a moment to display, depending upon the amount of
calculation that must be done.)

If you make changes, Commit and Cancel will become enabled, and you can use these to save or discard your
changes. (If you select a different asset without clicking Commit or Cancel, your changes will be committed.)
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8.7.1 Ordering forms

To change the order of the Asset Information forms, simply click, drag and drop the Asset Information tab title to a
different location.

For more details on Asset Information forms and fields, see the NEXUS IC documentation.

8.8 Charts

The Charts window will list all of the Chart Templates that are appropriate for the inspection data shown in the Event
Listing window. If you don’t see any charts listed, try different types of events, by changing asset or by changing your
filters. Charts will only show event data included in your filters (workpacks, event types, column-specific filters, etc).
If your Chart Template is on Continuous Event data (such as cross-profiles), ensure that you select that Continuous
Event in your event type filter.

To expand/collapse each chart, click the button at the top right of that chart, or click the chart’s grey header row.

If a chart is misconfigured, you will see a message explaining this in place of the chart. Go to Chart Templates to
resolve the described problem.

Charts are generated from Chart Templates. For details on setting these up, see Chart Templates.

Available charts will be listed alphabetically. The first chart will be automatically expanded.

Events with Findings will be shown on the chart in red.

For some Chart Templates, at the right or the bottom of the chart is the chart legend. If you hover the mouse over an
item on the legend, other series on the chart will fade out temporarily. If you click an item on the legend, that series
will be toggled on/off. If you export the chart (see below), only series currently visible will be exported.

8.8.1 Chart Width

When the Charts pane is 1000 pixels wide or less, all charts are shown at the full width of the chart pane. When the
Charts pane is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit
more charts side-by-side onto your screen.

Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full
width. Of course, you can adjust the width of all charts by adjusting the width of the whole application window,
adjusting other elements such as the asset tree wider/narrower, etc.

8.8.2 Zooming

At the bottom of most Chart Templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.
You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all
charts support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.
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8.8.3 Charts Toolbar

There is no toolbar for the whole Charts panel. Instead, each chart has its own toolbar.

• Zoom In Zoom in.

• Zoom Out Zoom out.

• Reset Zoom Resets to default zoom level.

• Export the chart to image(s) Click this button to open the Export dialog. Ensure the range you want is set
correctly using the Zoom Bar. Ensure the series you want to export are visible. If you would like to export
the chart as a series of images, each covering a smaller horizontal range, enter the range you would like
each chart to cover in the Range of X Axis per image field. For example, if you have a 300km pipeline
and you enter “10” as the range per image, it will be broken into 30 images, each covering 10km.

• Copy the chart to the clipboard Copies the chart, as you see it displayed, without the “zoom” section at the
bottom, to the clipboard.

• Toggle chart Expand/collapse display of this chart.

There are also several buttons specific to the Pipeline View chart:

• Track the current KP This button is only available in IC-Inspection. When selected, the pipeline view will
move in time with the KP value coming in from survey. For NEXUS IC, see Time Source → Synchronise
KP on the Inspections Toolbar.

• Exaggerate the scale to show more of the pipeline When selected, will distort the scale of the pipeline to make
a greater KP range visible.

• Toggle stacked series mode When selected, will move events above the pipeline to make them more obvious.
Different events will be moved up different distances so that all are easily distinguishable.

• Toggle 3D perspective mode When unselected, you will see the pipeline viewed from the side. When selected,
you will see the pipeline viewed from above and slightly off to one side.

Tip: Click on the chart area and then, with the mouse cursor still inside the chart area, use your mouse wheel to
increase/decrease the chart scale for export.
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8.8.4 Report Table Sources

To extract chart template data into a report template, use a Chart Template element in the report, and use the appropriate
Asset table or Event table as a source. For more information see Report Templates.

8.9 Devices

The Devices panel allows you to manage:

• Incoming serial data;

• Control of DVRs.

8.9.1 Toolbar

• Add Add a DVR or survey device.

• Edit Edit the selected device. If the device has Diagnostics information available, you can view it here.

• Delete Delete the selected device.

• Enabled Disbale/enable the selected device. When the selected device is enabled, this button will be in the
“down” state.

• Text Overlays Edit IC-Recorder Text Overlays.

• View → Legend Use this to show/hide the legend at the bottom of the grid.

• View → Diagnostics If selected, you will see a diagnostics pane appear in the bottom of the Devices panel. The
Diagnostics pane will show details relevant to the device selected in the list.

• View → Capture Preview If selected, and the device selected in the list is capable of showing still images (e.g.
it’s a DVR), you will see a preview of those still images here. You can specify a capture interval, and
IC-Inspection will request an image from the device every time that interval elapses.

• Customise The usual.

These survey devices are exactly analogous to their equivalents in IC-Inspection 5 — it’s the same code at heart.

8.9.2 Adding a Custom Survey device

In the Add New Device wizard, choose Survey Device, then choose Custom Survey. Choose a COM port as input.
Under Properties, 9600 8N1 are industry-standard, though you should check them with whoever is supplying the
survey string to you.

String Format

The following string formats are supported by IC-Inspection:

• Character Delimited Each unique survey field in the incoming Survey string is separated by a character delim-
iter (usually a comma), and each survey field is defined by its index in the Survey String.

• Position and Length Each survey field has a fixed length. If the survey field is less than this defined length, it
may be padded with either zeros or spaces as appropriate.

• Identifier and Length The start of each survey field is defined by an identifier, and the end of the survey field
is defined by its length. Again, the field may be padded with zeros or spaces as appropriate.
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• Identifier and Delimited The start of each survey field is defined by an identifier, and a character delimiter
(usually a comma) separates each data field.

• Pre/Post Identifier and Delimited The start and end of each survey field is defined by an identifier, and a char-
acter delimiter (usually a comma) separates each survey field. Identifier and Delimited is the most common
format for an incoming Survey string. If this format is used, then in a noisy signal environment, IC- In-
spection will still be able to correctly identify data even if only a partial string was received.

Delimiter should be set to match whatever is coming down the survey string. Comma (,) is the most common.

End of Line Signal should be set to be compatible with whatever is coming down the survey string. Enter ASCII
control characters by typing a number prefixed with a #, so carriage return is #13, line feed is #10, and carriage
return followed by line feed (the most common case) is #13#10.

Survey Fields

Add Survey Fields to reflect the parts of the incoming survey string you’re interested in. Exactly what you can
configure for each field depends on the String Format selected, but they all have Name, Type and Unit. If Type is
Numeric, you can select a Unit for this field. For example, if the survey string is sending you Depth in feet, select the
unit to be Feet. In NEXUS IC’s Configuration → Events → Event Types, find your “Survey - Standard” form, edit the
Depth field, and ensure that its Unit is set to Metres. Now IC-Inspection will convert the incoming depth from feet
to metres before logging it in the database. Similarly if the survey string is sending you Heading in hundredths of a
degree or whatever, you can use Units to convert.

8.9.3 Adding a Survey Out device

The Survey Out device lets you send survey data out a serial port, for downstream consumption by another system.

In the Add New Device wizard, choose Survey Device, then choose Survey out. Choose a COM port for output.
On the Survey tab, make selections appropriate to what your downstream device is expecting. If you check Include
Identifiers, data will be sent with identifiers prepended, like “DateTime=01/01/2001 12:34:56, Depth=100”. Include
null values controls what happens if some fields are null: do you want several separators in a row in this case, e.g.
“1„3”? Null value replacement is for downstream devices that cannot cope with this case, so you can have the null
field replaced with the value of your choice (“0”, “ ”, etc).

Uncheck fields you don’t want sent. Use Move Up and Move Down to rearrange fields to suit the downstream device.

Date and Time format come from Windows settings — to change them, go to Windows’ Region and Language control
panel.

8.9.4 Adding an IC-Recorder device

In the Add New Device wizard, choose Video Device, then choose IC-Recorder.

If you’re adding several IC-Recorders, you should give each one a different Display Name so that you can tell them
apart.

If you have several instances of IC-Recorder running on one PC, they will each have a different port number. By
default, the first run will have port 4500; the second, port 4501; and so on. You can change this in IC-Recorder’s Tools
→ Options → Advanced.

If IC-Recorder’s title bar doesn’t say “Connected”, then on the toolbar click Enabled twice, to disable then re-enable
the device. This forces a fresh attempt at connection.

When you click Start to start an inspection, all Video Devices will attempt to start recording. While the Video Devices
are in the process of starting recording, you will see a progress dialog. If this dialog persists for more than a couple of
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seconds, this may indicate a problem with one or more of your Video Devices. Check the status of each device, both
here in IC-Inspection, and on IC-Recorder’s own window (which may be on a different PC). When you click Stop to
stop the inspection again, all Video Devices will attempt to stop recording.

8.9.5 Adding a third-party DVR device

In the Add New Device wizard, choose Video Device, then choose Generic Video Recorder. Any device that has
implemented our standard DVR control protocol is supported. Supported devices are listed here.

8.9.6 Text Overlays

If you are using IC-Recorder to record video with overlay, you can configure the overlay using either the Text Overlays
button here in IC-Inspection, or by using a similar button in IC-Recorder. But the IC-Recorder button is only intended
for IC-Recorder stand-alone, so you should use the button here in IC-Inspection. The reason is that when you have
multiple recorders, you generally want the same overlay on each (except for channel name). Configuring here in
IC-Inspection lets you do the configuration once and have it sent to all the recorders. (If a recorder is not currently
connected, it will receive the configuration when next it is connected.) To do this:

Click Add, or select a Client overlay and click Edit, and you’ll see the Edit Overlay dialog. If you’ve just added a new
overlay, you’ll need to fill in the Overlay Name field before you can click Save.

Drag the window larger to make the black overlay region larger. It doesn’t need to match the actual size of your video
feed, but it’s convenient for you if you drag it to approximately the same shape.

You can drag fields from the tree at the left onto the black overlay layout region. If the field you want is not shown in
the list, ensure that the appropriate survey field is configured and has a value.

Once you have dragged on your first field, you may wish to set its colour, font, size, etc., because additional fields you
drag in will “inherit” their settings from the previous field you dragged in.

Once fields are on the overlay, you can “lasso” several fields by click-dragging a box around them, or you can click
a single field to select it. You can use the toolbar buttons at the top of the dialog to act on all selected fields at once
(to “nudge” them around the screen, align them in a tidy fashion with respect to each other, change their font size, or
delete them). You can also use the list at the bottom of the screen to modify individual fields.

To put prefix text on a field (e.g. “Depth: “, etc.) edit its “Region Text”. You generally want a trailing space, so as to
separate the caption from the text coming in from IC-Inspection. Short captions are often best — “E: ” for Easting,
etc.

If you drag in an “Image” region, you will immediately be shown a file dialog, so that you can choose an image file
for this region. If you choose a .PNG file, then the transparency in that file will be honoured: where the PNG is partly
or wholly transparent, you will see the video through the image. You can drag on more than one image region if you
so desire.

Note that the “Top” and “Left” shown in this list are for the current size of the preview shown here in the Edit
Overlay window, not for the actual size of your captured video feed (so as you resize the window, you’ll see these
values change). This is because the overlay editor does not depend on the dimensions of the video you are currently
capturing. Font size, however, is in the dimensions of your video: a 10-point font on a 576-pixel high SD video will
fill about 1/57th of the height of the image and will likely seem about right, whereas this would be too small on a
1080-pixel high HD feed.

If you untick the “transparent” option for one or more fields, those fields will be shown with a solid background
rectangle of the colour you select. If you tick the “transparent” box, the text will be shown without a solid background
rectangle. This conceals less of the video, but may be less clear on some colours of video. Note also the “Show overlay
text shadow” option under Tools → Options → Advanced — ticking this works well with transparent-background
fields, because it places a dark border around light text, or a light border around dark text, thus making text more
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legible if the underlying video colour is similar to the text colour. This option does consume a bit more CPU power,
so if your CPU is near 100% during recording, try unticking this option.

If you are using a Marshall Encoder rather than system hardware, some overlay configuration options are ignored
because the Marshall Encoder does not support them. Text, prefix, suffix, source, top, left, font size, and font colour
are all supported, but font (Courier, Arial, etc.) is not. Additionally, the Marshall Encoder supports at most 16 overlaid
fields.

Once you’ve OK’ed out of that chain of dialogs, you should see survey values updating in real-time on your recorders.

8.10 Drawings

Drawings are essentially Library records where the Library Type has the “Show as Drawings” flag checked.

“Layers” can be added to drawings. These let you use drawings for navigation and data overlay.

Layers are marked up regions on the drawing which can be linked to assets in the asset hierarchy.

For more on adding and editing drawings and layers, see the NEXUS IC documentation.

An extra item available only in IC-Inspection is the Colour → Tasks option. This shows layers on drawings in colours
dependent on the tasks remaining on each layers’ asset:

• red for an asset with tasks, none of which are completed;

• orange for an asset with tasks, some of which are completed;

• green for an asset with tasks, all of which are completed;

• grey for an asset with no tasks.

This is dependent on the workpack selected in Active Inspection.

When you click on a layer, you will get a pop-up menu that lets you navigate to that asset or its child assets that have
tasks, or launch tasks on that asset or its children.

8.11 Event Launcher

The Event Launcher panel allows you to launch ad-hoc events. (If there is a task for your event, you can also launch
the event via the Tasks panel.)

Each event in your database is shown as a square button. Buttons are sorted by category. (You can set event categories
in NEXUS IC, under Configuration.)

Each Event Template in your database is also shown as a button. Note that to make events from your template group
available for launching, you must select your event template group in the Active Inspection window.

If you are not inspecting, all buttons on the Event Launcher panel are disabled.

Once you click the Start button, buttons for event types that are available on the currently selected asset type will be
enabled. (Again, you can set which event types are available on each asset type in NEXUS IC, under Configuration.)

To launch an event, simply click the corresponding button. Clicking on an event template button will carry out the
action(s) associated with that event template: filling in fields, capturing still images, etc.

Events appear in the launcher grouped by category and ordered alphabetically.
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8.12 Event Listing

The Event Listing panel allows you to view existing events in the current workpack (as selected in the Database
Information panel), and if desired edit those events.

Note that there is a right-click menu allowing you to edit, navigate to the event asset, update start, update end, toggle
bookmark, or delete.

The Event Listing Historical panel lets you view existing events, but also lets you select workpack(s) to view events
from. You cannot edit events from Event Listing Historical.

The Event Listing grid lists all events based on the currently applied filters. Primary filters are:

• Asset;

• Workpack; and

• Event Type

The number of events in the grid (based on the current filters) is displayed in the Event Listing window title.

Tip: If the Child Assets toolbar button is not in the “Down” state, then only events recorded on the selected asset
will be shown (e.g. events on child assets will not be listed).

Finding Column

There is significance to the colours in the Finding column.

• Yellow - the finding needs to be reviewed;

• Green - the finding has been deemed insignificant and is not linked to an anomaly.

• Grey - the finding is linked to a closed anomaly;

• Red - The finding is linked to an open anomaly;

• White - there are no findings on this event.

8.12.1 The Grid

By default, the Event Listing grid displays columns which are common to all event types. The first six columns in the
Event Listings grid represent:

1. F = The presence or absence of a Finding for this event.

2. B = The presence or absence of a Bookmark for this event

3. L = The presence or absence of a Library Item for this event

4. V = The presence or absence of Video for the event recorded at this date/time.

5. M = The presence or absence of Multimedia for this event

6. C = The presence or absence of Reviewer comments for this event

Tip: All columns listed above can be filtered and sorted. Each column has a filter icon which appears by hovering
over the column header, for example the F column, by clicking on the filter, a drop down with a list of relevant items
will appear that can be used to filter the events by that item in that column. By pressing on the column header, for
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example F, the events will be sorted in ascending order based on the findings, i.e all the events with findings will be
listed at the bottom of the list, by clicking on the header for another time, the events will be sorted in descending order
based on the findings, i.e all the events with findings will be listed at the top of the list. A small arrow (either up or
down) on the column header shows this functionality.

Right clicking on any of the events in the Event Listing grid will pop up the Events menu.

Hint:

To bulk update (or delete) events, use the Multi-Edit functionality. If you’re deleting only a few events, simply multi-select them and hit the Delete toolbar button. Otherwise:

• Go to the WORKPACKS screen and create a workpack called DeleteMe.

• Return to the INSPECTION screen, multi-select the events you wish to delete, and in the Event Details

pane, click Survey, click the ellipsis button on Workpack, and set it to DeleteMe.

• Go to the Workpacks screen again.

• Database → Close, then Database → Reopen or Database → Connect. . . to clear those events from
NEXUS IC’s cache.

• Now delete the DeleteMe workpack.

Tip: The Event Listing grid performs a check whenever the filtered data set is updated, when it detects there are only
events of a single event type, the properties of that event (the event data) will be displayed as additional columns in
the Event Listing grid.

8.12.2 Event Listing Toolbar

• Edit Allow editing of the selected event(s). This sends the event to the Active Events window. If inspection is
in progress, you will be able to Update Start and un-Pause End.

• Delete Deletes the currently selected event. Where multiple events are selected, the Delete menu item will
delete all selected events.

• Filter → By Workpack . . . From the Select Workpacks dialog, check which Workpacks to include in the filter.

• Filter → By Event Type . . . From the Select Table Definitions dialog, check which Event Types to include in
the filter. If you have no Event Types selected, then all Events will be shown, and no Continuous events
will be shown. To view Continuous events, you must explicitly select those event type(s) in the filter.

• Child Assets When in the Down state, events for the currently selected asset and all sub-assets will be included
in the Event Listing. When in the Up state, only events that have been recorded on the currently selected
asset will appear in the Event Listing.

• Events → Navigate to the event asset Will change focus in the Asset Hierarchy to the asset on which this event
has been recorded. To change back, click on the back arrow in the Assets toolbar (see Assets Toolbar).

• Events → Update Start Will change the start time of the currently selected event to the time displayed in the
Time Source control in the Assets toolbar.

• Events → Update End Will change the end time of the currently selected event to the time displayed in the
Time Source control in the Assets toolbar.
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• Events → Toggle Bookmark Bookmarks are simply flags on an event. Bookmarked events are identified by a
green star symbol in column 3 of the Event Listing grid. The use of bookmarks and the workflow around
setting and removing bookmarks will differ for each client.

• Export See Export for full description of the Summary Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections.

• Details Toggles visibility of the event details panel.

8.13 Event Templates

The Event Templates panel (or One-Click Eventing) displays a list of Events, which, when launched or recorded,
are populated with pre-defined values. Various keyboard keys and/or key combinations (F2-F12; shift-, alt- or ctrl-
F1-F12, alt- A-Z, ctrl-alt- A-Z, etc.) can be programmed to Launch or Record user defined Events. Event Templates
are grouped into Event Template Groups.

Event Templates created here appear in the Event Launcher

The Event Templates panel is divided in three parts: the list of Event Template Groups; the list of Event Templates
within the selected group(s); and the form for the selected template(s).

You can add different event template groups for different inspectors (“Alice’s Templates”, “Bob’s Templates”, etc.) or
for different inspection types (“Structures Templates”, “Pipeline Templates”, etc.), or for whatever suits your situation.

You can add as many or as few events to each group as you like. You can add multiple events of the same event type.
You can fill in as many or as few fields on each event form as you like.

The form for a specific event template shown at the right of the panel is read-only — to edit, double-click the template
(or select the template and click Edit). When editing an event template, you can specify the Action you would like
to occur when this event template is invoked: launch the event, launch the event and grab a still image from each
connected DVR, or launch and instantly save the event. You can also specify the shortcut key: either drop down the
Shortcut Key box and choose a function key, or click on the Shortcut Key box to give it focus and then press the
desired key combination.

To launch an event template, go to the Event Launcher and click the corresponding button, or press the key or key
combination associated with the event template.

Try to place key information near the start of the Event Template name, so it’s easily visible in the Event Launcher
button.

8.14 Heading

The Heading panel is a graphical representation of the serial data being collected in the Heading field (which usually
represents ROV heading). This allows you to tell at a glance which compass direction is left of the ROV, and which
is to the right (which is useful when commentating pipeline inspections), and which face of a structure you are likely
looking at (which is useful when you are commentating structure inspections).

It can be viewed in two modes:

• North up - The yellow heading indicator will move, keeping north at the top of the panel.

• Heading up – The yellow heading indicator will remain stationary at the top of the panel with the compass points
rotating accordingly.
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To switch between North up and Heading up modes, right click in the white space anywhere in the Heading panel and
choose the mode from the drop down menu.

8.15 Library

The Library panel shows all the library items for the current asset.

Library Items are electronic documents which can be linked (via Connections) to data and data types in NEXUS IC.

The electronic documents can be uploaded directly into the NEXUS IC database, or can be referenced via URL or
UNC paths.

Here are some examples of valid URL and UNC paths:

1. https://www.youtube.com/watch?v=oHg5SJYRHA0

2. \\example.com\groups\eng\this_doc.docx

Caution: Mapped drives - If you define a mapped drive as a hyperlink location (for example
H:\Working\document.docx, then you must be certain that the drive letter H:\ is mapped for every other
potential NEXUS IC user. In lieu of mapped drives, it is recommended that you use UNC paths for network drive
locations.

The Library functionality is available from multiple screens and dialogs in NEXUS IC including:

1. ASSETS

2. LIBRARY

3. INSPECTION

4. ANOMALIES

5. Configuration → General → Functions → Edit Function Definition

6. Configuration → Assets → Types

7. Configuration → Events → Event Types → Edit Table Information

Note: Example - Upload company Piping specifications to the NEXUS IC Library and assign to the Asset Type
“Pipework”. This will make the Piping Specifications available from the ASSETS | Library screen whenever the
active asset is of type “Pipework”.

8.15.1 Library Items Toolbar

The Library toolbar button allows the user to add, edit and delete Library Items.
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• Add The Add menu item allows you to add a new Library item. Depending on what screen is active, the
Add drop down menu will provide connection type options. Enter the Name of the Library item and any
other relevant document information (Revision, Date, Document Reference etc). If the document is to be
uploaded into NEXUS IC, then click on the Attachment button, else enter a Hyperlink location.

When adding an item, you can either Import or Link it. If you Import, the item will be brought into the
database. If you subsequently change the original on disk, the item in the database will not change to
match. If you Link the item, then when you change the original on disk, the next time you view the item
within NEXUS IC, you will see the updated item.

Note: NEXUS IC will still load a copy of a Linked item into the NEXUS database — this is so that if the
original is unavailable (for example, because you are away from your network), NEXUS IC can display
the cached copy. When you view the item, if the original has been updated, we also update the database
cached copy. You can’t Link items that are on your local hard disk — only items on network drives can
be Linked. The Link feature is designed to keep you up to date with items that may have been changed by
others, and that can’t happen on your local drive.

Hint: You can also add multimedia by dragging image files from Windows Explorer onto the Library
Items pane. If you drag/drop one file, you will be given the Add Library dialog, and clicking Cancel will
cancel the add. If you drag/drop multiple files, they will be added, and then multi-selected in the grid. You
can then click Edit to multi-edit them. Drag-drop will Import items, not Link them.

• Edit The Edit menu item allows you to edit the properties of the currently selected Library Item (not the
document itself).

• Delete Deletes the currently selected Library Item.

Note: Deleting a Library Item will delete all the connections of that Library Item.

• Launch Launches the Library item on the local machine. Note that by default NEXUS will only launch files
with the following extensions: doc, docx, xls, xlsx, jpg, png, jpeg, bmp, tiff, gif, mpg, mp3, wav, ppt, pptx,
txt, pdf, emf, zip, dwg, avi, rtf, mp4, csv.

Hint: Use the Space Bar on your keyboard to launch the currently selected Library item.

Note: If the local machine does not have an associated viewer for the document type (eg. AutoCad viewer
for DWG type), then the document can not be launched.
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• Email Attachment This option will launch a new email message and attach the associated Library Item to it.
Note that Email account properties need to be set up for this option to function.

• Import

See Import for detailed information on the Import Wizard. The MS Excel Import Template details
the required format for importing Library Items.

You can also import the Connections in the same import as the Library items, so in addition to the
Library Import columns, you can additionally define the Connection information using the following
column headings:

– Library Connection.Connect To

– Library Connection.Workpack

– Library Connection.Asset Type

– Library Connection.Asset

– Library Connection.Event Type

– Library Connection.Event

– Library Connection.Anomaly

– Library Connection.Risk Model

– Library Connection.Function

Note that the Connect To column should only contain one of the following text items:

– Anomaly

– Asset

– Asset Type

– Event

– Event Type

– Function

– Risk Model

– Workpack

• Export See Export for information about exporting Library Items. Please note that this option will only export
the contents of the grid, not the Library Items themselves.

• Customise See Customise for information about the Customise toolbar option.

• Connections See Connections for information about the Connections toolbar option.

Double-click

The first time you double-click on a library item, NEXUS will ask you what action to take: you can either Launch the
Library item in an external editor, or Edit the Library item. If you would like your choice to become permanent, tick
the “Always do this” box. Note that if you hold down the Alt key while double-clicking, you will be asked again.
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8.16 Map

The Map window shows you the events in the Event Listing on a two-dimensional map, based on their Easting and
Northing. Each event is a dot, coloured with the Event Type’s colour. (You can set the colour for each event in Event
Types.)

The Map window will only show event data included in your filters (workpacks, event types, column-specific filters,
etc). If the events you are interested in are Continuous Event data (such as cross-profiles), ensure that you select that
Continuous Event in your event type filter.

At the bottom or right of the map is the legend. If you hover the mouse over an item on the legend, other series on the
Map will fade out temporarily. If you click an item on the legend, that series will be toggled on/off. If you export the
Map (see below), only series currently visible will be exported.

8.16.1 Zooming

You can zoom in or out by clicking in the map area and (with the mouse cursor still inside the map area) spinning the
mouse wheel. You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

8.16.2 Maps Toolbar

• Zoom In Zoom in.

• Zoom Out Zoom out.

• Reset Zoom Resets the zoom so that all data points are visible.

• Copy Use this button to copy the Map, as currently displayed, to the clipboard.

• Legend Use this button to show the legend of the events on the map, the legend includes the Event Types that
are selected and the Layers which their opacity has been set to anything above 0%. Layers and Event
Types can be switched off by clicking on the layer or event on the legend.

• Layers OpenStreetMap, ESRI World Imagery, ESRI World Hillshade, ESRI World Topographic, ESRI Ocean
Base Map and ESRI Street Map are free to use on the web. Each of these layers has an opacity drop down
list to be selected from 0% to 100%. If 0% is selected for any of the layers, it will not be included in the
map legend.

• Event Types Use this button to select what event types are displayed. This is more persistent than click-
ing/unclicking series on the map legend.

• Inspection Track Selecting a workpack from this menu will result in a line on the map connecting events in
the order they were logged. If the events were logged by a single ROV (or a single human inspector), this
track will show the path that the ROV (or inspector) took.

• Configure Specify the sources of the various fields used by the Map tab to display pipeline baseline data and
map data. “As Built - Easting”, “As Built - Northing” and “As Built - Order” should all point to the same
table — this is the table used to supply the pipeline baseline track. Typically you would point these three
fields at a sub-AIG. If you don’t configure these, no as-built track will be displayed. If your pipeline has
many events on it, not showing an as-built may be OK — users may be able to get a sense of the pipeline
track from the events on it. “Coordinates - Datum” and “Coordinates - UTM Zone” should point to fields
that provide these values. Typically they will be in an AIG — only one datum and one UTM Zone are
necessary for an entire asset. Ask your surveyors for the values that you should fill in to these fields.

• Export Image Click this button to save the Map to an image file.
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8.17 Pipeline View

Pipeline View shows events along your pipeline in a 3D view. Each event will appear on the pipeline view when you
click Save on the event form.

Pipeline View Historical is similar, but shows only the events listed in the Event Listing Historical panel. This view can
also show seabed profile (if you have any PL - Cross Profile data imported), and animates motion along the pipeline
as you select events.

See Charts Toolbar below for details of buttons that are used by the Pipeline View.

8.17.1 Chart Width

When the Charts pane is 1000 pixels wide or less, all charts are shown at the full width of the chart pane. When the
Charts pane is over 1000 pixels wide, some charts are shown full width, and some are shown half width, in order to fit
more charts side-by-side onto your screen.

Charts that have an X axis of type string, date, or date/time, or whose X axis includes ‘KP’ are always shown full
width. Of course, you can adjust the width of all charts by adjusting the width of the whole application window,
adjusting other elements such as the asset tree wider/narrower, etc.

8.17.2 Zooming

At the bottom of most Chart Templates, below the horizontal scrollbar (if visible) is the Zoom Bar. You can hover the
mouse over the left or right end of the selected part of the Zoom Bar and drag to change the selection. Initially the
entire Zoom Bar will be selected, so hover the mouse over the left or right end of the bar and drag. Once a subset of
the chart is selected, you can use the scroll bar or the Zoom Bar to drag the whole selection area without zooming.

You can also zoom in or out by clicking in the chart area and (with the mouse cursor still inside the chart area) spinning
the mouse wheel. For charts with a lot of data (thousands of events) this can be slow, so the Zoom Bar may be faster.
You can zoom on a single axis by putting the mouse pointer over that axis and spinning the mouse wheel. Not all
charts support zooming in both axes.

You can also control zoom with toolbar buttons Zoom In, Zoom Out, and Reset Zoom.

8.17.3 Charts Toolbar

There is no toolbar for the whole Charts panel. Instead, each chart has its own toolbar.

• Zoom In Zoom in.

• Zoom Out Zoom out.

• Reset Zoom Resets to default zoom level.

• Export the chart to image(s) Click this button to open the Export dialog. Ensure the range you want is set
correctly using the Zoom Bar. Ensure the series you want to export are visible. If you would like to export
the chart as a series of images, each covering a smaller horizontal range, enter the range you would like
each chart to cover in the Range of X Axis per image field. For example, if you have a 300km pipeline
and you enter “10” as the range per image, it will be broken into 30 images, each covering 10km.

• Copy the chart to the clipboard Copies the chart, as you see it displayed, without the “zoom” section at the
bottom, to the clipboard.

• Toggle chart Expand/collapse display of this chart.

There are also several buttons specific to the Pipeline View chart:
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• Track the current KP This button is only available in IC-Inspection. When selected, the pipeline view will
move in time with the KP value coming in from survey. For NEXUS IC, see Time Source → Synchronise
KP on the Inspections Toolbar.

• Exaggerate the scale to show more of the pipeline When selected, will distort the scale of the pipeline to make
a greater KP range visible.

• Toggle stacked series mode When selected, will move events above the pipeline to make them more obvious.
Different events will be moved up different distances so that all are easily distinguishable.

• Toggle 3D perspective mode When unselected, you will see the pipeline viewed from the side. When selected,
you will see the pipeline viewed from above and slightly off to one side.

Tip: Click on the chart area and then, with the mouse cursor still inside the chart area, use your mouse wheel to
increase/decrease the chart scale for export.

8.17.4 Report Table Sources

To extract chart template data into a report template, use a Chart Template element in the report, and use the appropriate
Asset table or Event table as a source. For more information see Report Templates.

8.18 Survey Values

The Survey Values panel displays a list of all defined serial survey fields, the current value and the source of the serial
input. Survey fields are defined in the Device Manager, within the device they are being received from. A red status
colour shows for survey fields that are not receiving data or are disabled. A green status colour flashes for survey input
fields that are receiving data.

Type checking occurs for the values entered in the Value Column. A Value cell gets a red background if the cell
contains a value that does not match its survey field type. It gets a green background if the cell’s value matches its
survey field type. If IC-Inspection knows that this cell should contain a whole number, a “numeric” (i.e. a number
that can have a decimal point), a date, a time, or a date/time, then it can know whether to colour the cell red or green.
For example, if it’s a KP and it contains “1-1-2017”, then that’s not valid. For other types (such as text), IC-Inspection
doesn’t attempt to show any validation.
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8.18.1 Updating the Source for a Survey Field

To change the source of a Survey Field, click on the ellipsis ( ) button in the Source cell adjacent to the survey field
and choose the relevant input device from the drop down menu.

If your incoming survey contains a combined Date/Time, you will see a “Derived” option on your separate Date and
Time source entries. These take just the Date, and just the Time, respectively, from the combined Date/Time. Similarly
if your source has separate Date and Time fields, you will see a “Derived” option on your combined Date/Time field,
which combines the separate Date and Time fields into a single value.

8.18.2 Updating the Destination for a Survey Field

You can log data from a survey value into one or more survey fields in the database. Click on the ellipsis button in the
Destination cell adjacent to the survey field and tick one or more Survey fields. Now, during an inspection, the data in
this survey value will be logged into that survey field.

There are several “meta” destinations available for use when a real survey field is not appropriate: Survey Date/Time,
Survey Heading, and Survey KP. You should use Survey Date/Time as the destination for your DateTime field. (There
is no field called “Survey - Standard.DateTime”, “Survey - Pipeline.DateTime”, etc. because date/time is the key value
for every survey table, and it would be arduous and error-prone to force you to select them all separately.)

You should use Survey Heading if you do not wish to log Heading to a database field, but still want things that rely on
Heading (such as the Heading window) to work.

You should use Survey KP if you do not wish to log KP to a database field but still want things that rely on KP (such
as the Charts window or the Pipeline View window) to work.

8.19 Tasks

Tasks displayed in this panel are determined by the Workpack selected in the Database Information panel and the
Asset selected in the Assets panel.

8.19.1 Tasks Toolbar

• Launch - launches the currently selected task in the Event panel.

• Template -

• Edit - Edit the selected task.

• Navigate to task asset - Will change the active asset in the hierarchy to the currently selected task’s asset. Note
that this will change what tasks are visible in the Tasks window.

• Children - toggles on and off display of tasks on assets that are descendants of the asset selected in the Asset
Tree panel.

• Parent - toggles on and off display of tasks on assets that are ancestors of the asset selected in the Asset Tree
panel.

• Customise - See Customise.

• Connections - see Connections.

• Instructions – toggles visibility of the Instructions panel.
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8.19.2 Launching a Task

To launch a Task from the Task panel, click Launch Task, or double-click the task in the grid.

Note that there is a right-click menu allowing you to launch a task, edit a task, or navigate to a task’s asset.

8.20 Alerts

In certain circumstances, IC-Inspection will inform you of changes in its situation. Examples include: inspection
started/stopped; incoming survey started/stopped; video recorders started/stopped. When these messages are low
priority, they appear briefly at the bottom right corner of IC-Inspection’s main window. When you are inspecting and
they require your attention before you continue to inspect, they appear in the centre of the window, flash red, and
remain until the problem is resolved or you manually dismiss the warning.

Fig. 1: A low-priority notification and a high-priority notification

If you start an inspection and a DVR fails to start recording, you will get a modal dialog telling you so. If you decide
that you don’t need that recorder, Cancel that dialog and disable the device in the Devices panel. If you don’t disable
the device, then every time you launch an event, IC-Inspection will warn you that the recorder is not started. These
dialogs and notifications are to make it hard for you to accidentally event without recording video.

IC-Inspection is an on-line Eventing software application optimised for use in the off-shore environment. IC-
Inspection is built around a Microsoft SQL Server relational database with events (items of inspection) referenced
to positional data and assets. IC-Inspection can be configured to interface with:

• Survey systems, showing time, date, and ROV position;

• ROV video inputs, enabling image and video sequence references to events;

• Digital video recorders;

• Instruments such as CP Probes, FMD, providing automatic data input of results;

• Other digital input devices, through customisation of the software to suit the input string.

The IC-Inspection package is teamed with IC-Recorder to provide a digital recording package for real-time based
online eventing. Multi-camera, sonar and profiling data can be recorded digitally with positional data displayed by
IC-Recorder. NEXUS Integrity Centre (NEXUS IC) is used to configure the database, event definitions and other
relationships used within IC-Inspection.

To learn how the grids and toolbar buttons presented in many of IC-Inspection’s panels work, see Common Features.

A basic strategy for using IC-Inspection would be:

• Configure a NEXUS IC database, including Assets, Event Types, and optionally Tasks and Drawings.

• Configure IC-Inspection, including desktops, Devices, Survey Values and optionally Event Templates.

• Configure digital video recorders, whether IC-Recorder or a third-party recorder.
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• Use the Tasks list or the Drawings to drive the inspection, completing tasks until none remain.

• Launch ad-hoc events as required.

• For each event form, fill in the form, optionally attaching still images captured from digital video recorders.

A training manual, showing how to use IC-Inspection for offshore eventing and NEXUS IC for offshore review,
is available.
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CHAPTER

NINE

IC-INSPECTOR

9.1 Deployment

To deploy IC-Inspector 6.6, acquire appropriate iPad(s) and download the IC-Inspector 6.6 app, available for free from
the App Store.

9.1.1 Requirements

• iOS 13

• IC-Web Read/Write License

• IC-Web 6.6 or higher (6.6 recommended)

• NEXUS DB schema 8.200

9.1.2 Recommendations

We recommend the latest iPad Pro. IC-Inspector will run on any iPad (which can be useful for testing and training),
but will not run on iPhones or iPod Touches.

If you expect inspectors to mark up photos, we suggest also purchasing an Apple Pencil.

If you expect inspectors to do significant quantities of typing, we suggest also purchasing a keyboard cover. Note
that in quiet environments, you can use the iPad’s built-in speech-to-text dictation capability. On some devices this
capability works independent of internet connection — go to Settings → General → Keyboard and check the very
bottom of the screen for the message “You can use Dictation for English when you are not connected to the Internet.”

Tip: When using speech-to-text for numeric fields, use phrases like “numeral one” for single-digit numbers; phrases
like “one dot two three” for decimal numbers less than 10; phrases like “twenty three dot one nine” for decimal
numbers from 10 to 100; and phrases like “one two three dot four five” for decimal numbers greater than 100.

If you require intrinsic safety, intrinsically safe enclosures are available from third-party vendors, but note that you
may need to ship your iPad to the vendor so that they can install it into the enclosure.
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9.1.3 NEXUS IC Configuration

When configuring Asset Information forms, we suggest keeping forms as simple as possible. Only mark fields as
mandatory if it is guaranteed that inspectors are able to fill them in — if inspectors are required to fill a field but are
unable to do so meaningfully, they will perforce enter junk data. Avoid text fields where possible. As an alternative
you may be able to use a lookup list, where the inspector will pick from a list of options.

To make tasks available to an inspector, edit the tasks (possibly with multi-select) and set “Assigned To” to the desired
inspector. You can click Add on this picker to create a new inspector. The next time the inspector clicks Sync in
IC-Inspector, they will receive their tasks.

You can mark a task as ad hoc by ticking “Adhoc Task”. If you do this, when an inspector selects the task and fills
out the form, the task will not vanish from their list — it will be available for them to complete again and again. You
only need to create one ad hoc task of each type, as a single ad hoc task will be available on all assets. You should
create that task on the highest-level relevant asset that has that event type available. Ad hoc tasks are suitable for
events like “Damage”, where you want inspectors to be able to note any damage they see, even if it’s not part of the
explicitly-tasked scope.

9.2 Summary

This screen shows an overview of tasks assigned to you. Tap Task, Workpack or Asset to see the tasks divided up in
any of those three ways. For example, if you tap Asset, you’ll see one pair of donut charts for each different asset you
have been assigned tasks on. In each case, the left-hand chart shows the tasks of each type, and the right-hand chart
shows the completion of those tasks. To see completion for a particular donut segment, tap that segment. Tap the text
at the centre of a donut to be taken to the relevant collection of tasks. Depending on what you have selected under
→ Show Tasks in Drawings, you will either be shown a list of Tasks, or a collection of Drawings with tasks in layers
on those drawings.
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Hint: You can tap the top centre of the screen to quickly return to the top of the list.

9.3 Tasks

On this screen you’ll see a complete list of tasks assigned to you.

Tasks come in two varieties: assigned and ad hoc.

• Assigned tasks are a piece of work that you are tasked with doing. An example might be: carry out a General
Visual inspection on a particular piece of piping.

• Ad hoc tasks are available for you to fill out as required. For example, if your GVI procedure tells you that
where you see evidence of corrosion on a piece of piping, you should carry out a UT measurement task, then
you should find the ad hoc task for UT Measurement on this asset and carry it out. Or if you have a Leak ad hoc
task, then wherever you observe a leak, you should tap that task.

When you tap a task you’ll be taken to the Event Details screen to fill out more information. In the case of an ad hoc
task a new assigned task will be added to the list.
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When you complete a task, it will be marked as completed. You can complete a task in the Event Details screen or by
swiping the task’s row. When the task has been completed it will be uploaded to the server during the next Sync.
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You can choose which tasks to show by tapping the ellipsis at the top right.
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9.4 Drawings

This is the collection of drawings available to you. Scroll to see more. Each drawing shows its number of incomplete
tasks at the top right. Tap a Drawing to go to it.
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9.5 Drawing

A drawing has layers. These are created in NEXUS IC. A layer will be coloured according to its tasks:
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• If a layer has no tasks it will be grey.

• If a layer has tasks, all incomplete, it will be red.

• If a layer has tasks, some of which are complete, it will be orange.

• If a layer has tasks, all completed, it will be green.

To see a layer’s tasks, tap on that layer.
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To complete a task, tap on that task. You will be taken to the Event Details screen for that task.

At the top right of the Drawing screen you will see an ellipsis. Tap this to reveal options to change what you see on
the Drawings screen.
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9.6 Event Details

For each type of task, there’s a corresponding event form. (These forms can be designed in NEXUS IC.) You can fill

details into the form as appropriate. Some fields are required; when empty, these have a red required mark. You
can clear a non-required field by tapping the clear icon.

Tip: You can change the text size on event forms (and therefore how much of the form fits on your screen
at once) in your iPad’s Settings app, under Display & Brightness → Text Size.

Once you have filled in any required fields, you can complete the task by tapping Status then Mark as Complete.

If you are unable to complete an event, you can tap Status then tap an option from the drop-down. The items available
in this list depend on what your database has configured in NEXUS IC under Task Status.
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9.6.1 Task Information

Tap on TASK INFORMATION to see details of this task (the asset name, event type, asset location, any task in-
structions, and any drawings directly linked to this asset). If any Asset Information is configured to be shown in
IC-Inspector, it will be shown on this screen.
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9.6.2 Photos

You can add photos to your event details. Tap the camera button at the bottom left to take a photo, or tap the
picture icon to select one or more images from your iPad’s photos library.
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Tap a photo to edit it, including adding markup-up.

To remove photos, tap Photo Options (at the bottom right) then tap one or more photos to select them. Then tap the

trashcan icon. Similarly to send photos somewhere else (to a message or email, to the Photos app, to a printer, etc.)

select then tap the share icon.

Tip: If you want to mark up an IC-Inspector drawing, view the drawing in IC-Inspector, then take a screenshot by
briefly holding the Home and Power buttons simultaneously. Save that screenshot to your Photos. Then tap to
bring it into IC-Inspector, and tap the new “photo” to mark it up.

9.6.3 Bookmarks

You can “bookmark” an event by tapping . The icon will change to . You can tap again to remove the bookmark.
Bookmarking is used for user-defined purposes: it can mean whatever your organisation wants it to mean. Its usual use
is to flag events which require review: checking grammar, checking that you are on the correct asset, sense-checking
data recorded, etc. You may wish to add text in the Notes field flagging the reason you have bookmarked this event.
Bookmarked events will be flagged with a green star in NEXUS IC’s Event Listing.

9.7 Photo Editing and Markup

You can edit and mark up a photo. On an event, tap a photo. You will be taken to an editing screen. You can swipe left
and right to move between photos.

By default a photo is given the name of the task it was created from. To edit this, tap the name.

You can toggle the Can Report status of a photo. Can Report is an optional field that can be used in report templates
to select only key photos for reporting.
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At the top you’ll see four icons, for markup, crop/rotate, share and trash.

9.7.1 Markup

Tapping will take you to the markup screen.

You will see tools at the bottom of the screen:

These are colour, shape, line thickness, text entry, eraser, and select/move.

Tap colour to choose the colour(s) to mark up the photo with. If you have an Apple Pencil, the Secondary colour may
be useful to you; otherwise only the Primary colour is used.

Tap shape to choose the shape to mark up the photo with. Pen allows freehand drawing. When drawing other shapes,
you are dragging from one corner of the shape’s bounding rectangle to the other.

Tap line thickness to set the thickness of the line shapes will be drawn in.

Tap text to add text to the photo. Tap the photo to initially place your blank text box — the box will be placed centered
on the location you tap. Type text, using either the on-screen keyboard or a keyboard connected to your iPad (via
the magnetic Smart Connector or via Bluetooth). To move the edit cursor around within the text you are typing, use
the cursor keys on a physical keyboard (possibly in conjunction with Shift, Control, Option and Command keys) or
long-hold the spacebar on the on-screen keyboard, and then drag. For multi-line text, press Enter at an appropriate
point.

You can drag the whole text box around the screen, or drag the white drag-handle at the bottom right of the text box to
resize/rotate the text.

Tap erase to erase some or all of existing mark-up.

Hint: You can create a dashed line by drawing a continuous line and then swiping across it with the eraser.

Tap select to select a previously created markup item. You can then drag that item to a new location. If you select a
text markup, you can edit the text. While a markup item is selected, a trash icon will appear at the bottom right. Tap
this to trash the selected markup item.

Undo and redo buttons are available at top right.

Cancel and Done buttons are available at bottom corners.

9.7.2 Crop and Rotate

Tapping will take you to the crop-and-rotate screen. Use the slider at the bottom of the screen to rotate the photo
by an arbitrary angle, from 180° anticlockwise to 180° clockwise. Or tap any of the five buttons below the slider to
select specific angles.

Note: Using angles other than -180°, -90°, 0°, 90° or 180° will crop away part of your photo.
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Press Done or Cancel at the top right to keep or discard your changes.

Note: You can also rotate the image in 90° steps with buttons at the bottom left and bottom right of the Photo screen
but the rotations will not be saved.

You can also crop your photo here.

9.7.3 Share

Tap to see an iOS share sheet, which works in the way you’d expect — tap a destination to send the marked-up
photo there. Both rows of the share sheet can be scrolled horizontally to reveal more options, including the More
option, which lets you configure which items appear, and what order they appear in.

9.7.4 Trash

Tap to discard this photo and return to the event screen. This is different from tapping the < Event Details button
at the top left, which will return you to Event Details without discarding the photo.

9.8 Scan Code

If your NEXUS database has a field (such as an asset information field) configured to contain an asset tag, you can
affix QR codes or bar codes to your physical assets, then scan them in IC-Inspector. Tap Scan code, then point the
iPad’s camera at the QR code or bar code. If the code is found in your NEXUS database, and IC-Inspector currently
has one or more tasks for that asset, the asset name that matches this code will be shown at the bottom of the screen.
Tap the asset name to see its list of tasks, then select tasks from the list as normal.

9.9 Sync

Whenever you are in network range (wifi and/or cellular phone, depending on your iPad model) you can tap the Sync
button. Tasks you have completed will be sent to your database server. Any new tasks (and their attendant drawings)
will be sent to your iPad. Between syncs, you may operate outside of network range; it’s only during sync that you
need converage.

In Demo mode, sync is disabled.

9.10 Settings

If you would like to try IC-Inspector with demo data, tap the Use demo data switch. Note that using demo data will
erase any local data currently in the app.

If you are planning to use real data, enter your server name and credentials. The credentials are typically the same as
those you enter when you start NEXUS IC. (If you don’t enter any credentials when you start NEXUS IC, you may be
using Single Sign-on — enter your Windows domain credentials here instead.) Then tap Test the connection. If all
is well, you can tap Save Server Settings. If you change user credentials, the previous user’s data (tasks, events, etc.)
will be cleared, and the new user’s data will be loaded from the server. Ensure that the account you use has a IC-Web
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Read/Write license in NEXUS — if it does not have this, you will not be able to sync your work back to the server.
(You will be told “This account has a readonly license.”)

The Remove completed tasks during sync switch controls whether no-longer-available tasks remain on your iPad.
(They may be no longer available either because someone has removed them in NEXUS IC, or because you have
completed them.)

Workpack display name lets you control how workpack names are displayed in IC-Inspector. This can be useful
if you are using many workpacks and have configured Workpack Groups in NEXUS IC, and/or you have configured
abbreviations for your workpack names in NEXUS IC.

Display selection wheel for lookup lists controls how IC-Inspector lets you select a value from a lookup list of
choices. This is particularly useful when some of your lookup lists may have many choices.

Clear Data will erase data from this iPad.

IC-Inspector is a tablet application optimised for inspection data collection using an iPad. IC-Inspector communicates
with a NEXUS REST server to receive tasks and drawings, and to upload inspection data. It can be used for inspection
with no internet connectivity, although it requires connectivity to initially receive tasks and finally send inspection
data.
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A basic strategy for using IC-Inspector would be:

• Configure a NEXUS IC database, including Assets, Event Types, Tasks, and optionally Drawings.

• Assign Tasks to personnel.

• Configure IC-Inspector with a REST server address, login name and password. The login name should match
an inspector who has tasks assigned to them.

• Synchronise to the REST server to receive your assigned tasks.

• Use the task list or the drawings to complete tasks by filling in event forms. Take or attach photos as desired.
Optionally, create ad hoc tasks to allow you to fill in additional event forms over and above those assigned to
you.

• Synchronise to the server again to send your inspection data to the database.

Tasks in IC-Inspector can be completed in two ways: by tapping on a layer on a Drawing from the list of Drawings,
or by tapping on a task in the list of Tasks.

You can download the IC-Inspector app free from the App Store.

It is only available for iPads. The app comes with demo data suitable for touring and learning the app. You can connect
it to your actual database via Settings and Sync.

166 Chapter 9. IC-Inspector

https://apps.apple.com/au/app/ic-inspector/id1444380445
https://apps.apple.com/us/app/ic-inspector/id1444380445


CHAPTER

TEN

IC-RECORDER

10.1 IC-Recorder Deployment

IC-Recorder is a single-channel recording application. But it is designed to smoothly allow several copies to be run
on one or more PCs for multi-channel recording scenarios.

When deploying IC-Recorder you will need to either:

• run the software on existing DVR hardware, or

• source appropriate hardware specifically for video recording.

The hardware that you require depends on the number of channels to be recorded and the required video resolution &
framerate (SD or HD?). The below information is provided to help guide your selection.

10.1.1 PC-based Video Capture Devices

IC-Recorder supports a variety of video capture hardware, both internal and external. In short, if a device supports
“DirectShow”, it is likely to work with IC-Recorder.

Startech sell an external USB device, suitable for use on laptops and on any machine where you want single-channel
recording. It captures the full analog resolution (720x576 if you’re recording in PAL). Any USB device that says it
has a “2861” or “EM2861” chip or chipset is likely good too. They aren’t broadcast quality, but by the time the signal
reaches the capture device, it is unlikely to make much difference — electrical noise and signal attenuation will have
degraded the image enough that the capture device won’t be the weakest link. We have had some negative experience
with connecting multiple of these USB devices to a single machine, but one has always been fine.

Osprey sell a family of internal cards. These are broadcast quality. We’ve had good experience with the 260e and the
210e’s older sibling. We’ve not tried the 100e, but it is likely fine.

For multi-channel recording there’s also the 4-channel 460e, which has also worked fine for us. (Note — There is
one known issue with the 460e: Windows occasionally misallocates IRQs on the PCIe bus, causing the 460e to drop
frames. To mitigate this, go to Options → Hardware → Properties → Device, and move the slider on the ‘PCIe Bus
Usage’ section (up or down, it doesn’t matter). Then click Apply. After next reboot, the problem may recur.)

Blackmagic also sell a range of suitable cards, but they have historically been more finicky to set up than Osprey
devices, and are less heavily tested with IC-Recorder.

For HD, Osprey have USB 3.0 devices and internal cards.

If you want the ability to edit recording profiles, you will also need Windows Media Encoder installed. After in-
stalling, copy its WmProEdt.exe (usually found in C:\Program Files (x86)\Windows Media Components\Encoder) to
IC-Recorder’s Profiles folder (usually C:\Users\Public\Documents\IC-Recorder\Profiles).
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Computing power

With these devices, video is converted into WMV format by the PC’s own CPU. Thus, the CPU needs to be powerful
enough to do the conversion work.

In very rough terms, a single channel of HD video at 1080p25 requires a multi-CPU score of about 11000 on Geek-
bench. Two channels requires twice as much (i.e. 22000). Double the frame rate (e.g. 1080p50) requires twice as
much, and so on. An SD channel has about one fifth as many pixels as a 1080p25, and thus requires about a fifth as
much CPU.

If buying an Intel CPU, an LGA 2066 socket and an X299 chipset is likely most suitable (as of 2018). Number
of PCIe lanes required depends on number of hard disks connected to motherboard NVMe connectors: if only one
motherboard NVMe port is used, likely a 28-lane CPU will suffice; if several NVMe SSDs are connected, more lanes
might be advisable. Check motherboard documentation to see which PCIe card slots will be activated under what
circumstances (often in a phrase like “×16/×0/×8/×0 or ×8/×0/×8/×8”). As of 2018, AMD CPUs may provide more
power per dollar than Intel, and should work fine.

In general terms, a single modern PC with an Osprey 460e will be capable of recording 4 channels of SD video.

In general terms, a single modern PC with an Osprey 825e should be capable of recording 2 channels of HD video.

Hardware

When selecting PC hardware, be sure to choose hardware with an adequate number of PCIe lanes for the cards in use
(typically capture card(s) plus optional graphics card plus optional RAID controller). Bear in mind that SATA, M.2
etc. drives may consume lanes. Once you have selected a CPU, check motherboard documentation: if the CPU has
a small number of lanes (e.g. less than 44), not all PCIe slots may be active, or may be active at less than their full
physical width.

As of 2019, we recommend the X299 chipset as being suitable. A high-end graphics card is not necessary: the key
feature of a graphics card for this purpose is how many “heads” (i.e. monitors) it will support at once. (Some cards
have more physical output connectors than they are capable of driving at once.) As of 2019, i7-7800X is likely a
suitable CPU.

Where possible, we recommend avoiding RAID on the encoding machine(s), as RAID introduces failure points and
complicates troubleshooting. Instead, we advocate moving video off the encoding machine(s) and onto a NAS or other
redundant storage system.

If you are using SSD, be sure that the SSD sustained write speed is adequate for the maximum video capture rate:
recording several HD channels may exceed the sustained write capabilities of some SSDs. You can mitigate this by
installing several SSDs, and writing different channels to different disks. (The pathological case is when you nearly fill
the disk, then delete files to create space, then immediately start recording video: for an SSD, erasing previously-used
space to make it available for re-use is time-consuming.) Spinning hard disks are also perfectly acceptable in this use
case. You may wish to use a small SSD for the operating system, plus a hard disk for the video data.

10.1.2 Non-PC based Video Capture Devices

IC-Recorder also supports the Marshall VS-103E-3GSDI encoder. IC-Recorder controls this in a similar way to an
on-board capture device, but the conversion to digital video is done by the Marshall encoder’s own hardware, not by
the PC/laptop’s CPU. Its text overlay is slightly less capable, but still perfectly adequate. This device captures either
standard definition composite analog video or HD digital video via SDI or HDMI (but not both simultaneously). The
Marshall Encoder can only record to AVI, when controlled by IC-Recorder.
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Computing power

Video is digitised and encoded on the Marshall device which reduces the load on the PC or laptop to simple video
decoding for the purpose of viewing the video stream. In general terms, a single PC will be capable of controlling and
previewing 4 channels of video from 4 encoders.

Hardware

If possible, use a PoE-capable Ethernet switch for your Marshall encoders. This removes the need for a separate wall-
wart power brick for each unit, and provided that the switch is on good-quality power, removes power as a source of
trouble.

Limitations of SSD write speed described above also apply here.

Preview

You can preview video from a Marshall encoder in IC-Recorder, complete with overlay. In some circumstances, this
preview may stutter or skip. This preview is separate from the recorded stream, so typically skipping on the preview
does _not_ imply skipping in the recorded video. Play back a recorded video to check.

If you want an accurate video reference, use VLC Player via rtsp://<IP address>/video1_audio1 or connect a monitor
directly to the Marshall encoder’s HDMI Out port. You won’t see text overlay on HDMI Out because it’s just pass
through.

10.1.3 Storage & Redundancy

IC-Recorder will store video in the location it is directed to by IC-Inspection. Care should be taken to ensure there is
sufficient storage space for the recorded video and that appropriate measures are taken to secure and backup the video
data. There are no inherent archiving or backup routines within IC-Recorder. We recommend using a network based
archiving utility or powershell scripts to handle the video data as desired.

Consideration should always be given to hardware redundancy to allow continued operation in case of any hardware
failure.

10.1.4 Time

We recommend unticking “Automatically adjust clock for Daylight Saving Time” on DVR computers. IC-Recorder
periodically receives time updates from IC-Inspection, but between messages it dead-reckons. If the IC-Recorder
PC’s clock occasionally jumps forward or backward by an hour during operations, bad things might happen. Daylight
Saving: Just Say No.

IC-Recorder is a Digital Video Recorder software application capable of overlaying text onto video as it is recorded.
It can accept video from a variety of sources (USB cameras, SD cameras, HD SDI cameras, etc) depending on the
capture hardware available to the PC. A single IC-Recorder instance captures a single channel of video, but several
IC-Recorder instances can be run on one PC, enabling multi-channel capture on a single PC.

IC-Recorder is designed to work seamlessly with IC-Inspection to deliver the most efficient offshore campaigns pos-
sible and the software is provided free-of-charge as a companion product to IC-Inspection. (Contact us to request a
copy.)

When you start IC-Recorder, if the default TCP port (4500) is unavailable, IC-Recorder will “probe” each higher port
number in turn (4501, 4502, etc.) to find a free port. Thus, you can run several IC-Recorders and each will find a free
port. IC-Recorder will load a settings file based on the port number it found, so each IC-Recorder can be pointed at
different capture hardware, different output recording folders, etc. So the typical use case is that if you have several
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capture devices on a single PC, or a multi-channel capture device on a single PC, you will run several copies of IC-
Recorder on that PC. In the first IC-Recorder select the first capture device (or the first channel on your multi-channel
device), etc.

When you first start IC-Recorder, you’ll need to configure it. Go to Tools → Options.

10.2 Hardware

The first page is Hardware, and the first choice is Input, where you can choose System Hardware or Marshall Encoder.
“System Hardware” can be any device that implements Microsoft’s DirectShow interface. This includes nearly every
video capture card, sound card, or USB capture device.

10.2.1 System Hardware

Choose your input Video Capture Device and (optionally) Audio Device. For your main (centre) video channel you
should record audio. For other channels you may wish to not record audio — this is to prevent “echo” during multi-
channel playback caused by several copies of the same audio playing in not-quite-perfect synchronisation. If in doubt,
we recommend recording audio on only the main video channel.

If you are running several IC-Recorders, you should choose a different Video Capture Device in each — in general
you can’t consume one Video Capture Device twice.

Video Device and Audio Device each have a Properties button next to them. Clicking these will pop up a dialog
provided by the driver of the hardware device in question. This dialog is not designed by us, and what you see will
vary according to your capture device. Some device drivers do not supply a Properties dialog at all — in this case,
clicking Properties will do nothing.

The Video Preview option controls some behaviour of the underlying Windows Media encoder. Its default of “Soft-
ware - Most CPU for compression/Some CPU for Preview” is fine for most circumstances. With this setting, if there
is insufficient CPU power, preview may become jerky (with just a few frames per second), but it will still try to record
smooth video. If you are seeing jerky preview, you should record a test video with plenty of movement in it, then play
back that video (using Windows Media Player or some other tool) to see if it seems smooth. If you are experiencing
no preview whatsoever, you should still try a test recording and playback, as there are circumstances where Windows
Media encoder may fail to deliver preview, but still record perfectly.

10.2.2 Marshall Encoder

The Marshall VS-103E Encoder is is an external piece of hardware that takes a single video signal in, converts it
to a digital stream, and sends it to IC-Recorder over Ethernet. IC-Recorder then records that to disk as a file. The
advantage of this approach is that there is little CPU overhead on the computer running IC-Recorder, as most of the
“work” is done by the Marshall Encoder. The Marshall Encoder also overlays text onto the video, under the direction
of IC-Recorder.

Set the IP Address to the address of the Marshall Encoder. Set the Username and Password to match the values you
have set up in your Marshall Encoder. Tick the Use Authentication box. Set Channel to 1. (The remaining fields on
this page are informational.)

When you click OK, you should see a preview of the video feed coming in to the Marshall Encoder.

10.3 Recording

The Recording page lets you set a variety of values related to recording.
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Camera is the name that will be used in video files. This is a free text field with some presets available. Note that
if your IC-Recorder is being controlled by IC-Inspection (the common use case), file names will be determined by
IC-Inspection, and you should configure the camera name there, not here.

Project Location controls where IC-Recorder will save video files as they are created. It’s usual to record video to
a local drive rather than to a network drive, to avoid problems with bandwidth, latency, dropouts, etc. IC-Inspection
can specify a subfolder, so if your IC-Recorder folder is “E:\Video" and IC-Inspection specifies the “Main Pipeline”
subfolder, then video will be recorded to “E:\Video\Main Pipeline".

If you are running several IC-Recorders, you can specify the same recording folder for all of them, and rely on each
one having a different camera name to distinguish files, or you can specify a different folder for each (“C:\Video\Port",
“C:\Video\Centre", etc). If two copies of IC-Inspection attempt to record the same filename at the same time (e.g.
“C:\Video\2018-01-01 120000 Digital Video.wmv”), one of them will fail.

The remaining options on this dialog page are explained within the dialog.

The intent behind specifying a Time Limit on video files is to reduce video to manageable “chunks”: if you want
video files to never be more than 2GB (to fit within FAT32 file size limits, for example), you should specify a time
limit that ensures that files are always below this limit. Or use a File Size Limit instead. Note that if you are controlling
IC-Recorder from IC-Inspection, you should control file time limits from there, not here — untick the limits here in
IC-Recorder.

10.4 Video Format

For system hardware (cards or USB devices directly connected to this PC), there are a variety of video format options to
configure. For Marshall Encoder devices there are none, because the encoding is carried out by the Marshall Encoder,
not by IC-Recorder. When controlled by IC-Recorder, Marshall Encoder video recordings will always be AVI.

For system hardware, the first choice on the Format page is whether to use AVI or WMV. This is like an “envelope”:
digital video can be encoded with a variety of different codecs, but can also be wrapped in a variety of different video
format “envelopes” (such as AVI or WMV). The analogy is to a paper letter in an envelope: the choices as to what
envelope to use, and what language to write the letter in, are separate. When a computer plays back a video file, it will
first handle the envelope, and then handle the video stream(s) within. If you know that video will only be played back
on Windows computers, WMV is a good choice, because all Windows computers have WMV support pre-installed.
Support for other formats depends on operating system version and what codecs are installed. Getting a codec installed
on a particular client computer may require cooperation from corporate IT.

10.4.1 AVI

If you choose AVI, you will need to specify a Codec. For the video files to be playable on a particular client computer,
a suitable codec must be installed on that computer, so again choosing something widely supported may be important.

Next to Codec is an Advanced button, which shows the configuration dialog supplied by the codec. Again, the appear-
ance and functionality of this dialog will vary from codec to codec, and some codecs may not supply a configuration
dialog at all.

Device Resolution has a Change button next to it. This lets you configure “Capture Pin Properties”. “Capture Pin”
is a Windows Media concept, and what (if anything) you can change here may be restricted by the codec you are
using. If possible, ensure that the device resolution and frame rate match what is actually coming in from the device.
(“Capture Pin Properties” is quite a technical thing, and ordinarily you won’t need to change it or look at it.)
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10.4.2 WMV

If you choose WMV, you will need to choose a Profile. The profile’s resolution and frame rate should match the
resolution and frame rate of the incoming video feed. If they do match, you’ll see a green message telling you so; if
they don’t match, you’ll see a red message telling you so.

If you have installed Windows Media Encoder on this PC and you have copied WmProEdt.exe (usu-
ally found in C:\Program Files (x86)\Windows Media Components\Encoder) to the Profiles folder (usually
C:\Users\Public\Documents\IC-Recorder\Profiles), you can click the Edit button to adjust settings within a profile.
A button is provided to open the Profiles folder, for your convenience in copying in profiles.

Your aim is to make the incoming resolution and frame rate match the resolution and frame rate in the profile, by
modifying one or the other. If the resolution matches, you will see a green message on this page saying “Valid
resolution for [device].” If they don’t match, you will see a red message saying “Invalid resolution for [device]”. Note
that if the resolution does not match, you will not be able to record.

Whichever format you choose, during recording IC_Recorder will write to a file whose name ends in “.part”. Once
recording is complete, the file will have “.part” removed from its name, and will end in “.avi” or “.wmv”. You should
configure any backup processes to ignore “.part” files.

10.4.3 Video Standards

SD (Standard Definition) NTSC video is 60 interlaced fields (30 full frames) or 59.94 fields (29.97 frames) per second,
with a vertical resolution of about 486 lines. SD PAL video is 50 interlaced fields (25 full frames) per second, with a
vertical resolution of 576 lines. Analog video does not have a fixed number of horizontal pixels, but 768, 720 and 704
are common numbers used when converting to digital. NTSC and PAL encode colour differently, so if you choose the
wrong format, you may get black and white video.

HD (High Definition) video is at least 720 pixels high, but 1080 pixels high is the most common resolution. It is
usually in an aspect ratio of 16:9 (i.e. 1280x720, or 1920x1080). It can be interlaced (“i”) or progressive (“p”). The
frame rate is most often 25, 29.97, 30, 50, 59.94, or 60 fields per second. “1080p25” for example, is a 1920x1080
pixel image delivered 25 times per second. “1080i50” is the same, but is delivered as 50 interlaced fields per second,
where two interlaced fields are the same as one full frame. So when using progressive video, it is fine for the final
number to be half the size. All other things being equal, progressive video is preferable to interlaced video, as it is
slightly easier to encode and avoids artifacts such as “combing”.

SD video is usually delivered as analog video. Analog video can be delivered as composite, S-Video, or Component,
but composite is almost always the format used in our industry. HD video is usually delivered as SDI (Serial Digital
Interface, a digital format). In other words, SD usually isn’t SDI. SDI deliberately uses the same types of cables and
connectors as analog, to allow TV studios to re-use existing cabling, but if you feed a digital signal into an analog
capture device (or vice versa) you will not get video captured.

10.5 Advanced

Show overlay text shadow, if ticked, puts a white border around dark text or a black border around light text on your
overlay, thus making text more legible if the underlying video colour is similar to the text colour. This option does
consume a bit more CPU power, so if your CPU is near 100% during recording, try unticking this option.

Borderless, if ticked, means that when you start recording (either by clicking the Record button or by starting an
inspection in IC-Inspection), IC-Recorder will hide its border, toolbars, etc. This can be useful if you want to maximise
the amount of monitor space devoted to video. You can switch back by right-clicking on the video area and unticking
Borderless Mode in the pop-up menu, or by double-clicking in the video area.
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Logging level should generally be left at its default setting unless directed by technical support. The more verbose
levels write more detailed information which can sometimes help us solve bugs, but more verbose logging can also
slow the system down.

10.6 Edit Overlays

IC-Recorder can overlay data onto video without requiring additional overlay hardware. If you are controlling IC-
Recorder from IC-Inspection 6, you should configure overlays in IC-Inspection 6. If you are controlling IC-Recorder
from IC-Inspection 5, you should configure overlays here in IC-Recorder. (It is not necessary to run the separate Text
Overlay Server application.)

Click the Edit Overlays button. This will show you a list of overlays. Any overlays with a Source of Server were
created in IC-Inspection 6, and can only be edited from there. Any overlay with a Source of Client is created from
within IC-Recorder, and can be edited from here. Click Add, or select a Client overlay and click Edit, and you’ll see
the Edit Overlay dialog. If you’ve just added a new overlay, you’ll need to fill in the Overlay Name field before you
can click Save.

Drag the window larger to make the black overlay region larger. It doesn’t need to match the actual size of your video
feed, but it’s convenient for you if you drag it to approximately the same shape.

You can drag fields from the tree at the left onto the black overlay layout region. This tree is populated from IC-
Inspection, so if the field you want is not shown in the list, ensure IC-Inspection is running and is connected (via
its Devices) to this IC-Recorder, and that the appropriate survey field is configured and has a value in IC-Inspection.
(If you configure Spare1 thru Spare4 fields in IC-Inspection 5’s Text Overlay window, they will be sent through to
IC-Recorder.)

Once you have dragged on your first field, you may wish to set its colour, font, size, etc., because additional fields you
drag in will “inherit” their settings from the previous field you dragged in.

Once fields are on the overlay, you can “lasso” several fields by click-dragging a box around them, or you can click
a single field to select it. You can use the toolbar buttons at the top of the dialog to act on all selected fields at once
(to “nudge” them around the screen, align them in a tidy fashion with respect to each other, change their font size, or
delete them). You can also use the list at the bottom of the screen to modify individual fields.

To put prefix text on a field (e.g. “Depth: “, etc.) edit its “Region Text”. You generally want a trailing space, so as to
separate the caption from the text coming in from IC-Inspection. Short captions are often best — “E: ” for Easting,
etc.

If you drag in an “Image” region, you will immediately be shown a file dialog, so that you can choose an image file
for this region. If you choose a .PNG file, then the transparency in that file will be honoured: where the PNG is partly
or wholly transparent, you will see the video through the image. You can drag on more than one image region if you
so desire.

Note that the “Top” and “Left” shown in this list are for the current size of the preview shown here in the Edit
Overlay window, not for the actual size of your captured video feed (so as you resize the window, you’ll see these
values change). This is because the overlay editor does not depend on the dimensions of the video you are currently
capturing. Font size, however, is in the dimensions of your video: a 10-point font on a 576-pixel high SD video will
fill about 1/57th of the height of the image and will likely seem about right, whereas this would be too small on a
1080-pixel high HD feed.

If you untick the “transparent” option for one or more fields, those fields will be shown with a solid background
rectangle of the colour you select. If you tick the “transparent” box, the text will be shown without a solid background
rectangle. This conceals less of the video, but may be less clear on some colours of video. Note also the “Show overlay
text shadow” option under Tools → Options → Advanced — ticking this works well with transparent-background
fields, because it places a dark border around light text, or a light border around dark text, thus making text more
legible if the underlying video colour is similar to the text colour. This option does consume a bit more CPU power,
so if your CPU is near 100% during recording, try unticking this option.
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If you are using a Marshall Encoder rather than system hardware, some overlay configuration options are ignored
because the Marshall Encoder does not support them. Text, prefix, suffix, source, top, left, font size, and font colour
are all supported, but font (Courier, Arial, etc.) is not. Additionally, the Marshall Encoder supports at most 16 overlaid
fields.

10.7 Communication with IC-Inspection

IC-Recorder works best in conjunction with IC-Inspection 5 or IC-Inspection 6 — a connection to IC-Inspection is
necessary to get IC-Inspection’s survey data visible as an overlay on IC-Recorder, for IC-Inspection to be able to start
and stop recording on your IC-Recorders, and for IC-Recorder to be able to send multimedia still images on request.
Go to IC-Inspection 5’s Device Manager or IC-Inspection 6’s Devices and add a Generic DVR or an IC-Recorder.

10.7.1 IC-Inspection 5

IC-Inspection is responsible for choosing the file name for each video file. So if you set a Project Location of “C:\one”,
and a Base Path of “two” and a Filename Format of “<yyyy-mm-dd> <hh-nn-ss-zz> - <camera> - <countfromone>”,
then when you click Start Inspection, or when IC-Inspection decides that it’s time to roll over to a new file, it might
create a file on the IC-Recorder PC called “C:\one\two\2018-01-02 12-34-56-00 - Centre - 1.wmv”. You can create
your own Filename Format — you can put a date or time format of your choice inside <angle brackets>, and you can
also include “<camera>” to include the camera name and <countfromone> to include a “uniquifier” which will start
from the value shown in Count, and increment each time a new video file is started. (Note that while you can specify
tenths, hundredths or thousandths of a second with z, zz or zzz, if IC-Inspection’s survey source only gives time down
to whole seconds, the fraction part will always be 0, 00 or 000.)

To send a DVR folder, go to IC-Inspection’s Tools → Options → Video, and click the ‘. . . ’ button next to Source
Field and select the Asset Information field that contains your DVR folder. The final path that your video file gets
recorded to will be made up of the Project Location you selected in IC-Recorder’s Tools → Options → Recording,
plus the base path you selected in the IC-Inspection device, plus the Source Field, followed by the filename created
using the template you specified in the IC-Inspection device, with a file extension of “.avi” or ‘.wmv” depending on
your selection in Tools → Options → Format.

(Previously it was necessary to carefully synchronise time between IC-Inspection 5 and DVRs, to ensure that the DVR
used the correct time in filenames. But since IC-Recorder receives the filename directly from IC-Inspection, this is no
longer necessary.)

10.7.2 IC-Inspection 6

IC-Inspection sends the time to IC-Recorder, and IC-Recorder uses this to generate a filename. During recording, this
filename is used. Once recording is complete, IC-Recorder checks to see if there was a time difference between it
creating the video file and actual recording starting. If there is, it adjusts the filename accordingly (typically by only 1
second, depending on machine load).

In IC-Recorder you can set a Project Location. In NEXUS IC, under Configuration → Assets → Features, edit DVR -
Relative Folder to select the field that will be used for DVR folder. This path is then appended to the project location.

See also Devices.

10.7.3 Daylight Saving

If Windows automatically switches to daylight saving time during an inspection campaign, this could potentially cause
video files to be confusingly named. For example at the beginning of daylight saving in spring, there could appear
to be a one-hour gap in your video recording when there was none in reality, because your PC clocks have sprung
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forward one hour. Similarly in autumn/fall, video files might be recorded apparently at the same time as videos
actually recorded an hour earlier, because clocks have fallen back by an hour.

For this reason, we recommend disabling automatic daylight saving adjustment on PCs that will run either IC-
Inspection or IC-Recorder. This also applies to any third-party systems that might e.g. be supplying time via a
survey string. Choose your timezone at the start of any given inspection campaign, and remain in that timezone for
the duration.
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CHAPTER

ELEVEN

IC-WEB

11.1 IC-Web Deployment Guide

• Requirements

• Installation

• Updating

• Configure IIS

• Configure IC-Web

• Authentication

• Common Errors and Troubleshooting

11.1.1 Requirements

Server Side

• Microsoft Windows Server 2008 R2 (or above)

• IIS 8.0 (or above). Running:

– ISAPI Extensions

– IIS Management Studio (is highly recommended)

• Connection to SQL server running a NEXUS IC database

Client Side

• A Modern web browser. The following have been tested to work:

– Chrome 54.0 or above

– Microsoft Edge 79 or above

– Safari 9.1 or above

– Firefox 53.0 or above. 3D drawings may be slower in Firefox.
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11.1.2 Installation

On the web server:

1. Run ICWebSetup.exe

2. Accept the License Agreement.

3. If you don’t have Internet Information Service (IIS) installed then select Yes, otherwise select No.

4. Select New Website.

5. On the New Website Details page:

• New Website Name - this is the name of the website in IIS.

• New Website App Pool Name - this is the name of the Application Pool the website will use.

• Run Website as - this needs to be the username of an account with rights to connect to the SQL
server and DB_OWNER of the NEXUS IC database. (Note if a domain account it must be in
the format domain\username.)

• User’s Password - the password of that account specified above.

6. On the destination page - IC-Web Path is the path where the website will be installed to.

7. On the Website Bindings page:

• Website Binding URL Name - lets you set the URL of the website binding (Normally it is fine to leave as
*.)

• Port - this should be left as port 80 unless your web server listens on a non-standard port.

8. On the NEXUS Database Connection page:
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• Specify Microsoft SQL Server - this should be the IP address or domain name, and database
server instances.

• Specify NEXUS Database - this is the name of the NEXUS IC database hosted on the SQL
server.

9. Click install and the file and configuration will be setup.

10. The last step contains a link to a driver for ODBC Driver 17 for SQL Server (https://www.microsoft.com/en-us/
download/details.aspx?id=56567). This must be downloaded and installed on the server before you run IC-Web.

11.1.3 Updating

If you have installed IC-Web once and just want to update to a new version without having to reconfigure the web
server

On the web server:

1. Run ICWebSetup.exe

2. Accept the License Agreement.

3. Select No to install IIS (as you already have IIS installed).

4. Select Update Existing when asked if you want to update you existing version
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5. Click Next

6. Click install

This will install the new version of IC-Web but will leave the web server settings and configurations settings as they
are.

11.1.4 Configure IIS

Once installed, IIS should be set up and IC-Web should be running on the HTTP protocol on port 80 of your web
server. Running IIS on HTTP should only be done for initial testing. As soon as you are happy with the deployment
you must modify the IC-Web website to use Secure HTTP (HTTPS) and stop the IC-Web HTTP protocol or redirect it
to HTTPS. Not doing this step is a security risk and will exposes users’ passwords so it is vital that this is done straight
away.

HTTPS Configuration

1. Open IIS Manager, expand out the website tree and select the IC-Web website.

2. On the Actions section on the right of IIS Manager click on Bindings. . . .
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3. Remove the HTTP item. (NB you may leave this if you intend to redirect HTTP to HTTPS and understand the
security ramifications — not covered by this deployment guide.)

4. Add an HTTPS item. (This will require at least one SSL certificate on your server to do this without errors.)

5. Your bindings should now look like:

6. You should now be able to browse to your website via https://<your site>, and http://<your site> should give
you a 404 file not found error.

If you wish to manually check server settings:
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Web server

• Open IIS Manager, open the ISAPI and CGI Restrictions. Make sure there is an entry for
<the_path_you_set_in_step_6_of_the_install>\webroot\data\ICWeb.dll

• Double click Feature Delegation. Make sure Handle Mapping is set to Read/Write.

• Select the Application Pools and select the ICWeb application pool click on the Advanced Settings. Make sure
“Enable 32-Bit Application” is set to false.

• Check the “Identity” in the application pool advanced settings is set to the correct username and password.

• Open the ICWeb website in the IIS tree. Expand out the tree and select the data directory under the ICWeb
website. Open Handle Mappings. Click on Edit Feature Permissions on the right. Make sure Execute is ticked.

Website

The installer should do this for you but if you want to check the settings:

• Select the IC-Web website and select the Advanced Settings in IIS Manager.

• Check the Physical Path is correct - note this should be what ever you specified in step 6 of the install wizard with
“\webroot” added; e.g. if it was “c:\Websites\ICWeb” the physical path should be “c:\Websites\ICWeb\webroot”.

• Check the Physical Path credentials.

11.1.5 Configure IC-Web

The installer should do this for you but if you want to check the settings:

Open the ICWeb website in the IIS tree. Expand out the tree and select the data directory under the ICWeb website.
Double Click the Configuration Editor. Open the Collection. It should contain 6 entries:

• Server - This is the domain name or IP address and instance of the SQL server.

• DatabaseName - This is the name of the NEXUS IC database on the SQL server.

• Username - This attribute contains the username of a NEXUS account that exists and is enabled in the
Database.

• InstallPath - This is the directory location of the directory that holds the IC-Web \webroot directory.

• LogLevel - (optional) Allows you to specify the log level of the ICWeb.dll.

• TokenUrl - (optional) The URL address of the ICWeb homepage - this is used by email/token authentication
methods.

• sqlUserName - (optional) Can be used to authenticate to a database server if you want to use SQL authenti-
cation instead of Windows authentication for the SQL connection between IIS and the SQL server.

• sqlPassword - (optional) As above.

Note, these values are case sensitive

11.1.6 Authentication

Authentication can be via local NEXUS account or Single Sign On account.

• If your IC-Web account is a local NEXUS IC account, just enter this as the username and password.
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• If your account has been set up in NEXUS as a SSO account then your username must be in full UPN format
username@domain. Your password is just your normal SSO password.

11.1.7 Common Errors and Troubleshooting

Test the REST service

Test the REST services is working:

1. Turn on Error Pages by opening IIS manager selecting the web server and open Error Pages.

2. Click Edit Feature Settings and set it to Detailed Errors.

3. Open the ICWeb.dll by browsing to your website address and adding /data/ICWeb.dll to the end of the address
URL. This should bring up a default page for the ICWeb.dll rest service similar to the image below. If there are
any errors with the DLL they should show here.
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If you get a completely blank screen here please ensure you have installed the ODBC Driver 17 for SQL Server
(https://www.microsoft.com/en-us/download/details.aspx?id=56567).

If the ICWeb.dll tries to download instead of run please ensure the web server is configured to execute ISAPI exten-
sions. See the last item under Configure IIS -> Web server.

File Size Errors

If you are unable to upload files and you are seeing an “File Size Error”

You might need to adjust a setting on your IIS server to allow your users to upload larger files. On the web server
if you go to location you installed IC-Web too. In the <installedLocation>webrootdatadirectory is a web.config file.
Open this file with a text editor and make sure this line circled below appears in there. If not add you will need to add
it in.
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The number you enter for the maxAllowedContentLength represents the maximum size of the file allowed to by loaded
to the server and thus inserted into the NEXUS IC database in Bytes. So in the example above this is 1073741824
Bytes (which is 1GB).

IIS Server Modules

Ensure the following modules are installed and running in IIS through the Add Roles and Features sections of your
server:

• Default Document

• HTTP Errors

• Static Content

• Static Content Compression

• HTTP Logging

• ISAPI Extensions

• IIS Management Console

Check the Application Pool and the website account have rights to run the website and connect to the SQL server and
NEXUS Database.

IC-Web is a web-based version of NEXUS IC, running in Chrome, Edge, Safari or Firefox. It aims to replicate the
functionality of NEXUS IC in a web browser, using Javascript and REST, with the exception of Configuration, which
is available only from NEXUS IC.

It aims to meet two use cases: read-only access for a large number of users, and read/write access for a smaller number
of users with an IC-Web read/write license.

To deploy IC-Web your organisation will need an IC-Web license. Contact support@nexusic.com for details. If your
NEXUS IC is hosted within Wood infrastructure, IC-Web may be available via Software as a Service (SaaS).

11.1. IC-Web Deployment Guide 185

mailto:support@nexusic.com


NEXUS Documentation, Release 6.6.xxxxx.0

For the most part, user documentation for NEXUS IC applies to IC-Web. There are a variety of differences related
to the different implementation challenges in Javascript/REST versus Windows/SQL. Recent changes in NEXUS IC
may not yet be reflected in IC-Web, and vice versa.

11.2 Differences

• After 1 hour of inactivity, your IC-Web will disconnect. Also, after 10 minutes (by default) of inactivity over
the entire web server, the web server will disconnect. In either case, tap F5 / Refresh to go back to the login
prompt.

• A variety of tabs, panels, pop-ups, etc. will briefly show a “Loading” throbber when selected.

• A variety of forms (e.g. Asset Information forms) in NEXUS IC allow in-place editing. In IC-Web, you will
instead see an Edit button, which will pop up a modal form for you to do the editing in. This is so that when
you complete editing, IC-Web can immediately commit your changes to the REST service.

• IC-Web pop-up “windows” are not actual windows, and cannot be moved outside the bounds of the web browser.

• Some data entry controls, such as date/time pickers, will look and work slightly differently in IC-Web.

• When another user changes data, NEXUS IC will automatically offer to refresh your local copy. IC-Web will
not automatically invalidate stale data.

• NEXUS IC remembers many window and panel sizes and positions in a settings file for each user. IC-Web does
not.

• IC-Web shows version information at top right instead of at bottom right. Other NEXUS IC status bar fields are
inapplicable to IC-Web, and are not shown.

• NEXUS IC has a Search box at the top right. IC-Web instead has a Search box above the Asset tree, which
searches only Asset names.

• The IC-Web asset tree is not yet updated to match the new look in NEXUS IC 6.6.

• Reports in IC-Web can be delivered via email (just as in NEXUS IC) but cannot be generated and launched
directly. The up-side is that an IC-Web user does not have to wait for a report to generate before continuing —
the IC-Web server will generate and email the report in the background.

• Charts in IC-Web are rendered by a third-party library and will not look identical to charts in NEXUS IC. Charts
in IC-Web may be slower to render than in NEXUS IC.

• 3D drawings are supported via a conversion process:

– Once you are happy with a 3D CAD drawing (you have set up any desired tags for navigation etc), send it
to us.

– We will convert your CAD file to DAE, a 3D format that works well in web browsers and which is under-
stood by IC-Web.

– You (or we) can then load that file into your NEXUS Library as a Drawing on the same asset in the same
Library Category group as your original CAD drawing.

– NEXUS IC will list both files in the drawing panel but only the CAD files renders in 3D; DAE is an
unsupported drawing format for NEXUS.

– IC-Web will display the DAE file as a 3D scene.

In 3D drawings in IC-Web, hold left mouse button and drag to rotate, right mouse button and drag to pan, and
use mouse wheel or hold middle mouse button and move up/down to zoom.
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TWELVE

MAIN MENU

12.1 Database

• Database → Connect

• Database → Reopen

• Database → Backup

• Database → Subscriber

• Database → Expert Systems

• Database → Close

• Database → Your Profile

• Database → Change Password

• Database → Audit Log

• Database → Security

• Database → Properties

• Database → Export Repository

• Database → Show Status Bar

• Database → Exit

12.1.1 Connect

Database → Connect

Use this menu option to connect to a database. (If you have connected to this database before, use Reopen instead.)
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Choose the name of a database server. A database server running on the same machine as IntegrityCentre may be
called ‘.’ or ‘localhost’, or may have a name like ‘.\sqlexpress’. Your IT administrator may provide you a database
server name.

Under Connect using, you will usually use the default setting, Current User. This uses your Windows domain
credentials to log into NEXUS IC. (NEXUS IC does not look or store a copy of your Windows domain password.)

Click Next.

You can create a new blank database, connect to an existing database, or restore a Backup. Click Next.
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If this database has a user account with your Windows domain credentials (see Security) you should be immediately
connected. If not, you will be asked for a NEXUS user name and password (which may not be the same as your
Windows domain user name and password).

If this is your first run of NEXUS IC 6, you won’t have yet set a restore path, so you will be asked for one. This
needs to be a folder that you can read/write, and that the SQL Server process can read. This may be a UNC path
(like ‘\MyServer\MyShare’) or if the database server and NEXUS IC are running on the same machine it may be a
Windows path (like ‘C:\Database Backups’).

When the path is valid (i.e. it is visible to both Integrity Centre and the database server) the text will go black and the
red warning message will disappear.
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If you enter a path that is valid for Integrity Centre but not the database server, you will see different red error text:

If you are unable to work around this error by choosing an appropriate folder, you probably have a deployment problem,
relating to SQL Server service accounts and/or permissions.

If you have chosen to restore a database from backup, you will be shown details of the backup file. Click Next to begin
the restore.

Now watch this progress bar.

Once NEXUS IC tells you the restore has been completed, click Connect.

If a schema update is required, NEXUS IC will ask you if you want to proceed. Schema updates are irreversible —
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any old backup files (including the one you just restored from) will continue to exist, but this running copy of the
database can never be downgraded, and thus can never again be opened by old copies of NEXUS IC. (This is not a
problem when everybody is using the same version of NEXUS IC and you are confident there will never be a need to
roll back to an older version. The circumstances that require caution are those where you might be running a newer
version than others, or there is a substantial chance that you will want to roll back to an older version.)

Schema 7.596 is NEXUS IC 5; schema numbers that begin with ‘8’ are NEXUS IC 6. Updates from 7.596 may take
some time. It’s OK to kick it off in the evening and check the results in the morning — it doesn’t need watching.

Use this menu option to connect to a database. (If you have connected to this database before, use Reopen, described
below, instead.) For details, see Database → Connect.

12.1.2 Reopen

Choose a database that you have opened in the past from this list to re-open it. If you have filled in Windows domain
credentials (see Security, below) you should be immediately connected. If not, you will be asked for a NEXUS user
name and password (which may not be the same as your Windows domain user name and password).

12.1.3 Backup

Use this menu item to create a backup. Your IT department may have a system of scheduled backups that make
this unnecessary on a regular basis. But from time to time when you are about to do something hard to reverse in a
database, such as deleting data, it may be wise to take a backup first.

You will need to supply a Network Path. This path must be accessible to both the database server and to Integrity
Centre. This may be a UNC path (like ‘\MyServer\MyShare’) or if the database server and Integrity Centre are
running on the same machine it may be a Windows path (like ‘C:\Database Backups’).

When the path is valid (i.e. it is visible to both Integrity Centre and the database server) it will go black — until this
point the text will be red. Note that the database server process must have permission to read and write the folder in
question — if you can’t get the path to turn black, check the permissions of the user account that the database server
service is running under. Similarly, the user account requires read/write permissions to both the share (for UNC paths)
and the folder.

The next page lets you select a name for the backup file. The default is usually suitable. Click Next.

Once the backup is made, its name will be changed to include 32 hexadecimal characters at the end. This is an MD5
checksum of the database file. Before restoring (see above) Integrity Centre will check this hash against the contents
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of the file, to verify a match. This is useful for protecting against corruption introduced by e.g. copying the database
backup to a USB3 hard disk and back onto a new machine. (Windows’ own file copy routines do not perform any
integrity checks.)

Click the Open Folder button and a Windows Explorer will open with your new backup selected.

12.1.4 Subscriber

Database Synchronisation is based around the concept of Master and Subscriber databases.

A Master database is the primary database of an organisation. A Master database can create one or more Subscriber
databases. Changes can be made to the Master database whilst there are active Subscriber databases.

A Subscriber database is created from a Master and can be edited offsite and subsequently synchronised back into the
Master database. A subscriber database can only be synchronised with a Master database (i.e. you cannot synchronise
two Subscriber databases together).

192 Chapter 12. Main Menu



NEXUS Documentation, Release 6.6.xxxxx.0

Create a Subscriber Database

A Subscriber database can either be created as a backup file, or via a direct connection to the offsite MS SQL Server.
In most cases, Subscriber databases are created by the Backup File (Manual) method, the backup file is then restored
to the offsite MS SQL Server.

To create a Subscriber database, select Database → Subscriber → New, and supply a name for your new subscriber
database. NEXUS IC will create the subscriber as a database backup file. Once a Subscriber database has been created,
it will appear in Database → Subscriber → View.

Synchronising a Subscriber

All changes made to a Subscriber database need to be synchronised back with the Master database. To synchronise a
live Subscriber database, do the following:

1. Ensure that the active database in NEXUS IC is the Master database.

2. Click Database → Subscriber → Synchronise.

3. The Database → Connect wizard will appear. This is for the subscriber database. If your subscriber is already
present on a database server then connect to it. If not, restore it under a different name from your main database
— if you have the subscriber as a *.nexus-backup file, you must specify a temporary location to restore the
backup to so that the synchroniser can work with it. Note that during synchronisation, no other users can be
connected to the database.

4. Resolve conflicts if required. In the below picture, an asset has been renamed from ‘10” PL’ to ‘10” PL m1’ in
the master, and similarly renamed to ‘10” PL t2’ in the subscriber. The Resolve Conflicts dialog requires that
we tell it which change we want to keep. You can click the Use Master or Use Subscriber buttons to resolve all
conflicts at once, and/or resolve conflicts individually. Once you have chosen a resolution for all conflicts, the
Next button becomes available. Click Next, then once the synchronisation is complete, click Commit. Other
users may now connect to the database again.
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Changes made to the following tables in a subscriber will not be synchronised back to the master:

• Email

• Report Schedule (hosted clients only)

• Map Server

Note: Ensure that none of the machines essential to the sync shut themselves down due to power management
settings. This includes the NEXUS IC machine and the SQL Server machine. If you are accessing NEXUS IC via
RemoteApp, similarly ensure that your client PC will not shut down. If you do lose connection to the RemoteApp
instance, you (by default) have 15 minutes to re-establish it (from the same or from a different client machine).

If your network is subject to interruptions, try running NEXUS IC on the same PC that is running your SQL Server.

If your location is subject to power failures, try running NEXUS IC on a laptop.

If you are running Windows 10, try temporarily pausing Windows updates: Start → Settings → Update & Security →
Windows Update → Advanced options, and set a “Pause until” date.
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12.1.5 Expert Systems

Worked Examples

Port configurations between two databases

In the following example we will create a Template file from one database and use it to import it into another.

Step 1 - Create an Expert System

Go to Database → Expert Systems and click on the Add toolbar button.

In the Expert Sytems dialog, enter the Name, Owner and some descriptive text in the Comments field which describes
this Expert System configuration.
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Step 2 - Choose items to export

There are two main options for choosing which items to include in your Template.

• Asset Type - By clicking on any one or more of the asset types means that NEXUS will determine all the
associated AIGs, Event Definitions, Functions, Report Templates that are linked to that Asset Type and will
include all those items in your template.
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• Advanced - Choosing the Advanced option allows you to pick and choose which items of this database you
want to include in your template. Based on your selection, NEXUS will still ensure that all associated AIGs,
Event Definitions, Functions, Report Templates linked to the items you have selected will be included in your
template.

Step 3 - Add a Version

Select the Expert System created in Step 2, click on the Versions | Add toolbar button to create a new Version. Note
that the Date, Version number is auto-populated. Enter a description for this version is the Comments field, then click
on OK to save the Version.
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Step 4 - Create the Template

Click on the Save Template button in the Versions toolbar to create the Template file. You will be prompted to give
the file a name and to save it to a folder location.

Step 5 - Import the Template

In the destination database, click on Database → Expert Systems. Click on Import and navigate to the import file.

Publishing and Updating Expert Systems configurations from the internet

Saving and retrieving Experts System configurations via the internet follows the same process described in Steps 1 to
3 (above), it is only Steps 4 and after which which differ:

What happens when I click Publish?

Note that you will need access to the internet to use this feature. When you click Publish, NEXUS locates the
corresponding Expert Systems asset in the Wood client management database (or creates a new Expert Systems
asset if one does not already exist). It then creates a new Version record against the Expert System storing the
database schema version as well.

Step 4 - Publish

Click on the Publish button in the Versions toolbar.
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Step 5 - Make the new Version available to clients

For any NEXUS database to have access to a published version of an Expert System configuration, the Expert System
node in NEXUS_Clients database needs to exist as a child node of the clients database).

In the Wood hosted NEXUS_Clients database, navigate to the Expert System record and check the “Available to
clients” check box against the versions which you want clients to be able to retrieve.
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What happens when I Download?

Note that you will need internet access to use this feature. When you click on the Expert System from the Down-
load menu, NEXUS retrieves the configuration template via the internet and makes the required changes in the
destination database.

Step 6 - Download the Template

In the destination database, click on Database → Expert Systems → Import → Download.

This menu will display and make available the latest Expert System revision which is compatible with the schema
version of the destination database. If there are no revisions which match the schema version, then no updates will
appear for selection. If there are more than one revision of the same schema version, then only the latest revision will
appear for selection.
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The Expert Systems functionality allows you to export or import asset information groups, event forms, functions,
report templates, shortcuts, etc. out of one database and into another.

The concept is that a central library of “base configuration” databases exist for NEXUS clients to subscribe to. The
subscription allows for the clients own database to be periodically updated from the base configuration database. An
example of this would be the Wood API 581 database which is maintained by a committee of Wood engineers. When
new changes are made to the code, the “base configuration” database is updated and the changes to the configuration
pushed out to all the subscribers.

This functionality also allows for configuration elements to be ported between databases using Template files without
reliance on the subscription model.

Configurations of Asset Types (including Asset Information forms, Global Tables, Risk Models, Event Definitions,
Reports, Charts and all referenced Functions) can now be ported/synchronised between NEXUS databases.

Configuration tables which are included as part of the template are:

• Asset Types and asset type icons

• Asset and Sub Asset Information Groups

• Event and Sub Event Definitions

• AIG and Event form and grid layouts

• Anomaly Triggers

• Workflows

• Global Lookup Tables and Items

• Lookup Lists and Items

• Boolean Types

• Unit Groups and Units

• Functions

• Charts

• Risk Models and Risk Charts

• Report Templates

See Worked Examples for step-by-step guide on how to configure and maintain and deploy Expert Systems configura-
tions between databases.

12.1.6 Close

If you want to open a new database, Close the currently open one first. IntegrityCentre only allows you to have one
database open at a time. (If you would like two databases open at once, launch a second copy of Integrity Centre.)

12.1.7 Your Profile

Go here to view and/or change details about your own NEXUS user account. If unit groups (e.g. metric versus US
weights and measures) are defined on your database, you can select your preferred unit group here.

Here you can also choose Favourite Reports. Tick boxes here, and you will have quick access to the ticked reports
via the Reports toolbar button.

12.1. Database 201



NEXUS Documentation, Release 6.6.xxxxx.0

12.1.8 Change Password

To change your own NEXUS password, use this menu option. If you are using Windows credentials, this option is not
useful or necessary, and will be greyed out.

12.1.9 Properties

This dialog shows (and allows you to edit) a variety of values specific to your database. These include client name,
client logo, a variety of default colours associated with drawings, and a variety of settings associated with 3D drawings.

You only need to set values that are useful to you and your use case.

Name and Details are not used anywhere.

Logo can be used in the headings of report templates, and is by default included in the Dashboards Page
report and the Dashboards report.

Secondary Logo is similar, for when you need two different logos in the one database.

User Upgraded identifies the name of the logged in user which instigated the latest database schema
update.

Date Upgrade is the date that the latest schema update was performed.

Require History Comment, if checked, means that when changing various data fields, including Asset
Information, you will be asked to enter a comment describing the reason for the change.

Keep History (days) controls how long that information is retained.

Global Video Path is the root folder or UNC path for all inspection video which may be linked to
inspection events in INSPECTIONS. This could also be an Azure SAS URL (https://docs.microsoft.com/
en-us/azure/storage/storage-dotnet-shared-access-signature-part-1 ) which links to cloud based storage.
See How does video playback work?

Temporary Inspection Video Path would normally be populated during offshore inspection campaigns
for offline video review and where the video will be local to this instance of NEXUS IC. See How does
video playback work?

Default Traffic Light Colour – If the currently selected Traffic Light does not specify a colour to go with
the traffic light’s actual value on the asset for a drawing region or button, then that region or button will
be shown in this Default Traffic Light Colour.

Known Asset Colour – in Drawings, when you select Unknown Asset under Colour, this colour will be
shown for drawing regions and buttons where the region or button is connected to an asset. For regions or
buttons not connected to an asset,**Missing Asset Colour** is used.

Unknown Asset Colour – 3D drawing Layer with an asset, but that asset isn’t found in the database.

North Layer Name – Name of the ‘True North’ layer for 3D drawings.

Asset Serial Number Attribute – in 3D DWGs, you can use a tag in the DWG to specify what asset this
is. NEXUS IC will then match that tag to the field you specify in Configuration → Asset Information →
Configure Asset Features → Asset Serial Number → Edit. Here, you are specifying the DWG tag that
NEXUS IC will attempt to match on. See 3D Drawing Setup Example for more information on how to
configure 3D Drawings.

Missing Serial Number Colour – if you have specified an Asset Serial Number Attribute and an Asset
Serial Number field (both described above), then when NEXUS IC finds an attribute in the DWG but is
unable to find an asset with a matching value in the database, it will highlight the asset in the colour you
select here.
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Grid Size – Size of a grid cell at scale 1 for the 3D drawings.

Grid Colour – Colour of the grid for 3D drawings.

Anomaly Risk Chart – Anomaly Risk Matrix can be defined in Risk Charts and then to be be selected
here to show the open and close anomalies in the defined Anomaly Risk Chart in Anomalies screen.
System - Anomaly - Risk Score function which is a user defined function needs to be set up to calculate
the Risk Score for any anomaly. The result of this function will be a number that is assigned to each
square inside the matrix. The matrix must be defined to only have unique values in in each square.

The Email tab contains settings to allow NEXUS IC to send mail (e.g. to email a generated report or
the contents of any of the grids). It is recommended that a NEXUS IC email account is set up by your
company’s IT team and all email activities are generated from this generic account. Please speak to your
IT department for information on the Host, Username, Password, Port and SSL settings.

The License tab contains details of your license key. As part of Software Based Licensing, this is where
you will enter that license information.

12.1.10 Audit Log

Here you can see a list of user sessions. Each time a user logs in, a session is created, with a login time. When they
log out, a logout time is recorded.

During a user’s session, they may edit data in the database. The Audit dialog displays a row for each data row they
change. The ‘Table Definition’ column shows the name of the table that the change was made in. Some of these tables
are ‘System’ tables — for example, if a user moves an asset, you’ll see a record for ‘Asset Location’. Some are ‘user’
tables — for these you will see the name of your Asset Information Group, Event, etc. Select a change from the list,
and you’ll see the values as they were prior to that change. Fields within the form that were changed are marked with

a blue highlight.

Possible operations are Insert, Update and Delete.

See also History.

12.1.11 Security

Asset Security

Asset security is a feature that allows even more granular control of access to information than our generic Security
Permissions table does. It allows you to set what assets in your database you want each user to have access to.

Asset security works on the principle that all users have access to everything by default, and then database admins
remove access as necessary. Restricting access is as simple as creating an asset view that contains the parts of the
hierarchy to be restricted, and then setting appropriate access rules on that asset view. Parts of the hierarchy can
appear in multiple views with multiple security rules — the rules will be applied across all of their views.

Example:

Suppose you have the following asset hierarchy:
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If you wish to restrict access to the “Offshore” part of the hierarchy by making it visible to Offshore Engineers but
block access to Onshore Engineers, you would:

1. Log in as an administrator account.

2. Create a new Asset View — give it a helpful name like “Offshore assets - Offshore Engineers only”.

3. Display the new Asset View by clicking Asset Views → Offshore assets - Offshore Engineers only.

4. Add a link to the Offshore part of the hierarchy by clicking

• Assets → Add → Linked Asset (with children).

• Select the Offshore asset and click OK.

5. Set the permissions on this asset view by clicking

• Asset Views → Edit → Permissions → Add.

• Now set appropriate permissions for each user group:

– For Offshore Engineers: set to Read/Write to give them full access.

– For Onshore Engineers: set to Deny All to block these users.

Now, the Offshore Engineers will have full access to that part of the tree, and Onshore Engineers will have no ac-
cess. This access will be applied across asset views, so that Onshore Engineers will not be able to circumvent their
restrictions by switching to a different asset view. If people who are blocked from assets try to view them, they will
see:

In setting up asset level security rules, it is important to note that a user will have the lowest access they have set up.

Common gotchas are:

• Removing a user group’s access from the “Default View” — this gives them no access to any assets (as they
now have deny access on all assets).

• Where a user belongs to multiple user groups, and one of the groups has access in one view but another group
does not have access — the user will not have access to the assets. The rule is that the most restrictive permission
is what’s applied.

• Giving a user Read Only access is the same as Deny Write (in this context).

Asset security also applies to Library items. If a library item is connected to an asset that the user has no permission
to read and/or write, then the user will similarly have no permission to view and/or edit that library item.

Note that asset security is likely to have an impact on performance, because NEXUS IC must look up every asset to
check its security before it can be displayed to the user.

Special Permissions - Security

To log in to the database, a NEXUS login must have Read permissions (as a minimum) to the Personnel table, so
ensure that System Table | Security Permissions is set to Read for all users.

Setting Deny All on the Special Permission ‘Security’ will disable the Database → Security main menu item,
regardless of what permissions have been set on the Security Permissions tables.
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Here you can add/edit/delete users, and can set their permissions. Permissions in Integrity Centre 6 are on a table-by-
table basis, rather than on a screen-by-screen basis. For example, if you would like a user to be able to add or delete
assets, you should edit the user (or the user’s Group) and give them Read / Write permission on the system table
‘Asset’. If you would prefer that this user (or group) only view assets and not add or delete them, give the user (or
group) Read permission.

Items inherit Security in two ways: from their parent security item, or from their corresponding item in all other
groups. Each user has their own permissions, plus the permissions of any group they are a member of. ‘Inherited’
mostly means ‘No permissions applied for this security item, for this user/group’. Read and Read/Write are additive.
Deny is subtractive and is applied last. To figure out the permission for an item, NEXUS retrieves permissions for the
user, and all groups the user is a member of. If there are no resultant permissions set, then NEXUS finds the parent of
the item and checks permissions on that. If necessary, a Special Permission will be counted as a parent — for example,
if an Asset Information form has no explicit permissions (because it is set to ‘Inherited’), then NEXUS will use the
Asset Information special permission.

Finer control over Asset Security is available.

• Set-up SSO - you can configure a user to use Window domain credentials to log in to Integrity Centre. This is
smoother as users will not need to enter a separate password when they start Integrity Centre — instead Integrity
Centre will query the domain controller to check the user’s credentials. To configure this:

1. Edit the user and go to the Login tab.

2. Click the button under ‘Windows User’.

3. In the resulting ‘Select User’ dialog, you may need to click Locations and select Entire Directory.

4. Type the user’s full or partial Windows login name, and click Check Names, choose the appropriate name
from the list and click OK.

Note that Windows domain credentials may not work when you are away from the Windows domain.

Tip: You can always bypass the automatic connection to the database using domain credentials by
holding down the Shift key as Integrity Centre starts up.

• Force Reset - if you are not using SSO, you can force a user to reset their NEXUS password on their next login.
(You would typically do this when you have just created a user account and have set a temporary password.) On
their next login, the user will be required to enter their old password and then choose a new one before they can
proceed.

12.1.12 Export Repository

Use this menu option to export all library items (including drawings) and event multimedia. (In previous versions, this
option also exported survey data, but survey data in version 6 is no longer stored in the same way and is therefore not
exported from this menu option.)

12.1.13 Show Status Bar

The status bar at the bottom of the main NEXUS IC window shows the database server you are connected to, the
name of the database you are connected to, the number of currently connected users, and an estimate of how fast
the connection to this database server is. In addition the Memory Available, Memory Used, Software Version and
Database Schema number are also displayed.
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When Memory Available is small compared to Memory Used, you are running low. In this circumstance, NEXUS IC
may start clearing parts of its cache in order to avoid running out of memory. You can force a complete emptying of
cache by closing the application and restarting.

You can toggle the status bar on/off using this menu option.

12.1.14 Exit

Self-explanatory, really.

12.2 Tools

12.2.1 Options

All options and settings in this dialog are currently user specific. The options and settings are stored in the windows
folder: C:\Users\[USER_NAME]\AppData\Roaming\NEXUS

• Tools → Options Launches the Options dialog with the following tabbed pages:

General
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• Prompt to backup database on startup - When checked, the ‘Database Backup’ wizard will be launched on
login.

• Network path for backup/restore - This path must be accessible to both the database server and to Integrity
Centre. This may be a UNC path (like ‘\MyServer\MyShare’) or if the database server and Integrity Centre are
running on the same machine it may be a Windows path (like ‘C:\Database Backups’).

When the path is valid (i.e. it is visible to both Integrity Centre and the database server) it will have no
border. If the path is invalid, a yellow border will be shown around the field.

Tip: The database server process must have permission to read and write to the folder. If the path is
shown as invalid, check the permissions of the user account that the database server service is running
under.

Example valid path:

Example invalid Path:

• Cache Folder - Drawings, Library Items and Multimedia images, when retrieved from the database for the first
time are saved to this folder.

• Export Folder - This is the default path that NEXUS will use when exporting data.

Spell Checking

• Spelling - When checked, typed data is spelled checked against the selected Dictionary.

• Custom Words - Enter words that should be ignored by the spell checker. Enter one word per line.

12.2. Tools 207



NEXUS Documentation, Release 6.6.xxxxx.0

Inspection

• Inspection Shortcuts - Inspection shortcuts allow the user to assign Function keys and Numeric Keypad keys
to common review actions within the Inspections Review screen. Click on the Restore Defaults button to pre-
populate common Shortcut Keys. To assign a shortcut key to an Action:

1. Select the Action.

2. Click on the Ellipsis button.

3. Press the shortcut key (or key combination) that you want to assign to the currently selected action.
The shortcut will then be displayed in the grid.
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12.2.2 Video. . .

The Configuration - Video dialog lists all parsed video files which exist in the folders defined in the Database →
Properties → Global Video Path field and the Database → Properties → Temporary Inspection Video Path folders.

• Play launches and attempts to play the selected video file.

• Open Location opens a Windows Explorer at the folder location of the currently selected video file. Note that
this menu item is only enabled for non-cloud based storage locations.

• Upload is used to copy video files from the Temporary Inspection Video Path to the Global Video Path. This
is typically used to copy inspection video returned from an inspection campaign to the master video storage
location. The Upload process gives the user the option to Delete, Rename, or Retain the local video files (this
could be on a USB HDD) after the Upload has finished. Additionally, you can elect to encode the video files to
the native streamable H.264 file format during the copy process.

If there are videos listed here that no longer exist (for example because you have used Windows Explorer to move or
delete them), you should remove them from this list too, using the Delete button. Multi-select may help here.
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12.2.3 Parse Video

Clicking on an item in the Parse Video submenu causes NEXUS IC to read video and image files and store their
properties (such as start time and duration) in the database. The datetime properties of the video and image files are
the links to the events in the INSPECTION screen.

• Clicking Global Video parses all video and image files in the Global Video Path. (Typically you would use this
option onshore.)

• Clicking Temporary Video parses all files in the Temporary Inspection Video Path. (Typically you would use
this option offshore.)

• Clicking All Video parses all files in both those locations.

The parsed videos and images will appear in the Tools → Video. . . dialog (see above).

See also How does video playback work?

12.3 Configuration

12.3.1 General

Boolean Types

Any Yes / No field can have a Boolean Type assigned to it. By default, each Yes / No field is given the Boolean Type
“Yes / No”, but you can add others. For example, if you have a field called “Secure?”, you might add A Boolean Type
for the field with values named “Secure” and “Not secure”.

Edit a type to set up its Values. A Boolean type can have two or three values: one for the True state, one for the false
state, and an optional third on for the null “neither checked nor unchecked” state. If you want a Boolean field to have
just two states, tick the Required box for that field.

Chart Templates

Charts and Drawings

You can put a drawing behind a chart template. This is useful when the chart template shows event data — you can
show that event data right on a drawing or photo of the asset itself.

You can also show regions (points, lines, shapes) from events on a chart template, and you can show multimedia
(photos) on a chart template.

Configuring this involves visiting several different areas of NEXUS IC, so it is documented here, rather than in any
specific area.

Configuring an Event Type to include a shape

First, take a database backup.

Then go to Event Types. Ensure that a sub-event is created, and that in the bottom half of the configuration dialog it
has two numeric fields called X and Y.

Still in Event Types, select the event you want to show as a polygon, series of lines, or point on the chart template. In
the bottom half of the configuration dialog, ensure that it has a field of type Table Link. Edit this field. On its Field
Definition page, ensure that its Sub AIG/Event is set to the sub-event you created in the previous step.
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On its Field Layout page, look at its Editor Type. If you would like this to show on the chart template as a series of
line segments (i.e. as an open curve, good for representing cracks, scratches, etc) select Graphical Markup (Line).
If you would like it to show as a point, select Graphical Markup (Point). If you would like it to show as a polygon
(i.e. a closed curve), select Graphical Markup (Region).

Configuring the Chart Template to support Drawings and Event shapes

Go to Chart Templates. Edit the chart template you want to show events on. Ensure that Show Drawings is checked.

Still on that Chart Template, in the bottom half of the dialog, ensure that the Chart Template has a Series for the Event
Type that you want to display on the chart. Edit the Series. Ensure that its Series Type is set to match the Editor
Type that you picked for the Event’s Table Link field: Points for Graphical Markup (Point); Polygon for Graphical
Markup (Region); Polyline for Graphical Markup (Line). On the Series’ Axis page, ensure that it has an X and a Y
axis. Edit each Axis. For the X Axis, ensure that the Parameters (Inputs) value is set to the X field of the Sub Event.
For the Y Axis, similarly ensure it is set to the Y field of the Sub Event.

Configuring a Drawing to support display behind a Chart Template

Go to Drawings, click Edit Layers, add a rectangle layer, change its type to Coordinates, set an Asset for that layer,
set left/right/top/bottom for that layer.

On the Inspections screen, in the Charts pane, select the Chart Template. Click the Drawings button/menu and pick
the Drawing from the list.

At least one event must have event shape data on it for the Chart Template to show the Drawing — the Chart Template
zooms to Event data, not to the coordinates layer. If that Event’s Shape is completely outside the Coordinates you
selected for the drawing Layer, the Drawing may not be visible.

Once the image is set up correctly in the Chart Template, it will also show in the Event shape editor.

Photos in Events onto Chart Templates

You can have a multimedia (e.g. a photo) on the event’s shape layer. In shape layer editor in Event Details, click
Multimedia then pick photo. You can move and size the photo.

Mouse wheel zoom may not work in the Event shape editor. This is a focus issue related to Windows. Use the
magnify+ and magnify- buttons instead.

When you change an Event’s shape, the Chart Template may not automatically refresh in 6.0. Click off the asset and
back on to force a refresh.

In the top half of the Configuration → General → Chart Templates dialog, you can add, edit and delete chart templates.
These templates can then be shown on the Inspection screen and in Report Templates. In the bottom half of the dialog,
you can add, edit or delete series within a chart template.

Add

To add a new chart template, click the Add button at the top of the “Configuration - Chart Templates” dialog. Give
your new chart template a name.

Available controls whether the chart is available for display in relevant Charts panes on the Assets and Inspection
screens. All chart templates are available for use in Report Templates, regardless of this setting.
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Show Zoom Bar controls whether a mini version of the chart will be shown at the bottom of the chart on the Inspection
screen. This is useful if users may be zooming a long way in to the chart (which is often the case on KP-based charts,
for example).

Show Drawings is used to show a drawing as the background of the chart. See Charts and Drawings for more details.

Show X Axis Title and Show Y Axis Title control whether the chart will contain text showing a title for each axis.

Edit

To edit an existing chart template, select it and click Edit, or just double-click it.

Series

You can add/edit/delete a chart template’s series either by editing the chart template and clicking on the Series tab, or
by using the bottom half of the main “Configuration - Chart Templates” dialog.

At bottom right is a preview — as you add or edit series, random sample data will display in this preview to show
you conceptually what your chart will look like. If you have chosen options that cause the chart to have a legend, the
legend is interactive: you can mouse over a legend item to highlight the corresponding item in the chart, and you can
click legend items to toggle the corresponding chart item off/on.

When you add or edit a series, you’ll need to give it a name. If your chart has just one series (this is common), you’ll
often give the series the same name as the chart.

A series also needs a Series Type. Different series types have different properties, which will become visible when
you select that type. Available series types are:
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• 3D Events,
• 3D Mesh,
• 3D Pipeline,
• Anomaly Trigger,
• Bars,
• Bezier Lines,
• Bubble,
• Contour,
• Donut,
• Gantt,
• Gauge,
• Gauge Indicator,
• Heat Map,
• Histogram,
• Horizontal Lines,
• Lines,
• Pie Chart,
• Points,
• Polygon,
• Polyline,
• Vertical Lines.

Points, Lines, and Bezier Lines have more options, as shown in the image. If you tick Shaded, the area between
your line series and the horizontal axis will be shaded in a paler version of the series’ colour. If you tick boxes for the
various Statistics and Trend Line items, you will see corresponding lines show on your chart. (Standard Deviation
shows horizontal lines one deviation above and one deviation below the mean.)

Axis

When you edit a series, you will be able to configure one or more axes for it, by clicking on the Axis tab. (This tab
isn’t visible when you’ve just added a series — click OK and then Edit to make the tab visible.)

Each axis must have a name. If your chart has several series, you may wish to give the X axis the same name in each
series, and give the Y axis the same name in each series.

For an X/Y chart you may have two axes, but charts may have more — up to one each of the kinds listed below.

Axis Kind

Available Axis Kinds are:

• X Axis,

• X2 Axis,

• Y Axis,

• Z Axis,

• Z2 Axis,

• Colour Axis,

• Split Chart Axis,

• Split Series Axis.

12.3. Configuration 213



NEXUS Documentation, Release 6.6.xxxxx.0

Conceptually, if you wanted to use some piece of event data to set the Y value of points on your chart, you would add
a Series of type Points, and within that you would add an Axis of kind Y Axis, with an axis type of Field, then select
the database field you want to use for your Y values. You’d also want to pick something for your X position: you’d
add another Axis to your Series, with kind X Axis, and then choose whatever type and other details were appropriate.

Time and KP are both common choices for X Axis field. The X2 Axis is useful for things that cover a span of time or
a distance of KP — for example, you could set your X Axis to pull from Event.Start - KP and your X2 Axis to pull
from Event.End - KP. (If your chart covers a period of years, the displayed chart will attempt to pick axis ticks on the
first day of the month or first day of the year.)

Point, Line and Bezier Lines series have just X and Y axes.

Bubble series similarly have just X and Y axes. If there are multiple points at the same location in a Bubble series, the
resulting bubble will be drawn larger.

Vertical Line series have just an X axis. Horizontal Line series have just a Y axis.

Bar series have X, X2 and Y axes: X and X2 are used to define the left and right edge of each bar. Histogram series
have just X and Y: X is used to define the centre of each bar.

Gantt series have X, X2 and Y: X and X2 are used to define the beginning and end of each horizontal Gantt line.

For a Donut or Pie series, you should use an X Axis to give the name of each pie slice, and a Y Axis to set the size
of each slice. (Donut and Pie charts don’t really have an X or Y, so we made an arbitrary choice there.) You can
also add a Colour series if you like, to give the colour of each slice. (If your chart is representing event counts, Table
Definition.Colour might be a good choice.) If you don’t specify a Colour series, NEXUS will make up a different
colour for each slice.

Tip

Create a Global Table to define the Gauge series colour, order and values.

Gauge and Gauge Indicator series are designed to be used together. A Gauge series is like the top half of a Donut
chart, in a half-circle. Gauge series have X and Y axes: X is used to supply the order entries should be shown in, and
Y sets the size of each slice. A colour series is also typically used. The Gauge Indicator series is the needle showing
the value on the scale, and has a Y axis for value, plus X for label.

Anomaly Trigger is like a Horizontal Line series. When you specify a value field for this series, NEXUS does not pull
data directly from that field; rather, it looks for anomaly triggers configured on that field, and shows one horizontal
line for each trigger. If there are several different triggers on this field (perhaps with different severities or codes), you
will get several different lines. The vertical position of each horizontal line is determined by the trigger value. If there
are different trigger values for different horizontal positions (for example, a pipeline might have different allowable
span lengths at different KP ranges), you can add an X axis of type Auto and NEXUS will behave appropriately.

The Polygon and Polyline series are very similar — Polygon is a “closed curve”, where we connect the last point back
to the first. They are useful where events have defined shapes (e.g. delamination on a concrete wall). See Charts and
Drawings for more details. Polyline is an “open curve”.

The Pipeline View is a 3D view, and uses the Y Axis to represent the diameter of the pipeline. If you don’t set a Y
Axis value of some kind, you won’t see a pipeline. Because it uses Y for diameter, it uses Z Axis and Z2 Axis to
represent distance along the pipeline. As with X and X2, the two different axis types are used to represent the start
and end of an item on the “chart”. A 3D Pipeline series is used to represent the pipeline itself, and has Z and Z2 axes
which represent the start KP and end KP of the whole pipeline. It also has a Y axis, which represents the diameter of
the whole pipeline. A 3D Events series is used to represent events along the pipeline, with:

• Z and Z2 axes representing the start and end of each individual event;

• a Y axis representing the diameter with which that event should be drawn (diameter is inflated slightly “for
free”, to make the events stand out from the pipeline);
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• a Split Series axis (see below) which is typically used to separate different event types into separate series; and

• a Colour axis, to determine the colour to paint each event.

It also has a 3D Mesh series, which is used to represent the seabed. The Z axis is used to represent the KP (i.e. the
distance along the pipeline). The X axis is used to represent the distance away from the pipeline. The Y axis is used
to represent the vertical distance, to show the actual variation in the seabed.

Contour and Heat Map are conceptually similar. Contour can be used to show contour lines for some “height” value,
as seen in a topographic map or an isobaric weather chart. Heat Map is similar, but shows the “height” value as a
colour axis, instead of as a series of colour lines. You can combine a Contour series and a Heat Map series on a single
chart, to give two different representations of the same data.

A Split Series axis lets you split data on one series into several series by some field you choose, such as Asset or
Workpack. For example, if you have data in several different workpacks, and you’d like each workpack represented on
your chart as a separate series, add a Split Series axis, and set its Parameters (Inputs) to Event.Workpack. Similarly,
if you’d like to split data from different assets into different series, you would choose Event.Asset for your input.
(Splitting by asset is only useful when the user filters to include child assets in their event listing, and has selected an
asset that has children — otherwise, all the data in the listing will by definition be from just one asset.) The series will
each show separately in the chart legend, and the user can make individual series visible/invisible.

If you have a Split Series axis on a Gantt series, ticking the Gantt series’ Show Stacked will show each separate split
value in its own vertical space. If you untick Show Stacked, the split series will share vertical space. For example,
if your Split Series splits on Event Type, ticking Show Stacked will give a row for each event type; unticking it
will combine all event types in one row (but the user may still distinguish event types by colour, and can can make
individual series visible/invisible).

A Split Chart axis works the same way, except that instead of your data appearing as several series on one chart, they
will instead appear as a series of charts, one above another. (Any other series on the chart which don’t have a Split
Chart axis will appear on all of the split charts.)

You can add a Split Series axis, Split Chart axis or Colour axis to almost any chart series. For example, a Split Series
axis on a Histogram series will give a stacked bar chart.

Axis Type

Several Axis Types are available:

• Auto,

• Average,

• Calculation,

• Count,

• Field,

• Sum.

The simplest axis type is Field: specify a field from a table that you want the chart series to pull data from.

The second simplest is Calculation: specify a function, and specify inputs for that function. (You could equivalently
create that function as a field on your form, and then use the Field type, but sometimes you only want the function in
the chart, and you don’t want it cluttering up your form.)

Average, Count, and Sum are all aggregate axis types.

The Auto axis type is useful in conjunction with the Solver function element. Suppose you have wall thickness
depletion as a percentage, and you want a chart showing how often each percentage occurs. Set up an Auto axis,
ranging from 0 to 100, and set up the other axis as a Calculation type. In the function you select for that Calculation
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axis, include a Solver element. NEXUS IC will call your solver function many times, for different points along your
axis range, and those values will get plotted on your chart.

As your Auto axis’ range increases, the step size increases, but not proportionately. This means that if you choose a
very wide range (1 to 1000000, say) then your Solver function may get called a very large number of times. That may
take a long time.

Sensor Clock

When configuring a date/time axis for a chart of sensor data, there’s a special case for picking the Clock value. When
configuring Clock for an Event table, you can just pick Event.Start Clock and/or Event.End Clock. But Sensor has no
analogous “parent” table, so you can’t do this. You also can’t pick Clock directly from the specific sensor table —
although the sensor table has Clock and Asset fields, they don’t show in the picker, because they’re key fields. (Asset
is a foreign key, except of course in the Asset table, where it’s the primary key. And keys of type date/time are special
— they count as foreign everywhere.)

So set up your other axis first (typically the Y axis), referring to the sensor table data field. Then set up your date/time
axis (typically an X axis). Instead of entering a value under Parameters (Inputs), go to Parameters (Values) and
enter the special value :Clock (including the colon). Click OK. When you come back in to edit this axis, you’ll find
Clock (without colon) filled in under Parameters (Inputs), showing that NEXUS has understood that you want a
Clock field, and has found the relevant sensor table to pick it from.

Load / Save Template

Clicking Save Template will save the selected Chart Template and related details to a .chart file. NEXUS IC will find
all items related to this Chart Template (asset information forms, event definitions, chart templates, lookup tables, etc),
and will present a dialog listing all the dependencies it’s found, with a checkbox for each row. Untick any that you
don’t want saved with your Chart Template.

This Chart Template can then be loaded into this or another database via Load Template. Note that if the previously
saved Chart Template still exists in this database, Load Template will overwrite that existing Chart Template — it will
not create a new copy of it. Similarly with any other elements saved in the .chart file: asset information fields, lookup
tables, etc.

Company

Company entries can be used to group Personnel (to show what company a given person works for) and Schedules
(to show what company will be carrying out a particular scope of work). You should set up Company entries if these
groupings are useful to you.

Functions

Function Elements
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Function Parameter

A function parameter is an input to the function. For example, in a function that calculates the circumference of a
circle given a radius value, you can add a Function Parameter element, that provides the ability to enter a value for the
radius. This value is then multiplied by 2 and by the value of pi to calculate the circumference of the circle. When
defining a Function Parameter, you need to give it a name and a data type. Function Parameters may be alphanumeric,
whole numbers, real numbers, boolean values (true or false), dates, times, or combined date/time values.

If you tick “Allow Null Inputs”, you can specify a Default Value to be used when the input is null.

Constant

Constant function elements are used when a data value is known and will remain the same for every situation where
the function is run. When defining a Constant, you need to supply a name for the constant, the value of the Constant
and the field type. Constants (like Input function elements) can be alphanumeric, numbers, Boolean values (true or
false), or date/time values.

Colour

Colour function elements are like a Constant element, but they are always Whole Numbers. When you edit a Colour,

it presents you with a colour picker. Click the arrow to choose a colour from the list, or click the button to
choose a custom colour.

Operation

Operation function elements provide data manipulation functions. Operators take input data from various sources
such as Input, Constant or Decision elements, or even other system or user-defined functions. You can drag in as many
inputs as you like to an Operation.

Addition, Subtraction, Multiplication, Division, Modulus and Power are all arithmetic operations. Note that Modulus
only works with whole numbers as inputs.

Minimum, Maximum and Average take the minimum or maximum or average of all their inputs. (If some inputs to a
Minimum, Maximum or Average are null, those null inputs will be ignored.)

Coalesce works the same as SQL’s COALESCE operator: if the first input is not null, it will return that first input. If
the first input is null, it will look at the second input. It will keep looking along its inputs until it finds one that is not
null. If all are null, it returns null.

Any True and All True are logical operations. They expect inputs of type Yes/No, and you should set their output type
to Yes/No.

For some operations the behaviour with more than two inputs is obvious; for others, less so, and you should experiment
to confirm that you understand it.

Bitwise / Logical Operation

These are similar to Operation elements, but carry out bitwise operations. Bitwise / Logical Operation elements can be
configured for And, Or, Xor (eXclusive Or), or Not. You should set the Result Type of a Bitwise / Logical Operation
to “Whole Number”. They differ from Any True and All True in that Bitwise / Logical Operations work on all bits of
a whole number, rather than just on a yes/no basis. For example, 1010 AND 1001 = 1000; 1010 OR 1001 = 1011; etc.
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Concatenate

These are similar to Operation elements, but are designed to concatenate several inputs together (converting them to
Alphanumeric if necessary) and give an Alphanumeric as an output. You should set the Result Type of a Concatenate
element to “Alphanumeric”.

The Format property can be used to control how values are converted to strings, and how the final concatenated string
appears. (Programmers may find this similar to the concept of printf format strings in C.) If the input is a whole
number, you can put %d in the format string at the point where you’d like that whole number to appear. If the input is
a numeric, you can put %f. You can put other text in the string literally as desired, and to get a % symbol, put %%.
So a format string like “There are %d apples, which fill %f%% of the basket” would result in output like “There are 1
apples, which fill 12.34% of the basket”. If your input types don’t match the format string you’ve specified, you’ll get
an error message. So in this example we’ve assumed that the first input is a whole number. If it was in fact a numeric,
you’d see an error like “Format is invalid for for the inputs.”

You can put a number between the “%” and the letter to specify the width. If the number turns out to be less characters
than the width you’ve specified, it will be padded with spaces. You can put a “.” after that width (or just directly before
the “%”) followed by a precision, to specify the number of decimal places for a numeric. So “%2d” might result in
output like ” 1”; “%.3f” might result in output like “12.340”.

You can use types other than “d” for Whole Number and “f” for Numeric. Here’s a list:

Type Output
d Decimal. Input must be a Whole Number.
u Unsigned decimal. If input is negative, it will be shown as positive. Input must be a Whole Number.
e Scientific: you will get output like “1.234E1”.
f Fixed: you will get output like “12.34”.
g General: you will get fixed or scientific output, whichever is shorter.
n Number: you will get a number with thousand separators, like “123,456.78”.
m Money: you will get a currency output, formatted as specified by your settings in Windows control panel.
s String. If one of your inputs is a string, you can use “%s” to put it in the format string: “There are %d %s,

which fill %f%% of the %s”. If you specify a precision, like “%.3s”, the string will be limited to at most
that many characters — any remainder will be truncated.

x Hexadecimal. Input must be a Whole Number.

Decision

Decision function elements in the NEXUS IC database are explained below:

Case

Evaluates a list of conditions and returns one of multiple possible result expressions. If the Case input does not
equal any of the defined conditions, then the Default is returned. The concept is similar to switch statements in many
programming languages, or nested IF functions in Excel.
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In the above example, the Case object is configured so that:

• When Input Variable matches Option 1, Result 1 will be output. (This is indeed the path taken in this case.)

• When Input Variable matches Option 2, Result 2 will be output.

• When Input Variable does not match any of the “When” options, the Default, Result if no Match, will be
returned.

Compare

Compares two inputs (comparators) and returns one of two values depending on whether the inputs match. Compar-
isons available in the Compare decision include: Equals (=), Not equals (<>), Greater than (>), Less than (<), Greater
Than or Equal (>=), Less Than or Equal (<=).

Matrix

Evaluates a number of inputs and returns the looked-up value. You can add more inputs with the Add Column Input
and Add Row Input buttons. If you have several column inputs or several row inputs, they must all be matched for
that cell to be picked. That effectively means that this is an n dimensional matrix. The 2-dimensional case (with one
column input and one row input) is the simplest and most common, but if your situation demands more dimensions,
add inputs to suit.

When no cells are matched, the Default Value will be used. You should ensure that the result type of the Default Value
is the same as the result type of the Matrix.

Range

The Range element is similar to the Case element, except that you specify a range of input values for each case, rather
than a single specific value. Range evaluates a numeric input against a series of numeric ranges and returns the found
value. For each range, you specify the Lower (>=) and Upper (<=) as numeric values, and then choose a Result from
the available inputs. A Range element needs at least three inputs: one to supply the Case value that will be used to
decide which range is matched (if any); one for the Default Value which will be used if no range is matched, and one
to define a result for the first range. If you want more than one range, add more than three inputs. If you want to re-use
one input several times, drag that input onto the Range element several times. If multiple ranges match the input, the
first matched range will be used, so if your ranges are 1 to 5 and 2 to 6, only inputs of greater than 5 will match the
second range.
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Lookup

Returns a summarised value from various sources of data within the NEXUS IC database.

So if you wanted to (say) fetch an Asset Information field from an Asset, you could choose that Asset Information
field as the Result Field, and connect the Asset Input to a Function Parameter which will be fed from Asset. Almost
any field from almost any table can be used as the Result Field.

You can also aggregate data from the Result Field by selecting an Aggregate: Max, Min, Average, Sum, Standard De-
viation or Count. If you select an aggregate, NEXUS IC will make a list of all the results and aggregate as appropriate.
For example, if you chose a field from an event form as your Result Field and Min as your Aggregate, then NEXUS
IC will look through all the events on that asset, and return the minimum value from that field in that list of events.

If Aggregate is left at None, you should ensure that your filters allow only one value to be returned. If multiple values
exist, the Lookup will return the first value it finds.

If the Result Field you select has a Display Type different from its Field Type, then you can set the Return Type
to be either the Functional Value or the Display Value. The Display Value is usually human-friendly text, whereas
the Functional Value is the underlying numeric key value, which may be useful for feeding into subsequent function
elements for comparisons, etc.

You can set an Asset Input, if the result table you have selected has Asset or Component_ID as a key field (for example,
if your Result Field is an Asset Information field). Only use this for Asset or Component_ID — for any other table’s
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key field, add a Filter, as shown below. An Asset Input must have a type of Whole number (not Numeric).

You can set an Asset Filter:

• The default, “No Children”, returns results from just the single asset specified by the Asset Input.

• “This Asset and dependent Assets” returns results from the asset specified, and also from that asset’s children,
grandchildren, great-grandchildren, etc.

• “Dependant Assets but not this Asset” does almost the same thing, but leaves out results for the asset specified.

• “Immediate Children” returns results from the specified asset’s immediate descendants, but not from the asset
itself, nor from any grandchildren, great-grandchildren, etc.

• “Parent Assets” looks up the tree instead of down, returning results from the specified asset’s parent, grandpar-
ent, great-grandparent, etc., all the way to the root of the asset tree.

• “Direct Parents” returns results from the specified asset’s immediate parent.

If you are using an Asset Filter option other than “No Children” or “Direct Parents”, you will typically also want to
specify an Aggregate.

If an asset appears in multiple Asset Views, it may have different parents and different descendants in different views.
These asset filters will match parents and descendants in all asset views.

You can also specify a Workpack Filter, whose options (Most Recent, All, Specific Workpack) are reasonably self-
explanatory.

Filters can be used to filter the list of results that would otherwise be returned to a shorter list (possibly containing
exactly one item, thus avoiding the requirement to use an Aggregate). You can drag extra inputs onto the Lookup
element for use as Filter inputs.

The first six comparisons (=, <>, >, >=, <, <=) are straightforward.

The various “closest” filters (“closest (either)”, “closest (lower or equal)”, “closest (higher or equal)”, “closest (lower)”
and “closest (higher)”) are special. Suppose you want to find the event whose KP is closest to a particular value: for
this you would use “closest (either)”. Or suppose you wanted to find the event just before this one; i.e. the event with
KP closest to a particular value, but lower: for this you would use “closest (lower)”. And similarly, “closest (higher)”
would be used to find the next event after a particular KP.

For “highest” and “lowest” you need specify no input; these simply return the single result that has the highest or
lowest value in whatever Field you specified in the filter. (Be aware that using an Aggregate of Max or Min is usually
faster than using a filter for highest or lowest.)

“contains” lets you search for a substring within an alphanumeric input. You can use “_” and “%” as wildcard
characters, with “_” matching any single character and “%” matching several characters, so “abcde” contains “a_c”,
and also contains “a%d”.

All filters must be matched for results to be returned; in other words, filters are implicitly connected by ANDs.

Lookup Optimisation

Lookups may be executed a large number of times, so it may be worth configuring them so that NEXUS can best
optimise their execution. Aggregates such as “Max” are more efficient than Filters such as “highest”. In Filters
comparisons, “=” is better able to be optimised than <, >, <=, >=.

Results may be cached, so subsequent lookups in a particular circumstance may be faster than the first lookup.

When the return value of a function is deterministic, NEXUS IC may cache the result for a given set of inputs. For
example if you have a function to add two numbers, 1 plus 2 always equals 3, so NEXUS IC may enter that result into
its cache, so that if it has to calculate that same result again in future, it can simply read the value from the cache rather
than actually recalculating. If a function contains a Lookup, NEXUS IC will cache the result only if it is confident that
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the result is deterministic — i.e. a future run of the function with those same inputs will necessarily produce the same
outputs. This might not be the case if, for example, your function contains a Lookup that is returning the closest event
to a particular date – if any event is added or deleted, or any event’s date is changed, then the Lookup result could
change.

You can help NEXUS IC be confident that a function is deterministic (and therefore potentially make your functions
run faster) by tucking each Lookup into its own function. So if you have a function that contains several Lookups,
and that function is running slowly, try putting each Lookup into its own function, and then replacing the Lookups in
your main function with calls to the new simple functions you’ve just created. NEXUS IC can now consider caching
separately for each function.

In general where time is critical, avoid aggregates across tables, aggregates across fields that reference other tables,
and aggregates across slow fields.

For small frequently-used tables (a few hundred rows), all the rows in the table will typically quickly get cached and
remain cached for the entire run of the application. If the value changes, cache entries are expired as appropriate, then
re-cached the next time they are requested by a function. NEXUS IC may also clear parts of its cache if it runs low on
memory.

Notes

Notes are used when building functions for reference and documentation purposes. Notes are placed in the Function
Builder work space. You should use Notes whenever you think a function is not self-explanatory, where you want to
refer to a standard, document changes to a function, etc.

Risk

Returns the aggregate risk value for an asset and all its children in a particular asset view.

Error

In version 6, the function builder includes the concept of errors. You can see errors by, for example, dividing by zero
or by feeding an element an input of a type it did not expect.

But you can also deliberately include errors. For example, suppose you have a function whose input must not be 0.
You can add a comparison which compares that input to 0, and if true, returns the value of an Error element. If you set
the Error value inside the Error element to “Oh no! An 0!”, then when the function has its input set to 0, the user will
see that error message output.

The advantage of using an Error element is that it can give a textual description to the user explaining what is wrong
without changing the output type of the function — the output of the function might still be of type Numeric. This
means that if this function’s output is in turn consumed by other functions, those functions will get a Numeric value as
they expected. In this way, functions can chain to other functions, while also giving descriptive messages to the user.

Is Anomalous

You can use this element to check, within a function, if a particular event field causes any Anomaly Triggers to fire.
Its input should be an event Header_ID.
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Solver

The solver element is used within charts to solve for a particular input parameter of a function — see Chart Template
Axis Type for details.

Electronic Corrosion Engineer (ECE)

If you drop an ECE element into a function, it will call Wood’s proprietary ECE library. Set the ECE Result
Type to determine which value it will return an estimate for. ECE is a separately licensed feature — contact sup-
port@nexusic.com for details.

The Section Start Fe Concentration parameter is optional and can be null. When it is null, supersaturated = true. This
relates to the dissolved iron concentration in the water at the inlet, which may be low in Fe, or may be supersaturated
with iron carbonate. There are two options. The default setting is supersaturated, assuming that the water has been
flowing through carbon steel equipment for some distance before entering the flowline: this would be appropriate if the
fluids come from a well completed with carbon steel production tubing for example. When most of the water comes
from condensation from water vapour in gas, this setting should be changed to none, which can lead to increased
corrosion rates for a short distance at the inlet region. This would be appropriate for a gas overhead line from a
separator vessel for example.

Required input parameter units:

• Start Pressure - bar

• End Pressure - bar

• Start Temperature - °C

• End Temperature - °C

• Liquid Holdup - %

• Inlet Pressure - bar

• Inlet Temperature - °C

• Oil Density - °API (API gravity)

• Section Length - m (metres)

• Inside Diameter - m (metres)

• H2S Concentration - Mole %

• CO2 Concentration - Mole %

• Percentage Carbon - Mole %

• Chloride - g/l (Grams per litre)

• Acetic Acid - ppmw (Parts per million by weight)

• Bicarbonate - ppmw (Parts per million by weight)

• Gas Production Rate – MMSm3/d (million metric standard cubic metres per day)

• Oil Production Rate - m3/d (Cubic metres per day)

• Water Production Rate - m3/d (Cubic metres per day)

• Fe Concentration - moles/litre
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Function

You can embed an entire other function into this function via the Function element. This is the same as dragging in a
System Function or User Function — see below.

System Functions

System function elements in the NEXUS IC database can be broken up into Character functions, mathematical func-
tions and other functions. These system functions are pre- defined and explained below:

Character/String Functions

Func-
tion

Description Example of use

ASCII Returns the ASCII code value of the leftmost
character of a character expression.

ASCII(‘Alphabet’) = 65

Chr Converts an ASCII code to a character. CHR(65) = ‘A’
InStr Returns the starting position of the specified ex-

pression in a character string.
INSTR(‘CORPORATE FLOOR’,’OR’, 3) = 14
INSTR(‘CORPORATE FLOOR’,’OR’, 1) = 2

Len Returns the number of characters of the given
string expression.

LEN(‘Alphabet’) = 8

Length Same as LEN. LENGTH(‘Alphabet’) = 8
Lower Returns a character expression after converting

uppercase character data to lowercase.
LOWER(‘Alphabet’) = ‘alphabet’

LTrim Returns a character expression after removing
leading blanks.

LTRIM(‘ Alphabet’) = ‘Alphabet’

Re-
place

Replaces all occurrences of the 2nd given string
in the 1st string with a 3rd string.

REPLACE(‘Alphabet’,’ph’,’f’) = ‘Alfabet’

RTrim Returns a character string after truncating all
trailing blanks.

RTRIM(‘Alphabet ‘) = ‘Alphabet’

Sub-
Str

Returns a part of a character expression. SUBSTRING (‘Alphabet’,0,6) = ‘Alpha’

Up-
per

Returns a character expression with lowercase
character data converted to uppercase.

UPPER(‘Alphabet’) = ‘ALPHABET’
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Mathematical Functions

Func-
tion

Description Example of use

Abs Returns the absolute, positive value of the given nu-
meric expression.

ABS(-15) = 15

ACos Returns the angle, in radians, whose cosine is the
given value.

ACOS(.3) = 1.26610367

ASin Returns the angle, in radians, whose sine is the
given value.

ASIN(.3) = .304692654

ATan Returns the angle in radians whose tangent is the
given value.

ATAN(.3) = .291456794

Ceiling Returns the smallest integer greater than, or equal
to, the given numeric expression.

CEILING(15.7) = 16

Cos Returns the trigonometric cosine of the given angle
(in radians).

COS(180 * 3.14159265359/180) = -1

Erf Gaussian Error function. See https://en.wikipedia.
org/wiki/Error_function

ERF(0) = 0

Exp
(10^x)

Returns the exponential value of the given numeric
expression.

EXP(4) = 54.59815

Exp
(e^x)

Returns the exponential value of the given numeric
expression.

EXP(4) = 54.59815

Floor Returns the largest integer less than or equal to the
given numeric expression.

FLOOR(15.7) = 15

InvErf Inverse Gaussian Error Function.
IsNum-
ber

Returns true if the Alphanumeric input can be con-
verted to a Whole Number.

ISNUMBER(“three”) = false

IsNu-
meric

Returns true if the Alphanumeric input can be con-
verted to a Numeric.

ISNUMERIC(“three point one four”) = false

Ln(x) Returns the natural logarithm of the given numeric
expression.

LN(95) = 4.55387689

Log(x) Returns the base-10 logarithm of the given numeric
expression.

LOG(100) = 2

Log_b(x) Returns the base-b logarithm of the given numeric
expression.

LOG_B(2, 256) = 8

Round Returns a numeric expression, rounded to the near-
est whole number.

ROUND(15.193) = 15

RoundTo Returns a numeric expression, rounded to the spec-
ified length or precision.

ROUNDTO(15.193,1) = 15.2
ROUNDTO(15.193,-1) = 20

Sign Returns the positive (+1), zero (0), or negative (-1)
sign of the given expression.

SIGN(- 15) = - 1

Sin Returns the trigonometric sine of the given angle
(in radians).

SIN(30 * 3.14159265359/180) = .5

SqRt Returns the square of the given expression. SQRT(26) = 5.09901951
Tan Returns the tangent of the input expression. TAN(135 * 3.14159265359/180) = -1
ToNu-
meric

Converts the input to a numeric data type. (Use
Concatenate to go the other way.)

TONUMERIC(‘123’) = 123
TONUMERIC(TODATE(‘22 April 2005’)) =
38462

Trunc Returns n truncated to a whole number. TRUNC(15.79) = 15.7
TruncTo Returns n truncated to m decimal places. m can be

negative.
TRUNCTO(15.79,1) = 15.7
TRUNCTO(15.79,-1) = 10

UnitEx-
ample

Used under the hood to provide examples in Con-
figuration → General → Unit Types
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Compare Functions

There are a variety of Compare functions (“Compare A = B”, “Compare A < B”, “Compare (A = B and C = D) or (E
in (F, G, H) and I = J)”, etc.) They all compare the various inputs in the way described in the function name.

Date/Time Functions

Function Description Example of use
CurrentDate Returns the current system date. CURRENTDATE( ) = <Today’s cur-

rent date>
CurrentDate-
Time

Returns the current system date and time. CURRENTDATE( ) = <Today’s cur-
rent date and time>

DateDiff
(Day Of
Month)

Returns the difference between the day-of-month of
two dates. Returns a whole number from -30 to +30.

DATEDIFF (DAY OF
MONTH)(2005-04-22, 2006-06-
12) = 10

DateDiff
(Days)

Returns the number of days between two dates. DATEDIFF (DAYS)(2005-04-22,
2006-06-12) = -416

DateDiff
(Month of
Year)

Returns the difference between the month-of-year of
two dates. Returns a whole number from -11 to +11.

DATEDIFF (MONTH OF
YEAR)(2005-04-22, 2006-06-12)
= -2

DateDiff
(Months)

Returns the number of months between two dates. DATEDIFF (MONTHS)(2005-04-22,
2006-06-12) = -13.667

DateDiff
(Years)

Returns the number of years between two dates. DATEDIFF (YEARS)(2005-04-22,
2006-06-12) = -1.139

Day Returns the Day part of a date. DAY(2005-04-22) = 22
LastInspec-
tionDate

Returns the last inspection date for a component. N/A

Month Returns the Month part of a date. MONTH(2005-04-22) = 4
NextInspec-
tionDate

Returns the next inspection date for a component. N/A

ToDate Converts the input value to date data type. TODATE(38462) = 2005-04-22
TODATE(‘22 April 2005’) = 2005-04-
22

Year Returns the Year part of a date. YEAR(2005-04-22) = 2005

Other Functions

Function Description Example of use
IsNull ISNULL(A, B) returns A if A is not null; or B if A is

null. See below for details.
ISNULL(<null>, 10) = 10
ISNULL(30,10) = 30

Linear In-
terpolation

Specify Ymin, Ymax, Xmin and Xmax, and for a given
Xset, this function will return Yset.

LINEAR INTERPOLATION(0,0, 2,4,
1) = 2

Length Calculates length from two parameters, i.e. ABS(Param2
- Param1)

LENGTH(5.418 – 6.254) = 0.836

PassThru Returns parameter value without modifying its display
type.

PASSTHRU(‘Alphabet’) = ‘Alphabet’
PASSTHRU(123) = 123

IsNull: The syntax for this function is ISNULL(check_expression, replacement_value), where check_expression is
the expression to be checked, and replacement_value is the expression to be returned if check_expression is NULL.

226 Chapter 12. Main Menu



NEXUS Documentation, Release 6.6.xxxxx.0

check_expression can be of any type. replacement_value must have the same type as check_expression. Note that an
alphanumeric field that contains an empty string is not null — to set the field value back to null, click the “X” button
at the right of the field.

User Functions

User functions are functions that have been defined by the Users. They can be further categorised by type.

Nulls

Almost any calculation involving a null will return null. For example, 2 + null = null.

Any comparison involving a null will always return false. This is occasionally a bit subtle: in a Comparison object, if
you compare null to null, it will return whatever value you have set for the False case.

(This is in line with accepted IT industry practice for nulls in data.)

There are some exceptions, where the right thing is to produce a numeric value despite the presence of some nulls:
if you use an operation object to calculate a Minimum, Maximum, or Average, nulls will be left out and the non-null
values will be used to calculate the answer. For example, the Average of 1 and null is 1. (If all inputs are null, a null
will of course be returned: the average of null and null is null.)

Tests

You can write test cases for your functions, under the “Tests” tab. Test cases let you test a function as you create it, and
storing your tests within the function lets you verify that a function still does what it did when you created it, and let
you re-validate a function after changes. When writing tests, you should write at least one that returns a valid result,
and if it’s possible for your function to return an Error, you should write at least one test for each possible error case.

Load / Save Template

Clicking Save Template will save the selected function and related details to a .function file. NEXUS IC will find all
items related to this function (asset information forms, event definitions, chart templates, lookup tables, etc), and will
present a dialog listing all the dependencies it’s found, with a checkbox for each row. Untick any that you don’t want
saved with your function.

This function can then be loaded into this or another database via Load Template. Note that if the previously saved
function still exists in this database, Load Template will overwrite that existing function — it will not create a new
copy of it. Similarly with any other elements saved in the .function file: asset information fields, lookup tables, etc.

Configuration → General → Functions allows you to create, edit and delete functions.

The Functions window enables you to build and edit customised functions which can be used in other areas of NEXUS
IC, such as Asset Information fields, Event fields and Report Sources. You can drag and drop elements into the Function
Editor, then connect the elements together to define the way in which data flows through your function.

Functions are integral to NEXUS IC. Functions are used within Risk Models (defining models, matrices and parame-
ters), they are also used in Asset Information fields (e.g. corrosion rates, retirement dates, pressures, wall thicknesses
etc) and Event Definitions (e.g. functions to calculate remaining wall thickness or span lengths).
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Add

To add a new function, click the Add button at the top of the “Configuration - Functions” dialog. Give your new
function a name and (optionally) a category. In the bottom half of the dialog, click the ‘+’ next to Elements, and drag
a Function Parameter from the Elements tree to the design area at the right. (All functions are required to have at least
one function parameter.) Drag other elements as desired.
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Once elements are in the design are at the right, you can connect two elements by dragging from the output square at
the bottom of one element to a second element. Your drag must begin on the source element’s output square, but can
end anywhere in the target element (not just on its input squares).

You can replace an existing connection by dragging from an output square to the specific input square whose connec-
tion you want to replace. You can break an existing connection by dragging it off an input square and dropping it on a
blank part of the design area.

You can connect one output to multiple inputs — there is no limit to the number of places you can connect a single
output to.

To view “on the fly” values for your function, click the Show Results button. You can also enter Input Values at the
bottom of the Tests tab. The function will be evaluated using the input values you specify.

If you give an element an input of a type it is not expecting, instead of a green result you will see a yellow error
message at the bottom of that element, explaining the type mismatch. You will similarly get yellow error messages for
other error cases, such as division by zero. These errors are only visible if the Show Results button is selected.

To edit an existing function, click the Edit button at the top of the Configuration → Functions dialog, then proceed as
above.

To save the function you’re editing, click OK.

To delete existing functions, select them in the Configuration → Functions dialog and click the Delete button at the
top of the dialog.

To see if a function is being used elsewhere in the application, click Connections.

Functions and function elements in NEXUS IC 6 are unit aware: if you have a function with two inputs leading to
an Addition operation, and one function has units in metres while the other has units in millimetres, NEXUS IC will
correctly deduce that one number needs to be scaled by a factor of 1000 before the two numbers are added. (Which
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direction the scaling happens depends on the output unit you select for the Addition element.) For many function
elements, you can select the output unit. (Note that NEXUS IC isn’t dimensionally aware: if you divide a length by a
time, it won’t understand that the result is a velocity.)

Global Tables

Global tables allow you to look up data based on another field or fields. Much of their configuration is similar to Asset
Information or Event Types, but the way they are used is quite different.

Suppose we set up a global table with two fields: Number (a numeric), and Name (an alphanumeric), and we add
values to the table like below:

Number Name
1 one
2 two
3 three

Then, if you have an asset information form field called Number, you can look up the matching entry from the global
table, and display it on the form. To do this, add an asset information form field of type Global Lookup. Edit that field
and set Linked Field to the “Name” field from your global table. On the Function page, you need to set a comparison
function — in this simple example you would choose “Compare A=B”, and the two parameters you’d set for that
function would be the Number field from your global table and the Number field from your asset information form.
This works somewhat like a JOIN in a database query: NEXUS will apply the comparison function, and that will cause
it to find the global table row that matches your asset field. If the “Number” field on your asset information form has
the value “2”, then NEXUS will look in your global lookup table, find the row with Number equal to “2”, look across
that row to find that Name is “two”, and will show that in the global lookup field on your asset information form.

Global tables can have more than two fields — we could add a third column to our example giving the name in French.
We can also use other comparison functions: there are others with names like “Compare A < B”, “Compare A <>
B”, and so on. You can also create your own: if you had three different fields in your asset information form that
all had to match the corresponding fields in your global lookup table, you might create a comparison function called
“Compare A=B and C=D and E=F”. Your comparison function should return the whole number “1” when you want
rows to match, and “0” when you want rows to not match. If there are several rows that would return a “1” (you could
write a particularly simple-minded comparison function called “Always return 1”, for example), then the first row that
matches will be returned.

Global tables can be useful for storing standardised data — for example, you could have global tables that store things
like properties of different materials, piping schedule data, etc.

Note that Global lookup fields are distinct from Lookup List fields: lookup lists let the user choose from a drop-down;
whereas Global Lookup fields are more like a Calculation, filling in a value without the user taking any action, and
without the user being able to later modify that value.

Lookup Lists

Lookup Lists store information used repeatedly throughout the application, ensuring that this data is stored uniformly.
Lookup Lists can be referenced from Asset Information fields and Event fields. Lookup Lists are particularly useful
for restricting a subjective assessment to a limited set of predefined values. For example, a Lookup List is an ideal
way to ensure consistency in the assessment of a concept like ‘priority’. Defining Lookup list Items High, Medium
and Low (with associated values of three, two and one respectively) in a Lookup List called ‘Priority’ can be used to
force a choice from a predefined priority schema.

On Asset Information forms, Event forms and Global Table forms, a lookup list field will show as a drop-down, from
which the user can pick an item.
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Each item in a Lookup List can have a value, a comment, an icon and a item order.

Comment is the descriptive text visible to users in the field on the form.

Value is what’s passed to functions that use this lookup list field as an input. If the lookup list item has some sensible
numeric value, this is often given in the Value field. For example, if the lookup list is “Anode depletion”, and the first
item has a Comment of “0 - 25%”, the Value might be “25”. If the lookup list items don’t have a sensible numerical
value, the Value is often set to the same text as the Comment.

Icon is optional. If set, users will see these icons in the field on forms, and in the drop-down list as they are picking an
item.

Item Order is also optional. If set, it controls the order that items are shown in in the drop-down list as users pick an
item. You can also click the Item Order button at the top of the dialog, and ‘Item Order’ dialog will appear. From
there, you can move the item with the Move Up or Move Down buttons available in the toolbar.

Map Servers

Map servers are used by the Map tab in the INSPECTIONS area. If you have your own GIS system, you can add its
Tile Server URL here to make your own GIS available in NEXUS IC’s maps tab. Your GIS must offer map tiles in the
way NEXUS IC is designed to consume them — contact us for details.

Traffic Lights

Traffic lights display as a coloured dot next to each asset in the asset hierarchy. Each traffic light has:

• A Name

• A Description

• A Value Field
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• An optional Colour Field, which is an Asset Information field used to give the colour of each traffic light dot.

• An optional Hint Field, which is an Asset Information field used to give the text that is visible when a user
hovers the mouse over a traffic-light dot.

If you don’t set a Colour Field, you can configure a series of traffic light colours in the bottom half of the dialog. These
will then be used to give the colour for the traffic light dot for each asset, by comparing each of these rows to the Value
Field for each asset. If your Value Field is numeric, you can use the Min Value and Max Value fields to set the colour.
If your Value Field is an alphanumeric, you can use the String Value field to set the colour. The Name you set for each
row will be visible in the Traffic Light legend at the bottom of the asset tree. Use the Order field to control the order
that items appear in in the legend.

If you don’t set a Hint Field, the Value Field is used for the hint text.

It is common to centralise all the Asset information fields you plan to use for traffic lights on the Traffic Light asset
information form. This allows you to glance at all the traffic lights for a given asset at once.

(Note that because the Traffic Light field must be calculated for every asset, NEXUS IC may be slower with a traffic
light turned on than it is with no traffic light turned on. However, since NEXUS IC caches results, this slowness should
only be visible the first time you view a given group of assets.)

Permissions

You can set permissions on traffic lights, to control which users and groups have access to display which traffic lights.

Edit a traffic light, and click on it Permissions tab. Click Add. Under User / Group, pick a user or group. Under
Permission, set a permission. The user or group you select will now have that permission applied: if you select Read
Only or Deny Write, the user (or group of users) will be able to use that traffic light, but not edit it. If you select
Read/Write, the user will be able to use that traffic light, and also edit it. If you select Deny All, the user will not be
able to select the traffic light for viewing, nor edit it.

Be sure not to deny access to all users, or you’ll wind up with a traffic light no-one can delete. See Security for more
on how different permissions interact.

This is an optional feature — if you set no permissions, all users will by default have access to all traffic lights.

Unit Types

Configuration → General → Unit Types allows you to create, edit and delete unit groups. Unit Types make NEXUS
IC unit-aware, and let it offer the user the option of switching units on a field.

The NEXUS IC database comes pre- populated with a standard set of Unit Groups and Units. When a Unit is assigned
to an Asset Information field, the value can be converted to any other Unit contained in that Unit Group.

Numeric fields that are defined with a Unit Group appear in the Asset Information form with a blue label. To convert
the value to a different unit type, click and select the unit type.

Unit Groups

Configuration → General → Unit Groups allows you to create, edit and delete unit groups. Unit Groups are a way of
quickly switching to different systems of measurement — for example, switching between metric and US weights and
measures.

Users can then select their desired units under Database → Your Profile.

Databases should by default have two unit groups configured: “Metric” and “US Weights and Measures”. To edit one
of these groups, select it and click Edit. On the Units tab, you can change which units are selected for this unit group.
Then, when a user views a field of that unit type, if the default unit for that field is not in the currently selected unit
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group, that field is instead displayed in the closest unit that is in the currently selected unit group. So if a field has an
underlying unit of centimetres, and the user has selected the “US Weights and Measures” unit group, that field will
instead be displayed in inches.

If you like, you can add extra unit groups: cgs and MKS, Potrzebie, etc.

Providers

Connections allows you to create point-to-point connections to external databases. Connection types shown in the
following table:

Definitions

Connection Type Description
Push where changes made in NEXUS are sent to the external field, but not vice versa
Pull where changes made in the external table are pulled into the field in NEXUS.
Push & Pull where changes made in either the external table or in NEXUS are propagated to the other

There are three steps to setting up a point-to-point connection. They are:

1. Set up the Provider

2. Set up the Tables; and

3. Set up the Columns.

Setting up the Provider

1. Click on Configuration → General → Providers

2. Click Add from the Configuration - Providers toolbar.

3. In the Add External Provider dialog, enter a descriptive Name for the Provider (eg. MAXIMO)

4. Choose the Provider Type (currently supports Oracle, MSSQL Server and Excel). Based on the Provider Type
selected, you will be presented with further options (eg. if you choose Oracle type, then you will need to enter
the Oracle Easy Connect String; if you choose Excel type, then you will need to enter the full path to the Excel
file; and if you choose MSSQL Server you will be required to enter the Server Address, Database Name and
other Authentication information.)

Connections

Setting up the Tables

Source Name

When you are adding a new Table, click on OK after you have chosen the Provider. When you relaunch the dialog,
the list of available Sources will be available for selection from a dropdown list.

1. Click on Configuration → General → Connections

2. Click Add from the Configuration - Connections toolbar.
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3. In the External Table dialog, click on the Ellipsis ( ) button to choose the Provider set up previously, and enter
a Name for the Table (eg. Workpack).

4. Enter the Source Name, this will be the database table name or for Excel the named table (eg. Workorder).

5. The Primary Key is the column or field defined in the External table which will be used to match to field in
NEXUS IC which identifies the row to be updated. The values in the chosen field must be unique (eg. Name).

6. Check or uncheck Allow Insert determines if NEXUS will insert rows into the External Table or the NEXUS
table.

Setting up the Columns

1. Click on Configuration → General → Connections

2. Click Add from the bottom toolbar in the Configuration - Tables dialog.

3. In the Add External Field Map dialog, click on the Ellipsis ( ) button to choose the Table set up previously.

4. The External Field Name will be the name of the Excel column or the name of the field in the MSSQL Server
table.

5. The Primary Key Field is a column or field defined in the NEXUS IC database which will be used to match to
the Primary Key field in the External table.

6. Choose which direction the data is to be passed from the Sync Direction dropdown list.

7. Finally, click on the Internal Field ellipsis button to choose a field in NEXUS which is mapped to the External
field column.

Shortcuts

Shortcuts - Worked Examples

Set up a Shortcut to send an email

In the following example we will create a Shortcut which sends an email when data in an AIG is edited and saved.

Step 1 - Create the Shortcut

Go to Configuration → General → Shortcuts and click on the Add toolbar button.
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Input requirements for the Shortcut are Name (mandatory field) and Category (non mandatory field).

Step 2 - Set up the Shortcut Trigger

The trigger for sending the Email is going to be the AIG titled Pipeline. So that when any user edits any data in this
AIG, an email will be generated and sent to the specified recipient.

To set up the trigger for the email, we need an Input Row element. Click on Input Row under the Inputs group and
drag it into the Shortcut workspace.

Input requirements for the Input Row is Name (type the name of the triggering AIG here), From (choose On Edit
from the dropdown list) and Object (choose the AIG table Pipeline).
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Step 3 - Set up the Email Attributes

We need to define the email Recipient, Subject line and Body text. To do this click on the Constant element under the
Inputs group and drag into the shortcut workspace. Edit the Constant and enter the Name (“Email Recipient” so that
is identifiable later) and Value (your email address) and click OK.
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Click on the Constant element under the Inputs group and drag into the Shortcuts workspace. Edit the Constant and
enter the Name (“Email Subject” so that it is identifiable later) and Value (your email address) and click OK.
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Click on the Concatenate String element under the Actions group and drag into the Shortcuts workspace. Edit the
Sentence builder element and enter the Name (“Email Body” so that it is identifiable later).

We are going to add text into the email body which is made up of information from the Pipeline AIG, click on the +
button in the bottom right hand corner of the control and choose New Item.
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In the New Shortcut Element dialog, choose Field from Row as the Element Type. The Name field will be auto-
populated based on your remaining selections. Choose Pipeline Row for the Row field and Pipeline Name as the
Field.
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Finally, click on the Email element under the Actions group and drag into the Shortcuts workspace. Edit the Email
element enter the Name (Send Email). Choose Email Recipient from the Recipient dropdown, choose Subject Line
from the Subject dropdown and EmailBody from the Body dropdown.

To test this functionality, change some data in the Pipeline AIG and click save.

Shortcuts are a series of steps all grouped together into one menu item. They can be seen as similar to Excel macros.

Editing a shortcut is analogous to editing a function.

Refer to Shortcuts - Worked Examples for a step-by-step guide on configuring Shortcuts.

Note: It is suggested that shortcuts are thoroughly tested prior to use in a Production environment. A shortcut can
have a destructive effect on a NEXUS database if not tested properly.

Toolbar

• Add, Edit, Delete: Add / Edit / Delete Shortcut(s).

• Export See Export for full description of the Export menu item.

• Customise See Customise for full description of the Customise menu item.

• Connections See Connections for information about the Connections toolbar option.

• Load Template Loads a previously saved .shortcut template. Note that if the previously saved Shortcut still
exists in this database, Load Template will overwrite that existing Shortcut — it will not create a new copy
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of it. Similarly with any other elements saved in the template file: asset information fields, functions, etc.

• Save Template Saves this Shortcut and related details to a .shortcut file. NEXUS IC will find all items related
to this Shortcut (functions, asset information forms, event definitions, chart templates, lookup tables, etc),
and will present a dialog listing all the dependencies it’s found, with a checkbox for each row. Untick any
that you don’t want saved with your Shortcut.

Shortcut Categories

Shortcuts can be put into categories. If a shortcut’s category matches the name of an existing button menu, then the
shortcut menu item will be placed in that menu. For example, if a shortcut is placed in a category called Assets, then
on the Assets screen this shortcut will be placed under the Assets menu button on the toolbar. The Inspection screen
also has an Assets menu button, so the shortcut would also be placed under the Assets menu on that screen. If the
shortcut was instead placed in a category called Asset Views, then on the Assets screen it would be placed under the
Asset Views menu button. The Inspections screen has no such menu button, so instead it would be placed under a
menu button called Shortcuts.

Shortcuts do show when appropriate on other panels within a screen — for example, shortcuts that act on an asset will
appear on the Children panel on the Assets screen. But shortcuts will not appear on “Picker” dialogs that work on that
type — so if you edit a drawing layer and pick an asset for that layer, you won’t see shortcuts.

Shortcut Elements

The shortcut editor contains two types of elements - Actions and Inputs.

These two items are very similar as some inputs may perform an action and some actions may be able to act as an
input, but they are categorised and displayed based in the editor based on what their ‘primary’ purpose is.

Actions

Name Description
Function This action executes a NEXUS function, the output of the function can be used as an input into

another element.
Update Row This action is used to update a row in a Business Object
Insert Row This action is used to create a new row in a Business Object
Concatenate
String

This action builds a string using a set of inputs and the result can then be used as an input into
another element.

Set Value This action sets the value of a variable.
Email This action generates an email.

An Action can have Inputs and outputs. Actions appear in the white centre part of the Shortcut configuration window.

The “Update Row” action can be used to show a dialog to the user, by setting the action’s Style to “Allow User to
Edit”.

Inputs

Input Row This forms the basis of where a shortcut exists and is triggered.
Variable Holds temporary information within the shortcut, used as an input to an action.
Constant A constant value, used as an input to an action.
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Inputs can have an Action. Inputs appear in the grey section on the right-hand side.

An Input’s “From” determines when the shortcut will be available: if the From is set to “On Add” then the shortcut
will run every time a row is added to the selected Object (i.e. database table). Similarly with On Edit and On Delete.
(In these three cases the shortcut will only execute when the row is added/edited/deleted by our software, be it NEXUS
IC, IC-Inspection or the REST service used by IC-Web, IC-Inspector and third parties.) If the From is set to Retrieve
Focused Item, the shortcut will appear as a menu option on grids for the relevant Object — e.g. if the Object is the
Anomaly table, your shortcut would appear as a menu item on the toolbar above the Anomaly table on the Anomalies
screen and on the Assets screen and on any dialog where the user is selecting an anomaly. If the From is set to Prompt
User to select Row, then when the shortcut runs, the user will be shown a picker dialog on the appropriate database
table.

The Name you set for your input may be visible as title text on a user selection dialog.

To get your new or edited shortcuts to refresh, you will need to close and re-open your database.

Multi-select

You can have multi-selected rows feeding into your shortcut, so the user can select several items in a grid and then run
your shortcut. But user selection dialogs launched within the shortcut are single-select. If the user multi-selects and
runs a shortcut that has a selection dialog, an Apply to All checkbox will appear at the bottom left of the selection
dialog. If the user ticks this box, their selection will apply to all (remaining) runs of the shortcut. If they don’t, their
selection will be used for this run, and the selection dialog will be shown again for the next run.

Within an input, the “From” option of “Retrieve Focused Item” is inherently multi-select: your shortcut actually gets
run once for each selected item.

Boolean Types: open/closed, on/off, etc.,
Chart Templates: for display in the software and in reports,
Company,
Functions: for use in calculated fields, charts, reports, etc.,
Global Tables: lookup data from one field for display in another,
Lookup Lists: create lists for users to pick from,
Map Servers: configure URLs for custom map servers,
Traffic Lights: for use on the asset tree,
Unit Types,
Unit Groups,
Providers: details for connections to external data sources,
Connections: connections to external data sources,
Shortcuts: sequences of actions that users can activate with a single menu item click.
Shortcut Categories.

12.3.2 Assets

Asset Information

Configuration → Assets → Information allows you to create and configure Asset Information forms. Users can then
use these forms to record data against assets.
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Asset information forms with the same Category will appear grouped together. (Icon, Colour and Shape are not used
for asset information forms, though they are for Event forms. ‘Allow Inheritance’ is not yet implemented.)

In the top half of this dialog, you can add, edit and delete forms. In the bottom half, you can add, edit or delete fields
within forms.

To add a form, click Add in the top toolbar. To edit, click Edit. Once you do either of these things, you should see
the ‘Table Definition’ dialog. (From NEXUS’s point of view, form data is stored in tables, which is why it gives the
dialog that title.)

When you Add, you will need to select what type of form you are creating: Asset Information or Sub Asset Informa-
tion.

An Asset Information form has a one-to-one relationship with an asset: a single asset has a single instance of this
particular form. So Appurtenance #23 would have a single Appurtenance form for capturing its details. (That asset
might have other forms of other types: Traffic Light, Inspection History, etc.; but it would only have one form of each
of the types assigned to it.)

A Sub Asset Information form appears within one of the other four types of form, and can contain multiple records for
a single instance of its owning form. For example, a “Licenses” Asset Information form might contain a field showing
the date the asset was first licensed, a field showing the date its latest license expires, and a Sub Asset Information
form showing the various different licenses the asset has held over time.

Table Definition Dialog

On the Table Definition page you can choose the form’s Name (as it will appear in the user interface), and an optional
Description, Category, Icon, Colour and Shape.

If you tick Allow Security, then in the Database → Security menu, you can control which users (and groups of users)
will have what access to this form (no ability to view, ability to view but not modify, or ability to view and modify).

On the Library tab, you can optionally add one or more Library Items to this form. This might be useful if you want
instructions for filling out the form to be stored in the database.

On the Asset Types page, you can select the asset types for which this form will be available. (By default, no asset
types are selected, so this form won’t be available anywhere in the database.)

To move a field up or down in the form or grid, use the Field Order button in the Asset Information main toolbar. For
example, if you want to place a field between two other fields in the form, select Form . . . from the drop down list,
then a ‘Form Field Order’ dialog will appear. From there, you can move the field with the Move Up or Move Down
buttons available in the toolbar.

Fields

Forms are only useful if they contain fields. Each field can contain data of a single type (except for fields of type
Position Link and Table Link).

To add a field, click Add. That will bring up the ‘Add Field Definition’ dialog.

Field Definition

On the Field Definition page, you must give the field a Name and a Field Type. The remainder of the form will change,
depending on the Field Type you select.

For Numeric fields, you can specify Unit, Format and number of decimal places or significant figures to display.
(This can be helpful if a user chooses to display data in a different unit: an integer number of millimetres might be a
non-integer number of inches.)
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Field Layout

The Field Layout page has various section which control the display of the field in different modes.

Grid

Under Grid, you can set Visible to determine whether this field will be visible when the form data is viewed as a grid
(e.g. on the Children tab for asset forms, or in the Event Listing for events).

You can set Order to control the column order within the grid — the column with the lowest Column Order will be at
the left of the grid, and so on. (You can also set grid Field Order on the form as a whole — see above.) Grid order is
also used to set the order of columns in a Custom Export of assets or events.

Text Alignment controls whether this field aligns left, centre or right. If you do not set an alignment, text fields will
default to left, numeric fields to right, and date fields to centre.

Caption allows you to have a title on the grid column for this field that is different from the field’s underlying name.

Form

Similarly you can set Visible Form to control whether the field appears on the form itself.

You can set Category to group fields within a form. Setting Order controls the order of fields within Categories, and
the order of Categories on the form: the Category that contains the field with the lowest Order will be displayed first.
Within the Category, the field with the lowest Order will be displayed first. (You can also set form Field Order on the
form as a whole — see above.)

Untick Show Caption if you want this field to appear without a caption next to it on forms.

Set Columns to control how wide this field appears on a form: if this is a two-column-wide form, setting this field’s
Columns to 1 will cause the field plus caption to fill 50% of the width of the form; setting it to 2 will cause it to fill
the full width. Forms default to two columns wide, unless you specify otherwise in a Category — edit the Category

(click on the button, then click Edit) and set its Columns. While editing the Category you can also set an image
or descriptive text to appear at the top of this category. This might be instructions on how to fill in the form, details of
how calculations on the form are worked out, etc.

Form Caption allows you to have a title on the form next to the field that is different from the field’s underlying name.

Report

Visible controls whether this field will be shown when the table is exported in a report template.

IC-Inspector

Visible means this field will be shown in IC-Inspector. If you set an event field to visible, it will be available to
inspectors to fill in. If you set an asset information field to visible, it will be displayed to inspectors above any forms
they may be filling out. Use this sparingly: a long list of visible asset information fields will fill the inspector’s screen
and force them to scroll to reach the form they are trying to fill out.

Order and Caption work analogously to those in Grid and Form.
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General

Editor Type controls what type of editor the user will see when they edit the value in this field.

If you set Blank Text, the text you set will be displayed greyed out whenever the field is empty. (You can see several
fields with Blank Text set right here on the Field Layout tab.)

Hint: As you add (or edit) fields, you can see a preview at the lower right of the dialog, showing how the

fields will appear on either a form or a grid. Fields that are selected will be shown with a exclamation
mark next to them in the form preview. If the field is a lookup list, you can drop down the lookup list
to see its values. (You can also see and edit a lookup list’s values when choosing the lookup list: on the
“Select Lookup List” dialog, click Edit, click Items.)

Edit

To edit a field, click Edit. That will bring up the ‘Edit Field Definition’ dialog. (This is the same as Add Field
Definition, but has more tabs. This is because a variety of field settings are only available after a field has been
created.)

If your field is of type Calculation, there will be a Function tab. This tab will allow you to choose a function for this
calculation, and will also allow you to choose parameters for the function. You can either set “Parameters (Inputs)” or
“Parameters (Values)” for each parameter. “Parameters (Inputs)” lets you choose some other field as the input for that
parameter; “Parameters (Values)” lets you assign a constant. These are mutually exclusive — you can only fill one or
the other for each parameter.

Workflow Rules

Sometimes you want a field’s properties to be controlled by other data. If you want, for example, a field to be visible
only when some other field is filled in (or vice versa), edit the field and go to the Workflow Rules tab. Click Add,
and under Trigger Type choose “Set Field Visibility on Form”. Then add a function, and parameters for that function.
The function should return a Yes/No value. When it returns Yes, the field will be visible, when No, the field will
be invisible. Similarly you can use Workflow Rules to set a field as read-only, or to mark a field as required. The
remaining trigger type, “Clear Field Value on Form”, can be used to automatically empty out a field’s value when
some condition is met — for example, it can be used to make two fields mutually exclusive, so that users can fill in
one field or the other, but not both.

There are a set of system functions that you can use that mean you don’t need to create custom functions:

• Compare - Is Null

• Compare - Is Not Null

• Compare A = B

• Compare A <> B

Note that workflow rules are run when forms are viewed interactively, but are not applied during imports. If you have
ticked the “Required” box on the Field Definition page, this will be enforced during imports — rows that are missing
required fields will be rejected. But if a workflow rule makes a field required, this will not be enforced during imports.

12.3. Configuration 245



NEXUS Documentation, Release 6.6.xxxxx.0

Field Specific Units

This feature works in coordination with Unit Groups. Suppose you want Easting and Northing to display in metres,
even when US Weights and Measures are selected — you can specify that here. (You’ll need to specify it once for the
Easting field, and once for the Northing field.)

Anomaly Triggers

Here you can add anomaly triggers to a field.

When an anomaly trigger is violated, a yellow exclamation mark ( ) will appear next to the field. You can set
lower/upper bounds to be constant values (so a field might trigger if it was outside, say, 1 to 9) or to pull from a field,
on this form or on another form. So for example if this field is Measured Wall Thickness, it might trigger if its value
is less than Minimum Allowable Wall Thickness.

For Lookup List fields, the comparison is done of the lookup list item’s Value, not its Comment. So if you have a
lookup list titled “Anode Depletion”, and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS
will use the “25” for purposes of determining whether an anomaly trigger should be fired.

For Yes/No fields you can set the trigger to fire on any combination of Yes, No or blank; but you can’t compare to
another field.
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The Include Boundary tickbox controls whether exact matches cause the trigger to fire: if you have set a trigger
to “Fail when inside Upper/Lower bounds”, your lower bound is 1 and your upper bound is 9, this is the difference
between “1 < x < 9” and “1 <= x <= 9”.

You can optionally give an anomaly trigger a date range. If you set just a Date From, the trigger will apply only to
event data from that date forward. If you set just a Date To, the trigger will apply only to event data from that date or
earlier. If you set both, the trigger will apply only to event data within the specified range. In this way, you can change
triggers to reflect new conditions, without causing spurious warnings on historical data. For example, if you decrease
the operating pressure of an asset, this might decrease the minimum allowable wall thickness. Rather than editing the
existing anomaly trigger, you can set a “To” date on that old trigger, and add a new trigger with a “From” date.

Caution: In most cases, Findings are generated at the time events are added or imported. There are however some
scenarios in which the Anomaly Triggers utility should be run manually. These are 1) whenever anomaly triggers
are edited; 2) when anomaly triggers exist on a calculation field; 3) before any Finding review sessions; or 4) after
a bulk import of event data (particularly when anomaly triggers rely on events other than itself).

Triggers for a field independent of asset are found in NEXUS IC in Asset Information and Event Types. Anomaly
triggers for specific assets can be configured in NEXUS IC by right-clicking on an asset and choosing Anomaly
Triggers. . . . If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply. Note that asset-specific anomaly triggers are specific to their asset — they do not automatically
apply to an asset’s children.

A trigger can have an anomaly Code and a Severity, and you can have several different triggers on a single field, with
different codes and/or severities. The dialog may also show a preview chart, showing which triggers apply at which
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(You may need to close and re-open the database for any newly added anomaly triggers to take visible effect.)

Auto-increment Fields

It’s possible to set a field to auto-increment. For example, if you wanted each new anomaly you created to automati-
cally have an as-yet-unused anomaly number pre-populated, you would do this by setting the Anomaly Number field
to be an auto-increment field. To do this, set the field’s Default Value to @autoinc. For system tables like Anomaly,
you can’t do this through the NEXUS IC user interface, so you should ask support@nexusic.com for assistance.

Auto-populate date/time or user name

Similar to @autoinc, you can set a field to pre-populate with the date/time the record was created by setting its
Default to @now. This works for any sub-event, AIG or sub-AIG field.

You can also set a field to pre-populate with the logged-in user’s name by setting its Default to @user. This works
for any event, sub-event, AIG or sub-AIG field.

These default values are populated when the row is created. For an AIG, that’s when the asset is created. For an event
it’s when the event is created. For a sub-event or sub-AIG it’s when the user clicks the ‘+’ to create the new sub-event
or sub-AIG row.

Asset Types

Asset Types are assigned to each asset in the Asset Hierarchy Tree. The Asset Type determines what Asset Information
Groups, Event Definitions and Survey Data groups are applicable to particular Assets.

The Asset Type describes the following properties for each individual asset:

• The Name of the asset type

• The Description of the asset type

• The Asset Icon (16 x 16 pixels) which will represent the asset in the asset hierarchy tree.

If no icon is assigned to an Asset Type, then the default icon will be displayed in the asset hierarchy tree.

When selecting an icon, you can click Connections to see what other asset types it is already used on.
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Asset Types also have Asset Information forms, Event Types, and Survey Data types assigned to them. If an asset type
has an asset information form assigned to it, when you click on an asset of that type, you will see that form (and you
will be able to enter and store data for that asset in that form). If an asset type has an event type assigned to it, then
you will be able to create events of that event type on assets of that asset type. If an asset type has a survey data type
assigned to it, then survey data of that type can be logged against assets of that type.

Assigning Asset Information Forms

To assign Asset Information forms to an Asset Type, do the following:

1. Select the Asset Type from the Asset Types dialog.

2. Click the Edit button on the Asset Types toolbar to launch the Edit Asset Type dialog.

3. On the Asset Information Groups tab page, check the Asset Information Groups to assign to the selected Asset
Type.

Assigning Event Types to an Asset Type

To assign Event Types to an Asset Type, do the following:

1. Select the Asset Type from the Asset Types dialog.

2. Click the Edit button on the Asset Types toolbar to launch the Edit Asset Type dialog.

3. On the Events tab page, check the Events to assign to the selected Asset Type.

Assigning Survey Data to an Asset Type

To assign a Survey Data group to an Asset Type, do the following:

1. Select the Asset Type from the Asset Types window.

2. Click the Edit button on the Asset Types toolbar to launch the Asset Type dialog.

3. On the Survey Data tab page, check the Survey Data groups to assign to the selected Asset Type.

Features

Configure Features to set which Asset Information field is the source for:

• As Built - Order, As Built - Easting, As Built - Northing: sub-AIG fields used by the Map feature to show an
as-built pipeline track.

• DVR - Relative Folder: used by IC-Inspection to specify the folder to record video into for each asset.

• Feature - Start, Feature - End, Feature - Name, Feature - Category: These fields are now redundant but may
be used in the future. Just leave blank.

• Asset - Abbreviation: This field is now redundant but may be used in the future. Just leave blank.

• Asset - Serial Number: used to connect NEXUS IC assets to elements in a 3D drawing.

• Coordinates - Datum, Coordinates - UTM Zone: used by the Map feature to fetch real-world maps from
OpenStreetMap, ESRI, etc.
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Sensors

This is the area that was known as Monitored Data in NEXUS IC 5. Sensor data is recorded against assets, at a series
of points in time (for example, once per hour).

Here you can configure sensor data forms.

(Icon, Colour and Shape are not used for asset information forms, though they are for Event forms. ‘Allow Inheritance’
is not yet implemented.)

In the top half of this dialog, you can add, edit and delete forms. In the bottom half, you can add, edit or delete fields
within forms.

To add a form, click Add in the top toolbar. To edit, click Edit. Once you do either of these things, you should see
the ‘Table Definition’ dialog. (From NEXUS’s point of view, form data is stored in tables, which is why it gives the
dialog that title.)

Table Definition Dialog

On the Table Definition page you can choose the form’s Name (as it will appear in the user interface), and an optional
Description, Category, Icon, Colour and Shape.

If you tick Allow Security, then in the Database → Security menu, you can control which users (and groups of users)
will have what access to this form (no ability to view, ability to view but not modify, or ability to view and modify).

On the Library tab, you can optionally add one or more Library Items to this form. This might be useful if you want
instructions for filling out the form to be stored in the database.

On the Asset Types page, you can select the asset types for which this form will be available. (By default, no asset
types are selected, so this form won’t be available anywhere in the database.)

To move a field up or down in the form or grid, use the Field Order button in the Asset Information main toolbar. For
example, if you want to place a field between two other fields in the form, select Form . . . from the drop down list,
then a ‘Form Field Order’ dialog will appear. From there, you can move the field with the Move Up or Move Down
buttons available in the toolbar.

Fields

Forms are only useful if they contain fields. Each field can contain data of a single type (except for fields of type
Position Link and Table Link).

To add a field, click Add. That will bring up the ‘Add Field Definition’ dialog.

Field Definition

On the Field Definition page, you must give the field a Name and a Field Type. The remainder of the form will change,
depending on the Field Type you select.

For Numeric fields, you can specify Unit, Format and number of decimal places or significant figures to display.
(This can be helpful if a user chooses to display data in a different unit: an integer number of millimetres might be a
non-integer number of inches.)

Field Layout

The Field Layout page has various section which control the display of the field in different modes.
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Grid

Under Grid, you can set Visible to determine whether this field will be visible when the form data is viewed as a grid
(e.g. on the Children tab for asset forms, or in the Event Listing for events).

You can set Order to control the column order within the grid — the column with the lowest Column Order will be at
the left of the grid, and so on. (You can also set grid Field Order on the form as a whole — see above.) Grid order is
also used to set the order of columns in a Custom Export of assets or events.

Text Alignment controls whether this field aligns left, centre or right. If you do not set an alignment, text fields will
default to left, numeric fields to right, and date fields to centre.

Caption allows you to have a title on the grid column for this field that is different from the field’s underlying name.

Form

Similarly you can set Visible Form to control whether the field appears on the form itself.

You can set Category to group fields within a form. Setting Order controls the order of fields within Categories, and
the order of Categories on the form: the Category that contains the field with the lowest Order will be displayed first.
Within the Category, the field with the lowest Order will be displayed first. (You can also set form Field Order on the
form as a whole — see above.)

Untick Show Caption if you want this field to appear without a caption next to it on forms.

Set Columns to control how wide this field appears on a form: if this is a two-column-wide form, setting this field’s
Columns to 1 will cause the field plus caption to fill 50% of the width of the form; setting it to 2 will cause it to fill
the full width. Forms default to two columns wide, unless you specify otherwise in a Category — edit the Category

(click on the button, then click Edit) and set its Columns. While editing the Category you can also set an image
or descriptive text to appear at the top of this category. This might be instructions on how to fill in the form, details of
how calculations on the form are worked out, etc.

Form Caption allows you to have a title on the form next to the field that is different from the field’s underlying name.

Report

Visible controls whether this field will be shown when the table is exported in a report template.

IC-Inspector

Visible means this field will be shown in IC-Inspector. If you set an event field to visible, it will be available to
inspectors to fill in. If you set an asset information field to visible, it will be displayed to inspectors above any forms
they may be filling out. Use this sparingly: a long list of visible asset information fields will fill the inspector’s screen
and force them to scroll to reach the form they are trying to fill out.

Order and Caption work analogously to those in Grid and Form.

General

Editor Type controls what type of editor the user will see when they edit the value in this field.

If you set Blank Text, the text you set will be displayed greyed out whenever the field is empty. (You can see several
fields with Blank Text set right here on the Field Layout tab.)

12.3. Configuration 251



NEXUS Documentation, Release 6.6.xxxxx.0

Hint: As you add (or edit) fields, you can see a preview at the lower right of the dialog, showing how the

fields will appear on either a form or a grid. Fields that are selected will be shown with a exclamation
mark next to them in the form preview. If the field is a lookup list, you can drop down the lookup list
to see its values. (You can also see and edit a lookup list’s values when choosing the lookup list: on the
“Select Lookup List” dialog, click Edit, click Items.)

Edit

To edit a field, click Edit. That will bring up the ‘Edit Field Definition’ dialog. (This is the same as Add Field
Definition, but has more tabs. This is because a variety of field settings are only available after a field has been
created.)

If your field is of type Calculation, there will be a Function tab. This tab will allow you to choose a function for this
calculation, and will also allow you to choose parameters for the function. You can either set “Parameters (Inputs)” or
“Parameters (Values)” for each parameter. “Parameters (Inputs)” lets you choose some other field as the input for that
parameter; “Parameters (Values)” lets you assign a constant. These are mutually exclusive — you can only fill one or
the other for each parameter.

Workflow Rules

Sometimes you want a field’s properties to be controlled by other data. If you want, for example, a field to be visible
only when some other field is filled in (or vice versa), edit the field and go to the Workflow Rules tab. Click Add,
and under Trigger Type choose “Set Field Visibility on Form”. Then add a function, and parameters for that function.
The function should return a Yes/No value. When it returns Yes, the field will be visible, when No, the field will
be invisible. Similarly you can use Workflow Rules to set a field as read-only, or to mark a field as required. The
remaining trigger type, “Clear Field Value on Form”, can be used to automatically empty out a field’s value when
some condition is met — for example, it can be used to make two fields mutually exclusive, so that users can fill in
one field or the other, but not both.

There are a set of system functions that you can use that mean you don’t need to create custom functions:

• Compare - Is Null

• Compare - Is Not Null

• Compare A = B

• Compare A <> B

Note that workflow rules are run when forms are viewed interactively, but are not applied during imports. If you have
ticked the “Required” box on the Field Definition page, this will be enforced during imports — rows that are missing
required fields will be rejected. But if a workflow rule makes a field required, this will not be enforced during imports.
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Field Specific Units

This feature works in coordination with Unit Groups. Suppose you want Easting and Northing to display in metres,
even when US Weights and Measures are selected — you can specify that here. (You’ll need to specify it once for the
Easting field, and once for the Northing field.)

Anomaly Triggers

Here you can add anomaly triggers to a field.

When an anomaly trigger is violated, a yellow exclamation mark ( ) will appear next to the field. You can set
lower/upper bounds to be constant values (so a field might trigger if it was outside, say, 1 to 9) or to pull from a field,
on this form or on another form. So for example if this field is Measured Wall Thickness, it might trigger if its value
is less than Minimum Allowable Wall Thickness.

For Lookup List fields, the comparison is done of the lookup list item’s Value, not its Comment. So if you have a
lookup list titled “Anode Depletion”, and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS
will use the “25” for purposes of determining whether an anomaly trigger should be fired.

For Yes/No fields you can set the trigger to fire on any combination of Yes, No or blank; but you can’t compare to
another field.
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The Include Boundary tickbox controls whether exact matches cause the trigger to fire: if you have set a trigger
to “Fail when inside Upper/Lower bounds”, your lower bound is 1 and your upper bound is 9, this is the difference
between “1 < x < 9” and “1 <= x <= 9”.

You can optionally give an anomaly trigger a date range. If you set just a Date From, the trigger will apply only to
event data from that date forward. If you set just a Date To, the trigger will apply only to event data from that date or
earlier. If you set both, the trigger will apply only to event data within the specified range. In this way, you can change
triggers to reflect new conditions, without causing spurious warnings on historical data. For example, if you decrease
the operating pressure of an asset, this might decrease the minimum allowable wall thickness. Rather than editing the
existing anomaly trigger, you can set a “To” date on that old trigger, and add a new trigger with a “From” date.

Caution: In most cases, Findings are generated at the time events are added or imported. There are however some
scenarios in which the Anomaly Triggers utility should be run manually. These are 1) whenever anomaly triggers
are edited; 2) when anomaly triggers exist on a calculation field; 3) before any Finding review sessions; or 4) after
a bulk import of event data (particularly when anomaly triggers rely on events other than itself).

Triggers for a field independent of asset are found in NEXUS IC in Asset Information and Event Types. Anomaly
triggers for specific assets can be configured in NEXUS IC by right-clicking on an asset and choosing Anomaly
Triggers. . . . If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply. Note that asset-specific anomaly triggers are specific to their asset — they do not automatically
apply to an asset’s children.

A trigger can have an anomaly Code and a Severity, and you can have several different triggers on a single field, with
different codes and/or severities. The dialog may also show a preview chart, showing which triggers apply at which
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(You may need to close and re-open the database for any newly added anomaly triggers to take visible effect.)

Auto-increment Fields

It’s possible to set a field to auto-increment. For example, if you wanted each new anomaly you created to automati-
cally have an as-yet-unused anomaly number pre-populated, you would do this by setting the Anomaly Number field
to be an auto-increment field. To do this, set the field’s Default Value to @autoinc. For system tables like Anomaly,
you can’t do this through the NEXUS IC user interface, so you should ask support@nexusic.com for assistance.

Auto-populate date/time or user name

Similar to @autoinc, you can set a field to pre-populate with the date/time the record was created by setting its
Default to @now. This works for any sub-event, AIG or sub-AIG field.

You can also set a field to pre-populate with the logged-in user’s name by setting its Default to @user. This works
for any event, sub-event, AIG or sub-AIG field.

These default values are populated when the row is created. For an AIG, that’s when the asset is created. For an event
it’s when the event is created. For a sub-event or sub-AIG it’s when the user clicks the ‘+’ to create the new sub-event
or sub-AIG row.

Risk Charts

Here you can configure risk matrix charts. One chart can be used by several risk models.

Risk charts will be displayed on the Assets screen, on the Risk tab.

When you edit a risk chart, you can change its various properties. “X Axis Granulation” defines how many squares
wide the risk chart is; “Y Axis Granulation” sets how many squares tall it is.

Once you’ve chosen a granulation, you’ll want to set Axis Ticks. These are semicolon-separated lists, one for each
axis. So if your matrix is 5x5, you might set X Axis Ticks to “A;B;C;D;E” and Y Axis Ticks to “1;2;3;4;5”. Or you
could use longer descriptive text like “Negligble;Mild;Moderate;Major;Severe”, or whatever is mandated by your risk
model.

Right-click on a square to set its colour. Choose a predefined colour or choose Custom to get a colour picker dialog.

Left-click on a square and you can set a whole number risk value for that square.

Risk Models

The Risk technology within NEXUS IC provides a powerful framework so that you can configure formalised risk
assessment & RBI methodologies (e.g. API 581 BRD, DN- RP- G101, AS 2885.1, AS 4360) or set up custom risk
models of any level of complexity (i.e., Corporate risk models, internally workshopped models, or tailored/customised
models to suit specific issues or situations).

Here on the Configuration → Assets → Risk Models dialog you can create and configure Risk Models.

(To assign risk model(s) (and corresponding assessments) to an asset, go to Assets, select the Risk tab, and use the
Assign button. You can assign more than one risk model to an asset.)

You can see what assets have a particular risk model assigned by clicking on the risk model, then clicking the Con-
nections button.
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Risk Models can optionally be given a (user-configurable) Model Status and a (user-configurable) Category. (This
Category is separate from the Categories discussed below.)

The concept of Risk Models is hierarchical: the final Risk value is comprised of n Categories. Each Category value is
comprised of n Factors. Each Factor value is comprised of n Calculations, Pass Thrus, Values and Factors.

Each of these entities (Category, Factor, etc.) is displayed in the bottom half of the Configuration - Risk Models dialog
in a hierarchical structure tree, with each level expandable and collapsible.

When you create a new risk model (via the Add button), it has three top-level categories: Risk, X Value, and Y Value.
X Value and Y Value are used to determine the position of the dot on the risk chart: 0 is at the left or bottom of the chart
(depending on which axis we’re talking about), and 1 is at the right or top. Typically you want a function which puts
each likelihood or consequence into its row or column, but you may also want to move to slightly different locations
within a risk square based on scenario, so that different scenarios’ dots will not all draw over the top of each other.

The other top-level category, Risk, contains your risk model functionality. Beneath Risk you can add Factors, and
below Factors you can add Calculations, Pass Thrus, Values and more Factors. Each factor has a Function, which you
can access by clicking in the Function cell at the right-hand side of that factor’s row in the grid, and then clicking the

at the right of that cell. That function has all of the elements that are children of this factor as inputs, thus allowing
you to combine all those inputs in whatever way is appropriate, for use by the next layer up. Ultimately, the function
in the Risk element is therefore combining everything below it.

Risk models can pull information from Asset Information forms, or from calculations within the risk model, or from
Values stored directly within the risk model assessment. If you are using more than one scenario for a single asset, the
information that varies from one scenario to another should be stored as Values within the risk model. (You can add

scenarios on the Assets → Risk tab: click Edit to edit the assessment, then click Scenario.)

Asset Information: forms for users to enter data against assets,
Asset Types,
Features,
Sensors: forms to log periodic data (temperature and pressure once per minute, etc.),
Risk Charts,
Risk Models.

12.3.3 Planning

Configuration → Planning

The various Configuration → Planning menu items allow you to create, edit and delete Cost Codes, Schedule Types,
Task Categories, Task Statuses, Workpack Groups and Workpack Revisions.

Cost Codes

Schedules can be given a Cost Code. This can be useful if it ties in with an external CMMS.

Types

Schedules can be given a Type. This is a non-required field, used for grouping, categorising.
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Task Categories

Are used to group Tasks. If your database contains different kinds of data, for example some below-water and some
above-water data, you might like to create one Task Category for “Above water” and another for “Below water”. Or
below water might be separated into “ROV” and “Diver”.

Task Status

Tasks have a Status, for user-defined categorisation. For example, it can contain entries describing why a task could
not be completed: item inaccessible, item non-existent, task is a duplicate, etc.

Workpack Groups

Workpacks can be grouped. . .

Workpack Revisions

. . . and given a Revision. By default, the grid on the WORKPACKS screen is grouped by Revision.

Cost Codes,
Types,
Task Categories,
Task Status,
Workpack Groups,
Workpack Revisions.

12.3.4 Events

Event Types

Configuration → Events → Event Types allows you to create and configure event forms. Users can then use these
forms to record event data.

An event’s Icon is used to represent it in IC-Inspection’s Launch pane. An event’s Colour is used to represent it on
charts. An event’s Shape is used to represent it on charts with drawings. “Allow Security” controls whether an entry
for this event type will be shown in the Security dialog. (Category is not used for event forms.)

In the top half of this dialog, you can add, edit and delete forms. In the bottom half, you can add, edit or delete fields
within forms.

To add a form, click Add in the top toolbar. To edit, click Edit. Once you do either of these things, you should see
the ‘Table Definition’ dialog. (From NEXUS’s point of view, form data is stored in tables, which is why it gives the
dialog that title.)

When you Add, you will need to select what type of form you are creating: Event, Sub Event, Survey Data, or
Continuous Event.

Events are for things that represent a single point in time and space, or a short range of time and/or space: a form to
capture details about an anode’s current state, for example, would be an event.
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Continuous Events

A Continuous Event is for capturing periodic data. For example, on a subsea pipeline inspection, you might cap-
ture seabed information every n metres. Continuous events do not normally appear in the Event Listing, unless you
specifically filter for them.

Survey Data

A Survey Data form captures information like location (Easting, Northing, etc.), KP, CP (CP Reading, Field Gradient,
etc.) and so on. Survey Data such as KP, Easting, Northing, Latitude, Longitude and Elevation is logged into a Survey
Set. Each Event has a reference to Survey Set and the positional data contained is retrieved from the Survey Set,
matching on the Date Time Stamp in the Survey Set and the Date Time Stamp (Start Clock) of the event. Survey
Set data is imported inherently with any Event Import. The Inspection data import templates are formatted with the
required columns. It is also possible to import Survey Set Data independent of Event records and the following sections
describe how this can be achieved. To edit individual survey data points, go to Configuration → Events → Survey Sets.

Sub Events

A Sub Event appears within one of the other four types of form, and can contain multiple records for a single instance
of its owning form. For example, a CP Reading event form might have a sub-event form on it for registering several
readings; a Seabed Profile continuous event form might have a sub-event form on it for recording a range of cross-
profile depths; etc.

Configure Location/Pipeline Features

Here you can set which field is the source for various position information, used by the Pipeline View. Usually, you
will select Survey fields for the position fields.

Table Definition Dialog

On the Table Definition page you can choose the form’s Name (as it will appear in the user interface), and an optional
Description, Category, Icon, Colour and Shape.

If you tick Allow Security, then in the Database → Security menu, you can control which users (and groups of users)
will have what access to this form (no ability to view, ability to view but not modify, or ability to view and modify).

On the Library tab, you can optionally add one or more Library Items to this form. This might be useful if you want
instructions for filling out the form to be stored in the database.

On the Asset Types page, you can select the asset types for which this form will be available. (By default, no asset
types are selected, so this form won’t be available anywhere in the database.)

To move a field up or down in the form or grid, use the Field Order button in the Asset Information main toolbar. For
example, if you want to place a field between two other fields in the form, select Form . . . from the drop down list,
then a ‘Form Field Order’ dialog will appear. From there, you can move the field with the Move Up or Move Down
buttons available in the toolbar.

Fields

Forms are only useful if they contain fields. Each field can contain data of a single type (except for fields of type
Position Link and Table Link).
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To add a field, click Add. That will bring up the ‘Add Field Definition’ dialog.

Field Definition

On the Field Definition page, you must give the field a Name and a Field Type. The remainder of the form will change,
depending on the Field Type you select.

For Numeric fields, you can specify Unit, Format and number of decimal places or significant figures to display.
(This can be helpful if a user chooses to display data in a different unit: an integer number of millimetres might be a
non-integer number of inches.)

Field Layout

The Field Layout page has various section which control the display of the field in different modes.

Grid

Under Grid, you can set Visible to determine whether this field will be visible when the form data is viewed as a grid
(e.g. on the Children tab for asset forms, or in the Event Listing for events).

You can set Order to control the column order within the grid — the column with the lowest Column Order will be at
the left of the grid, and so on. (You can also set grid Field Order on the form as a whole — see above.) Grid order is
also used to set the order of columns in a Custom Export of assets or events.

Text Alignment controls whether this field aligns left, centre or right. If you do not set an alignment, text fields will
default to left, numeric fields to right, and date fields to centre.

Caption allows you to have a title on the grid column for this field that is different from the field’s underlying name.

Form

Similarly you can set Visible Form to control whether the field appears on the form itself.

You can set Category to group fields within a form. Setting Order controls the order of fields within Categories, and
the order of Categories on the form: the Category that contains the field with the lowest Order will be displayed first.
Within the Category, the field with the lowest Order will be displayed first. (You can also set form Field Order on the
form as a whole — see above.)

Untick Show Caption if you want this field to appear without a caption next to it on forms.

Set Columns to control how wide this field appears on a form: if this is a two-column-wide form, setting this field’s
Columns to 1 will cause the field plus caption to fill 50% of the width of the form; setting it to 2 will cause it to fill
the full width. Forms default to two columns wide, unless you specify otherwise in a Category — edit the Category

(click on the button, then click Edit) and set its Columns. While editing the Category you can also set an image
or descriptive text to appear at the top of this category. This might be instructions on how to fill in the form, details of
how calculations on the form are worked out, etc.

Form Caption allows you to have a title on the form next to the field that is different from the field’s underlying name.

Report

Visible controls whether this field will be shown when the table is exported in a report template.
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IC-Inspector

Visible means this field will be shown in IC-Inspector. If you set an event field to visible, it will be available to
inspectors to fill in. If you set an asset information field to visible, it will be displayed to inspectors above any forms
they may be filling out. Use this sparingly: a long list of visible asset information fields will fill the inspector’s screen
and force them to scroll to reach the form they are trying to fill out.

Order and Caption work analogously to those in Grid and Form.

General

Editor Type controls what type of editor the user will see when they edit the value in this field.

If you set Blank Text, the text you set will be displayed greyed out whenever the field is empty. (You can see several
fields with Blank Text set right here on the Field Layout tab.)

Hint: As you add (or edit) fields, you can see a preview at the lower right of the dialog, showing how the

fields will appear on either a form or a grid. Fields that are selected will be shown with a exclamation
mark next to them in the form preview. If the field is a lookup list, you can drop down the lookup list
to see its values. (You can also see and edit a lookup list’s values when choosing the lookup list: on the
“Select Lookup List” dialog, click Edit, click Items.)

Edit

To edit a field, click Edit. That will bring up the ‘Edit Field Definition’ dialog. (This is the same as Add Field
Definition, but has more tabs. This is because a variety of field settings are only available after a field has been
created.)

If your field is of type Calculation, there will be a Function tab. This tab will allow you to choose a function for this
calculation, and will also allow you to choose parameters for the function. You can either set “Parameters (Inputs)” or
“Parameters (Values)” for each parameter. “Parameters (Inputs)” lets you choose some other field as the input for that
parameter; “Parameters (Values)” lets you assign a constant. These are mutually exclusive — you can only fill one or
the other for each parameter.

Workflow Rules

Sometimes you want a field’s properties to be controlled by other data. If you want, for example, a field to be visible
only when some other field is filled in (or vice versa), edit the field and go to the Workflow Rules tab. Click Add,
and under Trigger Type choose “Set Field Visibility on Form”. Then add a function, and parameters for that function.
The function should return a Yes/No value. When it returns Yes, the field will be visible, when No, the field will
be invisible. Similarly you can use Workflow Rules to set a field as read-only, or to mark a field as required. The
remaining trigger type, “Clear Field Value on Form”, can be used to automatically empty out a field’s value when
some condition is met — for example, it can be used to make two fields mutually exclusive, so that users can fill in
one field or the other, but not both.

There are a set of system functions that you can use that mean you don’t need to create custom functions:

• Compare - Is Null

• Compare - Is Not Null

• Compare A = B
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• Compare A <> B

Note that workflow rules are run when forms are viewed interactively, but are not applied during imports. If you have
ticked the “Required” box on the Field Definition page, this will be enforced during imports — rows that are missing
required fields will be rejected. But if a workflow rule makes a field required, this will not be enforced during imports.

Field Specific Units

This feature works in coordination with Unit Groups. Suppose you want Easting and Northing to display in metres,
even when US Weights and Measures are selected — you can specify that here. (You’ll need to specify it once for the
Easting field, and once for the Northing field.)

Anomaly Triggers

Here you can add anomaly triggers to a field.

When an anomaly trigger is violated, a yellow exclamation mark ( ) will appear next to the field. You can set
lower/upper bounds to be constant values (so a field might trigger if it was outside, say, 1 to 9) or to pull from a field,
on this form or on another form. So for example if this field is Measured Wall Thickness, it might trigger if its value
is less than Minimum Allowable Wall Thickness.

For Lookup List fields, the comparison is done of the lookup list item’s Value, not its Comment. So if you have a
lookup list titled “Anode Depletion”, and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS
will use the “25” for purposes of determining whether an anomaly trigger should be fired.
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For Yes/No fields you can set the trigger to fire on any combination of Yes, No or blank; but you can’t compare to
another field.

The Include Boundary tickbox controls whether exact matches cause the trigger to fire: if you have set a trigger
to “Fail when inside Upper/Lower bounds”, your lower bound is 1 and your upper bound is 9, this is the difference
between “1 < x < 9” and “1 <= x <= 9”.

You can optionally give an anomaly trigger a date range. If you set just a Date From, the trigger will apply only to
event data from that date forward. If you set just a Date To, the trigger will apply only to event data from that date or
earlier. If you set both, the trigger will apply only to event data within the specified range. In this way, you can change
triggers to reflect new conditions, without causing spurious warnings on historical data. For example, if you decrease
the operating pressure of an asset, this might decrease the minimum allowable wall thickness. Rather than editing the
existing anomaly trigger, you can set a “To” date on that old trigger, and add a new trigger with a “From” date.

Caution: In most cases, Findings are generated at the time events are added or imported. There are however some
scenarios in which the Anomaly Triggers utility should be run manually. These are 1) whenever anomaly triggers
are edited; 2) when anomaly triggers exist on a calculation field; 3) before any Finding review sessions; or 4) after
a bulk import of event data (particularly when anomaly triggers rely on events other than itself).

Triggers for a field independent of asset are found in NEXUS IC in Asset Information and Event Types. Anomaly
triggers for specific assets can be configured in NEXUS IC by right-clicking on an asset and choosing Anomaly
Triggers. . . . If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply. Note that asset-specific anomaly triggers are specific to their asset — they do not automatically
apply to an asset’s children.
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A trigger can have an anomaly Code and a Severity, and you can have several different triggers on a single field, with
different codes and/or severities. The dialog may also show a preview chart, showing which triggers apply at which
KPs or depths.

(You may need to close and re-open the database for any newly added anomaly triggers to take visible effect.)

Auto-increment Fields

It’s possible to set a field to auto-increment. For example, if you wanted each new anomaly you created to automati-
cally have an as-yet-unused anomaly number pre-populated, you would do this by setting the Anomaly Number field
to be an auto-increment field. To do this, set the field’s Default Value to @autoinc. For system tables like Anomaly,
you can’t do this through the NEXUS IC user interface, so you should ask support@nexusic.com for assistance.

Auto-populate date/time or user name

Similar to @autoinc, you can set a field to pre-populate with the date/time the record was created by setting its
Default to @now. This works for any sub-event, AIG or sub-AIG field.

You can also set a field to pre-populate with the logged-in user’s name by setting its Default to @user. This works
for any event, sub-event, AIG or sub-AIG field.

These default values are populated when the row is created. For an AIG, that’s when the asset is created. For an event
it’s when the event is created. For a sub-event or sub-AIG it’s when the user clicks the ‘+’ to create the new sub-event
or sub-AIG row.

Mutually Exclusive Events

Configuration → Events → Mutually Exclusive Events allows you to tell NEXUS about groups of events that should
not be allowed to run at the same time.

An example would be a Span event and a Burial event: where a pipeline is buried, it cannot be in a span; where
a pipeline is in span, it cannot be buried. To represent this, you could create a Mutually Exclusive Group called
Span/Burial, and within that group add two event types: Span, and Burial.

This means that when you launch a Span event in IC-Inspection, if there is a Burial event running it will be saved.
Similarly if you launch a Burial event while a Span event is open, the Span will be saved.

ROVs

Here you can add/edit/delete ROVs.

ROVs are useful for simultaneous operations in IC-Inspection: whenever you have (or might have) two ROVs in the
water at once (or more generally two separate sources of video at once, even if one or more of those sources is not
actually a ROV), you should add a ROV for each source. (A single multi-channel source, such as several cameras on
one ROV should be represented by just one ROV.)

Each ROV can be associated with one or more Survey Sets, which are in turn associated with events.

Then, when NEXUS IC plays back video for review, it can play the correct channel(s) of video for that event. Similarly
the Pipeline View chart can show correct data.
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Survey Sets

Here you can add/edit/delete Survey Sets.

Survey sets are useful for grouping data from a particular inspection. You might have a survey set called “2018
Inspection Campaign”, or you might have a survey set called “Pipeline A 2018 Inspection”.

For each survey set you can select a ROV , where appropriate. You should do this if the survey data was captured with
a particular ROV/pig/diver/etc., particularly if there were dual operations, with more than one ROV or diver recording
survey and/or video simultaneously.

You can Import data into Survey Sets from here. Click the Import button, then click Example to get an example
import sheet. Note that for large quantities of data, a text import file (tab-separated value or comma-separated value)
is likely to be faster than an Excel import file.

Events get their survey data from a particular survey set based on the event’s date/time — that date/time is looked up in
the survey data, and the corresponding survey values (Easting, Northing, depth, etc.) for that date/time are displayed.
The threshold for survey matching is +3/-2 seconds: if there is survey data up to 2 seconds before, or up to 3 seconds
after the event’s date/time, NEXUS will match that event to the closest survey data point. Thus, if you are importing
survey data into NEXUS from an external file (e.g. a track reposition file supplied by a surveyor), you should ensure
that the file has data at least once every 4 seconds — that way there will definitely be a suitable data point to match to
any event. It’s OK to have gaps in a survey set import, provided there are no events you care about in the time span
covered by the gap.

Note: In a single survey set, a single point in time can only have one set of survey values associated with it. If you
need two events at the exact same time with different survey values, ensure that they are in different survey sets.

In the bottom part of the dialog, if you click on a day, you will see survey data logged on that day. The grid listing
each survey row is linked to the chart: if you click on a survey point in one, it will be highlighted in the other. You can
multi-select, too. You can click the Add button to add a single survey row, Edit to edit the selected row(s), or Delete
to delete them. Note that any events which were relying on those rows may now not have valid survey data — if there
is another row within the +3/-2 second threshold the event will use that instead, but if not, the event may now simply
have no Easting, Northing, etc. There is no confirmation dialog or Connections button.
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Event Types: forms to log inspection data,
Mutually Exclusive Events,
ROVs,
Survey Sets.

12.3.5 Anomalies

Configuration → Anomalies

The various Configuration → Anomalies menu items allow you to create, edit and delete Checklists, anomaly and
finding Codes, anomaly and finding Code Categories, anomaly Priorities, anomaly Sets, anomaly Severities, and
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anomaly Statuses.

Checklists

You can tie checklists to Findings, such that when an inspector raises a finding, they are reminded to carry out the
items on the checklist.

Codes

Findings and Anomalies can be given a Code, describing their type.

Code Categories

Are used to group Codes. If your database contains different kinds of data, for example some below-water and some
above-water data, you might like to create one Code Category for “Above water” and another for “Below water”.

Priorities

Anomalies can be given a Priority.

Sets

Anomalies can be grouped in Sets.

Severities

Anomalies and Findings can be given a Severity.

When you set up Anomaly Triggers on fields, you can specify a Severity. You can set several triggers on a single field,
with a variety of different severities. If that anomaly trigger is violated on an event field, a finding of that code and
severity will automatically be created. Severities let you equate dissimilar problems: you can decide that a problem in
one field is of the same severity as a problem in a different field.

Status

Anomalies can be given a Status. This intended to convey the current situation with the anomaly: “Rectified - Closed”,
“Not Anomalous - Closed”, “Monitor”, “Temporary Repair”, etc.

Action Status

Anomaly Actions can be given a Status. This intended to convey the current situation with the action. The default
action statuses are Approved, Assigned, Completed, Proposed, and Rejected; but you can customise these to meet
your needs.
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Action Types

Anomaly Actions can be given a Type. This lets you specify an event type to be associated with an Action Type. When
a Task is created from an Anomaly Action, then the Event Type of the Task is determined by the Event Type associated
with the Action Type.

Checklists,
Codes,
Code Categories,
Priorities,
Sets,
Severities,
Status,
Action Status,
Action Types.

12.3.6 Reports and Dashboards

Report Categories

Configuration → Reports and Dashboards → Categories allows you to create, edit and delete report categories. Cat-
egories are a way of grouping report templates.

(see Report Templates).

Report Statuses

Configuration → Reports and Dashboards → Statuses allows you to create, edit and delete report statuses. Statuses
are a way of marking reports as e.g. “Work in Progress”, “Final”, etc.

(see Report Templates).

Report Templates

Sources

Simple Source

You can edit the Simple Source by double-clicking it. You can choose a table for this Simple Source. The table you
choose will obviously depend on the data you want to show: if you want to display GVI event data, you would choose
your GVI event table. If you want to display data about events overall, you would choose the Event table. And so on.

Fields

The second tab on the Simple Source dialog is Fields. This shows you all the fields in the source you’ve selected, plus
any extra columns you may have added. The Show Local Columns button controls whether fields in this source are
selected.
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Filters

The third tab is Filters. Here you can control which rows are returned from the table. If Parameter is set to None, you
will be able to immediately choose a value.

If this is a string or a numeric or a whole number field, you can simply type a value in.

Some fields are keys to other tables. For example, in the Event table, Asset, Event Type, Survey Set, and Workpack

are keys to other tables. If your filter field is a key to another table, you will be given a button to allow you to pick

a value. For example, if your source table is Event, and your filter is on Workpack, clicking the button will bring
up a list of workpacks to pick from. If your Comparison is ‘=’ (equals), you can pick just one item; if your comparison
is ‘in’, you can pick several items by checking the checkboxes next to each desired item.

If the field you want to filter on is in this table, click the arrow to choose it from the list. If it’s not, you can click

the button to pick the field you want from any table. NEXUS IC will figure out a path connecting the Table you
selected to the field you have selected. If there is only one such path, NEXUS IC will choose correctly; if there are
multiple paths, you may experience unintended behaviour.

‘like’ is only applicable to string comparisons: use ‘%’ (percent) to match several unknown characters, and ‘_’ (un-
derscore) to match a single unknown character. For example, Name like _VI would match ‘GVI’ and ‘CVI’; Name
like ‘PL %’ would match ‘PL Anode’, ‘PL Damage’, etc.

‘<’, ‘>’, ‘<=’ and ‘>=’ are only meaningful for numeric and whole number types — their behaviour on key fields are
undefined.

If you would like to test whether a key is null, just use ‘=’ as the comparison, and leave the value blank.

If Parameter is set to User, then when the user runs the report, they will be asked for a choice. The equals/in rule
described above still applies: if you choose ‘=’ for your Comparison, the user will be able to choose one item; if you
choose ‘in’, the user will be able to choose several items.

Asset selection is a special case: here, the correct field to choose is ‘Asset Location.VN_ID’, and ‘Is Child Of’ is
added to the Comparison list. An illustration of how to configure a filter to let the user choose a single asset, and have
the query report on that asset and its children is shown here:

If you wanted to report on just that asset, you would use ‘=’ as the Comparison, instead of ‘Is Child Of’. If you wanted
to let the user select several assets, you would use ‘in’ as the Comparison.

Other special cases exist for reports run from the Reports menu button on each screen in NEXUS IC:
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Screen Parameter
Assets View_Node
Library Library
Planning View_Node
Workpacks Workpack
Inspection Header / Finding (depending on what is visible)
Anomaly Anomaly

If you use one of these special parameters, then when a user runs your report template from the appropriate screen, the
currently selected item will be pre-populated into the parameter in the report generation wizard. For example, if you
set up a report template with an Anomaly parameter, then when the user runs your template from the Anomaly screen,
the currently selected Anomaly will be automatically selected in the report wizard.

The Parameter choice of ‘Group’ only has meaning if this Simple Source is inside an Element Group (available from
the Available Elements list at the left of the Report Template dialog). If you choose ‘Group’, then this filter will pick
its value from the Simple Source used for the Element Group.

Filters can be connected by “All” or “Any” connectors. If you have multiple filters, you’ll see a drop-down appear at
the left. If you select All, then all these filter criteria must be met for data to be returned. If you select Any, then if
any criterion is met, data will be returned. (All and Any are equivalent to SQL’s AND and OR.) You can construct
more complex combinations by grouping rows: use the Shift and/or Ctrl keys on the keyboard and click filters to
multi-select. Then click Group. The rows you selected will be joined together into a group with their own Any/All
filter, and that group will be connected to other groups with a separate Any/All connector. By choosing your grouping
and choosing Any/All as appropriate, you can construct any logical expression you desire. You can ungroup rows by
selecting a row within a group and clicking Ungroup.

Union Source

A Union Source lets you join together results from several other Sources, much like SQL’s UNION ALL. In the Union
Source, select the sources you’d like to pull data from. Only columns that are common to all selected sources will be
passed through to any element that consumes the Union Source. So if you chose two tables, both of which had a Name
column, your Union Source would have a Name column.

When configuring a Union Source, ensure that every source being unioned is named differently, otherwise when saving
and loading a report template, the sources within the Union Source will not all be retained.

Distinct Source

Sometimes, you want just a subset of a table’s rows, showing each value (or combination of values) just once. (A
common reason for this is as the source for an Element Group.) Suppose you wanted a list of Task Categories that
were actually in use. (This might be different from the full list from the Task Category table.) Create a Simple Source
and set its Table to Task. Then create a Distinct Source, set its Source to your simple source, and then select the
Category column. Now this Distinct Source is a data source that you can use in an Element Group (or anywhere else)
that will have one row for each value of Category found in the Task table.

(Another way of grouping rows is by using a Pivot Table.)

Parameter Source

If you want to use parameters chosen by the user in headings, text, etc., add a Parameter Source. (You don’t need one
of these to use parameters in simple source filters.)
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Elements

Element Group

Element Groups are used to repeat data for a series of records or to group sections of a report. For example, to tabulate
anomalies for a series of workpacks. You can also use the Conditions in an Element Group to make the group and all
its contents only appear if the conditions are matched.

If you’re using this Element Group to repeat data, or if you wish to specify Conditions for it, you’ll need to select a
Source for it. (It must be a Source outside the Element Group.)

If you check the Repeat Elements box, all the report elements within this element group will be run once for each
row in the source.

The Element Group plays nicely with the Copy An Element button on the Report Template dialog toolbar — if you
suspect you might later wish to copy a group of elements to another spot in this report template or into another report
template, put them in an Element Group as you create them, for easy copying later.

Tip

If you check the Allow user to exclude group attribute of the Element Group, then when the report is being
generated, the user will have the option to exclude the output contained within this group to the report.

For example, you may set up an Element Group which outputs all Isometrics for an asset. This typically takes some
time to export, so the user can, if they wish choose NOT to export the Isometrics.

Ticking Repeat Elements will also cause the Action drop-down to appear. You can select ‘All Rows’, ‘Only rows
that match conditions’, ‘Only rows that don’t match conditions’, or ‘Only when there are no rows’. If you select either

of the ‘conditions’ options, the Conditions box will appear. Click its button to add, edit or delete conditions.
Conditions can be on a field in the source, or on the number of rows in the source, or the index of the row, and can
compare (=. <, >, <=, >=, <>, contains) to a constant value.

If you configure Sort Column and Sort Order, then when there are multiple values for a group, those values will come
out in the order specified. If your source is Workpack, you are sorting on Workpack.Name, and you have workpacks
“2017 Inspection”, “2018 Inspection” and “2019 Inspection”, then they will come out in that order in your report
regardless of the order they might have in the underlying database table. If you have ticked Repeat Elements, the
repeats will be in the specified sort order; if not, but the field is consumed e.g. in a Paragraph or Heading element,
then the field’s multiple values will all appear at that point in the Paragraph or Heading in the order specified here in
the Element Group. (If the field has a single value, sort order is of course irrelevant.)

You can drop elements, including Simple Sources, into the Element Group. In the Filters tab of a Simple Source within
an Element Group you can choose a Parameter of Group. This will compare the field you have selected to the value in
the current row of the Element Group’s Source.

Text (Paragraph)

Text entered into the Content field will be displayed as text in the report output. Use the right-click menu to insert
System Fields, Database Fields, Parameters, or set the style of the paragraph text (the Body style will be applied by
default).
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Comments

This element has no effect on the output report. It is intended for use by report designers to document the report
template itself.

Section Heading

This element lets you set up headings in your report. Right-click within the Content box to get a list of styles and
fields, or simply type text. Check the Include in Table of Contents checkbox to have this section heading appear in
the Table of Contents.

Section Headings are not supported in Dashboard reports — use a Text (Paragraph) element instead.

Table of Data

You can edit the Table of Data by double-clicking it, and choose a Source. If you only have one Source in the report
template, only one item will be shown on the drop-down list.

If you click OK after selecting a Source, you will see a ‘+’ next to the Table of Data. This shows the Simple Source
you have attached to the table. This is really the same object as the Simple Source shown elsewhere in the tree —
making changes on one will make changes on the other. If the Simple Source is connected to several tables, Drawing
Details, Chart Templates, or Risk Charts, making changes to any one will make changes to all.

Hint: Once you have set up a Table of Data, and have connected it to a Simple Source which in turn has a database
Table selected, you have a basic report which can be generated to RTF, HTML, or Excel.

If you give the Table of Data a Name, and check the Show Caption checkbox, the table’s name will be shown above
the table in the generated report.

Note: Only tables with data will be shown in the generated report. If a table has 0 rows, it (and its caption) will not
be shown.

If you check the Fit Window box, NEXUS will constrain the width of the generated table to the width of the page
(in RTF) or the browser window (in HTML). If you uncheck this box, the table should be as narrow or as wide as is
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needed to display the data. Please note that Microsoft Word’s RTF reader does not respect this setting well. To get
Word to respect the setting, it is necessary to encourage it, for example by clicking Save As in Word and choosing
.docx as the save format.

If you check Hide columns with Null Values, then any column which is entirely empty will be omitted from the
output report.

Style Prefix lets you set a Style Prefix.

Layout

The top half of this pane lists all the columns. Tick or untick to make columns visible or invisible. If you place
several columns in the same Category, they will be grouped together. Any Category headers will also be visible in the
generated report.

If the Show Data button is set to All Data, NEXUS will display data from the table specified in this table’s source,
complete with any extra columns you may have added. This can give context and make it easier to understand what
the final generated table will look like.

Caution: If the table contains many rows, this may take up to 5 seconds. After this time, NEXUS will stop
fetching additional rows, and will display only the rows that it has fetched.

Column ordering

Click on the Layout tabbed page in the Table of Data dialog to choose which columns you want to appear in your
table. Drag and drop the column heading to re-order them in your table.

Click on one or more column headings to sort by that column. Shift-click a column to add it; ctrl-click a column to
subtract it from the set of columns we’ll sort on. Click (or shift-click) a column a second time to change sort direction.

You can change the width of columns by hovering the mouse over the right edge of the column header, and then either
double-clicking or by clicking and dragging the column to a new width. This will change the column widths in the
generated report.

Styles

The Styles tab can be used to highlight table cells or rows, use particular fonts, sizes or colours, change spacing, and to
change the lines used to draw the table. You can choose a style here to be used when particular conditions are matched.

A style can be applied to a row or to a cell — if you want it to apply to a cell, be sure to set your Condition to include
“[COLUMN NAME] equals” in addition to the value you actually want to filter on, in order to restrict the filter to just
that cell.

To add/edit/delete styles themselves, drop back out to the Configuration - Templates dialog and click the Styles button.

Title Fields

If you right-click in the Name field, you will get a pop-up menu similar to the one available in Text or Section Heading
elements. You can choose fields from this menu and (assuming that the Show Caption box is ticked) these fields will
be built into the title of the table in the rendered report. This is particularly useful if the table is inside an Element
Group with Repeat Elements ticked — you can put the value for this particular repeat into the table name. This
right-click also works for Vertical Table, Pivot Table, Risk Chart, and Chart Name fields.
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Vertical Table

The Vertical Table element is like the Table of Data element, but rotated 90 degrees: what would be a column in one
is a row in the other. ‘Column headers’ are in the left-most column.

Show Caption, when checked will output the Name of the Vertical Table directly above the Vertical Table.

When output to RTF, Fit Window will make the Vertical Table stretch from the left page margin to the right page
margin.

If you check Hide columns with Null Values, then any output row which is entirely empty will be omitted from the
output report.

Style Prefix lets you set a Style Prefix. The Styles tab lets you set conditional Styles for this table.

You can choose how wide the header Column is by setting a Header Width (%) value.

Entering 2 or more Number of Header Columns arranges the output fields in a form-like layout. This is most
commonly used when you are outputting the details of single record. Example shown here:
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Pivot Table

Pivot tables are conceptually similar to pivot tables in Excel. (If you aren’t familiar with those, you may wish to
Google for a tutorial.) They aggregate data from many rows of a data source into just a few rows, according to the
rules you set up.

As always, you’ll need to start by selecting a Source for your pivot table element. Then choose one or more Rows. For
example, if you wanted to see how many tasks were in each workpack, you would set up a Simple Source on the Task
table, and in your pivot table you would choose Workpack as the Row field to pivot on. (If you wanted that broken up
by task completion, you would choose Workpack and Is Completed as Rows — the table would then contain two rows
for each workpack that had both complete and incomplete tasks.) Under Values, click Add, and select criteria. if you
wanted a simple count of tasks, you would choose Task_ID as the Field, Count as the Aggregate, and choose a Name
like ‘Number of Tasks’. That completes the minimum for a Pivot table element: a Source, a Row Field, and a Values
entry.

You can do much more with pivot tables, though: you can have several different Values entries. For example, you might
add a second Values entry on Approx Timing, with an Aggregate of Sum, and a name like ‘Total Time Estimate’. Each
additional Values entry will result in an extra column in the output table.

You can separately choose the Aggregate (Total), which is the value shown under Column Totals or Row Totals (if
selected). Often you want the same aggregate for cells within the table and for end-of-row or end-of-column values
(for example, for a Value where you’ve chosen Average, your might want Totals to also be Average, giving a grand
mean), but sometimes you want the Total value to have a different aggregate from cells within the table proper.

You can also add entries under Columns. If you added, say, Category, under Columns, and your tasks were assigned
to different categories, then you output would have one column per category for whatever your Values entry specified.
If you add items under both Columns and Values, then it works multiplicatively: if your Tasks fell into five different
Categories and you had two different Values, you’d get 10 columns of numbers out. For each Column you select you
will get a common table “band” header, and within each band you’ll get columns for each Value.

You can also have a more complex source: for example, if you only wanted to see incomplete tasks, you would put a
filter in your Simple Source for Is Completed not equal to true. If you wanted to use a single Simple Source to show
both all tasks and all completed tasks, then instead of filtering the Simple Source, you would add an extra field to it,
with a function that returns 1 if the task is complete and 0 if it is not. Then you would add a Values row to Sum that
function.

There are checkboxes near the top of the Pivot Table element. Show Caption does the same thing as for a Table Of
Data: it shows the Name as a caption above the table.

Show Column Totals adds an extra row at the bottom of the table showing the aggregate of values in each column.
Show Row Totals works similarly except that it adds an extra column, with the aggregate of each row. If you have
several Values, it will add several columns, one showing the aggregate of each.

Show Zero Values, by default is checked. If unchecked, will replace any values that would have shown “0” with a
blank. This makes it easy to spot data in a sparsely populated grid.

Show Rows with all Zero/Blank values, by default is checked. If unchecked, rows which contain all “0” or blanks
are not shown. This limits the pivot table to only rows which have aggregate data.

Show Dash instead of “NaN” by default is checked. If unchecked, then “NaN” (Not a Number) will be output as
“NaN”.

Fit Window doe the same as for a Table Of Data: it will attempt to make the table as wide as the browser window or
Word page.

Style Prefix lets you set a Style Prefix.

The Styles tab lets you set conditional Styles for this table. In your Conditions, set Field to [Column Name], Compar-
ison to Contains, and Value to the column name. This is because as far as the pivot table is concerned, it’s not using
the underlying data source column — it’s using a new pivot table column with a similar name.
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Chart Template

Choose a Source. Choose a Chart Template which you have already configured. Only Chart Templates relevant to
your Source will be available for selection.

For charts with legends: if the legend can appear in a single row at the bottom of the chart, it will. Otherwise, it will
attempt to appear at the right-hand side of the chart. But in this case it will only appear if it will take less than a third
of the available width. So if you set a relatively narrow chart width (less than 400 or so, depending on the length of
text in the legend items), the legend may not appear.

Risk Chart

Choose a Source. Typically, your source for this element will use Risk Assessment as its Table. If you click Show
Count, your final risk chart will have a number in each square that has risk results, showing how many risk results are
in that square. If not, it will merely have a dot in each square with one or more risk results.

You can also use the Anomaly table as the Source for a Risk Chart. Each anomaly’s Risk Score is used to place it
on the diagram. Note that anomalies do not have a Likelihood or Consequence to give them an X/Y position on the
diagram — they only have a Risk Score. So if your diagram has several squares with the same Risk Score (as is
usually the case), your anomalies will be placed in the left-most such square. That is, risk-assessed assets are placed
in a particular square, but anomalies are merely placed in a particular band.

To make this matrix work, you will need to configure Database → Properties → Database → Anomaly Risk Chart.
You will also need to configure the “System - Anomaly - Risk Score” function.

Multimedia Thumbnails

Choose a Source. Typically, your source for this element will use Multimedia as its Table. Caption may be Name
from the Multimedia table, or may be a function column that returns details about the event type and event number.
Repository Field should be Image from the Multimedia table.

Multimedia Thumbnails are not supported in Dashboard reports.

Drawing Details

Choose a Source. Typically, your source for this element will use Library as its Table. Caption Field is used for the
text underneath the drawing, and may be Name from the Library table, or may be a function column.

Under layers, if you select “Display all layers” or “Display only layers that are associated with assets in asset source”,
you can specify a Source, and then specify the fields within that Source to be used for the Asset (i.e. the Compo-
nent_ID), the Name (such as Asset.Name, or any other field that will be meaningful to the person reading the report),
and optionally the Colour.

Page Break

In RTF, in addition to forcing output onto a new page this element lets you set headers and footers for your document.
You can select a number of Columns for this section of the report. Settings chosen here for Section Columns, Layout,
Page Size and Header and Footer persist until the next Page Break element.

In Excel, this starts a new worksheet, with the Name of the page break used for the name of the worksheet. If you put
a field in [square brackets] in the page break’s Name, the field will be substituted with its value in the usual way. This
is particularly useful if the page break is inside an Element Group with Repeat Elements ticked — you can put the
value for this particular repeat into the page break name.
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In HTML, this has no effect.

Section Break

Similar to Page Break above, but will not force a new page and does not let you choose paper size and orientation.

Table of Contents

The Table of Contents element inserts a hyperlinked Table of Contents for the report. In HTML outputs, any section
headings will appear with “Back to top” hyperlink.

Table of Contents elements are not supported in Dashboard reports.

Toolbar

• Add, Edit, Delete: Add / Edit / Delete Report Template(s).

• Load Template Loads a previously saved .report template. Note that if the previously saved report template
still exists in this database, Load Template will overwrite that existing report template — it will not create
a new copy of it. Similarly with any other elements saved in the template file: asset information fields,
functions, etc.

• Save Template Saves this report template and related details to a .report file. NEXUS IC will find all items re-
lated to this report template (functions, asset information forms, event definitions, chart templates, lookup
tables, etc), and will present a dialog listing all the dependencies it’s found, with a checkbox for each row.
Untick any that you don’t want saved with your report template.

• Schedules If your database is hosted on a Wood cloud server, you will see the Schedules toolbar button. Here
you can configure scheduled reports to automatically run periodically, sending the output to users via
email. Click Schedules to bring up the Scheduled Reports dialog. In this dialog, click Add to add a new
scheduled report. Add one or more Recipients as a comma-separated list.

• Generate Click to launch the Export Report wizard, to generate your report to RTF, HTML or Excel format.

• Asset Dashboard Click this to set the selected report template as the dashboard. Only one report template can
be set as the dashboard at any one time.

• Customise See Customise for full description of the Customise menu item.

• Styles See below:

Styles

The Styles dialog lets you define the look and feel of the final report by pre-defining the fonts and colours for the
various styles in the report.

To edit the Styles used in reports, click the Styles button. Choose the Style to edit from the list box in the left of the
dialog and update the font, colours, spacing, alignment and font style.

When defining borders for styles, you must ensure that the border icon is in the “down” state (see below).
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Many of these styles are applied automatically to report elements where appropriate. For example, “Table Heading”
will get applied to headings in tables (including Category bands); “Table Event Rows” will get applied to even-
numbered data rows in tables, etc.

For Pivot tables, the following styles will be automatically applied (if they exist):

• Table Heading for headings

• Table Row Odd & Table Row Even for odd & even rows

• Number for cells that contain numbers

• Total for total cells

• Total Number for total cells that contain numbers

Note: Excel reports will ignore many style settings, in favour of using Excel’s own style settings.

Note: In an RTF report, if the NEXUS style name matches the name of a style used by default in Word or that appears
in your .dotx Word template file, the generated text will appear in that Word style, so you can use Word’s styling tools
to modify it once the report has been generated.

Note: The Orientation setting, for orientations other than Normal, is poorly supported by many web browsers. It is
known to be supported correctly by Chrome and Safari. For RTF reports, Word will correctly draw the text in the Up
or Down direction, but will incorrectly calculate the height and width of that text, and therefore you may find vertical
text wrapped unpleasantly.

Style Prefix

Table of Data, Vertical Table and Pivot Table offer a Style Prefix. If you fill this in, the table’s style prefix will be added
in front of any style name applied. So if you set a prefix of “Large”, then the table’s heading cells will be styled in
“Large Table Heading” instead of just plain “Table Heading”, and so on. This lets you apply different styles to a table
or tables. (There is no automatic fallback, so if you specify a style prefix, you should create an appropriate matching
set of table styles with that prefix, including as many of “Table Caption”, “Table Heading”, “Table Even Rows”, Table
Odd Rows”, “Total”, “Number”, “Total Number” as you want formatted.)

Configuration → Reports and Dashboards → Templates allows you to create, edit and delete report templates. These
templates can be used to generate reports throughout NEXUS IC.
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Report templates (once configured), can be given a Status and a Category. Additional report categories can be config-
ured (see Report Categories).

You can mark a particular report template as a Dashboard report: edit the template and tick the Dashboard Report
box. That template will then be available when users visit the DASHBOARDS area. If you tick Dashboard Report,

Section Heading, Multimedia Thumbnails and Table of Contents types will be marked with a to indicate that these
elements will not be displayed in a Dashboard template.

Similarly with Asset Dashboard: set a template as your Dashboard report by right-clicking it and choosing Asset
Dashboard or by selecting it and clicking the Asset Dashboard button, and each time you visit an asset on the Assets
screen with the Dashboard tab visible, your selected dashboard template will be executed. (You should ensure that the
template you use does not take long to execute — if it does, you will be waiting every time you change asset with the
Dashboard tab visible.) (In order for a Dashboard report to reflect the selected asset in the asset hierarchy, it needs to
have Simple Source in it which retrieves VN_ID from a User Input Parameter.)

General strategy

In your final report template, you want to present user-visible things like headings, text, tables, drawings, etc. To
power these, you will need Simple Sources to query data from the database. To power any custom columns in the
sources, you will need functions.

NEXUS IC’s design lets you create these things in whatever order is convenient to you: you can create all your
functions first, then your sources, then the user-visible elements; or you can rough out your report in an empty state by
starting with the user-visible elements, and then go on to create the Simple Sources that underly them, and then create
the functions needed for those sources. And it’s usually easier to work in this latter way: create your report from the
top down.

Add/Edit

To add a new report template, click Add. You’ll have to give your new report a name, and we strongly recommend
you give it a category.

To edit an existing one, select it and click Edit, or just double-click it.

In both cases, you’ll be taken to the same dialog.

Report Template dialog

At the top of the dialog, you’ll see Name, Status, Category and Comments.

At the left of the dialog, you’ll see a view of available elements. This is broken into two parts: Sources contains the
things you can get data from, and Elements contains all the things that you can display in the report. Most elements
need a source to get data from. A single source can give data to more than one element.

At the right, you’ll see the Report Layout tree showing all the elements currently in the report.

Take a look at some existing templates and you’ll see how they’re put together.

Often the simplest kind of report you’ll want to design contains a single table, displaying data from a single source. To
create a report like this, drag a Simple Source from ‘Available Elements’ at left onto the ‘Report Layout’ element at
right, and drag a Table of Data (or a Vertical Table or a Pivot Table) from ‘Available Elements’ to ‘Report Layout’. (In
general, you can drag elements onto the root ‘Report Layout’ element, in which case they will appear at the bottom of
your report; or drag them onto another element, in which case they will appear just above that element.)

278 Chapter 12. Main Menu



NEXUS Documentation, Release 6.6.xxxxx.0

Report Template dialog toolbar

(As distinct from the overall Reports dialog toolbar.)

• Perform an operation Perform the selected operation (Add, Edit, Delete, Move Up, Move Down, Copy, Paste)
on the element currently selected in the Report Layout tree. Most of these operations are also available by
right-clicking on an element in the tree.

• Copy an element You can copy an element from elsewhere in this report template, or from another report tem-
plate, with this button. Note that “child” elements will be brought across too — if you Copy an Element
Group which contains other elements, all those other elements will be copied in at the same time. Your
new element will have “Copy of” prepended to its name. Filter values may not be fully copied across, so
check your Simple Sources’ Filter tabs after copying.

• Parameters Configure parameters for this report template. Parameters allow the user to specify values for the
report. For example, you could add a parameter called Asset View, allowing the user to specify what asset
view they would like the template to pull information from. The user can select parameter values each
time they interactively run a report. Unlike most other NEXUS dialogs, the Parameters dialog does not
have an Add button — to add a parameter, simply specify the name of the parameter you would like added
in a simple source filter. Then come here to the Parameters dialog to adjust other values for your new
parameter. Dashboard reports should not use parameters. Asset Dashboard reports should use a parameter
which specifies the asset. NEXUS will automatically supply this value to the template based on the user’s
selection in the Asset tree when the asset dashboard report is run.

• Generate You can generate output from your report template from right here without having to click OK and
drop back out to the Reports dialog. Your report will be generated with the its previously selected parameter
values.

• Move Up Move the element selected in the Report Layout tree up by one spot. You can also do this with Ctrl-Up
arrow.

• Move Down Move the element selected in the Report Layout tree down by one spot. You can also do this with
Ctrl-Down arrow.

You can also move items up and down by drag-dropping them within the Report Layout tree. You can also reparent
items by drag-dropping them onto an Element Group.

Categories,
Statuses,
Templates: templates that users can run to generate reports as Word documents, HTML, or Excel.

12.3.7 Caution

Some areas of Configuration are relatively safe to explore. (Although before deleting anything we advise checking for
Connections.)

But for Chart Templates, Functions, Connections, Shortcuts, Asset Information, Sensors, Risk Charts, Risk Models,
and Event Types: here be dragons, and we advise caution. Before you experiment in these areas, we suggest that you
take a database backup.
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12.4 Help

• Help → Help This option will launch the on-line help files from https://docs.nexusic.com.

• Help → About The About dialog identifies the version and build number of NEXUS IC that you are currently
running. This is important information when you are reporting issues or bugs to Wood. Click on the
support@nexusic.com label to launch the default mail program and prepare an email for Wood’s support
and bug tracking system.

The Database menu and Help menu are fairly similar between NEXUS IC and IC-Inspection. Other items above
primarily describe NEXUS IC.
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CHAPTER

THIRTEEN

COMMON FEATURES

The below topics cover functionality which apply to the grids (and to the grids toolbar) which appear in many different
places in NEXUS IC and IC-Inspection.

13.1 Search

At the top right of NEXUS IC’s main window is the search box. Type text into this box and press Enter and the Search
Results window will be displayed. (This window is non-modal, so you can keep it open and still work with NEXUS
IC’s main window. Some users like to drag the Search Results window to, say, the bottom left corner of their screen
and leave it open until they close NEXUS IC.)

Within the Search Results window, results are broken into categories. Categories are shown in capital letters.

In the example below you can see many categories, including: Anomaly, Asset, Finding and Library.

Categories with many results (such as FINDING above) will initially appear rolled up; categories with only a few
results will automatically be expanded.

You can double-click on any result that isn’t a category, and NEXUS IC will take you to the appropriate place and
give that item focus. For example, if you type part or all of an asset name and press Enter, then double-click the result,
NEXUS IC will switch to the ASSETS screen and focus the asset in question.
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For results which are not available on a main NEXUS IC screen but are available on a Configuration window, NEXUS
IC will open that dialog window and give the appropriate item focus. If you’d like to go straight to editing the item
instead of to its Configuration dialog, hold down the Control key on your keyboard as you double-click.

When NEXUS IC has opened a dialog window to show you a search result, these dialog windows are modal, so you
won’t be able to access the Search Results window until you close the dialog window.

Values in Asset Information forms will not be found by the Search feature — we don’t search these because doing so
is a little slow. Values in Risk tables may also not be shown.

Anomaly codes and numbers can be searched — if you have an anomaly with code AN and number 1, a search for
“AN-1” will return this anomaly in the search results.

To carry out further searches, type fresh text into either the Search Results window or the Search box, and press Enter.

You can use ‘_’ (underscore) as a wildcard to represent a single character.

13.1.1 Autocomplete

Most places you see a record lookup editor (a text box with a ellipsis button and clear button at the right) you
can type the first few letters of the entry you want to match, and NEXUS will fill that value, without having to click

and pick a value from the picker dialog.

This method is most suitable when you are certain of the text of the value you want to pick, and where there are not
many values with the same first few letters (“Anode 001”, “Anode 002”, etc). For other cases, Find As You Type,
below, may be more suitable.

13.1.2 Find As You Type

In most grids in NEXUS IC, if the grid has focus and you type on the keyboard, the grid will filter for the text you
have typed. For example, if you type “Pipe” (without the quote marks), all rows in that grid that contain “Pipe” will
be shown, and other rows will be temporarily hidden.

Find As You Type searches all text fields, which includes the Name column and any other text fields in the grid. It
does not include any fields of type Lookup List. You can see which fields are included in the search: they have a blue
arrow in their column header.

You can dismiss the Find As You Type search box by clicking the at the right of the find box. You can also dismiss
it by pressing the Escape key. (But note that if the Find As You Type box doesn’t have focus, and you’re in a dialog,
pressing Escape cancels the whole dialog.) You can manually bring up the Find As You Type box by pressing Ctrl-F.
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13.1.3 Asset Trees

If you want to use Find As You Type on assets, one way is to go to the ASSETS → Children tab.

You can also use Find As You Type anywhere an asset tree appears: on the ASSETS or PLANNING screen, on a
picker that asks you to select assets, etc. When filtering a tree, unmatched rows will not disappear — instead, they
will grey out. This is so that you can still expand nodes to reach child nodes that may be included in your filter. If the
picker is asking you to select multiple assets (e.g. Risk Copy Assessment, ANOMALIES Filter → Asset, etc.), then any
assets that are not matched in your filter will be unselected. If you click Select Children, only assets that match your
filter will be selected. This provides a handy way to select all assets of a particular type: select your root asset, type
the name of the asset type you want to filter for, and click Select Children.

See also: Filtering.
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13.2 History

With each editable dialog, there is a tabbed page titled History. This shows all changes made against this record.

The left section lists in tabular form, all changes made to this record. The right section displays the name of the user,
the form and the values of each field prior to the currently selected change.

Select a change from the list, and you’ll see the values as they were prior to that change. Fields within the form that

were changed are marked with a blue highlight.

See also Audit Log.

13.3 Add / Edit / Delete

Most grids in NEXUS IC have toolbar buttons for Add ( ), Edit ( ) and Delete ( ).

If there is insufficient space for some or all of the captions, you will see buttons without captions. If you have read-only
permissions on the object in question, you will see a View button instead of an Edit button.

Tip: You can use keyboard shortcuts to perform an Add, Edit or Delete action:

• Add - Insert key.

• Edit - Enter key.

• Delete - Delete key.

To use the shortcut keys, ensure that the grid you want to edit has focus. To set focus to a grid, click on a row or empty
area inside the grid.

• Add Add a new item.
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• Edit Edit the selected item(s) in the grid.

• Delete Delete the selected item(s) in the grid.

Tip: Most grids support multi-edit, which can be used to bulk edit/delete items (See Multi-Edit for more information).

13.4 Connections

The Connections toolbar button shows items that are linked to the active record.

Note: The Connections toolbar only shows items that depend on this item — it does not show the reverse. For
example, if you are looking at Connections for an event, it will show Multimedia, Findings, etc, but it will not show
the Asset that this event is on, because the event is connected to the asset, not the asset to the event.

Hint: If you are considering deleting an asset (or assets) from the asset hierarchy, we recommend first checking
what data might be linked to that asset. To do this, from the ASSETS screen, right click on any asset and choose
Connections from the pop-up menu. The Connections dialog will appear categorising and listing all data elements
which have a reference or connection to the selected asset.

Note: You can edit the selected item in the Connections dialog. Click the row, then click Edit. An edit dialog will
appear.

13.5 Import

The Import functionality gives the user the ability to bulk update data stored in the database. There are numerous
Import buttons throughout NEXUS IC — the Import button on the Assets screen allows you to import assets and Asset
Information; the Import button on the Library screen allows you to import Library Types; the Import button on the
Library tab within the Library screen allows you to import Library items; etc.

The format of the Excel workbook needs to be very specific. It is recommended that you use the Example button
(shown below) to generate an Excel template in a format suitable for importing data.
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The Import Template generated from the Example button will highlight fields which have been flagged as Required
fields, set up lookup lists and provide information on the format and field type in the grey rows as shown here:

Caution: It is important to note that as the Importer is importing rows, the SQL server creates Row and Table
Locks. This may mean that to other users accessing NEXUS IC, the application may appear unresponsive. When
the import has finished and the data committed, then the Row and Table locks are released and the other users will
be able to continue using NEXUS IC as normal.

13.5.1 The Import Wizard

1. Import Filename - Navigate to the Excel or Text file which has been prepared for import. If you uncheck
the “Automatically commit transaction on successful import”, the wizard will present you with a summary of
the Import actions, and will prompt you to commit changes. Please note that the database will still be in a
Transaction state until you Commit or Cancel the import.

2. Configure Import - If you are using the Excel output from the Example template, then the destination Fields
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will be pre-populated. If you would like to make changes to the Destination fields or elect to ignore some fields,
then click on the column heading titled Field: and choose from the options presented in the pop up menu.
Finally, ensure that the correct Asset View is selected from the Required Fields selection box and that the
number of Header Rows and worksheet are correct (by default this will be 1 or 2 rows).

3. Import Complete - This page summarises the import, advising the user how many rows have been added to
various forms/tables. It is important that you scrutinise this summary to ensure that the import has performed
the actions that you expected. What is important to take note of is the total rows for a specific item; i.e. add
together the number added and updated and make sure that is equal to the number you expect.

Note: If the importer encounters a completely blank row in an Excel file, it will stop importing at that point, even if
there are non-blank rows further down. This can provide an easy way to test an import sheet: set it up, and then after
just one or two rows of data, insert a blank. Run the import to see if it’s doing what you expect, and if so, delete the
blank and run again. Similarly, if the importer encounters a blank column in an Excel file, columns to the right of this
will not be imported.

Tip: When importing inspection event data, anomaly triggers are checked during the import and findings created
automatically from data which falls outside the data bounds.

Note: If you are importing a sheet designed for use with NEXUS IC 5, it may have one or more columns titled
‘Component.Location’. In the Configure Import page, you should select ‘Asset Location.Full Location’ for these
columns.

Note: You can have one ‘Asset Location.Full Location’ column, with levels in the asset hierarchy separated by space
slash space, like ‘My Field / My Plaform / My Member’, or many ‘Asset Location.Full Location’ columns, with one
asset hierarchy level in each. (But you can’t mix the two, with one containing ‘My Field / My Platform’ and a second
containing ‘My Member’.)

Tip: You can also import from .csv files. For very large imports, saving your Excel file as a .csv and then importing
from the .csv may be faster.

13.5.2 Sub-rows

Sometimes a single “master” row will have several “detail” rows. For example, an asset information row might have
several sub-AIG rows; or an event might have several findings or several multimedia images or both. When this occurs,
you should repeat the row, with different “detail” values in each.

For example, if you have several multimedia images to import against a single event, your Excel sheet should have
several rows that are identical except for the Multimedia.Name and Multimedia.Image columns. If you have specified
an event number, and you use the same event number on each row, NEXUS will only create the event once, but will
create several multimedia items. (If you do not specify an event number, NEXUS will instead create several different
events with one multimedia item each.)

It is also acceptable to leave event fields blank for all except the last row — under the hood, NEXUS is importing each
Excel row into the event, and only the last Excel row imported will “stick”. Note that if your event has a finding, you
should not repeat the finding data on each event row — if you do, NEXUS will create one finding for each Excel row
that has finding data filled in.
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In some cases you do want multiple findings on one event, and in that case you should fill in several rows as appropriate.
Similarly for sub-event data or sub-AIG data: if you want several different sub-events or sub-AIG rows imported, you
should repeat the event row or AIG row with different sub-event or sub-AIG data in each case. If you are repeating
an Excel row for another reason and you do not want several sub-event or sub-AIG rows imported, you should fill in
sub-event or sub-AIG data in only one of the Excel rows.

Tip: You can find the next available event number for a given event type by creating an event of that type using Add
Event, noting the event number, then deleting that event. If you want next available event numbers for several event
types, create a report template with a Simple Source on table Event and a Pivot Table with a pivot row on Event Type
and a value field on Event Number with aggregate Max. Then add 1.

13.5.3 Excel

During an import, we communicate with Excel “behind the scenes”: we command Excel to open the file you want to
import, and ask Excel what’s in each cell. An upshot of this is that if you use Excel to modify the file while we’re
importing it, even if you don’t hit Save, you may confuse the import process. Similarly if you take a variety of other
actions: using Save As, closing Excel, etc. If you see error text “Call was rejected by callee”, this is what’s happened:
Excel has stopped answering our calls.

13.6 Export

The Export toolbar option is common to many screens in NEXUS IC. The Export toolbar option provides the user the
option to export the contents of the active grid to Excel, Text or CSV.

The Export toolbar button allows the user to choose what format to export the contents of the active grid to.

• Export → Excel

• Export → Text

• Export → CSV

After choosing a format, you have the option to export the contents of the active grid to a file, in which can you will
need to navigate to a windows folder location from the Save As dialog and click on Save, or embed into an email, in
which the file will be emailed to the email address of the currently logged in user.

Note: The “Export” button available on grids is different from ASSETS → Custom Export and INSPECTION →
Custom Export. These buttons launch the Export wizard which allows you to select assets and data types for export.

13.7 Reports

The Reports toolbar button enables you to generate a report template which has been configured in the NEXUS IC
database.

Report templates (once configured), are saved into a Report Category. Whilst additional report categories can be
configured (see Report Categories), default Report Categories included with a standard NEXUS IC database are:

1. Anomaly

2. Archived
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3. Asset

4. Miscellaneous

5. Risk

6. Schedule

7. Workpack

The dropdown menu on the Reports toolbar will display each of the Report Categories, and a sub menu listing each
of the report templates assigned to that category.

There are two special categories: No Category and Favourites. Go to Database → Your Profile to configure what
appears in Favourites.

All reports can be exported to RTF, HTML or Microsoft Excel. The formatting of the report depends on the output
form selected. For example, Page Break elements do not cause the beginning of a new page in HTML or Excel reports;
Excel tables enable Excel’s filtering feature; and so on.

Depending on the layout of the report and filtering options configured in the report, you will be presented with a wizard
to generate the report.

Note: By default, you will be required to confirm the output format (File, Email or Shortcut) of the generated
document. If you select File as the destination, then either confirm the default path and name of the report, or choose
another file location and name for the file. If you choose Email as the destination, then Email account properties need
to be set up. The Shortcut format is only available if a suitable shortcut is configured.

For information on configuring report templates, see Report Templates.

13.8 Customise

The Customise toolbar button enables you to define which columns are shown (or hidden) and how to configure the
rows for display in the active grid.

These settings are saved for each user and will be remembered next time that user logs into NEXUS IC.

Note: The settings are saved to a file called Integrity Centre.Settings in
C:\Users\[USER_NAME]\AppData\Roaming\NEXUS

• Customise → Grouping Shows and hides the Grouping panel above the grid. When the Grouping panel is
visible, column headings can be dragged onto it from the grid. It is also possible to group by multiple
columns.
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• Customise → Columns Shows and hides columns in the grid. Drag and drop columns headings from the grid
into the Customization dialog to hide columns and vice versa to show the columns.

• Customise → Reset to Default Clicking on this menu item will restore the default columns and column sizes
back to the original designed state.

• Customise → Apply Best Fit As the name suggests, when clicked the visible columns will be resized to fit best
within the grid.

13.9 Multi-Edit

Most grids in NEXUS IC provide the user the ability to edit and delete multiple rows in a single action.

13.9.1 Selecting Multiple Rows

1. To select a consecutive group of rows, click the first item, press and hold down the Shift key, and then click the
last item.

2. To select non-consecutive rows, press and hold down the Ctrl key, and then click each item that you want to
select.

Sorting, Filtering and Grouping can be helpful in selecting the rows you want to work on.
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13.9.2 Editing Multiple Rows

Once you have selected the rows that you want to edit, then click on the Edit toolbar button. This will launch the
relevant edit dialog for the active table.

Fields that are unedited will retain their original values for all selected rows (even when the data differs from row to
row).

Fields that are edited in this dialog are identified with an (Undo) icon directly to the right hand side of the edited
field.

Clicking on the (Undo) icon will revert the data back to the original values.

Clicking on OK in the dialog will apply all changes to the edited fields for all selected rows.

13.9.3 Deleting Multiple Rows

Once you have selected the rows that you want to delete, then click on the Delete toolbar button. This will launch the
Question dialog and ask you for confirmation that you want to delete all selected rows. Click on Delete to confirm, or
Cancel.

13.10 Sorting

All grids in NEXUS IC provide the user the ability to sort by one or more columns.

13.10.1 Sorting by a single column

Click anywhere in the column heading to sort by that column. Down arrow indicates descending order, Up arrow
indicates ascending order.

13.10.2 Sorting by one or more columns

Shift + Click in any column heading to sort by that column. Down arrow indicates descending order, Up arrow
indicates ascending order. Shift + Click in another column to apply a second sort.

13.11 Filtering

All grids in NEXUS IC provide the user the ability to apply one or more column filters.
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13.11.1 Applying a column filter

Hovering over any column heading with the mouse will make the filter icon appear (shown in the above image). Click
on the filter icon to display a list of names unique to this column. Check any of the checkboxes to apply that text filter
to the column.

13.11.2 Custom Filter

Selecting the (Custom. . . ) item from the filter dropdown list launches the Custom Filter dialog. This dialog allows
you to specify the filter criteria for a single column consisting of one or two filter conditions. You can also specify the
operator for these conditions.

When using the LIKE or NOT LIKE operator, you can use the ‘underscore’ (_) and ‘percent’ (%) characters to
substitute one or several symbols in a string value respectively.

Filters are not remembered between sessions: if you close and re-open NEXUS IC, your filters will be cleared.

See also: Find As You Type.
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13.12 Grouping

When the Grouping panel is visible, column headings can be dragged onto it from the grid. It is also possible to group
by multiple columns.

Click the Customise button on the toolbar above a grid. If Grouping is selected, you’ll see a dark grey bar at the top of
the grid. This bar can contain one or more column headings. In the screenshot below, you can see the default grouping
in the ANOMALIES screen. You can see that the grid appears as a “tree”, with [+] or [-] marks at the left of each
category. The first level of the tree is the first thing shown in the grey Grouping bar — in this case, Closed Out. The
second thing in the Grouping bar corresponds to the second level of the tree, and so on. You can click on “columns”
in the grey Grouping header to sort by them or to filter by them. You can drag column headings off the grid and onto
the Grouping bar, or back from the Grouping bar onto the headings row of the grid. You can drag items around in the
Grouping bar to control which level is first in the tree.

Almost all grids in the software can be grouped in this way.

See also: Customise, Sorting, Filtering, Find As You Type.

13.13 Data Validation

A number of data validation rules can be defined to ensure data quality within the NEXUS database. These are applied
on the individual data fields contained within “Asset Information” or “Event” forms.

13.13.1 Required

Any data field of any field type can be set to be “Required”. This means that, when adding a new record, this field
must be filled before the record can be saved. Typically fields should be set to “Required” when they provide essential
information or are used as an input to critical calculations. Required fields are clearly identified on the form.
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Hovering your mouse over the provides the hint: “Design Life is a required field and must have a value specified”

This requirement is also enforced during any data import. The user is unable to proceed with the import until the
column with the ‘required’ field is present in the import sheet. Import sheets created by NEXUS identify required
fields with a red column in MSExcel.

13.13.2 Maximum & Minimum

Numeric and Whole Number data fields can have Maximum and Minimum values set. This means that, when adding
a new record, values in this field must be within range before the record can be saved.

Typically maximum and minimum values should be set to ensure data quality for fields where ranges are consistent
for all assets. For example; a percentage field must be between 0 and 100.

Fields with out of range data are clearly identified on the form.

Hovering your mouse over the provides the hint: “Design Life must be less than or equal to 90” or “Design Life
must be greater than or equal to 0”

13.13.3 Lookup Lists

Look List fields by their very nature enforce selection of valid data and provide consistency.

13.13.4 Anomaly Triggers

Data input onto Event forms are additionally subject to Anomaly Triggers. These are validation checks that define
anomalous readings and are used to trigger the automatic creation of Findings of a given type and severity.

When an anomaly trigger is violated, a yellow exclamation mark ( ) will appear next to the field. You can set
lower/upper bounds to be constant values (so a field might trigger if it was outside, say, 1 to 9) or to pull from a field,
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on this form or on another form. So for example if this field is Measured Wall Thickness, it might trigger if its value
is less than Minimum Allowable Wall Thickness.

For Lookup List fields, the comparison is done of the lookup list item’s Value, not its Comment. So if you have a
lookup list titled “Anode Depletion”, and its first entry has value “25” and comment “0 to 25% depleted”, NEXUS
will use the “25” for purposes of determining whether an anomaly trigger should be fired.

For Yes/No fields you can set the trigger to fire on any combination of Yes, No or blank; but you can’t compare to
another field.

The Include Boundary tickbox controls whether exact matches cause the trigger to fire: if you have set a trigger
to “Fail when inside Upper/Lower bounds”, your lower bound is 1 and your upper bound is 9, this is the difference
between “1 < x < 9” and “1 <= x <= 9”.

You can optionally give an anomaly trigger a date range. If you set just a Date From, the trigger will apply only to
event data from that date forward. If you set just a Date To, the trigger will apply only to event data from that date or
earlier. If you set both, the trigger will apply only to event data within the specified range. In this way, you can change
triggers to reflect new conditions, without causing spurious warnings on historical data. For example, if you decrease
the operating pressure of an asset, this might decrease the minimum allowable wall thickness. Rather than editing the
existing anomaly trigger, you can set a “To” date on that old trigger, and add a new trigger with a “From” date.

Caution: In most cases, Findings are generated at the time events are added or imported. There are however some
scenarios in which the Anomaly Triggers utility should be run manually. These are 1) whenever anomaly triggers
are edited; 2) when anomaly triggers exist on a calculation field; 3) before any Finding review sessions; or 4) after
a bulk import of event data (particularly when anomaly triggers rely on events other than itself).
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Triggers for a field independent of asset are found in NEXUS IC in Asset Information and Event Types. Anomaly
triggers for specific assets can be configured in NEXUS IC by right-clicking on an asset and choosing Anomaly
Triggers. . . . If you have both an asset-specific and a generic anomaly trigger on the same field, for assets with the
asset-specific trigger, only the asset-specific trigger will apply. For assets with only a generic trigger, only the generic
trigger will apply. Note that asset-specific anomaly triggers are specific to their asset — they do not automatically
apply to an asset’s children.

A trigger can have an anomaly Code and a Severity, and you can have several different triggers on a single field, with
different codes and/or severities. The dialog may also show a preview chart, showing which triggers apply at which
KPs or depths.

Fields with out-of-range data are clearly identified on the form.

13.13.5 Data quality alerts

Even with the most rigorous of data validation regimes it is sometimes possible for inaccurate data to be entered.
Data quality checks can additionally be established for calculation results by means of Traffic Lights and Reports. For
example, a “Remaining Life” traffic light could be configured to shown any negative values as red. Simply turning on
the traffic light enables you to spot and investigate any potential data issues.

13.14 Unhandled Exceptions

In many places in NEXUS IC, when something goes wrong you’ll receive a polite message explaining the problem.
But occasionally you’ll run into an unhandled error. In this circumstance, NEXUS will show you an “Unhandled
Exception” message and will attempt to send a crashlog to our bug tracking server. (No personally identifying infor-
mation is tracked, and nothing about your usage can be tracked back to you.) If you click the Details button, you
will see a Windows Explorer window with the .crashlogz file highlighted. This is the same data that is sent to us
automatically, but if the computer in question is not connected to the internet, we may ask you to mail us that file.

When you see an “Unhandled Exception” message, it may be helpful to us if you send an email to sup-
port@nexusic.com telling us the steps you took that led you to the error dialog. (Some of the time the crashlog
alone is enough to tell us exactly where the error lies and how to fix it; sometimes not.) It’s helpful if you do this
immediately after you see the error, or if you include enough information for us to figure out which crashlog you are
talking about — since the crashlog is anonymised, if you don’t proactively tell us about your problem, we often don’t
know who it’s from. Emailing us also lets us reply to you when we’ve fixed the issue so that we can, for example,
offer you a new build with the bug removed.
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CHAPTER

FOURTEEN

GENERAL

The following topics contain information relating to software deployment, technical and release information.

14.1 Deployment Guide

14.1.1 Hardware and Software Pre-Requisites

Client Software

• Client Operating System: Windows 8, Windows 10. x86 (32-bit) and x64 (64-bit), Windows Server 2012 R2
(or higher) supported.

• ODBC Drivers: Version 17 required. (https://www.microsoft.com/en-us/download/details.aspx?id=56567)

• Windows Media Foundation: For clients running Windows Server, then use the ‘Add Roles and Features’
wizard from the Server Manager. Skip through to ‘Features’ and select ‘Media Foundation’.

• Desktop Experience: For clients running Windows Server, then the Desktop Experience feature needs to be
installed (https://technet.microsoft.com/en-us/library/cc772567(v=WS.11).aspx) )

• Oracle Instant Client: Required on every client machine when one or more Oracle connectors are configured
(http://www.oracle.com/technetwork/database/database-technologies/instant-client/overview/index.html).

Other Client Software

Other software applications commonly installed on client machines include:

• Microsoft Excel: Used for viewing reports which are exported to XLS format. Also commonly used to compile
source input files for bulk data imports and updates (CSV or TXT can be used as an alternative).

• Microsoft Word: Used for viewing Reports which are exported to RTF format (alternative viewer is WordPad).

• Any web browser: Used for viewing Reports which are exported to HTML format.

• Any PDF reader: Used for viewing PDF format reference documents which may have been uploaded to the
NEXUS IC Library.

Client Hardware

• Processor: Core i5 / i7

• Graphics card: If 3D support is required then the graphics card must support OpenGL.
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• Memory: 4GB RAM

• Hard Disk: 30GB

• Video Resolution: 1280 x 1024 (dual monitors recommended for IC-Inspection)

Network

We recommend network latency is maintained at < 4ms. Latency is displayed in the application status bar, as well as
Memory Overhead and Memory used. Tasks within NEXUS can take a varying amount of time (from milliseconds to
minutes) depending on complexity. Increased network latency can degrade performance. Some tasks will suffer barely
at all from increased latency; some tasks will suffer much more. (Degradation is never worse than linear: double the
latency will cause at most double the time to be taken by the application.)

IC-Web Supported Browsers

• Chrome 54.0 or above

• Microsoft Edge 79 or above

• Safari 9.1 or above

• Firefox 53.0 or above. 3D drawings may be slower in Firefox.

IC-Web Server

• Processor: Core i5 / i7

• Memory: 4GB RAM

• Hard Disk: 30GB

• Server OS: Server 2012 R2

• Web server software: Microsoft Internet Information Services (IIS) 8.5 with ISAPI Extensions;

• ODBC Drivers: Version 17 required. (https://www.microsoft.com/en-us/download/details.aspx?id=56567)

SQL Server

• Version: SQL Server 2012 with Service Pack 4

• Processor: Multi-core CPU

• Memory: 4GB+

• Separation of System, Database and Transaction Log storage

Internet Connectivity

• Software Based Licensing requires access to internet (standard https port 443)

• Automatic Crash Logs requires access to internet (standard https port 443)
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14.1.2 Active Directory Groups & Service Accounts

Wood recommend that the following Active Directory Groups and Service Accounts are created in advance of the
NEXUS IC software installation process. These Active Directory groups and service accounts enable streamlined
management of the security permissions on the database and the database backup location.

Active Directory Groups

SQL Admins AD Group

Note - during SQL Server Setup you should add the SQL Admins Active Directory group as an Administrator in
the Setup Wizard.

1. Create a new Windows Active Directory group called NEXUS Backup Folder (or similar). This group will
contain users who will be permitted to perform NEXUS Database Backups using the NEXUS IC software
interface.

2. Create a new Windows Active Directory group called NEXUS Users (or similar), make it a member of NEXUS
Backup Folder Active Directory Group. The NEXUS Users group will contain all users who require access to
NEXUS.

3. If it doesn’t already exist, create a new Windows Active Directory group called SQL Admins, this group should
contain users in your organisation who have been identified as the SQL Administrators.

Service Accounts

1. Create a new service account for running SQL Server called NEXUS_SQL_Account. The password on this
account should not expire. Add this Service Account to the NEXUS Backup Folder Active Directory group
and the NEXUS Users Active Directory group. When installing SQL Server, choose this account as the account
to run the services, including SQL Agent and Browser.

2. For companies deploying IC-Web, create a new service account called NEXUS_Web_Account. The password
on this account should not expire. Add this Service account to the NEXUS Users Active Directory Group.

14.1.3 Backup Folder

1. Create a Windows folder called NEXUS_SQL_Backups on a file server for storing database backups generated
by users and the first time NEXUS database to restore from (it is recommended that this folder location is NOT
on the SQL Server itself).

2. Share this folder by granting read/write permissions to the NEXUS Backup Folder Active Directory group.

3. Copy the initial NEXUS database backup file into this folder for first time restoration.

14.1.4 NEXUS Software Installation

1. Select a member of the SQL Admins Active Directory group to install NEXUS IC (using the nexus setup
nnnnnnnn.exe file provided to you by Wood) and ensure that this account is also a member of the NEXUS
Backup Folder Active Directory group.

• Genuine NEXUS setup installers are digitally signed by Wood Group Kenny Australia PTY LTD.
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• If you are installing via command line, see the installer manufacturer’s website for details of command line
parameters.

2. After installation, launch NEXUS application to launch the Database Connection Wizard.

3. On the Which server. . . page of the wizard choose Specific Windows / Domain User authentication and
provide the username and account password of a user in the SQL Admins Active Directory Group, then click
OK, as shown here:

4. In the Which database. . . page of the wizard, enter the full path to the NEXUS backup file. This may be a UNC
path (like ‘\FILE_SERVER\NEXUS_SQL_Backups’) or if the database server and NEXUS IC are running on
the same machine it may be a Windows path (like ‘C:\Database Backups’).

5. Enter a name for the new database (eg. “NEXUS”), as shown here:
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6. Click on Next to restore the database and confirm connection to the newly restored database.

7. License prompt will appear. Enter valid license key and press Request License

14.1.5 Set up permissions on the Database Server

1. Using SQL Management Studio, navigate to the Database Server → Security → Logins.

2. Add the NEXUS Users Active Directory group as a new Login.

3. Under Server Roles for the NEXUS Users Active Directory group Login, ensure “public” is checked.

4. Under Securables for the NEXUS Users Active Directory group Login, ensure the Grant permission for “View
server state” is checked. This is required for the logged in user to query the active logins to display in the status
bar, in addition to determining forced log-offs for Audit Log sessions.
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14.1.6 Set up permissions on the NEXUS database

1. Using SQL Management Studio, navigate to the NEXUS database.

2. Add NEXUS Users Active Directory group to the “public” Database Role.

3. Add NEXUS Users Active Directory group to the “db_owner” Database Role.

14.1.7 Deployment Configuration File

On the first run of NEXUS on a particular PC under a particular user account, NEXUS will ask the user for details
of the database to connect to: server name, database name (along with options to create a new database or restore
a database from a backup file). This can be intimidating to new users. Instead, you can (optionally) supply these
details in a databases.xml file, in the same folder as the IntegrityCentre.exe executable. If NEXUS finds this file
during startup, it will connect to the named server and database. If SSO is specified for the user, no user interaction is
necessary. If SSO is not specified, the user will be shown a NEXUS login dialog, to enter their NEXUS credentials.

The format of the databases.xml file is:

<databases Force="[force restricted?]" AdministratorEmail="[email]" allowedExtensions=
→˓"[list]">
<database server="[server name]" name="[DisplayName]" database="[database name]"

→˓NetworkPath="[backup path]" SkipValidation="[skip validation?]"/>
</databases>
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Force: determines whether users are restricted to only being able to connect to databases listed. If Force is Yes, they
will be so restricted; if Force is No, users can use the Database → Connect menu to choose a different database to
connect to. Force defaults to Yes.

AdministratorEmail: the email address shown when users attempt to connect to a database that they don’t have
access to.

allowedExtensions: a list of file extensions that can be launched by the user e.g. from library items. Defaults to
“doc;docx;xls;xlsx;jpg;png;jpeg;bmp;tiff;gif;mpg;mp3;wav;ppt;pptx;txt;pdf;emf;zip;dwg;avi;rtf;mp4;csv;wmv”.

If allowedExtensions includes a blank extension (e.g. “doc;docx;;”) then users can launch library items that are just
folders (e.g. “C:\myfolder"). These will be opened in Windows Explorer. A single trailing semicolon in allowedEx-
tensions is insufficient — you must use two, or use two at some other point in the string, e.g. “doc;;docx”.

Server: Full SQL server name including instance. e.g. .\sql2012 or sqlserver\sql2012 or . or sqlserver (for the default
instance).

Name: Friendly name shown to the user when connecting.

Database: Physical database name.

NetworkPath: provides the path required for the user to perform a database backup. The SQL Service user account
needs read/write permissions on this Network share. The users performing backups also need read/write permissions.

SkipValidation: if Yes, NEXUS will not attempt to verify the NetworkPath. This means that non-admin users can
still carry out backup and restore operations.

Here’s an example file:

<databases Force="Yes" AdministratorEmail="support@nexusic.com" allowedExtensions=
→˓"doc;xls">

<database server="." name="Client Database 1" database="Database1" NetworkPath=
→˓"C:\Backups"/>

<database server="." name="Client Database 2" database="Database2" NetworkPath=
→˓"C:\Backups"/>

<database server="." name="Client Database 3" database="Database3" NetworkPath=
→˓"\\server\backupfolder" SkipValidation="Yes"/>
</databases>

14.1.8 Troubleshooting

Initial connection to a new database server can stumble at various points. Network connectivity might be a problem, or
a firewall might be preventing access, or the database server might not be configured to listen for network connections,
or authentication might not be configured correctly.

Firewall 1

Windows firewall, by default, blocks everything. If it is safe for you to turn off the firewall on the database server
machine while troubleshooting connectivity issues, you should do so. (If there are several problems, you must have all
the problems fixed simultaneously to succeed.) Then, once you have succeeded, configure the firewall to allow SQL
Server, and turn it back on.

On the database server machine, to turn the firewall off, go to Control Panel. (On Windows 10, be sure to go to Control
Panel, not Settings.) Look for Windows Firewall. (There is a search box at the top right — you can type “firewall”
into it.) Click it. At the left, you will see Turn Windows Firewall on or off. Click this. For each of several locations
you see here, select “Turn off Windows Firewall (not recommended)”. (Note that you should not do this if you believe
that you are connected to a network that might contain anything malicious.) Click OK. Remember that later you will
need to turn these back on (or at least back into the state you found them in).
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Network Connectivity

On the machine running NEXUS IC, open a cmd prompt. (Click the Windows Start button, type cmd, press Enter.)
Ping the database server machine:

ping machinename

or:

ping ipaddress

If the machine responds, this is good: it means that you have basic connectivity to the database server machine. If you
see “request timed out”, you do not have connectivity. See your local TCP/IP guru for assistance.

Anti-virus

If you are using a third-party firewall, anti-virus, anti-malware, “optimiser”, “cleaner”, etc. product, we recommend
disabling it while troubleshooting. (Windows Defender is fine.)

SQL Server Configuration Manager

On the database server machine, open Computer Management: click the Windows Start button, type manag and
click on Computer Management. In the tree at left, expand Services and Applications. You should see one or more
entries for SQL Server Configuration Manager. (There will be more than one if you have more than one SQL Server
installed on this machine.) Fully expand each of these (for example by clicking on each one and then pressing the
numeric * key on the keyboard). (Size the window larger as required.)

For each entry that mentions “Protocols”, click on it. Ensure that “TCP/IP” is set to Enabled in each case. (Right-click
and choose Enable as necessary.)

If you enabled any, you will see a message telling you that you’ll need to restart the service. Once you’ve gone through
the list, if you enabled any, click on Services in the tree at the left. Scroll down to SQL Server in the list. (You may
need to set the Name column wider.) (You may have several SQL Servers in the list.) Right-click on each and choose
Restart. (Note that this may interrupt any users who were using those database servers.)

Allow remote connections

In SQL Studio, right-click on the database server name in the Object Explorer at the left. Choose Properties. Go to
the Connections page. Ensure “Allow remote connections to this server” is ticked. (It is ticked by default, so you’re
just checking that no-one’s changed it.)

No default instance

If your SQL Server is set up with an instance name like “SQLExpress”, “SQL2012”, etc., and does not have a “default”
instance (i.e. one without an instance name) then when requests come in on the default port (1433), none of your
instances may be listening. You can fix this by re-installing the database server as the default instance, by installing
an additional database server as the default instance, or by reconfiguring the ports your existing server instance is
listening on:

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/configure-a-server-to-listen-on-a-specific-tcp-port?
view=sql-server-2017
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Firewall 2

Configure the firewall to allow inbound connections to your SQL Server executable(s):

https://docs.microsoft.com/en-us/sql/sql-server/install/configure-the-windows-firewall-to-allow-sql-server-access?
view=sql-server-2017

http://go.microsoft.com/fwlink/?LinkId=94001

Permissions

Set up permissions on the Database Server

Firewall 3

Now that you have fixed your connectivity issues (hopefully) or have temporarily admitted defeat and are returning to
a secure state, it’s time to turn the firewall back on. Once again, go to Control Panel, then to Windows Firewall. At
the left, you will see Allow a program or feature through Windows Firewall. Click it. If there is a button marked
Change Settings, and it is enabled, click it.

Click Allow another program. . . . Click Browse. Browse to the folder that contains your sqlservr.exe. This might
be a path like C:\Program Files\Microsoft SQL Server\MSSQL11.MSSQLSERVER\MSSQL\Binn.
This path may vary with your SQL Server version. In particular, x86 versions will be in “Program Files (x86)”. Select
sqlservr.exe and click Open. Click Add.

The list of allowed programs and features should now contain an entry like “SQL Server Windows NT - 64 Bit” (or
similar). There may be two or three columns to the right of it, with checkboxes for Domain, Home/Work (Private), and
Public (or just Private and Public). The process we have just stepped through should have ticked the required boxes.

Now click Turn Windows Firewall on or off and turn the firewall back on for each of the several locations. Check
that you still have database connectivity: in NEXUS IC click Database → Close, then Database → Reopen and ensure
the database can still be connected to.

A guide to setting up NEXUS IC on-premise, including best practice security recommendations:

1. Ensure that the minimum Hardware and Software Pre-Requisites are installed and available

2. Create required Active Directory Groups & Service Accounts

3. Set up the Backup Folder

4. NEXUS Software Installation

5. Set up permissions on the Database Server

6. Set up the NEXUS single sign-on accounts. Refer to Security section for instructions on SSO configuration.

7. Optionally set up a Deployment Configuration File.

8. If you run into problems, see the Troubleshooting guide.

14.2 Technical Information

14.2.1 Command-Line Switches

You can launch NEXUS IC with various command-line switches. The NEXUS IC executable is named ‘IntegrityCen-
tre.exe’. This can be useful when launching NEXUS IC from a Windows Explorer shortcut, or when configuring a
RemoteApp icon.
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Screen

If you use a command-line switch beginning with ‘-dock=’ and ending with a screen name, NEXUS IC will launch with
that screen open. Valid screen names are ‘Dashboards’, ‘Assets’, ‘Library’, ‘Planning’, ‘Workpacks’, ‘Inspection’, and
‘Anomalies’. They are case-insensitive.

Example usage to launch the Anomalies dock:

IntegrityCentre -dock=Anomalies

Disable Single Sign-On

If you have previously logged in to a NEXUS database using domain credentials, then on subsequent runs you will be
automatically logged in again with those credentials. You can either select Database → Close, or you can run NEXUS
IC with the command-line switch ‘-DisableSSO’.

Usage:

IntegrityCentre -DisableSSO

Disable Library screen and Export Repository menu item

You can use command-line switch /iad to prevent NEXUS IC displaying the LIBRARY screen or Database → Export
Repository.

Backup and Restore

You can use command-line switches to tell NEXUS IC to backup or restore a database. This may be useful, for
example, for automated backups of a live database, or automated refreshing of a sandpit database.

Example usage for a backup:

IntegrityCentre /backup /sql=MySQLServer /db=MyDatabase /username=admin /
→˓password=admin /path="C:\Database Backups"

Example usage for a restore:

IntegrityCentre /restore /sql=MySQLServer /db=NewDatabase /path="C:\Database
→˓Backups\MyDatabase.nexus-backup"

If you are overwriting an existing database, you must additionally supply credentials, to demonstrate that you have the
appropriate authority to overwrite:

IntegrityCentre /restore /sql=MySQLServer /db=NewDatabase /path="C:\Database
→˓Backups\MyDatabase.nexus-backup" /username=admin /password=admin

Debugging and Tracing

NEXUS IC logs information to a file called IntegrityCentre_Trace.log located in:

C:\Users\[USER_NAME]\AppData\Roaming\NEXUS
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You can control how verbose that logging is with any of the following switches: ‘-error’, ‘-warning’, ‘-informational’,
‘-debug’, ‘-debug1’, ‘-debug2’, ‘-debug3’, or ‘-debug4’. These are ordered here from least verbose to most verbose.
The default is ‘-informational’.

Example usage to log informational messages:

IntegrityCentre -informational

Example usage to log debug, informational and warning messages:

IntegrityCentre -debug

Example usage to log error messages and everything less verbose:

IntegrityCentre -error

Note that you should only use debug switches if instructed to do so by Wood technical support, as they can significantly
impact performance. If you start NEXUS IC with a debug switch, you will see a dialog reminding you of this.

Launching with credentials

Logging in with predefined username and password.

Example usage for login:

IntegrityCentre /dbuser=username /dbpass=pA55w0rd

If, in the Database → Connect wizard you have selected “Specific Windows / Domain User”, the dbuser and dbpass
you specify will be passed to SQL Server as domain credentials.

If you would like to connect to the database using SQL Server Authentication, then use the /sqlauth switch along with
the username and password. Example usage for login:

IntegrityCentre /dbuser=username /dbpass=pA55wOrd /sqlauth

The user will still be given a login prompt allowing them to provide NEXUS credentials, which will determine which
NEXUS user account will be used to identify any changes they make to the database.

14.2.2 Database Schema Diagram

Click to download a copy of the latest core database schema diagram pdf

Change History

8.201

• Increase Workpack.Abbreviation to 15 characters

8.199

• New chart series types

• Added Function_Definition.Readonly
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• Added Approval.Link_ID

• Added Active_Inspection.Is_Inspecting

8.198

• Increased size of Library.Name to 100 characters.

8.196

• Added Layer.Auto_Layer_Id

8.195

• Added Expert_System.Signature

• Added Expert_System_Row.Manual

• Added Task.Retasked_Same

• Added Task.Is_Held

8.194

• Added Form_Caption, Visible_Mobile, Mobile_Order and Mobile_Caption to Field_Layout

• Added LTIP.WPG_ID and LTIP.Revision_ID

• Added Series.Opacity

• Added Chart.Available

• Added Layer.Relative_Asset

• Change Action.Created_By and Assigned_To to FK’s to Personnel

• Added Table_Def.Allow_History

• Added Finding.Status

• Added LTIP_Task.Instructions_FD_ID

• Added Bound.Include_Bounds

• Added Report_Schedule.FD_ID

• Added Overlay_Value.Legend_Order

• Added Finding.Finding_Number

• Added Finding.Has_Comments

• Added Export_System, Expert_System_Row, and Expert_System_Version tables.

8.193

• Added Table_Def.Auto_Calculate field
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8.191

• Added Keepalive to Report_Schedule

8.188

• Added Field_Def.Require_Unique and Field_Def.Unique_FD_ID

• Added Task.Reference_Number

• Added Line Weights for Series

• Added Planning Task.Asset_Location

8.187

• Added Library.Force_2D

• Added Bound.Date_From, Bound.Date_To

8.186

• Added Workflow_Item_Input.Attribute_Name

• Added Approval, Approval_Note and Approval_Field tables

• Added Client.Secondary_Logo

8.185

• Added Asset_Location to Task, Finding, Event, Anomaly

• Added Asset_Location to Library_Conn

• Added Asset_Location to Component

• Added RS_ID to Report_Template, and Report_Status table

• Added Unit.Description

• Added Workpack.Event_Count

8.184

• Added Report_Schedule.Status

8.181

• Removed Report_Template.IsWelcomePage

• Renamed Report_Template.IsDashboard to Is_Asset_Dashboard

• Added Chart.Show_X_Axis_Title and Chart.Show_Y_Axis_Title
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8.180

• Renamed function GetDate to ‘Current Date/Time’, added ‘Current Date’.

• Removed Range Event Type.

8.179

• Removed Report_Template.Last_Generation_Time

• Added new Report_Generation table.

8.178

• Added FP_ID to Workflow_Item_Input.

8.177

• Changed Report_Part.Name to 200 characters.

• New calculated fields for Library_Conn and Library.

8.176

• Added Allow_Adhoc (bit) to Task.

• Added Adhoc_Complete (bit) to Task.

• Added Report_Favourite table.

• Added Dashboard_Report (bit) to Report_Template.

• Added Supports_Dashboard (bit) to Report_Part_Type.

• Added Schedule_Repeat table.

• Added Report_Schedule table.

8.174

• Added Map_Server table.

8.173

• Added Expiry (datetime) field to Repository_Data table.

• Added Text_Align table and TA_ID (int) field to Field_Layout table.

• Added Allow_Add (bit) to Form_Page table.
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14.2.3 Software Based Licensing

Software based licensing is supported in v6.2 and higher. The NEXUS application contacts the software license server
using the standard HTTPS protocol. All information is encrypted in transit between your computer and the NEXUS
License Server.

Upgrading from HASP to Software Based Licensing

In order to change from the physical HASP based license protection to the new software based licensing system:

1. Contact support@nexusic.com to create a software license key for your organisation. This will be a 13 digit key
and will be emailed to you.

2. Disable the existing NetHASP dongle/key by renaming the NETHASP.ini file (this is located in the same folder
as the integritycentre.exe).

Authenticating the Software Based License

• Launch NEXUS.

• When you connect to the database the first time, you will be prompted to enter the license key. This is in the
Database → Properties → License dialog, then click on Request License.
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NEXUS then communicates with the NEXUS License Server via the internet and retrieves license information asso-
ciated with your implementation including:

• Server Name

• Database Name

• License type

• Number of concurrent licenses available to your organisation

• [GRACE PERIOD] in days. This defaults to 30 days.

This information is then stored (encrypted) in the database, and is shown here:
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Subsequent License Validations

What if. . .

No one launches NEXUS for more days than the grace period?

The next time NEXUS is launched, it will contact the NEXUS License Server to authenticate and re-set the grace
period.

Each time a user launches the NEXUS application, it will contact the NEXUS License Server to authenticate the
license stored in the database against the license issued from the server. Upon successful connection and authentication
the grace period is re-set.

If NEXUS is unable to contact the NEXUS License Server for some reason (external internet connection is not
available for example), then NEXUS will still run providing the license has been authenticated within the last [GRACE
PERIOD] days.
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Named Users

If you are using Named Users licensing, a Named Users section will appear at the bottom of the window. You will

need to click the button in the Used column and assign a NEXUS IC license to at least one user. Users who are not
selected will get a message saying that they are not authorised. This includes the user account that you are logged in
under when you set up this license.

If you assign more licenses than you have available, NEXUS will remove any additional licenses above your total
automatically.

Re-authentication

The only circumstances under which re-authentication is required is when the database name OR the database server
name is changed.

Note: Your validation is tied to your database server name. If the database server name changes, the license will show
as invalid. This can happen if you have two different client executables (NEXUS IC, IC-Inspection, etc.) connecting
to the same server under different names. For example, one might be connecting to a server named “.” while the other
is connecting to a server named “127.0.0.1” or “localhost” or “192.168.0.1” or “databaseservername”. If this happens,
ensure that all clients are using the same database server name, and validate the license again.

Offshore use

Software licensing is designed with offshore use in mind. A couple of things to be aware of:

• If your offshore spread is not connected to the internet, before you leave internet range you should connect
a single workstation to the internet (e.g. by hotspotting it to a mobile phone), and start NEXUS IC on that
workstation. That will allow NEXUS IC to validate the license. This will ensure that you have your full
grace period. If you will be out of internet contact for more than [GRACE PERIOD] days, please contact
support@nexusic.com, and we will (normally) be able to temporarily increase your grace period.

• When you back up your database from one server and restore it to another, you will be asked to re-validate the
license, and you will need to temporarily connect a workstation to the internet to do this. Typically this occurs
during mobilisation, but may also occur in case of catastrophic failure of the primary database server. (Complete
failure of a database server is rare.)

14.2.4 NEXUS Administration Tasks

The following sections describe common administration tasks around the deployment and maintenance of NEXUS IC.

Regular Backups

Daily scheduled SQL backups should be performed by an SQL Maintenance job. Retention policy is at your discretion.

Ad-hoc Backups

Standard NEXUS users can take backups as and when required using Database → Backup menu item. Backups are
recommended prior to imports or large scale database changes.
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Database Restore

Database restores must be performed by the NEXUS SQL Admin. We recommend using the NEXUS application to
perform database restore of the proprietary .nexus-backup (or .aimbak for older versions) files. If restoring from
the daily backup then restore should be performed using SQL tools. Confirm that the User Group has [dbowner]
permissions on any restored databases.

Restore a database

• Set up a shared network folder which is accessible to both the database server and to NEXUS IC. This may
be a UNC path (like ‘\MyServer\MyShare’) or if the database server and NEXUS IC are running on the same
machine it may be a Windows path (like ‘C:\Database Backups’). Copy the NEXUS IC database backup file
into this folder.

Restoring the NEXUS IC Database to the SQL Server

You may not have sufficient permissions to create databases on the SQL Server, in this instance, you will need to
engage with your SQL Administrator in order to restore the database using SQL Management Studio (or similar)

Add a user

There are two steps to adding a new user to the NEXUS database:

1. In Active Directory, add user to NEXUS Users Group

2. In NEXUS IC, go to Database → Security and add a new user, entering name and email address. On the LogIn
tab use the SSO dialog to link the user to their AD account. (Alternatively there is an Active Directory Import
option for SSO users). On the Member of tab, assign the user to the appropriate NEXUS Security group.

Edit a user’s NEXUS permissions

In NEXUS IC, go to Database → Security and on the Member of tab select the appropriate security group for the
user.

Remove a User

Although it is possible in NEXUS we do NOT recommend deleting a user because this will delete all audit history
associated with that user. To disable a user:

1. In NEXUS IC, go to Database → Security and edit the user profile. On the Login tab uncheck the enabled
checkbox.

2. In Active Directory, remove the user from the NEXUS Users Group (or disable the user account).

Refresh or Update Software License

If the database name or SQL server name change then the NEXUS licensing will become invalidated. To refresh the
license navigate to Database → Properties and the License tab. Enter the unique license key, overwriting whatever
text is presently there. Press the Request License button. License information will be retrieved over the internet within
a minute or so.
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14.2.5 REST Service Specifications

The REST service provides a API with the ability to add, edit, get and delete information stored in a NEXUS IC
database. These REST service ensures all request are made through the NEXUS Storage engine which allows security
and cohesion to be maintained and respected within the NEXUS database data.

Usage

ICWeb.dll/web/?requestType=REQUESTTYPE[&hash=HASHTOKEN][&extra_options=EXTRA_OPTIONS]

Required Parameters

• requestType - The type of request

• hash - A valid pre-authenticated security token is required for every request except RequestType=getSecurity
requests.

• extra_options - Are optional additional settings which can be used to change, filter or may be required for
certain request types. (see Specific Parameters for RequestTypes below)

requestType

This is a string, it specifies the REST request type. Valid options for this are as follows:

• getSecurity: this is used to authenticate a username and password and get a security token for future requests.

• setSecurity : this is used to change an already authenticated users password.

• getData : this is essentially the same as a Select query on a NEXUS IC metatable

• setData : this is essentially the same as an update query on a NEXUS IC metatable.

• insertData : this is essentially the same as an add query on a NEXUS IC metatable.

• deleteData : this is essentially the same as a delete query on the NEXUS IC metatable.

• getTrafficLight : this is used to get traffic light specific requests

• getChart : this get either the chart list if no extra parameters are sent with this request or the chart data itself

• emailData : used to email Library items to the current user. [Deprecated - use Get Repository Item]

• getObject : used to just return a metatable’s metaData, rows will always be empty.

• getVersion : returns the version and schema for the NEXUS database. This requires no parameters and doesn’t
require authentication

hash

In is a hash token provided to the user and used in order to prove credentials are valid for subsequent requests. The
hash is generated on the server and will expire after 60 minutes of inactivity. To get a hash token you must perform
a requestType=getSecurity request. When performed if the request is successful the result will contain valid
hash token which can be used to prove credentials on all subsequent requests.

Specific Parameters for RequestType

For each type of request, there are a set of valid parameters to allow NEXUS to process the request correctly.

setData

316 Chapter 14. General



NEXUS Documentation, Release 6.6.xxxxx.0

• metatable : the Table_Def “Name” field string or the TD_ID value of the Table from Table_Def.

• filter : is a JSON object string used to return only a filtered subset of data from a metatable (further details
below). This must ensure that only one row is returned. If your filter returns multiple rows, you will get back an
error saying “More than one result”.

• rows: JSON array containing the data to update the row with. The format of the value of each row is determined
by the metaData part of any request to this metatable.

getData

• metatable : the Table_Def “Name” field string or the TD_ID value of the Table from Table_Def

• filter (optional) : is a JSON object string used to return only a filtered subset of data from a metatable (further
details below)

• sortJson (optional): is a JSON object with property attribute which is the field to sort on, and direction attribute
which is ASC or DESC, of the data set returned

• start (optional): the row from which to start returning data from

• limit (optional): the number of rows from the starting row for which to return data

• resultFormat (optional): the type of object the requester wants returned (defaults to JSON)

• maxSize (optional): Used in conjunction with resultFormat=thumbnail argument to specify the max size (either
height or width depending on source aspect ratio) of the thumbnail image returned

• addAigData (optional): special request used to get multiple AIG associated with Components, specifically used
for the Child screen in IC Web -> Asset -> Children panels

insertData

• metatable : the Table_Def “Name” field string or the TD_ID value of the Table from Table_Def

• rows: JSON array containing the data to be inserted, supports multiple rows. The format of the value of each
row is determined by the metaData part of any request to this metatable

[
{"TD_ID": 336, "Workpack_ID":3, "Workpack_Name": "2015 ROV"},
{"TD_ID": 335, "Workpack_ID":2, "Workpack_Name": "ESDT"}

]

deleteData

• metatable : the Table_Def “Name” field string or the TD_ID value of the Table from Table_Def

• filter : is a JSON object string used to return only a filtered subset of data from a metatable (further details
below)

getTrafficLight

• trafficLightKey : Set the traffic light id to either pull Component data or legend data

• componentIds (optional): If set the request will return traffic light data if blank it will return the legend data

getSecurity

• username : Specifies the username for authentication

• password : Specifies the password for authentication

setSecurity

• password : Specifies the password for authentication

• newPassword : Used to set a new password value for an already authenticated user
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getChart

• chartId (optional): The chart id of the chart you want from the list of charts. chartId and rowId are required for
chart data.

• rowId (optional): he currently focused row’s primary key. chartId and rowId are required for chart data

emailData (Deprecated)

• metatable : the Table_Def “Name” field string or the TD_ID value of the Table from Table_Def.

• filter : is a JSON object string used to return only a filtered subset of data from a metatable (further details
below). This filter must ensure only one row is returned. If your filter returns multiple rows, you will get back
an error saying “More than one result”.

getObject

This is identical to “getData” request but returns no rows. Its primary use is to retrieve the metaData for a NEXUS
metatable.

getVersion

No parameters

Filter

Filters are a JSON array, each array item consists of a JSON object with either 1 or 2 elements. There must be an
element called “method” and depending on the method value it may be necessary to have a second element called
“params”. The filter is made up one or more these objects, these represent a pseudo SQL where statement and allow
you to build complex queries to return data.

Examples

[
{
"method": "where",
"params": {

"field": "Workpack_ID",
"compareType": "ctGreaterEqual",
"value": 353

}
}, {
"method": "and"

}, {
"method": "isNull",
"params": {

"field": "Name"
}

}
]

Filter Method Types

The method element determines the type of this filter item

• where This is a normal condition check and requires the params FieldName, CompareType and FieldValue to
be specified.

• and combines conditions requiring left and right to be true.

• or combines conditions requiring either the left or the right to be true.
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• openNesting Represents a leading bracket i.e. “(” and does not require a params attribute.

• closeNesting Represents a trailing bracket i.e. “)” and does not require a params attribute but can only be present
if there is a preceding openNesting.

• not The inverse of the next defined valid filter object (where, isnull, isnotnull) in the array and does not require
a params attribute.

• isNull True if the field’s value is null, requires param FieldName to be set.

• isNotNull True if the field’s value is not null, requires param FieldName value to be set.

• sort Sorts the result set by the fields specified - Requires field and value parameters; value is either “ASC” or
“DESC”. Sort can also be done as a separate request arguments - see “Sort” below.

• distinct Ensures the result set contains unique rows. No parameters required.

Methods available for View_Node

View_Node is used for the asset tree and as such has 2 special commands which can be used on it:

• childrenOf Returns all child assets of selected item in viewnode, params must have the FieldName = “VN_ID”
and FieldValue needs to be set to the object you want to find the children of

• parentOf Returns all parents assets of selected item in viewnode, params must have the FieldName = “VN_ID”
and FieldValue needs to be set to the object you want to find the parents of

Params

Params is a JSON object containing 1-3 attributes. Allowed attributes are: “field”, “comparetype”, “value”:

{
"field" : "Name",
"compareType" : "ctEqual"
"value" : "Test Value"

}

Params is only sometimes required depending the method called - see Methods types above

field

Specifies the NEXUS metatable field on which you which to perform the filter on. It must be an alphanumeric string
in quotes and match a field name in the NEXUS schema.

value

This is a single value or array of values, this can be of type alphanumeric, number, float, boolean. The type of value
specified must match the underlying type of the field.

Dates are represented as strings and must be formatted in 24 hour time in the following format: yyyy/mm/dd
hh:mm:ss.
Boolean are either “true” , “false” or “null”.
If the compareType is ctIn then the value may also be an array of integers.

compareType

CompareType actually relates directly to the NEXUS Metatable type TCompareType. It can be any of the following:

• ctEqual For when FieldName = FieldValue

• ctLess For when FieldName is less than FieldValue
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• ctGreater For when FieldName is greater than FieldValue

• ctLessEqual For when FieldName is less than or equal to FieldValue

• ctGreaterEqual For when FieldName is greater than or equal to FieldValue

• ctLike For when FieldName is like FieldValue - NB FieldValue can contain SQL wildcard character ‘%’

• ctIn For when FieldName is contained with FieldValue - NB in this case FieldValue is a JSON array of integers

sort

Usage:

sort=[{"property":"FIELDNAME","direction":"ASC|DESC"}]

FIELDNAME : = a field in the NEXUS metatable that you want to sort on. ASC|DESC : the sort direction either
‘ASC’ or ‘DESC’ for ascending and descending respectively.

Ie ICWeb.dll/web/?requesttype=getdata&metaData=Header&sort=[{“property”:”Northing”,”direction”:”ASC”}] re-
turns all Header business object data and sorts it ascending on the Northing field.

start and limit

If you have a large data set returned it can be beneficial to get just a subset of rows from the data. You can do this by
appending the URL variables start and/or limit to any of the requests listed above:

start=x
limit=y

Where x and y are numbers

• x = the start row (with 0 being the first row)

• y = the maximum number of rows to display starting from X (0 = all rows)

e.g.

ICWeb.dll/web/?requesttype=getdata&metaData=Header&limit=200 – will return Header data
from the first row entry to the 200th entry
ICWeb.dll/web/?requesttype=getdata&metaData=Anomaly?start=20&limit=50 – will return
rows 21 to 71 of the Anomaly table

If you request a start value above the number or data rows available you will get an empty array If you request a limit
higher than is the remaining rows from the start row you will get all the remaining data, starting from the start value.
By default start and limit are 0 so if not defined this returns all data rows.

resultFormat and maxSize

Format type can be set if you wish for something other than JSON to be returned. Allowed types are as follows:

• json - This will return a JSON text object and is the default if the format argument is left off.
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• icon - This will specify the icon image used in Comp_Icon or Boolean_Value table

• image - This will return a single image or binary file

• binary - Same as image

• thumbnail - This is the same as image but returns a max 200 pixel thumbnail of the image file. You can include
“MaxSize” parameter with this request which will change the max size to something other than 200 pixels.

If request type image or binary you can supply an option parameter “imagefield” - this contains the fieldname in the
NEXUS metatable that contains the image data. If imagefield is left off the request then the NEXUS metatable must
contain a field called “UNC” which contains the image or binary data (i.e. the Repository metatable).

trafficLightKey and componentIds

trafficLightKey is the unique Traffic Light ID used to indicate which traffic light system the requester wants data
about. TrafficLightKey is required for any requestType=getTrafficLight. If the ComponentIDs parameter is also set in
the request then the request returns all Traffic Light data values for those componentIds will be returned. If omitted
then the Traffic Light Legend data is returned instead. componentIds is a jsonArray string

Authentication

Almost all requests can only be preformed once a user is authenticated. The user is authenticated by performing
a Request “requestType=getSecurity”. In order for that authentication request to be successful you must pass in a
“username” and “password” parameters. If the values of these 2 parameters matches values in the database a unique
hash token will be returned back to the requester. From that point on, all requests requiring authentication should then
use the returned hash token as the value of the “hash” parameter in subsequent requests. You can also change your
password via the setSecurity requestType. To do this you must first authenticate. Once authenticated then are required
to send a request with requestType=setSecurity which must include a authenticated hash, your existing password as
a “password” parameter and the new password in a “newPassword” parameter. If successful you will get a success
response back. See getSecurity above.

Tip: If Single Sign On (SSO) is enabled on your account your username must be in the format username@domain.
e.g. - joe.bloggs@mycompany.com

Returned JSON results

The results returned from a query have a number of attributes. “Success” is a boolean and is always returned it will be
true if the request was in the correct format. It will be false if the syntax or attributes passed have caused an error; if it
is false there will also be a “msg” attribute returned with the error message. e.g.

{
success: false,
msg: "Unknown meta table "Ta". Could not find table name in meta tables."

}

Successful results are returned with the success attribute, a metaData attribute, RowCount attribute and Rows attribute.
Please note that RowCount will return the total number or results available not the total number returned in the JSON.
This is because you can use the “limit” to return less than all results (see Starting Row and Limit above).
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rows

rows is an array of all the values returned from the data base, if no results are found it will be an empty array.
Each element in the Rows array is a JSON object containing a “value” attribute and possibly a “display” attribute.
Value is the raw data from the database and will always be present, Display will be present if it is different from the
value. Display is used for thing that are lookup into other sections of NEXUS. For example if your results return
Component_ID this is the Unique ID of a single component in the database but the Name of that component is more
useful to the users so as a result the data will be returned like this:

"rows" :[{
"Component_ID": {

"value": 364,
"display": "Tanks"

},
"CT_ID": {

"value": 21,
"display": "Pressure Tank"

}
}, {

"Component_ID": {
"value": 369,
"display": "Wharf 22"

},
"CT_ID": {

"value": 52,
"display": "Temporary Wharf"

}
}]

This allows you do display user friendly names to users but allows gives you the true value if this is a primary or
foreign key to perform future queries on a selected item. This is useful as you need to use “value” value if you wish to
use this field in a filter. IE - using the example above if you wanted all result where the CT_ID = “Pressure Tank” you
would need to use 21 as the “value” in your filter request for CT_ID not the “Pressure Tank”.

metaData

The Metatable attribute contains information describing the data returned. It contains the following properties:

• “defaultField” : this is the name of the field whose value you can use to display to represent the entire row’s
data as a single entry.

• “totalProperty” returns the value of the Counter of the number of rows returned (this is mostly for ExtJS and is
likely to disappear in future revisions)

• “root” show the attribute which contains the data values - again this was for ExtJS and is likely to disappear in
future revisions

• “fields” contains an array of every field that will be returned and includes information about those fields. See
below.

fields

Fields have the following attributes:

• FieldName: This is the field name

• FieldTitle: This is the User friendly field name or the displayable name for things like fields or column title
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• Comments: User defined comments about a field - can be used in tool tips

• FieldType: This is an integer representing what data type the field is stored in; see below for a list of types

• FieldSize: When displayed in NEXUS this is the size of the field used in characters

• EditorType: This is an integer representing what data type the field is shown as when it is being changed. Not
used yet.

• IsForeignKey: Boolean if this links to another Table in NEXUS

• IsPrimaryKey: Boolean if this is the tables primary key field

• Format: the data/time format if applicable

• DefaultFormat: the data/time format if applicable

• DisplayFieldType: This is an integer representing what data type you should display this data as; See below for
a list of types

• Category: Data is sometimes lumped into groups for display. If set this will contain the name of the group this
field belongs to

• CategoryColumns: How many columns this category has.

• CategoryAlignTop: not implemented yet

• FormOrder: Integer describing the order of the field in the form

• FormColumns: The number of fields per line to display if displaying as a form

• VisibleForm: Boolean which indicates if this fields should be shown or hidden from the user on a form

• ShowCaption: If a caption should be shown

• GridOrder: Integer describing the order of the field in the grid

• BlankText: The default value to display if it is a blank field

• VisibleGrid: Boolean which indicates if this field should be shown or hidden from the user on a grid

• AllowImport: not implemented yet

• AutoValue: If this is auto incrementing field (mostly used for primary keys)

• HasDefaultValue: If this field has a default value.

• PreventEditing: not implemented yet.

• UpperValue: If a numeric value this contains the highest value this number can be

• LowerValue: If a numeric value this contains the lowest value this number can be

• Link_ID: For Passthru fields, contains the Table_Def key for the table this links to.

• FD_ID: The Unique Field ID of this field in the NEXUS system

• LL_ID: The Lookup List ID if this field is a NEXUS Lookup List field

• Required : If the field is a required field

• BooleanType : If the field is a boolean field type

• GridCaption : The caption to display for the column when in a grid.

FieldType and DisplayFieldType values:

1 : Alphanumeric
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3 : Whole Number
5 : Boolean
6 : Numeric
7 : Currency
9 : Date
10 : Time
11 : DateTime
15 : Image
16 : Memo (long text)
17 : Guid
18 : Passthrough
37 : Lookup List
38 : Sub AIG
39 : Position Link
40 : Calculation
42 : Global Lookup

EditorType and DisplayEditorType values:

1 : Combo Box
2 : Radio Group
3 : Edit Box
4 : Number Edit
5 : Checkbox
6 : Form
7 : Grid
8 : Date
9 : Time
10 : Date and Time
11 : Calculated
12 : Memo
13 : Record Lookup
14 : Graphic
15 : Repository
16 : Color Combo
17 : Shortcut
18 : Markup Point
19 : Markup Line
20 : Markup Region
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Request Examples

Return all data from the Header metatable: ICWeb.dll/web/?metatable=Header&requestType=getData&hash={9112936E-
F2A1-4B64-BC71-90C0725A8004}

Return all data from the Table which is defined in Table_Def with the TD_ID = 436:
ICWeb.dll/web/?metatable=436&requestType=getData&hash={9112936E-F2A1-4B64-BC71-
90C0725A8004}&filter=[{“method”:”where”,”params”:{“field”:”TD_ID”,”compareType”:”ctEqual”,”value”:436}}]

Return all data from header metatable where Workpack_ID is greater than or equal to 353 and Event_No is equal to 2:
ICWeb.dll/web/?metatable=Header&requestType=getData&hash={9112936E-F2A1-4B64-BC71-
90C0725A8004}&filter=[{“method”:”where”,”params”:{“field”:”Workpack_ID”,”comparetype”:”ctGreaterEqual”,”value”:353}},{“method”:”and”},{“method”:”where”,”params”:{“field”:”Event_No”,”comparetype”:”ctEqual”,”value”:2}}]

Expanded out the filter JSON Looks like this

[
{

"method": "where",
"params": {
"field": "Workpack_ID",
"comparetype": "ctGreaterEqual",
"value": 353

}
},
{

"method": "and"
},
{

"method": "where",
"params": {
"field": "Event_No",
"comparetype": "ctEqual",
"value": 2

}
}

]

Return all data from the Anomaly metatable where Component_ID is 353 and the KP is greater than 2, or Name has the string ‘pipeline’ anywhere in it:
ICWeb.dll/web/?metatable=Anomaly&requestType=getData&hash={9112936E-F2A1-4B64-BC71-
90C0725A8004}&filter=[{“method”:”opennested”},{“method”:”where”,”params”:{“field”:”Component_ID”,”comparetype”:”ctEqual”,”value”:353}},{“method”:”and”},{“method”:”where”,”params”:{“field”:”KP”,”comparetype”:”ctGreater”,”value”:2}},{“method”:”closenested”},{“method”:”or”},{“method”:”where”,”params”:{“field”:”Name”,”comparetype”:”ctLike”,”value”:”%25pipeline%25”}}]

Expanded the JSON Looks like this:

[
{

"method": "opennested"
},
{

"method": "where",
"params": {
"field": "Component_ID",
"comparetype": "ctEqual",
"value": 353

}
},
{

"method": "and"
},

(continues on next page)
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(continued from previous page)

{
"method": "where",
"params": {
"field": "KP",
"comparetype": "ctGreater",
"value": 2

}
},
{

"method": "closenested"
},
{

"method": "or"
},
{

"method": "where",
"params": {
"field": "Name",
"comparetype": "ctLike",
"value": "%pipeline%"

}
}

]

Return data from data from rows 53 to 57 of the Anomaly business objects where Component_ID is 353 and the KP is greater than 2, or Name is not null and it will sort the data in descending order of Code_ID:
ICWeb.dll/web/?metatable=Anomaly&requestType=getData&hash={9112936E-F2A1-4B64-BC71-
90C0725A8004}&start=52&filter=[{“method”:”opennested”},{“method”:”where”,”params”:{“field”:”Component_ID”,”comparetype”:”ctEqual”,”value”:353}},{“method”:”and”},{“method”:”where”,”params”:{“field”:”KP”,”comparetype”:”ctGreater”,”value”:2}},{“method”:”closenested”},{“method”:”or”},{“method”:”isnull”,”params”:{“field”:”Name”}}]&limit=5&sort=[{“property”:”Code_id”,”direction”:”DESC”}]

The filter expanded out :

[
{

"method": "opennested"
},
{

"method": "where",
"params": {
"field": "Component_ID",
"comparetype": "ctEqual",
"value": 353

}
},
{

"method": "and"
},
{

"method": "where",
"params": {
"field": "KP",
"comparetype": "ctGreater",
"value": 2

}
},
{

"method": "closenested"
},
{

(continues on next page)
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(continued from previous page)

"method": "or"
},
{

"method": "isnull",
"params": {
"field": "Name"

}
}

]

Reports

Usage

ICWeb.dll/web/generateReport?key=KEY&format=FORMAT&recipient=EMAIL&hash=HASHTOKEN
ICWeb.dll/web/getReportParams?key=KEY&hash=HASHTOKEN

Description

The generateReport and getReportParams requests can be uses to have NEXUS email generate and email a report to
someone.

URL Parameters

• key - This is the report template id of the NEXUS report

• format - This is the file format the report will be in

• recipient - This is the single email address of the recipient to receive the report. (optional - if omitted will use
the email address of the account making the request)

• hash - The authenticated hash token the server has provided you with from a getSecurity request

Format Specifics

format - Can be:

rtf - For rich text formatted file
html - For a zip containing hyper text markup language files
xlsx - For an Excel formatted file

Request Body Parameters

If a call to getReportParams returns any rows then the report requires parameters to be inputted from the user. These
must be passed via the generateReport request in the body of the request in JSON format. The format of this JSON
should be a JSON object containing an attribute for each report parameter. The attribute should have the same name
as the “parameterName” returned from the getReportParams and the value of the element be either a single value
representing the value or for multiselect report parameters it may be an array of integers.

14.2. Technical Information 327



NEXUS Documentation, Release 6.6.xxxxx.0

Request Responses

getReportParams

getReportParams will return a JSON similar to the ones outlined above (See Returned JSON results). The fields
returned in the metaData contain the following attributes:

blankText - Helper text for the user if the field is blank
columns - The number of columns this field takes up in a wizard form
displayName - The title of this report parameter to display to the user
editorType - The editorType (see EditorType above)
fieldType - The fieldType (see FieldType above)
foreignTable - If this field represents a link to another table, this will contain the name of the table this is linked to
isNull - If this can be null
multiSelect - If this value can be an array of multiple values
order - the order of this field in the report wizard
parameterName - the name of the report parameter.

The “rows” returned in the response will contain a single row with a element for each “parameterName” the value of
each element will be last values a user used for this report.

generateReport

generateReport will simply return {"success":true} if success.

If not successful it will return an error response with an appropriate message.

Video List

Usage

ICWeb.dll/web/getVideoList?eventId=HEADER_ID&hash=HASHTOKEN

Description

This call returns JSON containing a list of video files associated with an event.

URL Parameters

• eventId - This is the Header ID of an event

• hash - The authenticated hash token the server has provided you with from a getSecurity request. See Authenti-
cation

Results

The resulting request returns the rows from the Video_File metatable in the same format as the requestType=getData
format above.
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Export Grid

Usage

ICWeb.dll/web/exportGrid?metatable=METATABLE&format=csv|txt&emailResult=true|false&
→˓fields=FIELDS&filter=FILTER&hash=HASHTOKEN

Description

This call will return either a CSV or txt file containing the data of a metatable if a particular format is defined by the
FIELDS parameter.

Required URL Parameters

• metatable - This is either a string or integer which is the NEXUS metatable name or Table_ID of a NEXUS
metatable.

• format - This has to be either csv or txt depending on the format you want the returned file to be in.

• emailResult - A string begin either true or false representing a Boolean value. This indicated if you want the
file returned or your want the server to just email the file and return if the email request was successful.

• fields - This is a string representing an array of ordered fields that you want included in the data. i.e.
&fields=["Name","CV_ID","Status"]

• hash - The authenticated hash token the server has provided you with from a getSecurity request. See Authenti-
cation.

Optional URL Parameters

• filter - A filter for the data included in the file. Format and use is identical to when you getData. See Filter
above

Results

The resulting request can return 2 different responses depending on if emailResult = “true” or “false”.

• If emailResult = true and the request is successful the response returns a response with a status 200 with the text
{success: true}.

• If emailResult = false and the request is successful the file will be return (either a CSV or TXT file depending
on what is specified in the format parameter)

Note: the hash parameter will determine the user making the request and if you request the file be emailed then the
requesting user must have an email address specified in their NEXUS account information or else you will get an error.

Get Repository Item

Usage

ICWeb.dll/web/getRepositoryItem?emailResult=true|false&filter=FILTER&hash=HASHTOKEN
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Description

This call returns a repository item to the requester. It will be will return in the response or via an email depending on
the setting of the emailResult parameter.

Required URL Parameters

• emailResult - A string beginning with either true or false representing a Boolean value. This indicated if you
want the file returned or you want the server to just email the file and return if the email request was successful.

• hash - The authenticated hash token the server has provided you with from a getSecurity request. See Authenti-
cation

• filter - A filter to identify a single row from the Repository metatable. The filter must ensure that one and only
one result is returned or else you will get an error. Format and use is identical to when you getData. See Filter
above

Results

The resulting request can return 2 different response depending on if emailResult = “true” or “false”.

• If emailResult = true and the request is successful the response returns a response with a status 200 with the text
{success: true}.

• If emailResult = false and the request is successful the repository file will be returned as the response.

Note: the hash parameter will determine the user making the request and if you request the file be emailed then the
requesting user must have an email address specified in their NEXUS account information or else you will get an error.

14.2.6 REST Service Specifications v2.0

Version

Returns the current REST service version and Database schema.

HTTP Request

GET /icweb.dll/version

URI Parameters

None

Responses

Name Type Description
200 OK Version OK
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Version

Contains the REST service version and database schema.

Name Type Description Optional
version String Version and build of REST service. No
schema String Database schema version No

Example

Request

GET /icweb.dll/version

Response

{
"version": "6.6.35223.0",
"schema": "8.198"

}

Login

Validates the supplied credentials, and if valid returns a hash to be used on subsequent REST api requests.

HTTP Request

GET /icweb.dll/security/login
Authorization {type} {value}

URI Parameters

Name In Re-
quired

Type Description

type HeaderYes String Style of authorization. This can be one of either BASIC, APIKEY, TOKEN.
valueHeaderYes String This is the base 64 encoded authorization key, it is a string containing

username:password for BASIC, apiKey for APIKEY, or the emailToken
for TOKEN.

Responses

Name Type Description
200 OK SecurityHash OK
401 An attempt was made to validate an invalid token/apiKey/username and password.
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SecurityHash

Contains the temporary hash that can be used with subsequent REST api calls.

Name Type Description Op-
tional

hash String Temporary security hash, that can then be used in subsequent REST api
requests, expires 60 minutes after last use.

No

id Inte-
ger

Key associated with the user that this hash is associated with. No

username String Username associated with the user that this hash is associated with. No
license String Type of license the user has assigned to them. Possible values are ‘write’

or ‘readonly’
No

allowPasswordChangeBooleanTrue if this user’s accounts password can be changed by the end user No

Example

Request authentication via a users username and password.

Request

GET /icweb.dll/security/login
Authorization BASIC YWRtaW46cGFzc3dvcmQ=

Note ‘YWRtaW46cGFzc3dvcmQ=’ is the BASE64 encoded equivalent to the string ‘admin:password’

Response

{
"hash":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓",

"id": 4,
"username": "admin",
"license": "write",
"allowPasswordChange": false

}

Example

Request authentication via an API Key.

Request

GET /icweb.dll/security/login
Authorization APIKEY
→˓RTA1REVCNTc2MDVCQTgyQ0QxQTBDMTMwQjM4QzdCQzE0MTVCQTA5NEIyOEQ3M0IwMw==
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Note: the APIKey is shown BASE64 encoded.

Response

{
"hash":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓",

"id": 4,
"username": "admin",
"license": "write",
"allowPasswordChange": true

}

Example

Request authentication via an email token.

Request

GET /icweb.dll/security/login
Authorization TOKEN
→˓RTA1REVCNTc2MDVCQTgyQ0QxQTBDMTMwQjM4QzdCQzE0MTVCQTA5NEIyOEQ3M0IwMw==

Note: the APIKey is shown BASE64 encoded.

Response

{
"hash":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓",

"id": 4,
"username": "admin",
"license": "write",
"allowPasswordChange": false

}

Logout

Invalidates the hash passed so that it can no longer be used for any subsequent requests.

HTTP Request

GET /icweb.dll/security/logout?hash={hash}
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URI Parameters

Name In Required Type Description
hash Url Yes String hash to be logged out/invalidated.

Responses

Name Type Description
200 OK OK
404 An attempt was made to invalidate an invalid hash.

Example

Invalidate a valid hash token.

Request

GET /icweb.dll/security/logout?
→˓hash=E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC

Response

200 OK

Business Objects

Retrieves information about a business object.

HTTP Request

GET /icweb.dll/bo/{tableName}

Additionally you can lookup a business object by it’s key, this is useful when you only have the key from a
foreignTableId field from within BusinessObjectField

GET /icweb.dll/boByKey/{keyValue}
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URI Parameters

Name In Re-
quired

Type Description

tableNamePath Yes String tableName of the business object to be returned
keyValuePath Yes In-

te-
ger

key value of the business object to be returned, this can be obtained from
BusinessObjectField foreignTableId

Responses

Name Type Description
200 OK BusinessObject OK
404 Not Found Business object with specified tableName was not found.

BusinessObject

The business object result type, describes a business object, henceforth referred to as meta table.

Name Type Description Op-
tional

De-
fault

key Integer Key value for this meta table, unique No
tableName String Table Name for this meta table, used to generate

REST requests
No

name String Display / Friendly name for this meta table No
description String Description of this meta table, omitted if null Yes
category String Category of this meta table, omitted if null Yes
tableTypeId Integer Id value of the type of meta table, omitted if null Yes
tableType String Name of the table type, omitted if null Yes
defaultNameFieldNameString Field Name of the field that should be used as the dis-

play name for rows in this object
No

uniqueFieldNameString Field Name of the field that contains the unique row
identifier

No

permissions String Permissions the user has on the BO. None / Read /
Write

No

categories BusinessObject-
FieldCategory

Array of Business Object Field Categories, defines all
the visible categories

Yes

fields BusinessObject-
Field []

Array of Business Object Fields, defines all fields in
Business Object.

Yes

BusinessObjectField

The business object field result type, describes a field in a business object, henceforth referred to as meta field.

Name Type Description Optional Default
name String Default display name of the field No

Continued on next page
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Table 1 – continued from previous page
fieldName String Field Name used in REST requests No
fieldTypeId Integer Type of data the field stores in the database. See Field Types No
displayFieldTypeId Integer The display type of the field type, this may differ to fieldTypeId, for example fieldTypeId may be calculated, but displayFieldTypeId may be string, must be a simple type. Yes fieldTypeId
editorTypeId Integer Type of control that should be used to allow the user to edit raw data for this field. No
displayEditorTypeId Integer Type of control that should be used to allow the user to edit the display value of this field, used for filtering, reports Yes editorTypeId
fieldSize Integer Maximum size of a string field Yes 0
comments String Long comments describing use of the field Yes
defaultValue String Contains the default value that should be given to this field when creating a new row in a client UI. Yes undefined
required Boolean Defines if the can be set to ‘null’. Yes No
lowerValue Float Defines the absolute minimum value for an Integer/Float field Yes undefined
upperValue Float Defines the absolute maximum value for an Integer/Float field Yes undefined
format String Defines the display format for a field Yes undefined
preventEditing Boolean Prevent the user from editing the value in this field, only valid for native field types. Yes No
category String Category of the field, used to group like categories into ‘groups’ Yes BusinessObject.Name
blankText String Value displayed in edit field, when the field value is null Yes undefined
formColumns Integer Number of columns the field should consume on the form Yes 1
formVisible Boolean Is the field visible on the form Yes True
formOrder Integer Order of the field when displaying as a form Yes 0
formCaption String Caption used as the form caption Yes BusinessObjectField.name
gridVisible Boolean Is the field visible on the grid, True, visible by default, False, not visible, null, not visible by default but can be turned on. Yes null
gridOrder Integer Order of the field when displaying as a grid Yes 0
gridCaption String Caption used as the grid caption Yes BusinessObjectField.name
mobileVisible Boolean Should the field be visible for mobile style UIs Yes No
mobileOrder Integer Order of the field when displaying on a mobile UI. Yes 0
mobileCaption String Caption used as the field caption for mobile UI’s. If not defined, use Name. Yes BusinessObjectField.name
booleanTypeId Integer The display type for Boolean fields Yes undefined
isBooleanTypeImage Boolean Is the above display type for boolean fields an image. Yes No
foreignTableId Integer The key for the foreign meta table this field refers to. Yes undefined
subTableId Integer The key for the sub event/aig table this field refers to. Only valid when field type is FT_TABLE. See Field Types Yes undefined
unitId Integer The key for the unit assigned to this field, only relevant for Float fields. Yes undefined
lookupListId Integer The key for the lookup list assigned to this field Yes undefined
isLookupListImage Boolean Is the display type for the lookup list. Yes No
nestedField BusinessObjectField If this field is linked to another business object field, such as PassThru or Global Lookup, then this contains the information about the nested field for formatting and display. No undefined
businessObjectName string If this is a nested field, then the Business Object Name will be included here to allow further requests. No undefined

BusinessObjectFieldCategory

The business object fields category type, describes a category for a field, used when displaying the fields in a form,
and optionally in a grid.
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Name Type Description Op-
tional

De-
fault

name String Display name of the category. No
alignTopBoolean Determines if the fields are positioned above the control, or to the left. Yes No
commentsString Comments/Description that is displayed at the top of the category group,

before any fields.
Yes unde-

fined
columns Inte-

ger
Number of columns of fields to display in categories. Yes 2

hasImageBoolean Determines if the category has an image that should be displayed at the top
of the category group.

Yes No

imageUrlString Specifies the relative Url to retrieve the image data for the category image,
only valid if hasImage is Yes.

Yes unde-
fined

Example

Request

GET /icweb.dll/bo/Workpack

Response

{
"key": 136,
"tableName": "Workpack",
"name": "Workpack",
"defaultNameFieldName": "Name",
"uniqueFieldName": "Workpack_ID",
"category": "Work Scoping",
"tableTypeId": 11,
"tableType": "System Table",
"permissions": "write",
"categories": [{

"name": "Budget"
}, {

"name": "Status"
}, {

"name": "Timing"
}],
"fields": [{

"name": "",
"fieldName": "Guid",
"fieldTypeId": 17,
"editorTypeId": 3,
"formVisible": false,
"gridVisible": false

}, {
"name": "Workpack_ID",
"fieldName": "Workpack_ID",
"fieldTypeId": 3,
"editorTypeId": 4,
"fieldSize": 4,

(continues on next page)
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(continued from previous page)

"formColumns": 1,
"formVisible": false,
"gridVisible": false

}, {
"name": "Workpack Group",
"fieldName": "WPG_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"fieldSize": 4,
"formColumns": 2,
"formOrder": 1,
"foreignTableId": 138

}, {
"name": "Cost Code",
"fieldName": "CC_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"fieldSize": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 20,
"gridVisible": false,
"foreignTableId": 31

}, {
"name": "Revision",
"fieldName": "Revision_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"fieldSize": 4,
"category": "Status",
"formColumns": 2,
"formOrder": 5,
"foreignTableId": 97

}, {
"name": "Name",
"fieldName": "Name",
"fieldTypeId": 1,
"editorTypeId": 3,
"fieldSize": 50,
"required": true,
"formColumns": 2

}, {
"name": "Abbreviation",
"fieldName": "Abbreviation",
"fieldTypeId": 1,
"editorTypeId": 3,
"fieldSize": 10,
"formColumns": 2,
"formOrder": 2,
"gridVisible": false

}, {
"name": "Actual Start",
"fieldName": "Actual_Start",
"fieldTypeId": 9,

(continues on next page)
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(continued from previous page)

"editorTypeId": 8,
"fieldSize": 16,
"category": "Timing",
"formColumns": 2,
"formOrder": 7

}, {
"name": "Description",
"fieldName": "Description",
"fieldTypeId": 1,
"editorTypeId": 3,
"fieldSize": 100,
"formColumns": 2,
"formOrder": 3,
"gridVisible": false

}, {
"name": "Read Only",
"fieldName": "ReadOnly",
"fieldTypeId": 5,
"editorTypeId": 5,
"fieldSize": 1,
"required": true,
"category": "Status",
"formColumns": 2,
"formOrder": 6,
"booleanTypeId": 9

}, {
"name": "Personnel",
"fieldName": "SU_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"formColumns": 1,
"formVisible": false,
"gridVisible": false,
"foreignTableId": 86

}, {
"name": "Task Time",
"fieldName": "Task_Time",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Timing",
"formColumns": 1,
"formOrder": 8,
"gridVisible": false

}, {
"name": "Work Hours (per day)",
"fieldName": "Hours_Per_Day",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Timing",
"blankText": "Number of effective work hours per day.",
"formColumns": 1,
"formOrder": 9,
"gridVisible": false

}, {
(continues on next page)
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"name": "Duration (Estimated)",
"fieldName": "Estimated_Duration",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Timing",
"formColumns": 1,
"formOrder": 10,
"gridVisible": false

}, {
"name": "Duration (Contingency)",
"fieldName": "Duration_Contingency",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Timing",
"blankText": "Enter a value to add a contingency to the estimated

→˓duration",
"formColumns": 1,
"formOrder": 11,
"gridVisible": false,
"unitId": 36

}, {
"name": "Duration (Override)",
"fieldName": "Override_Duration",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Timing",
"blankText": "Enter a value to override the estimated duration",
"formColumns": 1,
"formOrder": 12,
"gridVisible": false,
"unitId": 36

}, {
"name": "Actual End",
"fieldName": "Actual_End",
"fieldTypeId": 40,
"displayFieldTypeId": 9,
"editorTypeId": 11,
"displayEditorTypeId": 8,
"category": "Timing",
"formColumns": 2,
"formOrder": 13

}, {
"name": "Day Rate",
"fieldName": "Day_Rate",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Budget",
"blankText": "Used to calculate cost based on day rate",
"formColumns": 1,
"formOrder": 14,
"gridVisible": false

}, {
"name": "Cost based on Day Rate",
"fieldName": "Cost_Day_Rate",
"fieldTypeId": 40,

(continues on next page)
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"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 15,
"gridVisible": false

}, {
"name": "Costs (Fixed)",
"fieldName": "Fixed_Cost",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 16,
"gridVisible": false

}, {
"name": "Cost (Total)",
"fieldName": "Total_Cost",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 17,
"gridVisible": false

}, {
"name": "Cost (Override)",
"fieldName": "Override_Cost",
"fieldTypeId": 6,
"editorTypeId": 4,
"category": "Budget",
"blankText": "Enter a value to override the calculated total cost",
"formColumns": 1,
"formOrder": 18,
"gridVisible": false

}, {
"name": "Final Estimate",
"fieldName": "Cost",
"fieldTypeId": 40,
"displayFieldTypeId": 6,
"editorTypeId": 11,
"displayEditorTypeId": 4,
"category": "Budget",
"formColumns": 1,
"formOrder": 19,
"gridVisible": false

}, {
"name": "Asset",
"fieldName": "Component_ID",
"fieldTypeId": 3,
"displayFieldTypeId": 1,
"editorTypeId": 13,
"formColumns": 2,
"formOrder": 4,
"gridVisible": false,

(continues on next page)
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"foreignTableId": 30
}, {

"name": "Tasks",
"fieldName": "Task_Count",
"fieldTypeId": 3,
"editorTypeId": 4,
"formColumns": 1,
"formVisible": false

}, {
"name": "Task Breakdown",
"fieldName": "Task_Breakdown",
"fieldTypeId": 1,
"editorTypeId": 3,
"formColumns": 1,
"formVisible": false,
"gridVisible": false

}]
}

Get Row

Retrieve a single row from a business object. The result can be used to display or update the row.

HTTP Request

GET /icweb.dll/bo/{tableName}/{keyValue}?calculateValues={true|false}

URI Parameters

Name In Re-
quired

Type Description

tableNamePath Yes String Table Name of the business object
keyValuePath Yes In-

te-
ger

Id of the row to be returned, if you specify 0 as the key value (this can’t exist) then
getRow returns you a blank row with the default values for all fields populated,
ready to be used to insert a new row.

calculateValuesPath No BooleanThis can be used to disable returning calculated fields. By default this is true, if
you supply false, then no calculated fields will be returned.

Responses

Name Type Description
200 OK TableData OK
404 Not Found No row found for specified keyValue
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TableData

Contains the row data for the requested row for the specified business object.

Name Type Description Op-
tional

Default

key Inte-
ger

Key value for this business object, unique. No

stamp String Stamp for this row set, can be used to re-request the data or re-
quest the next page of data. If omitted row set can’t be paged or
re-requested.

Yes

startRowInte-
ger

Starting row for this set of paged data. Yes 0

pageSizeInte-
ger

Number of rows in each page of data. Yes 100

totalRowsInte-
ger

Number of rows total across all pages, this value may change
on subsequent page retrievals if modifications are made by other
users.

Yes null

rows TableRow
[]

Array of fields/values. Fields are defined by the BusinessObject. Yes Any field not speci-
fied is assumed to be
null.

TableRow

The business object data row, describes a row of data in a TableData result set. The fields that are defined in TableRow
are based on the BusinessObject.

Note: The fields are dynamic and can change. Each and every NEXUS database may have slightly different fields in
the System Tables. The custom tables (Asset Information, Events etc) may differ significantly between databases, and
can change between calls to the REST service if the users are actively making changes. It is expected that any client
consuming data from the NEXUS REST service is able to cope with this. Either by ignoring additional fields in the
TableRow or by assuming a field value is null if the field does not exist.

Name Type Description Op-
tional

Default

{fieldName}Any Contains the value for the specified field, see BusinessObject-
Field. If this is a non-stored field, then this will contain the
display value.

Yes If a field is omitted, it is
because the fields value
is null.

{fieldName}Er-
ror

If the field is in an error state, then an error object is returned. Yes

Error

The error object, contains a single value for the error message

Name Type Description Optional
error string Error string to be shown to the user No
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Example

Request

GET /icweb.dll/bo/Workpack/4

Response

{
"rows": [{

"Guid": "{35809A21-9174-4B56-AD5F-F3930DE24A2D}",
"Workpack_ID": 1,
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",
"Description": "Annual 2015 full field rov inspection",
"ReadOnly": false,
"Task_Time": 0,
"Hours_Per_Day": 12,
"Estimated_Duration": 0,
"Actual_End": "2015-05-15T00:00:00.000Z",
"Total_Cost": 0,
"Cost": 0,
"Component_ID": 1,
"Task_Count": 0

}],
"key": 136

}

Get Row Field

Retrieve a single field value from a row from a business object. The result is not JSON encoded, and is the literal
value.

HTTP Request

GET /icweb.dll/bo/{tableName}/{keyValue}/{fieldname}?format={format}

URI Parameters

Name In Re-
quired

Type Description

tableNamePath Yes String Table Name of the business object
keyValuePath Yes Inte-

ger
Id of the row to be returned

fieldNamePath Yes String Field Name within the business object
format Path No string Format of results. Possible values are value or png, but depends on the field

type. Only FT_CALC supports png.
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Responses

Name Type Description
200 OK Literal Value OK
404 Not Found No row found for specified keyValue
404 Not Found Field fieldName not found in tableName

Literal Value

The response contains the literal value of the field. The content type in the response header describes the type of
content returned.

Example

Retrieve the name of a workpack.

Request

GET /icweb.dll/bo/Workpack/4/Name

Response

Content-Type: text/plain
2015 ROV Inspection

Example

Retrieve the icon for an Asset

Request

GET /icweb.dll/bo/Comp_Icon/4/Icon

Response

Content-Type: image/png
{binaryData}

Get Rows

Retrieve a 0 or more rows from a business object. This can either return all rows, or rows that match a specified filter.
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HTTP Request

GET /icweb.dll/bo/{tableName}/

URI Parameters

Name In Re-
quired

Type Description De-
fault

tableNamePath Yes String Table Name of the business object
startRowQuery No In-

te-
ger

Starting row to be returned, when using paged datasets this sets the first
row returned.

0

pageSizeQuery No In-
te-
ger

The number of rows in each page. Determines the maximum number of
rows to return in the requests, starting at startRow.

100

stamp Query No String Specifies the existing result set to return more rows from. This must come
from a prior request.

Request Headers

Name Re-
quired

Type Description

X-NEXUS-FilterNo BusinessOb-
jectFilters

Filter that should be used to select rows. If this is not specified,
then all rows are returned.

X-NEXUS-Sort No BusinessOb-
jectSort []

List of fields and direction to sort the resulting dataset.

Responses

Name Type Description
200 OK TableData OK

BusinessObjectFilters

Specifies the filter that should be used to return rows.
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Name Type Description Optional Default
operator string Specifies the type

of operator used to
join filters together.
There are two possi-
ble values:

• and
• or

Yes and

where BusinessObjectFilter List of filters to be
used

Yes

nested BusinessObjectFilters Nested list of filters
to be used

Yes

BusinessObjectFilter

Specifies a single filter.
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Name Type Description Optional Default
field string Name of the field to

apply a filter on.
No

method string Filter method:
• eq Equals
• lt Less Than
• gt Greater

Than
• le Less than

or Equal
• ge Greater

than or Equal
• like Like

(Use %
characters
as wildcard
matching)

• in In (Use
items)

• pa Parents Of
• ch Children

Of

Yes eq

value string String representa-
tion of the filter
value. (Ignored
when the method
is in)

Yes null

items Integer[] List of values to be
used when method
is in.

Yes null

not boolean Inverts the
method, ie eq
becomes not eq,
in becomes not
in

Yes False

BusinessObjectSort

Specifies a sort, defines a field and direction to sort by.

Name Type Description Op-
tional

De-
fault

field string Name of the field to sort on No
ascendingboolean Specifies the order to sort, when true sort is in ascending order, when

false descending order.
Yes True

Example (Lookup_Item)

Return Lookup Items for Lookup List with LL_ID of 4. Page Size is set to 5, so the first response only returns 5 rows.
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Request

GET /icweb.dll/bo/Lookup_Item/?pageSize=5

Request Header

X-NEXUS-Filter: {"where":[{"field": "LL_ID", "value": "4"}]}

Response

{
"pageSize": 5,
"startRow": 0,
"totalRows": 12,
"rows": [{

"Guid": "{A348BB1B-4DD4-494A-8A26-51746F2BE1A8}",
"LL_ID": 4,
"LI_ID": 506,
"Value": "0",
"Comments": "Item 0",
"Item_Order": 0

}, {
"Guid": "{049D6A48-DFFF-4C37-8C91-5EF4C4C26BDA}",
"LL_ID": 4,
"LI_ID": 507,
"Value": "1",
"Comments": "Item 1",
"Item_Order": 1

}, {
"Guid": "{01AB1DDC-5909-434A-A441-CFB592FC2960}",
"LL_ID": 4,
"LI_ID": 508,
"Value": "2",
"Comments": "Item 2",
"Item_Order": 2

}, {
"Guid": "{8975DF1F-C06B-4B43-ADA1-5E549F846B3E}",
"LL_ID": 4,
"LI_ID": 509,
"Value": "3",
"Comments": "Item 3",
"Item_Order": 3

}, {
"Guid": "{D601759D-C2D5-4DBD-856A-EC2063138443}",
"LL_ID": 4,
"LI_ID": 510,
"Value": "4",
"Comments": "Item 4",
"Item_Order": 4

}],
"key": 67

}
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Example (Lookup_Item)

Return Lookup Items for Lookup List with LL_ID of 4 and (Item_Order < 5 OR Item_Order > 10). Page Size is set to
5, so the first response only returns 5 rows.

Request

GET /icweb.dll/bo/Lookup_Item/?pageSize=10

Request Headers

X-NEXUS-Filter: {"where": [{"field": "LL_ID","value": "4"}],"nested": [{"operator":
→˓"or","where": [{"field": "Item_Order","method": "lt","value": "5"}, {"field": "Item_
→˓Order","method": "gt","value": "10"}]}]}
X-NEXUS-Sort: [{"field": "LL_ID", "ascending": false}]

Response

{
"pageSize": 10,
"startRow": 0,
"totalRows": 12,
"rows": [{

"Guid": "{DE2042D6-D988-43B2-9097-3BE8130DE9A7}",
"LL_ID": 4,
"LI_ID": 506,
"Value": "0",
"Comments": "Item 0",
"Item_Order": 0

}, {
"Guid": "{13C2D078-B8E7-4A77-BF2C-15EF131618DB}",
"LL_ID": 4,
"LI_ID": 507,
"Value": "1",
"Comments": "Item 1",
"Item_Order": 1

}, {
"Guid": "{4BD34909-E95A-413C-BD43-6936BF1D5728}",
"LL_ID": 4,
"LI_ID": 508,
"Value": "2",
"Comments": "Item 2",
"Item_Order": 2

}, {
"Guid": "{918A854C-718C-4AA1-AC98-4C781F4985B9}",
"LL_ID": 4,
"LI_ID": 509,
"Value": "3",
"Comments": "Item 3",
"Item_Order": 3

}, {

(continues on next page)
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"Guid": "{B3234C2F-3C0C-46CD-B125-715DDC686786}",
"LL_ID": 4,
"LI_ID": 510,
"Value": "4",
"Comments": "Item 4",
"Item_Order": 4

}, {
"Guid": "{EEE0268D-B3F3-45F7-B8CE-A88989C9A1BB}",
"LL_ID": 4,
"LI_ID": 517,
"Value": "11",
"Comments": "Item 11",
"Item_Order": 11

}, {
"Guid": "{080A5FC0-DF25-44DE-896F-25EB95B28E74}",
"LL_ID": 4,
"LI_ID": 518,
"Value": "12",
"Comments": "Item 12",
"Item_Order": 12

}, {
"Guid": "{ABFDFC1C-8C31-4DC7-A0AE-0A3174A0C30F}",
"LL_ID": 4,
"LI_ID": 519,
"Value": "13",
"Comments": "Item 13",
"Item_Order": 13

}, {
"Guid": "{4758598E-5008-4008-A4A6-0EB4697D98C9}",
"LL_ID": 4,
"LI_ID": 520,
"Value": "14",
"Comments": "Item 14",
"Item_Order": 14

}, {
"Guid": "{7010FCB9-E0DC-409B-8C4F-2A6B81769852}",
"LL_ID": 4,
"LI_ID": 521,
"Value": "15",
"Comments": "Item 15",
"Item_Order": 15

}],
"key": 67

}

Example (complex expression)

For following filter:

((Field_A = Column_A AND Column_B = Value_B) OR (Column_C = Value_C AND Column_D = Value_D))

the syntax is:

{
"operator": "or",

(continues on next page)
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"nested": [
{
"operator": "and",
"where": [

{
"field": "Column_A",
"value": "Value_A"

},
{
"field": "Column_B",
"value": "Value_B"

}
]

},
{
"operator": "and",
"where": [

{
"field": "Column_C",
"value": "Value_C"

},
{
"field": "Column_D",
"value": "Value_D"

}
]

}
]

}

The above expression has been unpacked onto multiple lines and indented for easy reading; you will of course need to
deliver the expression in a single X-NEXUS-Filter.

Create Row

Create a new row in a business object.

HTTP Request

PUT /icweb.dll/bo/{tableName}/{keyValue}?calculateValues={true|false}

URI Parameters

Name In Re-
quired

Type Description

tableName Path Yes String Table Name of the business object
keyValue Path Yes In-

te-
ger

Reserved for future use, should use 0.

calculateValuesPath No BooleanThis can be used to disable returning calculated fields. By default this is
true, if you supply false, then no calculated fields will be returned.
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Request Body

This contains fields and values for the new row. For simplicity, you should only include fields that have a value other
than null. You should also exclude any non-stored field, as these will be ignored.

Name Type Description Op-
tional

Default

{fieldName}Any Should contain the new value for the specified field,
see BusinessObjectField.

Yes You can omit a field if the
value is null.

Note: If a field has a default value, then if you want to set the value of that field to null, you must include the field in
the request body with a null value. If you omit the field then the new row will have the default value inserted.

Responses

Name Type Description
200 OK TableData OK
403 An attempt was made to set a value for a read-only field.

Example

Request

PUT /icweb.dll/bo/Workpack/0

Request Body

{
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",
"Description": "Annual 2015 full field rov inspection",
"ReadOnly": false,
"Component_ID": 1

}

Response

{
"rows": [{

"Guid": "{35809A21-9174-4B56-AD5F-F3930DE24A2D}",
"Workpack_ID": 1,
"Name": "2015 ROV Inspection",
"Actual_Start": "2015-05-15T00:00:00.000Z",
"Description": "Annual 2015 full field rov inspection",

(continues on next page)
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"ReadOnly": false,
"Task_Time": 0,
"Hours_Per_Day": 12,
"Estimated_Duration": 0,
"Actual_End": "2015-05-15T00:00:00.000Z",
"Total_Cost": 0,
"Cost": 0,
"Component_ID": 1,
"Task_Count": 0

}],
"key": 136

}

Delete Row

Delete a single row from a business object.

HTTP Request

DELETE /icweb.dll/bo/{tableName}/{keyValue}

URI Parameters

Name In Required Type Description
tableName Path Yes String Table Name of the business object
keyValue Path Yes Integer Id of the row to be deleted

Responses

Name Type Description
204 No Content Row Deleted The server successfully processed the request, but is not returning any content.
404 Not Found No row found for specified keyValue
500 Error Error An error occurred details in Error object.

Example

Request

DELETE /icweb.dll/bo/Workpack/4

Response

200 OK

354 Chapter 14. General



NEXUS Documentation, Release 6.6.xxxxx.0

Request Cookie Token

Requests the REST service generates a single use token to be emailed to the user to then request a permanent access
token.

HTTP Request

GET /icweb.dll/security/requestCookieToken?{parameters}

URI Parameters

Name In Required Type Description
email Query Yes String Email address of existing user.

Responses

Name Type Description
200 OK OK
404 An attempt was made for an unknown email address.

Example

Request

GET /icweb.dll/security/requestCookieToken?email=joe.bloggs@nexusic.com

Response

200 OK

Validate Cookie Token

Validates a generated single use token, and if valid, responds with a permanent token lasting 90 days for subsequent
authorisation.

HTTP Request

GET /icweb.dll/security/validateCookieToken?{parameters}
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URI Parameters

Name In Required Type Description
token Query Yes String Single-use token

Responses

Name Type Description
200 OK SecurityToken OK
401 An attempt was made to validate an invalid token.

SecurityToken

Contains the permanent security token

Name Type Description Op-
tional

token String Permanent security token, that can then be used in subsequent REST api requests,
expires in 90 days.

No

Example

Request

GET /icweb.dll/security/validateCookieToken?
→˓token=C45CB5E015A81801327672766615578D6B4C37D69BBB43D74C9A3E4907676CD1C53EADC408A6B41B2B58DD3A6B500A7D0898

Response

{
"token":

→˓"E05DEB57605BA82CD1A0C130B38C7BC1415BA094B28D73B03577B7CAB438834E6B680B437C85A65CA796AB6E7DC8545555CC
→˓"
}

Post Blob

Post a blob to the REST service, that can then be used in subsequent operations, such as adding library items, multi-
media, and importing.

HTTP Request
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POST /icweb.dll/postBlob

URI Parameters

None

Request Body

This contains the binary data for the blob.

Responses

Name Type Description
200
OK

Blob OK

401 Not authorised An attempt was made to upload a blob when you do not have permissions.
404.13 File exceeds maxi-

mum IIS size.
An attempt was made to upload a file larger than the IIS setting. See: https://msdn.
microsoft.com/en-us/library/ms689462%28VS.90%29.aspx

Blob

The Blob object, contains information about the uploaded bloaded.

Name Type Description Op-
tional

ExpiryDate
Time

Date and Time the blob will expire and be removed from the server if it has not be persisted
using another REST api.

No

Guid string Unique Identifier for this blob No
md5 string MD5 checksum for this blob to ensure that the server received the blob correctly, you should

check this against your local md5 and if it does not match, re-post the blob using another
request.

No

Example

Request

POST /icweb.dll/postBlob

Request Body

binary data
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Response

{
"expiry": "2018-11-01T00:05:13.000Z",
"guid": "{69EA081E-84ED-4504-B15D-14BC7A020E49}",
"md5": "cf894da06f793ed73d841c72dd0bfde3"

}

Request

The guid can then be used to insert a row in Repository, passing the guid for the File_Data field.

PUT /icweb.dll/bo/Repository/0

Request Body

{
"UNC": "file.pdf"
"File_Data": "{69EA081E-84ED-4504-B15D-14BC7A020E49}"

}

Response

{
"Repository_ID": 1,
"UNC": "file.pdf",
"File_CheckSum": "cf894da06f793ed73d841c72dd0bfde3"

}

Get Function Object

Get information about a NEXUS function from the REST service, that can then be used to call the function via REST
to execute.

HTTP Request

GET /icweb.dll/function/{functionName}

URI Parameters

Name In Re-
quired

Type Description

functionName |
functionKey

Path Yes String | Inte-
ger

Specify the function name or function key to be
returned.
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Responses

Name Type Description
200 OK FunctionObject OK
401 Not authorised An attempt was made to access a function when you do not have permissions.

FunctionObject

The Function object, contains information about the function.

Name Type Description Op-
tional

name string Name of the function. No
key Integer Key value for this function, unique. No
resultTypeId Integer Result type of the result from executing this function. See

Field Types.
No

parameters FunctionParame-
ter []

List of parameters for this function. No

FunctionParameter

The Function Parameter object, contains information about each parameter in a function.

Name Type Description Op-
tional

De-
fault

name string Name of the parameter No
parameterTypeIdInteger Result type of the result from executing this function. See

Field Types
No

allowsNull Boolean If this parameter allows a null input value Yes Yes

Example

Request

GET /icweb.dll/function/Compare A = B

Response

{
"name": "Compare A = B",
"key": 57,
"resultTypeId": 5,
"parameters": [{

"name": "A",
"parameterTypeId": 0

}, {

(continues on next page)
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"name": "B",
"parameterTypeId": 0

}]
}

Execute Function

Execute a NEXUS function.

HTTP Request

POST /icweb.dll/function/{functionName}/?format={format}

URI Parameters

Name In Re-
quired

Type Description

functionName
|
functionKey

Path Yes String
| In-
teger

Specify the function name or function key to be executed .

format Path No String Possible values are value or png. value is the default if omitted, and
ensures the result of the function is returned. If png is specified then the
result will be a png containing the function preview with results.

Request Body

This contains parameters and their values to use to execute the function. For simplicity, you should only include fields
that have a value other than null.

Name Type Description Op-
tional

Default

{parameterName}Any Should contain the new value for the specified
field, see FunctionParameter.

Yes You can omit a parameter if
the value is null.

Responses

Name Type Description
200 OK FunctionResult OK
200 OK image/png An image containing the function layout with results
401 Not authorised An attempt was made to access a function when you do not have permissions.
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FunctionResult

The Function result, contains the result of the function execution, or if an error occurred the message.

Name Type Description Op-
tional

state string State of the function call, ok or error. No
value Any If state is ok then this will hold the result of the function execution. Yes
message String If state is error then this will contain the error message returned from the func-

tion.
Yes

Example

Request

POST /icweb.dll/function/Compare A = B/

{
"A": 5,
"B": 3.4

}

Response

{
"state": "ok",
"value": false

}

Request

POST /icweb.dll/function/Compare A = B/?format=png

{
"A": true
"B": 4

}
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Response

Dashboards

Generate the data required to display a dashboard, response data contains all information required for displaying the
dashboard. The response may be quite large, depending on the dashboard that is requested. Charts especially may
contain a large number of points.

HTTP Request

GET /icweb.dll/dashboard/{key}
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URI Parameters

Name In Required Type Description Default
key Path Yes Integer Key associated with dashboard.

Responses

Name Type Description
200 OK Dashboard OK
404 Not Found String Dashboard identified by key was not found.

Dashboard

Contains the data associated with a dashboard, there is a name as well as a list of elements, each element identifies an
element in the dashboard, these elements are extensible, and can be customised by the user within NEXUS IC itself.

Name Type Description Optional
name string Name of the dashboard No
elements Dashboard Element [] List of elements in the dashboard. No

Dashboard Element

Specifies an element in the dashboard, each element contains some base configuration, but each element also contains
a data element, and the contains of this JSON object is based entirely on the type of dashboard element. Those
elements that you don’t understand can be skipped and not displayed.

Name Type Description Optional
caption string Caption used for the dash-

board element.
No

type string Specifies the type of ele-
ment this represents.

• table Table Ele-
ment

• chart Chart Ele-
ment

• paragraph Para-
graph Element

• section Section
Element

• image Image Ele-
ment

No

data object Contains the data asso-
ciated with the element,
this is dependant on the
element type defined in
type

No
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Table Element

Contains the data for a table, a table can be either a normal table, a vertical table or a pivot table. A table may not have
any columns, categories or rows, but will have at least columns or ``rows defined. It is assumed that the
columns and rows are in matched order, so the first item in each TableRow is the value for the first column.

Name Type Description Op-
tional

De-
fault

sourceBusinessObjectString If there are source rows for Table Row entries, then this will contain
the name of the business object that the key values are from.

Yes null

columns Table
Column
[]

Contains a list of columns for the table. Yes

categories Table
Category
[]

Contains a list of optional categories for the table columns, generally
this are output above the columns, grouping them together.

Yes

rows Table
Row []

Contains the rows of data for the table. Yes

Table Column

Name Type Description Op-
tional

De-
fault

caption String Caption for the column. No
alignment String Specifies the way the caption should be align, center, right,

left.
Yes left

Table Category

Name Type Description Op-
tional

De-
fault

caption String Caption for the column. No
spanColumns Inte-

ger
Number of columns this category spans. Yes 1

alignment String Specifies the way the caption should be align, center, right,
left.

Yes left

Table Row

Name Type Description Op-
tional

De-
fault

cells Table Cell
[]

Contains the data for each of the cells of the Table Row. No

sourceKey Integer Contains the primary key for the source row applicable to this
Table Row.

Yes null
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Table Cell

Name Type Description Op-
tional

De-
fault

value String Contains the value for the column, if a datetime, contains an ISO 8601
formatted date/time. If the time is 00:00:00 it should be omitted from
display.

No

alignment String Specifies the way the caption should be align, center, right, left Yes left
sourceBusinessObjectString If there are source rows for this Table Cell then this will contain the name

of the business object that the key values are from.
Yes null

sourceKey In-
te-
ger
[]

Contains 0 or more primary key values for the source rows applicable to
this Table Cell.

Yes null

Image Element

Contains an embedded image, with a caption, should be displayed to the end-user with no interactivity.

Name Type Description Optional Default
type String Mime Type of format of image. No
image String Base64 encoded imaged No

Chart Element

Specifies the data that is produced when the dashboard element is a chart, a chart can be rendered as either a table of
data or a chart itself, decision should be made by the client. A chart element may contain more than 1 Chart, if more
than one is output then the Charts will take on the same structure, they will just contain a differing set of data.

Name Type Description Optional Default
charts Chart [] 1 or more charts defined in this Chart Element. No

Chart

Contains a the data for a single chart, for the Chart Element. Each chart can have 1 x and y axis, and then 1 or more
series. Eachs series will have a specific type, such as bar, line etc and contain the data for that series.

Name Type Description Optional Default
x-axis Chart Axis Defines the x-axis for this chart. No
y-axis Chart Axis Defines the y-axis for this chart. No
series Chart Series [] Defines the y-axis for this chart. No
zoomBar Boolean Determines if a zoombar is visible. Yes No

Chart Axis

Chart Axis defines the specific axis for a chart, such as title and format of data.
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Name Type Description Op-
tional

De-
fault

title String Title for the axis. Yes null
autoScaleBool Specifies whether this axis should auto-scale to fit the data Yes True
scale Float When autoScale is False, then this contains the scale at which the axis

should display the data.
Yes null

format String Specifies the type of data in the axis, float, int, datetime, string No

Chart Series

Contains the data for each chart series. A chart series is visually defined by the type that determines how the series
points should be displayed to the user.

Name Type Description Op-
tional

De-
fault

type String Type of Series, point, line, bezier, bar, gantt, verticalLine, horizontalLine, pie,
disjointedLine, histogram, shadedSection, polygon, minMax, average, stan-
dardDeviation, trendFirstLast, trendLastTwo, trendAll, leastSquares, heatMap

No null

name String Name of the series, to be shown in any legend. Yes null
colour String Web Colour Yes null

(use
series
colour)

points Chart
Point
[]

Contains the series points to be displayed in the chart series. No

opacityFloat 0 to 1 determining the opacity of the point, 0 is completely transparent, 1 is not
transparent at all.

Yes 1

pointStyleString Style of points for series that have points, circle, square, diamond, cross Yes null
border Bool For points, should a border be painted. Yes True
pointSizeNum-

ber
Size of points, in pixels. Yes 1

displayPointsBool For line series, do we show points for each point on the line. Yes False
shaded Bool Should the space between the line and where X = 0, be shaded. Yes False
showMeshBool For heatMap and contour series, should a mesh be shown. Yes False
ganttStyleString For Gantt charts, should it be painted as line or bar. Yes bar
shadeInsideString For shaded section series, should the shading occur between the bound lines, or

outside the bounding lines.
Yes False

gradientFloat For trend line chart series, this specifies the gradient of each line, if 0, then the
trend line is horizontal.

Yes 0

Chart Point

Contains the data for each series point. Depending on the series type, it may contain different fields
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Name Type Description Op-
tional

Default

opacity Float 0 to 1 determining the opacity of the point, 0 is completely
transparent, 1 is not transparent at all.

Yes 1

label String Point Label Yes null
id Number Unique key for this series for the point Yes 0
colour String Web Colour Yes null (use se-

ries colour)
x Float X-Value Yes null
y Float Y-Value Yes null
z Float Z-Value Yes null
x2 Float Secondary X-Value Yes null
y2 Float Secondary Y-Value Yes null
z2 Float Secondary Z-Value Yes null
coordinatesCoor-

dinate
[]

Polygon series require an array of X,Y points to plot the poly-
gon.

Yes null

Coordinate

Simple array of X,Y coordinates for polygon series.

Name Type Description Optional Default
x Float X-Value Yes null
y Float Y-Value Yes null

Paragraph Element

A paragraph element contains text, generally it does not have a title for the dashboard element, the text may be
formatted. It may contain 1 or more paragraphs within it.

Name Type Description Optional Default
text Paragraph Text [] Contains the values for the paragraph. No

Paragraph Text

Specifies text within a paragraph, including any styling.

Name Type Description Optional Default
value String Contains a text string for a paragraph. Yes
color String Contains a web colour in #AARRGGBB form. Yes
alignment String Alignment, left, center, right. Yes left
text-bold Bool Determines if the text is bold. Yes False
text-underline Bool Determines if the text is underlined. Yes False
text-italic Bool Determines if the text is italic. Yes False
text-size Bool Determines the point size of the text Yes
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Section Element

Specifies a new section starts in the elements, allowing the section to define the number of columns the elements are
displayed in

Name Type Description Op-
tional

De-
fault

columns Inte-
ger

Number of columns the elements should be split into. Columns are con-
sumed, top to bottom, left to right.

Yes 1

Example

Generate and return the dashboard for the dashboard identified by the key of 3

Request

GET /icweb.dll/dashboard/3

Response

{
"name": "Test Dashboard",
"elements": [{

"type": "section",
"data": {

"columns": 2
}

}, {
"type": "table",
"caption": "Workpack Listing",
"data": {

"columns": [{
"caption": "Name"

}, {
"caption": "Description"

}, {
"caption": "Read Only"

}, {
"caption": "Actual Start",
"alignment": "right"

}, {
"caption": "Hours (per day)",
"alignment": "center"

}, {
"caption": "Workpack Group"

}],
"rows": [{

"cells": [{
"value": "Workpack A"

}, {
"value": "This is the description for WA"

(continues on next page)
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}, {
"value": "No"

}, {
"value": "2019-08-26T00:00:00.000Z",
"alignment": "right"

}, {
"value": "8",
"alignment": "center"

}, {
"value": "Group A"

}]
}, {

"cells": [{
"value": "Workpack B"

}, {
"value": "This is the description for WB"

}, {
"value": "No"

}, {
"value": "2019-08-26T00:00:00.000Z",
"alignment": "right"

}, {
"value": "6",
"alignment": "center"

}, {
"value": "Group B"

}]
}]

}
}, {

"type": "paragraph",
"data": {

"text": [
{

"value": "The above table displays all workpacks.\r",
"color": "#0055FF3A",
"alignment": "center",
"text-bold": true

}, {
"value": "There should be 2 workpacks in this test."

}]
}

}, {
"type": "image",
"caption": "Drawing Details",
"data": {

"type": "image\/png",
"image": "iVBORw0KGgoAAAANSUh..."

}
}]

}

REST Examples

The following are some examples of different interactions with the REST service using Powershell commands.
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Note: It is suggested that interactions with the REST API are thoroughly tested prior to use in a Production environ-
ment. Modifying data directly via the REST APIs can have a destructive effect on a NEXUS database if not tested
properly.

Authenticating

The following provides an example of how to authenticate against the REST API using powershell. This is required
before any other interaction with the REST API.

$baseUri = "https://{icWebUrl}/data/icweb.dll/"
$loginUri = $baseUri + "security/login"

# API Key from the user account in NEXUS. We need to base64 encode it for the
→˓authentication request.
$apiKey = {apiKey}

$apiKeyBytes = [System.Text.Encoding]::UTF8.GetBytes($apiKey)
$apiKeyEncoded = [System.Convert]::ToBase64String($apiKeyBytes)

# Build "Authorization" header for login request.
$headers = New-Object "System.Collections.Generic.Dictionary[[String],[String]]"
$headers.Add("Authorization", "apikey " + $apiKeyEncoded)

# Login to the REST API, result is JSON containing the authentication hash.
$hash = Invoke-RestMethod -method GET -uri $loginUri -Headers $headers

Request a list of Rows

Following on from the above authentication, we now have a valid hash to be able to query other items from the REST
API. The below requests all rows from the Workpack business object.

# Base BO REST API
$boUri = $baseUri + "bo/"

# Build the URI to request all the rows from the Workpack business object.
$uri = $boUri + "Workpack/" + "?hash=" + $hash.hash
$workpackJson = Invoke-RestMethod -method GET -uri $uri

# Output the list of Workpacks
$workpackJson.rows | Format-Table -Property Workpack_ID, Name

Note: If there are more than 100 rows in the workpack table you will need to make subsequent requests to retrieve
the rest of the rows.

Request a list of rows with a filter

If you wanted to only return a list of workpacks where the Revision is set to “Planning” we would do that using a filter.
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# Create filter object
$filter = @{

where =
@(

@{
field = "Revision_ID.Name"
value = "Planning"

}
)

}

# Convert filter object to Json.
$filterJson = $filter | ConvertTo-Json

# Add the filter as a X-NEXUS-Filter http header.
$headers = New-Object "System.Collections.Generic.Dictionary[[String],[String]]"
$headers.Add("X-NEXUS-Filter", $filterJson)

# Build the REST uri for the Workpack business object and Invoke the REST method.
$uri = $boUri + "Workpack/?hash=" + $hash.hash
$workpacks = Invoke-RestMethod -method GET -uri $uri -Headers $headers

# Output the list of workpacks
$workpacks.rows | Format-Table

Generate a Report Template

The following generates a report template and emails it to a specified person.

# Base report REST URI
$reportUri = $baseUri + "web/generateReport"

# Set the recipient for the report email/
$recipient = "joe.bloggs@nexusic.com"

# Set the report format to RTF - You can use HTML and XLSX as well.
$format = "RTF"

# Set the report template key to 16, this specifies the report template to generate.
$reportTemplate = "16"

# Generate Report Template with ID of 16, using RTF format and email it to a specific
→˓person.
$uri = $reportUri + "?key=" + $reportTemplate + "&format=" + $format + "&recipient="
→˓+ $recipient + "&hash=" + $hash.hash
Invoke-RestMethod -method POST -uri $uri

Insert a New Row

The following creates a new Workpack, setting the initial values of that Workpack.

# Build an object that contains the specified values for Name, Actual_Start,
→˓Description and ReadOnly
$workpackRow = @{

(continues on next page)
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(continued from previous page)

Name = "2015 ROV Inspection"
Actual_Start = "2015-05-15T00:00:00.000Z"
Description = "Annual 2015 full field rov inspection"
ReadOnly = $false
}
$body = $workpackRow | ConvertTo-Json

# Build the URI to request all the rows from the Workpack business object.
$uri = $boUri + "Workpack/0?hash=" + $hash.hash
$newRow = Invoke-RestMethod -method PUT -body $body -uri $uri

# Output the the new Workpack row
$newRow.rows | Format-Table -Property Workpack_ID, Name

Updating an existing Row

Following on from the insert, we can use the row in $newRow.Rows to then update the name of the workpack and
abbreviation.

# Update Workpack Abbreviation and Name
$workpackRow = @{

Abbreviation = "2015_ROV"
Name = "2015 - Annual ROV Inspection"

}
$body = $workpackRow | ConvertTo-Json

# Build the URI - must include the Workpack_ID from the new row so the REST api knows
→˓what row we are updating.
$uri = $boURI + "Workpack/" + $newRow.rows[0].Workpack_ID + "?hash=" + $hash.hash
$updatedRow = Invoke-RestMethod -method POST -body $bofy -uri $uri

$updatedRow.rows

Getting information on a Function

$functionName = "Compare A = B"
$functionUri = $baseUri + "function/"

# Build the URI - must include the Workpack_ID from the new row so the REST api knows
→˓what row we are updating.
$uri = $functionURI + "/" + $functionName + "?hash=" + $hash.hash
$function = Invoke-RestMethod -method GET -uri $uri

$function

The REST service provides an API consisting of a set of HTTP endpoints(methods) with the ability to create, retrieve,
edit, or delete access to information stored in a NEXUS IC database. The REST service ensures all request are made
through the NEXUS Storage engine which allows security and cohesion to be maintained and respected within the
NEXUS database data.
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Components of a REST API request/response

1. The request URI, which consists of: {uri scheme} :// {uri host} /icweb.dll/
{resource-path} ? {query-string}

• URI scheme: Indicates the protocol used to transmit the request. This is either http or https. We highly
recommend using https in your deployments.

• URI host: Specifies the domain name or IP address of the server where the REST service endpoint is
hosted, such as sample.nexusic.com

• Resource path: Specifies the resource or resource collection, as detailed below in the API

• Query string (optional): Provides additional parameters as required.

2. HTTP request message header fields:

• A required HTTP method (or verb), which tells NEXUS what type of operation you are requesting. The
NEXUS REST service support GET, PUT, POST, and DELETE.

• Optional additional header fields, as required by the specified URI and HTTP method. For example, an
Authentication token that can be used for client authorization.

3. An Optional HTTP request message body, to support the URI and HTTP operation. For POST or PUT opera-
tions, the request body is required to have a MIME-type of application/json.

4. A HTTP status code, this may be from the 2xx, 4xx or 5xx codes. Each service will indicate what possible
returns are available.

5. Optional HTTP response message body, MIME-encoded response objects are returned in the HTTP response
body, such as a response from a GET method that is returning data. All results are return in the format JSON.

Authentication

There are 3 authentication options available using Login:

1. Username/password request

2. API Key, that is associated with any user account with NEXUS, this provides permanent access until the API
Key is changed in NEXUS

3. Email based login, that provides the capability for the REST api to email a request token to the user, this is then
used to have the REST api issue a token lasting 90 days.

All three of these authorization methods, issue a temporary HASH that expires 60 minutes after the last request.

Once the HASH is received from a valid authorization request to the server, this must be specified in subsequent
requests via a query string parameter.

GET /icweb.dll/bo/?hash={value}

Examples

Extensive examples of using the REST API with powershell scripting are available in the below topic.

REST Examples

14.2. Technical Information 373



NEXUS Documentation, Release 6.6.xxxxx.0

API Reference

Login Logout Business Objects Get Row
Get Row Field Get Rows Create Row Delete Row
Request Cookie Token Validate Cookie Token Post Blob Get Function Object
Execute Function Version

Field Types

Name Value Native/JSON Type Display Field Type
FT_STRING 1 string string
FT_NUMBER 3 integer (whole number) integer
FT_NUMERIC 6 float float
FT_BOOLEAN 5 bool bool
FT_CURRENCY 7 float float
FT_DATE 9 string (iso 8601

date/time)
string

FT_TIME 10 string (iso 8601
date/time)

string

FT_DATETIME 11 string (iso 8601
date/time)

string

FT_POSITION 39 string (iso 8601
date/time)

string

FT_LOOKUP 37 integer string
FT_IMAGE 15 binary binary
FT_MEMO 16 string string
FT_PASSTHRU 18 non-stored based on field type of the destination field. (this is re-

cursive)
FT_GUID 17 string string
FT_TABLE 38 non-stored not-visible
FT_CALC 40 non-stored based on result type of assigned function.
FT_GLOBALTABLE 42 non-stored based on field type of global field.

1. NEXUS provides support for a number of Command-Line Switches.

2. The latest version of the Database Schema Diagram can be downloaded.

3. Visit the Software Based Licensing page to understand the mechanics of the solution.

4. Common NEXUS Administration Tasks are detailed here.

5. REST Service Specifications.

6. REST Service Specifications v2.0.

7. How does video playback work?

8. A PDF version of these Help pages can be downloaded from: https://docs.nexusic.com/6.6/nexus.pdf

374 Chapter 14. General

https://docs.nexusic.com/6.6/nexus.pdf


NEXUS Documentation, Release 6.6.xxxxx.0

14.3 Software as a Service (SaaS)

14.3.1 NEXUS IC, IC-Web & IC-Inspector SaaS logins

If your NEXUS IC instance is hosted by Wood, the following guides to logins apply.

If your NEXUS IC instance is not hosted by Wood, parts of the guides may still be applicable.
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NEXUS IC Remote App login

1. For APAC navigate to
https://remote-ae.nexusic.com
For UK navigate to
https://remote-uks.nexusic.com
For US navigate to
https://remote-scus.nexusic.com

Note: The “old” APAC URLs https://remote-au.nexusic.com and
https://remote-sea.nexusic.com will be auto-redirected.
The “old” UK URLs https://remote-uk.nexusic.com and
https://remote-uk2.nexusic.com will be auto-redirected.
The “old” US URLs https://remote-us.nexusic.com and
https://remote-us2.nexusic.com will be auto-redirected.

2. For first time logins, enter User
name only and the temporary
password provided to you by
the NEXUS support team:

For returning users, skip straight to step 7.

3. Click on the hyperlink to change
your temporary password:

4. In the Change Password screen,
enter nexusic\username,
the temporary password, then
your new password (twice to
confirm). Click Submit.

Password rules can be seen here. In summary, your new password should contain at least three of: uppercase,
lowercase,
digits, non-alphanumeric (~!@#$%^&*_-+=‘|(){}[]:;”’<>,.?/), and alphabetic characters that are not uppercase or
lowercase.

5. If you have successfully changed
your password, then you should
click on the OK button.

6. You will then be taken back to the
login screen, which is where you will
be directed to next time you login.

7. In the RD Web Access login,
enter your User name only:

8. Click on the RemoteApp icon:

9. In the popup authentication
dialog, ensure that you use
the nexusic\username:
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Mac OS NEXUS IC login

Download the Microsoft Remote Desktop app from the Mac App Store. Then follow the above steps.

iOS/iPadOS NEXUS IC login

• Download the Microsoft Remote Desktop app from the App Store.

• Launch the app.

• At the bottom right, tap +.

• Choose Workspace.

• Enter the appropriate URL as from step 1 above; i.e. for APAC, enter https://remote-ae.nexusic.com.

• Tap Next.

• Enter nexusic\username, and your password.

IC-Web login

1. Enter the IC-Web URL.

2. Enter username as user-
name@nexusic.com
and your password.
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IC-Inspector login

1. Enter the Server name as normal.

2. Enter username as user-
name@nexusic.com
and your password.

14.3.2 Troubleshooting

If you are having difficulty connecting to a Wood NEXUS IC cloud instance via RemoteApp, the problem may be your
corporate firewall. Try connecting from a device not connected via the corporate internet connection, and not running
corporate software that may interfere with the connection. For example, try connecting from home via a personal
computer, or try connecting from your smartphone via the phone network.

If the corporate infrastructure is blocking the connection, note the following:

• RemoteApp requires client access to port 443.

• If you or your IT department have set policy “Network security: LAN Manager authentication level” away
from its default, you must set this back, via domain policy or Local Security Policy (secpol.msc). Under Local
Policies → Security Options ensure that Network security: LAN Manager authentication level is set to “Not
Defined” or “Send NTLMv2 response only”.
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• Deep-packet inspection and modification tools may prevent connections from completing, for example if they
find an RDP connection inside an HTTPS stream and decide to rewrite it. See diagram below for the steps
involved behind the scenes in an Azure RemoteApp connection:
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See also: NEXUS IC, IC-Web & IC-Inspector SaaS logins.

Wood provides a SaaS solution using cloud-based servers in Microsoft Azure. Access is provided via RemoteApp and
our web app, IC-Web.

Location – Wood presently operates cloud hubs in UK, USA, SE Asia and Australia. We can stand up services in any
Microsoft Azure data centre as required for clients with specific geographic restrictions on data storage.

Sign-on – NEXUS has the ability to authenticate users via Active Directory connection.

Availability – System availability is historically greater than 99.9%.

Downtime – Planned application downtime is required for server O/S patching. This is performed monthly and is
typically performed out of hours. Non-routine downtime is scheduled and approved with client contact.

Response times & Latency – Tasks within NEXUS can take a varying amount of time (from milliseconds to minutes)
depending on complexity. Increased network latency can degrade performance. Wood recommends <120ms latency
for acceptable performance with RemoteApp and <300ms for IC-Web.

Backup regime – database backups are taken each business day and retained for 14 calendar days. Additional backups
for longer term retention can be held by agreement or transmitted to customer. This may have a small cost impact.

Disaster Recovery (DR) & Business Continuity (BC) – There is no client side requirement for DR/BC. The hosted
service is resilient to single server failures through the use of redundant Azure infrastructure and provides coverage in
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the event that a data centre goes offline. Wood replicates database backups to each of the Azure data centres that we
use around the globe.

Privacy & Confidentiality – Data is stored securely in MSSQL Server and access is only granted to authenticated
users.

Security – Access to data within NEXUS is controlled by in-built functional security. Logged in users are authenti-
cated by SSO (where configured, or Username Password authentication where not). And each user is assigned security
permissions. Security permissions can be defined at Group Level, or user Level. Security for the overall service relies
on Microsoft Azure which meets a broad set of international and industry-specific compliance standards.

Scalability – the SaaS service can be scaled both horizontally and vertically for expansion of scope and increased
number of users.

14.3.3 Additional Features

Because we have more ability to closely manage cloud instances of NEXUS IC than we do for instances deployed on
client’s own infrastructure, we can offer some additional features:

• Scheduled reports

• Database maintenance

• Infrastructure optimization

• Database configuration management across regions

• Wood users supporting your database will not consume a NEXUS license

• Software update service, including early access to Beta releases

14.3.4 Pre-Requisites for RemoteApp

Client Operating System: Windows 8, Windows 10. x86 (32-bit) and x64 (64-bit), Windows Server 2012 R2 (or
higher) supported.

14.3.5 Windows 7

Note that Windows 7 is no longer supported. If you use it anyway, you will at minimum need to install the following
Microsoft patches: http://support2.microsoft.com/kb/2830477 and then update by following the Microsoft patch notes
here: http://support2.microsoft.com/kb/2923545

14.3.6 IC-Web Supported Browsers

• Chrome 54.0 or above

• Microsoft Edge 79 or above

• Safari 9.1 or above

• Firefox 53.0 or above. 3D drawings may be slower in Firefox.

Internet Explorer is not recommended, and does not support 3D drawings.
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14.4 Known Issues

#8358 SVG Grey scale issue: if you view SVG images and you select the Grey Scale option, the image may appear
with a solid black background, and thus black portions of the image may be obscured.

#8331 3D drawing not displayed: 3D drawings originally drawn with SESAM GeniE jacket and then converted to
DWG may not display. This is because our third-party 3D DWG viewer does not cope with these DWG files. (It is
possible that these particular files do not adhere to the DWG standard.)

#7725 Layer hovering doesn’t work with 2D DWG file: when you hover over a region on a regular drawing (JPG,
PDF), the opacity of the region changes slightly. When you hover over a region of a 2D DWG file, the opacity does
not change.
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#7630 3D drawing structure error: some 3D DWG files show minor rendering errors when viewed in NEXUS. Again,
this is a limitation of our third-party 3D DWG viewer.

14.5 Upgrading

14.5.1 IC-Inspection 5 Users

If you’ve upgraded from IC-Inspection version 5 to version 6, here are some quick things that you should know:

• The window manager has been replaced with the same panel manager used in NEXUS IC 6’s Inspections screen.
See Desktops for more details.

• All grids in version 6 work in the same way. Once you’ve learned one of them, you’ve essentially learned them
all. (Exception: There are one or two grids where the new multi-edit feature doesn’t work.)

• The Events toolbar is gone — use the Event Launcher and/or shortcut keys set up through Event Templates
instead.

• The Events pane is now called Active Events.

• The Database Information pane is now called Active Inspection.

• The Assets window no longer has a column to show the number of remaining tasks. An Incomplete Tasks traffic
light has been created to replace this feature.

• Asset information is now editable in IC-Inspection, if the user has that security permission.

• Text overlay is now part of Devices. Text Overlay Server is gone, as text overlay functionality is now incorpo-
rated directly into IC-Recorder (and some other third-party DVRs).

• The following windows are removed: CP Stab, Operation, Survey Charts, Video, Video Recorder. (If you want
video preview, just run an IC-Recorder.)

• The Task Information summary showing number of tasks remaining has been removed. If you want similar
functionality back, add a traffic light.

• Pipeline View (and Pipeline View Secondary) have been replaced with the all-new 3D Pipeline View.

• We now support 3D DWG drawings. (Bear in mind that large 3D DWGs may be slow.)

• If you are using a third-party DVR, you should test its integration with IC-Inspection 6 well ahead of your
inspection. Third-party DVRs must now support our generic DVR control protocol to be supported in IC-
Inspection.

See also NEXUS IC 5 Users upgrade notes.

14.5.2 NEXUS IC 5 Users

If you’ve upgraded from NEXUS IC version 5 to version 6, here are some quick things that you should know:

• All grids in version 6 work in the same way. Once you’ve learned one of them, you’ve essentially learned them
all. (Exception: There are a couple of grids where the new multi-edit feature doesn’t work.)

• Speaking of which, multi-edit is new and very powerful.

• The list of major areas at the left of NEXUS IC 6 should be immediately familiar, but there are now no sub-
selections within each of those areas. Configuration is moved to the Configuration menu. (Of course all those
Configuration screens are made of standard grids, and all work in the same way.)
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• Some areas are missing because they’ve been incorporated into other screens. For example, 4-Site has now been
incorporated into the Assets → Risk screen.

• The old Scheduling → Schedules screen’s View → Assets and View → Workpacks are now the Planning and
Workpacks screens respectively.

• Tools → Options is where it’s always been, but there’s less in it. Things specific to your database are now in
Database → Properties.

• You can rearrange Asset Information tabs by drag-dropping them.

• We now support 3D DWGs. (Bear in mind that large 3D DWGs may be slow.)

• Drawings are now a special kind of Library Item. If you add one drawing to several different assets, it now gets
added as a library item once, and connected to those several different assets, thus saving database space.

• Setting up a sheet for import is a bit different: in version 5, you created a sample sheet for import by exporting
something. In version 6, you instead use the Import wizard’s Example button.

• Chart Templates and Traffic Lights are configured differently in version 6.

14.5.3 Upgrading from an earlier v6 version

1. Ensure that you have a NEXUS user account which is in the Administrators Security Group, and that the account
has read/write access to special permission Upgrade Schema.

2. In your current version of NEXUS, perform a backup of the database (we suggest that this backup file is perma-
nently archived).

3. Run the installer on the Application Server (or on users’ individual PCs).

4. Have one of the users from Administrators security group launch NEXUS IC v6 from the desktop shortcut and
click on OK to update the database schema. The schema update will take some time to complete (about 1-10
minutes), so please be patient when the Status dialog appears.

Note: If you are currently using a HASP key license, you will need to switch to Software Based Licensing.

Note: If you’re upgrading from 6.0, 6.1 or 6.2, see this note about SQL Server permissions.

See the relevant What’s News for highlights of changes.

14.5.4 Upgrading from v5

If you are upgrading from NEXUS IC version 5:

• We suggest consulting with us. Email us at support@nexusic.com.

• Ensure that you have used NEXUS 5’s Database Backup feature to take a backup of your version 5 database and
have put the backup in a safe place. We suggest that this backup file is permanently archived.

• In NEXUS IC 5, ensure that a user account exists that has permission to upgrade the database. In Database →
Security, check Security Areas → Asset Integrity Manager → Schema Update for both the Administrators group
and the user account you plan to use. If in doubt, set both to read/write.

• Make another backup.
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• In NEXUS IC 5, set the security permission back to forbid the Schema Update permission. The reason for this is
to prevent a user who is experimenting with version 6 from accidentally upgrading your live version 5 database.
Once a particular database is upgraded to version 6, version 5 software will be unable to open it.

• Restore the database with NEXUS IC 6 from the backup which has its security permissions set to allow the
upgrade. We recommend not just connecting to the existing database, because if you do this you will not get an
option to set a backup path. This backup path is necessary for the upgrade to work correctly.

You will receive an upgrade prompt. Note that the upgrade is irreversible (which is why you took a backup) and may
take some time. (It’s OK to kick it off in the evening and check the results in the morning — it doesn’t need watching.)

At the end of the upgrade, NEXUS IC 6 will have written a log, giving details of
its actions. This log is named IntegrityCentre_Trace.log and can be found in
C:\Users\[USER_NAME]\AppData\Roaming\NEXUS.

Search this for the word “Warning” or the phrases “Warning[tab]Storage Engine” or “Warning[tab]Schema”. This
latter phrase covers the most important issues. All these are warnings, not errors — they are merely here to let you
know about changes that were made. Information messages can be safely ignored. Preserve a copy of this log file —
otherwise it will be overwritten next time you restart NEXUS IC.

If you run into any problems, contact us with a pre-upgrade backup of the database and/or a copy of the log file.

Traffic lights and report templates will not be ported from version 5 — you will need to recreate these afresh in your
new version 6 database. (This is because these features work in a different way in version 6, for speed reasons.)

14.5.5 Upgrading IC-Web to v6.6 (or later)

IC-Web 6.6 is now running a 64-bit rest service ISAPI module. Previous versions were 32-bit.

What needs to change? - You need to ensure that the “Enable 32-bit applications” attribute for the application pool
running IC-Web is set to False.

For New Website Setup

1. If you are setting up IC-Web for the first time or created a new website for 6.6, the installer will handle this for
you just run the installer and install the new site by following the instructions in the installer.

For Existing Website Upgrade

If you have IC-Web 6.5 (or earlier) installed and use the “update” option in the installer, these extra steps need to be
undertaken manually when the installer is finished running.

1. Open IIS and expand node on the left until you see “Applications Pools” and select it.

14.5. Upgrading 385



NEXUS Documentation, Release 6.6.xxxxx.0

2. Select the application pool that the IC-Web website is using (default application pool name is “ICWeb”) and
right click on this application pool and select “Advanced Settings. . . ”.

3. Find “Enable 32 Bit Applications” and change the value from True to False.
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4. Double check “Enable 32 Bit Applications” is definitely now set to “False” and press “Ok” on the Advanced
Settings window to save that change.

5. Restart your IIS service.

14.6 Third-party DVRs

IC-Inspection can be used to remote control digital video recorders during online inspection, providing a permanent
link between the inspection data and the video record. In addition to controlling our own IC-Recorder, the following
DVRs are also controlled by IC-Inspection 6.

Fig. 1: Seascape Pontus DVR

Fig. 2: Digital Edge
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Fig. 3: Visual DVR

A standard DVR control protocol has been developed and is available for purchase.

To configure a VisualDVR to accept commands via the protocol, left-click on the main video preview. A menu pops
up. Click Systems Setup & Admin → Advanced → NEXUS IC DVR control and tick Enable NEXUS IC DVR control.
For other products, consult manufacturer documentation.

14.7 Other Documentation

A training manual, showing how to use IC-Inspection for offshore eventing and NEXUS IC for offshore review,
is available.

14.8 What’s New

New features in NEXUS IC 6.6 include the following:

14.8.1 NEXUS IC

Expert Systems portability

Configurations of Asset Types (including Asset Information forms, Global Tables, Risk Models, Event Definitions
and Reports) can now be ported and synchronised between NEXUS databases. The concept is that a central library of
“base configuration” databases exist for NEXUS clients to subscribe to. The subscription allows for the clients own
database to be periodically updated from the base configuration database. An example of this would be the Wood API
581 database which is maintained by a committee of Wood engineers. When new changes are made to the code, the
“base configuration” database is updated and the changes to the configuration pushed out to all the subscribers.

A positive side-effect from this development is the enhanced Save and Load functionality of discrete functions, charts
and report templates. Specifically, a report template that depended on a function previously had to be loaded with care,
manually ensuring that you had also created or loaded the report template dependencies. This is now automated: when
you save (for example) a report template, NEXUS IC will offer to save Functions that the report template requires
straight into that save file. Similarly Asset Information groups, Chart Templates, Functions and Shortcuts can all be
saved in a way that records their dependencies, for import into another database. This makes it much more efficient
for example, to perform work in a test database and then copy that work into a production database.
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Asset tree

The asset tree (visible in the Assets and Planning screens and used in various asset pickers) has been modernised. It’s
now much faster for databases with large volumes of assets because it builds sub-parts of the tree only when required,
instead of building the whole tree up front.

We now have the ability to right-click on an asset to view the right-click menu for that asset without selecting it. This
means that you can access functionality for an asset without having to select it (potentially incurring a time penalty if
you have large drawings, complex asset information, etc).

Asset Information Groups

In previous versions, Asset Information was visible in the bottom section of the Assets screen, with all the other tabs

visible in the top section. You can now click the button to toggle Asset Information between being displayed at
the bottom of the screen, or being displayed as another tab along side Drawings, Library, Risk etc.

Historically, navigating between AIG screens was achieved by first clicking on the left-hand sideways tabs to select
an AIG category, then waiting for the first form in that Category to load, then clicking on the tab you want in the top
horizontal tab group. This has been replaced with a single drop down menu from the Asset Information toolbar button.
If you have many Asset Information forms, you’ll see a menu with submenus for each Category of form; if you have
only a few, you’ll see a single menu listing all your forms.

An unfortunate downside of the new UI is that it renders obsolete the humour of watching your co-workers turn their
heads sideways while looking for asset information.

Click the History button (see screenshot above) to view all changes in that form for the current asset. A similar History
button has been added to the Event form on the Inspection screen.
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The Auto Calculate button lets you disable automatic calculation — go to Configuration → Assets → Information to
enable/disable this for each form.

Charts

NEXUS now supports Gauge, Bubble and Donut chart Series types. By default, the Risk Matrix will use the new
Bubble type chart.

Chart Templates now also have an Available flag. If ticked, that chart will appear on the Assets and Inspection screens.
If unticked, that Chart Template will only be available for use in Report Templates.

Support for image playback

The Video playback window in INSPECTIONS now supports play back of timestamped still images (such as those
created by CathX) just as if they were a single video file. Store and parse the image files just as you would normally
parse Video files.
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Third-party point cloud viewer

If you have 3D point cloud data for your assets, you can add a function field to your NEXUS IC database to launch
open-source web-based point cloud viewer Potree with appropriate parameters to display the selected event or asset
location. This feature also integrates well with IC-Web.

And more. . .

• Images are now supported in Dashboards.

• Improved searching (in-grid and global search) which supports multiple word search.

• Automated layering of PDFs - NEXUS will automatically create region layers on PDF drawings using the
annotation objects of the drawing.

• Auto-complete of fields which historically required the user to click on the ellipsis button to select. The user
now only has to commence typing and the field will be populated by the record which matches the text.
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• Report templates support the output of multiple images in a single cell.

• New System Function elements: “DateDiff (Month of Year)”, which differs from “DateDiff (Months)” in that it
returns a number between -11 and +11; “DateDiff (Day Of Month)”, which differs from “DateDiff (Days)” in
that it returns a number between -30 and +30; and “exp(e^x)”, which differs from “exp(10^x)” in the obvious
way.

• You can now specify an order for items in a Traffic Light legend.

• Several grids now have more columns available for customisation: Planning has Workpack Group and Revi-
sion available; Workpacks has Asset, Abbreviation and Description available; Findings has Severity available;
Audit Log has Person available; and Configuration → Events → Event Types has Unit , Columns (Form) and
Comments available.

• You can now Search for an Anomaly via its Code and Anomaly Number linked by a hyphen. So if an anomaly’s
Code is set to TK and its Anomaly Number is set to 421, type “TK-421” into the search box to find your anomaly.
Similarly, search for “TK-” to find all your anomalies with code TK, or “TK-4” to find all of TK-4, TK-40 thru
49, TK-400 thru 499, etc.

• A new field called Finding Number is now available for Findings. (This is not the same as the previous
Finding_ID that some clients used in lieu of a finding number.) We can help you set this to auto-increment if
you like.

• When reducing the number of characters of text that an alphanumeric field can hold, you can specify as small a
number as you like. If this is smaller than the longest text stored in this field, the field will only be shrunk to the
length of that longest text, ensuring that the field size change is performed with no data loss.

• The storage engine was updated so that Pass Thru fields which return more than one value in a cell, now
concatenate that field in a comma separate list. For example, when you add Finding.Name column to a Simple
Source which is retrieving a row per Event, in v6.5, the Storage Engine would just return the Finding.Name
for a single finding, (even if there were more than one finding associated with that event). In v6.6, the Storage
Engine will now return a list of the Finding.Names for all Findings associated with that event.

14.8.2 IC-Web

• Along with new look/feel controls in some places, IC-Web now supports data editing. Users with an IC-Web
read/write license assigned to them can now use IC-Web to both view and edit data.
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• IC-Web now supports 3D drawings

• Interactive dashboard functionality

• The REST service behind IC-Web, IC-Inspector and external connectors has been upgraded to 64-bit, signifi-
cantly increasing the memory available to the REST service.
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14.8.3 IC-Inspector

• IC-Inspector now has a Summary screen.

• IC-Inspector supports 3D drawings and relative assets.

• IC-Inspector supports variable text size and Dark Mode through the iPad’s accessibility settings.

• IC-Inspector now has support for QR or barcode scanning.

14.8.4 IC-Inspection

• Performance enhancements of the Drawings | Task menu.

• Improvements in handling and reporting disconnection of DVRs.

• IC-Inspection can now receive and display error or warning messages from DVRs.

• You can now Save & Hold a tasked event. A new continuation task will be created.

14.8.5 Upgrade Warnings

Windows 7 Support

Windows 7 has reached end of support by Microsoft. As such, we are no longer testing any of our products on the
Windows 7 OS. There are known cosmetic rendering bugs in NEXUS IC 6.6 when run on Windows 7.

Upgrade may take a long time

As with every major release, a series of schema updates will occur automatically the first time you open your database
with the new version. During this v6.6 schema upgrade, NEXUS IC will perform check on each function in your
database to check its integrity. If your database has many functions and/or some of your functions have complex
lookups in them, then the schema upgrade may take a long time. A typical database will take between 2 and 4
minutes, but an extreme outlier might take over an hour. Be patient, the progress dialog lets you know that the schema
update is still ticking away.

Anomaly Action Created By and Assigned To

These two fields were previously alphanumeric free text fields, but are now fields filled with an entry from the Person-

nel table via the usual ellipsis button. During schema upgrade, NEXUS IC will check each entry in the Created
By and Assigned To fields to see if they exactly match the name of an existing user. If they do, that user will be
assigned appropriately. If not, text will be added to the Comments field saying “Assigned To: [text]”. So before you
upgrade, check the contents of these fields (e.g. by clicking in the Anomalies grid and hitting Ctrl-A on the keyboard
to select all, then looking at the Actions grid), and ensure that (a) names are consistent; and (b) names have matching
entries under Database → Security. (Users can have Enabled unticked, and need not be assigned a per-seat license.).

Future

To simplify support and development, we plan in version 6.7 to only officially support Microsoft SQL Server 2019
and newer. (6.6 and previous versions support SQL Server 2012 and newer.)
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Version upgrade information

To simplify our code, version 6.6 only includes the ability to upgrade from version 6.5. If you are running an older
version (v6.4 or earlier), backup your database, upgrade to 6.5, then upgrade to 6.6.

If you’re upgrading from 6.0, 6.1 or 6.2, see this note about SQL Server permissions.

If you’re upgrading from 5.x, more effort is required.

What Was New in 6.5, 6.4, 6.3, 6.2, 6.1.
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CHAPTER

FIFTEEN

LEGAL

The following pages contain pertinent legal information.

15.1 End User License Agreement

END-USER LICENSE AGREEMENT FOR: NEXUS INTEGRITY CENTRE

IMPORTANT: PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CARE-
FULLY BEFORE CONTINUING WITH THIS PROGRAM INSTALL.

This End-User License Agreement (“EULA”) is a legal agreement between you (either an individual or a single entity)
and Wood Group Kenny Australia Pty Ltd of [Level 1, 240 St Georges Terrace, PERTH, WESTERN AUSTRALIA]
(“Wood”), for the supplied software product(s) identified above which may include associated software components,
media, printed materials, and “online” or electronic documentation (“SOFTWARE PRODUCT”).

By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this
EULA. The following terms of this EULA govern your access and use of each SOFTWARE PRODUCT, except to the
extent: (a) there is a separate signed contract between you and Wood governing your use of the software, or (b) the
software includes a separate “click-accept” license agreement or third party license agreement as part of the installation
and/or download process governing your use of the software. To the extent of a conflict between the provisions of the
foregoing documents, the order of precedence shall be (1) the signed contract, (2) the click-accept agreement or third
party license agreement, and (3) this EULA.

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other
intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.

The SOFTWARE PRODUCT is licensed as follows:

a) Installation and Use:

Wood grants you the right to install and use the SOFTWARE PRODUCT on your computer running a validly
licensed copy of the operating system for which the SOFTWARE PRODUCT was designed.

b) Activation:

While you may install as many copies of the SOFTWARE PRODUCT as you wish, some or all of the SOFT-
WARE PRODUCT requires activation at runtime by access to an internet accessible license server operated by
Wood (https://license.nexusic.com/LicenseManager/Licenseserver.dll/test/). The software license key permits a
limited number of users to access the SOFTWARE PRODUCT on either a ‘named’ or ‘concurrent’ user basis.
Each software license key is designed to activate only the number of users and those features of the SOFTWARE
PRODUCT for which you have purchased a license. You must not attempt to subvert licensing restrictions by
any means including, but not limited to, reverse engineering, decompilation, or disassembly of the SOFTWARE
PRODUCT or licensing system.
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c) Loss of License Key:

The software license key can be invalidated and replaced if it is lost or if its security has been compromised.

d) Backup Copies:

You may also make copies of the SOFTWARE PRODUCT as may be necessary for backup and archival pur-
poses.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

a) Maintenance of Copyright Notices:

You must not remove or alter any copyright notices on any and all copies of the SOFTWARE PRODUCT.

b) Distribution:

You may not distribute copies of the SOFTWARE PRODUCT to third parties.

c) Prohibition on Reverse Engineering, Decompilation, and Disassembly:

You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the
extent that such activity is expressly permitted by applicable law notwithstanding this limitation.

d) Rental:

You may not rent, lease, or lend the SOFTWARE PRODUCT without Wood’s prior written consent.

e) Onsale:

You may not on-sell the SOFTWARE PRODUCT without Wood’s prior written consent.

f) Support Services:

Wood may provide you with support services related to the SOFTWARE PRODUCT (“Support Services”). Any
supplemental software code provided to you as part of the Support Services shall be considered part of the
SOFTWARE PRODUCT and subject to the terms and conditions of this EULA.

g) Compliance with Applicable Laws:

You must comply with all applicable laws regarding use of the SOFTWARE PRODUCT.

3. TERMINATION

Without prejudice to any other rights, Wood may terminate this EULA if you fail to comply with the terms and
conditions of this EULA. In such event, you must destroy and uninstall all copies of the SOFTWARE PRODUCT in
your possession and your software license will be revoked.

4. COPYRIGHT

All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies thereof are
owned by Wood or its suppliers. All title and intellectual property rights in and to the content which may be accessed
through use of the SOFTWARE PRODUCT is the property of the respective content owner and may be protected
by applicable copyright or other intellectual property laws and treaties. This EULA grants you no rights to use such
content. All rights not expressly granted are reserved by Wood.

5. PRIVACY

The application may anonymously track your usage and send it to Wood for analysis. We use this analysis to make
improvements to the software. The application may also capture information relating to unhandled errors and may
capture a screen image in this specific scenario. Any user identifiable information is blurred. No personally identifying
information is tracked, and nothing about your usage can be tracked back to you.

6. NO WARRANTIES
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Wood expressly disclaims any warranty for the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is provided
‘As Is’ without any express or implied warranty of any kind, including but not limited to any warranties of mer-
chantability, non-infringement, or fitness of a particular purpose. Wood does not warrant or assume responsibility for
the accuracy or completeness of any information, text, graphics, links or other items contained within the SOFTWARE
PRODUCT. Wood makes no warranties respecting any harm that may be caused by the transmission of a computer
virus, worm, time bomb, logic bomb, or other such computer program. Wood further expressly disclaims any warranty
or representation to Authorized Users or to any third party.

7. LIMITATION OF LIABILITY

In no event shall Wood be liable for any damages (including, without limitation, lost profits, business interruption, or
lost information) rising out of ‘Authorized Users’ use of or inability to use the SOFTWARE PRODUCT, even if Wood
has been advised of the possibility of such damages. In no event will Wood be liable for loss of data or for indirect,
special, incidental, consequential (including lost profit), or other damages based in contract, tort or otherwise. Wood
shall have no liability with respect to the content of the SOFTWARE PRODUCT or any part thereof, including but not
limited to errors or omissions contained therein, libel, infringements of rights of publicity, privacy, trademark rights,
business interruption, personal injury, loss of privacy, moral rights or the disclosure of confidential information.

15.2 Cryptography Declaration

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/)

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes
software written by Tim Hudson (tjh@cryptsoft.com).
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